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1.

Introduction

Thank you very much for your decision to purchase Translator’s Workbench 2.2, the 32-bit

generation of the leading and established integrated software workstation for translators
developed by "TRADOS.

"TRADOS Translator’'s Workbench, or “Translator’s Workbench” for short, represents the state
of the art as far as powerful and flexible management of linguistic reference material is
concerned. It offers lightning-fast access to previous translations not only at sentence and word
level, but also at sentence part level, thus helping all translators who want to be relieved of time-
consuming and repetitive tasks:

e The Translation Memory (TM) is a database in which source-language sentences are
stored together with their target-language equivalents. A TM learns unobtrusively while the
translator works and makes sure that no repeated term or phrase has to be keyed in twice.
Cutting-edge technology is used to perform fuzzy searches in this database to give you
instant reference to text segments that you have already translated. But a TM can do even
more for you: it can manage additional data such as the client of the translation project, or
the domain in which translation units were created. Later, among other things, these
additional data can be used to distinguish between different subsets of the data stored in the

TM.

e Active terminology recognition: Translator’s  Workbench is shipped with
MultiTerm ’95 Plus, the mature multilingual terminology management system developed
by *"TRADOS. Known terms are stored in this database and are automatically highlighted by
Translator’s Workbench. Their translations can be pasted into your word processor at the
click of a mouse button or a keystroke. Active terminology recognition works with a fuzzy-
matching algorithm, too. Thus, compound words or morphologically modified forms are
found even if they don’t occur in the same form in the text to be translated. Let’s assume
you have to translate the sentence Many windows are displayed on the screen. Now, if there is an
entry in the MultiTerm database containing the term sereen display, it will be found although
the original sentence did not contain the term in this form, but only the words disp/ayed and
screen.

* Bilingual Concordance: It happens very often that, when working on a translation, you are
sure that you have already translated a part of the sentence you are about to translate next.
So you would like to search Translation Memory not only at entire sentence level, but also
at sentence part level. This need has been met in Translator’s Workbench: it is not
restricted to entire sentences or other text segments. It can also create what is referred to as
“bilingual concordances” from sentence segments. Mark the part of a sentence that interests
you, click once with the mouse, and in a flash, a window opens with all the source- and
target-language sentences from Translation Memory that contain the selected sentence
segment.

In short: Translator’s Workbench gives you instant and flexible access to previous translation
material at three levels; at sentence level and sentence part level thanks to its Translation
Memory and Concordance Feature, and at terminology level thanks to active terminology
recognition performed in co-operation with MultiTerm.

How can Translator’s Workbench achieve all these demanding tasks? The answer is that it stores
all linguistic data in what is referred to as neural networks. This powerful new technology
enables it to look for all kinds of data in a flash and with a degree of flexibility and assurance that
will convince you as you try the different functions of Translator’s Workbench in the following
chapters.

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



1-2 Introduction

1.1 New in Release 2.2: TRADOS TagEditor and Much More!

This section sums up the most important news in release 2.2: "TRADOS TagEditor,
Translator’s Workbench Freelance Edition, and T-Window for PowerPoint. To get an overview
of what’s new in Translator’'s Workbench 2 compared to version 1, see “What’s New in
Translator’s Workbench 2” below.

1.1.1 TRADOS TagEditor

"TRADOS TagEditor is the new, free companion to *TRADOS Translator’s Workbench 2.2 or
higher. With *TRADOS TagEditor, a specialised translation editor for tagged file formats such
as SGML/HTML, STF (as produced by The S-Tagger for FrameMaker and Interleaf),
PageMaker, Ventura etc. has finally been combined with the most advanced and powerful
translation memory system available today. This section sums up the most important features of
TagEditor and provides references to corresponding topics in the documentation (User’s Guide
and online Help).

To get started with TagEditor as quickly as possible, we recommend to go through the self-
running demo that is available from the TagEditor product home page at
http://ww. trados. conf TagEdi t or . This User’s Guide also contains a “Getting Started”
chapter that we recommend you to read.

Supported Formats

Converting HTML and SGML files to and from RTF is no longer necessary. TagEditor
provides direct support for HTML and SGML. Pre-defined HTML settings allow you to start
translating HTML documents immediately. TagEditor’s DTD Settings Wizard guides you
through setting up support for your SGML files. The Wizard scans your D'TD, lets you specify
tag properties, and facilitates entity management.

Workbench RTF as produced by The S-Tagger and the ITP Filter Pack is also supported
permitting you to apply all of TagEditor’s advantages while translating FrameMaker, Interleaf,
PageMaker, Ventura and QuarkXPress documents. No preparation step is required for this
format (other than creating Workbench RTF from the original D'TP format).

Tag Protection & Verification

TagEditor protects all tags so that you cannot edit or delete them. TagEditor can also check the
tags for correct syntax after they have been transferred from the source document to the
translated document. This can be done in either interactive or batch mode. For more information
on tag protection and verification, see the “Tag Protection and Verification” chapter in the
TagEditor online Help.

Familiar TRADOS Toolbar and Shortcuts

TagEditor features the same toolbar, menu and keyboard shortcuts as are available when
working with Translator’s Workbench and Microsoft Word. For more information on the
interface, see the “Interface Between Translator’s Workbench and Your Word
Processor/TagEditor” chapter.

Key Editing Functions

TagEditor features many key text editing functions including Find & Replace, multiple undo,
specialised toolbars and a “Multiple Document Interface” allowing you to work on more than
one document at a time. You can also drag and drop documents from Windows Explorer directly
into the TagEditor window.

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



New in Release 2.2: TRADOS TagEditor and Much More! 1-3

Document Views

HTML and SGML documents may be viewed in semi-WYSIWYG format for more user-friendly
translation. You can switch between three different translation views: Source view, Target view,
and Bilingual Edit view.

TagEditor also features a special Internet Explorer Preview Mode. With one mouse click you
can display the document as it will appear in your browser from within TagEditor. This allows
you to quickly check the formatting of the translated HTML. Printing options are also available
from Preview mode.

If you do not wish to view your document in Internet Explorer or you are translating SGML
documents, simply specify the external browser of your choice to achieve the same results. For
more information on this, see the “DTD Settings Wizard” chapter.

Other TagEditor Highlights

e Fully UNICODE™ Compliant. TagEditor is based on the UNICODE™ standard,
allowing you to use any language combination that Translator’s Workbench supports. This
includes all Asian or Eastern European languages as well as Greek.

e Font Translation. The translator can map western fonts to their Eastern European and
double-byte font counterparts.

¢ Customisable Interface. The TagEditor interface may be customised to suit your
preferences. You can define the way tags look, automatically start up Translator’s
Workbench with TagEditor and much more!

e Full MultiTerm Integration. Terminology management via TRADOS MultiTerm works
in the same way as for the standard Translator’s Workbench interface.

e Multiple Dialog LLanguages. Switch between dialog languages for the user interface and
on-line help.

*  Platforms Supported. TagEditor is a 32-bit, object oriented C++ application which runs
under Windows 95, Windows 98 and Windows N'T'.

1.1.2 Translator's Workbench Freelance Edition

Along with Translator’s Workbench 2.2, TRADOS has also released Translator’'s Workbench
Freelance, a new member in the TRADOS family of translation memory systems mainly aimed
at freelance translators.

The only difference between the full version of Translator’s Workbench and the Freelance
Edition is that the Freelance Edition is not network-enabled, that is, it does not allow to share
translation memories over a local area network. This is because Translator’'s Workbench
Freelance Edition opens each translation memory in exclusive access mode.

All documentation is also valid for the Freelance Edition; the difference in network support is
mentioned wherever appropriate.

1.1.3 T-Window for PowerPoint

Along with Translator’s Workbench 2.2, TRADOS has also released T-Window for PowerPoint.
This new solution allows users to translate PowerPoint slides directly within PowerPoint,
availing of all the Workbench functionality. For further information, please see the
documentation and on-line Help shipped with T-Window for PowerPoint and the product home
page on our Web site at ht t p: / / www. t r ados. com t wi ndow.
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1.2 What's New in Translator's Workbench 2 Compared to Version 1?

In Translator’'s Workbench 2, the "TRADOS developers have not only refined the proven
features of the previous version—Translation Memory with neural network technology, fuzzy-
matching, active terminology recognition, concordance searching, word processor integration
etc.—but have also added many innovative new functions:

*  Full support for Word 97. Translator’s Workbench 2 is directly integrated into Word 97, and
the Workbench functions make full use of the VBA programming language. Of course Word
6.0 and 7.0 continue to be supported. See the “Getting Started” and “Interface With Your
Word Processor” chapters.

e  Support for the Unicode™ standard. This means that #// languages available in Windows
95/N'T" are supported by Translator’s Workbench 2, including Eastern European as well as
Asian languages, both as source and target. T'ranslator’s Workbench is the first TM system to
fully support fuzzy-matching for Asian languages. See the “T'ranslation Memory” chapter.

e Full support for non-WYSIWYG formats such as SGML/HTML, FrameMaker, FrameMaker
+ SGML & Interleaf (via The S-Taggers for FrameMaker and Interleaf), Ventura,
Pagemaker, Bookmaster, RC, etc. See the “Translating Tagged Files with Translator’s
Workbench” chapter.

* New database and neural network design for even faster access to large translation memories
especially in shared network TMs.

e New, hot Translation Memory maintenance function for global search & replace operations,
attribute manipulation, etc. See the “Translation Memory Maintenance” section in the
“Translation Memory” chapter.

e Enhanced tokenizer for more linguistically refined analysis and advanced substitution of
interchangeable elements (numbers, names, acronyms, date, time, etc.). See the
“Translation Memory” chapter.

e  New access-rights model for protecting read-only translation units via user group passwords.
See the “Network Operation” chapter.

e Dynamically switchable dialog languages. You can choose your preferred user interface
language at run-time via the Dialog Language command from the Settings menu.

e OLE/COM-based API (Application Programming Interface) for third-party applications. A
great variety of Translator’'s Workbench functions can be called by any third-party
application through OLE/COM. This is valid for interactive as well as batch translation.

* Translator’s Workbench 2 is a 32-bit application for Windows 95/98 and N'T..

1.3 Accessing Translator’s Workbench From Your Word Processor

When you are not working on tagged formats but “normal” Word documents, Translator’s
Workbench is unlike all other Translation Memory systems: it works directly from within the
working environment to which you are accustomedl] your word processor. This means you don’t
have to leave Word in order to take full advantage of the features offered by Translator’s
Workbench. This is because Translator’'s Workbench has a built-in interface that works with the
most popular word-processing systems (Word 97, Word 95 (7.0), Word 6.0). You translate directly
in your word processor, without any need to import or export the text, and your translation is
stored in the same format in Translation Memory as you have used in your word processor. For
instance, titles will remain in boldface, and highlighted text passages will remain in italic
characters. The Translation Memory will store this formatting information together with the
sentences they belong to.
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1.4 Translation Memory—What Is I1t?

Translator’s Workbench takes advantage of the fact that text segments in technical
documentation are often repeated. This may be that modern products are generally based on
existing products, and the accompanying documentation follows suit. Shorter product life cycles
also lead to shorter revision cycles for manuals. Research has shown that the repetition rate can
reach 70% or even more.

While the translator works, Translator’s Workbench builds a database that stores all translations
together with their source-language equivalents. Such a sentence pair is referred to as a
translation unit. The database consists of these translation units and stores them in what is
called a neural network. This innovative technology later enables the program to find identical or
similar sentences in a flash. The database itself and its associated neural network are as a whole
referred to as Translation Memory.

The following diagram sums up what has just been said:

Translation unit (TU): Translation Memory:
Linguistic data: Translation unit 1 (T'U 1):
TU2
! Dies ist ¢in Beispiclsatz. TU3
This is a sample sentence.
Additional TU information: TUn

Date of creation: 20 September 1994 I \

Creation user: Miller

Usage Counter: 2

Project code: Translation 105/1994

Client: Trados, Smith Ltd., Miller & Co.

Domain: Electronic Data Processing, Software TU database and neural network files for

linguistic data and additional TU
information

Figure 1-1: Translation Units and Translation Memory

1.4.1 Building Translation Memory

As the translator works, Translator’s Workbench unobtrusively updates the Translation Memory
in the background. As soon as the translator finishes entering a translation (usually a sentence)
into the target language, the program stores the translation unit in Translation Memory and
displays the next translation unit in the word processor.

The import feature allows you to load data from previous translations into Translation Memory,
including those created with previous versions of Translator’'s Workbench (Version 1.x,
Translator’s Workbench II for DOS) or with *"TRADOS WinAlign. WinAlign is the automatic
text alignment programs developed by *TRADOS which can generate Translation Memories
from documents that are translations of each other. Thus, for instance, a translation department
could load major jobs from recent years into Translation Memory to have reference material
immediately available before starting new projects.

1.4.2 Automatic Translation

When the system comes to a sentence that has already occurred, it automatically translates the
sentence by reading the corresponding target-language sentence from Translation Memory.

Unfortunately, these 100% identical sentences don’t occur as often as one might hope. Much
more common are sentences that have been slightly changed, for instance with a new product
name or a different performance statistic. 'T'o solve this problem, that is, find sentences that are
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only similar to each other, the computer linguists at *TRADOS have over the last years
developed and refined what is referred to as linguistic fuzzy matching.

1.4.3 Linguistic Fuzzy Matching

Computers generally search for exact matches. Fuzzy matching is a technique for finding data
that has only a certain similarity to the search argument. In Translator’s Workbench, this means
that sentences are found even if they are only similar to others already translated.

Small differences may alter the meaning of a sentence completely. On the other hand,
sometimes a sentence is still very similar to another in spite of more significant changes. In order
to find matches with meaningful content, an artificial neural network design has been developed
for T'ranslator’s Workbench. It works like this: a new sentence is matched against the ones
already present in the Translation Memory and its associated neural network. Linguistic
processing is carried out in the network to find the sentence with the fewest changes in
Translation Memory. This sentence is then selected as “best match.” Meanwhile, other
sentences that are less similar to the search sentence are not totally discarded by Translator’s
Workbench. On the contrary, Translator’s Workbench gives you the possibility to look at these
less similar matches and choose them if you prefer them to the one originally offered by the
program.

The user will probably have to make minor modifications to the translation chosen as “best
match.” To simplify this process, the system uses colour to highlight the differences between
the current sentence and the sentence from Translation Memory. For instance, inserted words
are displayed in grey, and changed words in yellow.

The fuzzy matching algorithm calculates a percentage value to express the level of similarity
between two sentences. The user can set a minimum value that must be achieved for the system
to suggest a translation. All sentences below this minimum are translated manually.

1.4.4 Active, “Fuzzy” Terminology Recognition

But even if Translator’s Workbench cannot find any sentence match in its Translation Memory,
it is far from leaving the translator to work alone. It can still be of great value when it comes to
retrieving information at term level. All terms that are stored in the MultiTerm terminology
database (and are therefore “known” to Translator’s Workbench) are highlighted in the source
text and the corresponding terminology entries displayed in a separate window of Translator’s
Workbench. A click on the mouse button or a keystroke pastes the corresponding translation into
your text. Of course Translator’s Workbench displays all translations of known terms together
with their attributes, so you can choose the best translation for your current project. Thus, for
example, if one of your German clients prefers the translation Anwendung to Anwendersoftware for
the English word application, Translator’'s Workbench will display both German translations and
you can decide which one fits best into your current context. Of course, you can also call
MultiTerm at any time and have a closer look at the whole entry for application.

The active and automatic terminology matching carried out by Translator’s Workbench also
required the development of special fuzzy-matching algorithms. It would be desirable to find not
only morphologically reduced forms, for example base forms of verbs, but also root forms of
compound words, even if the elements of these compound words are spread all over the
sentence. Consider the following example:

One of the companies located on the Danube river produces steamboats.

Now, if there is an entry in MultiTerm for Danube steamboat, it would be nice to find it even if
this compound has been split up in the source sentence and occurs in the plural. Also, it would of
course be desirable to find entries for Jocate and produce, even if the past participle and 3rd person
singular form of these verbs are used in the sentence to be translated. Translator’s Workbench
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will find all these terms thanks to the fuzzy-matching algorithm that is used not only to access
Translation Memory, but also MultiTerm terminology databases.

1.5 About This Manual

This User’s Guide has been written to help you learn to use Translator’s Workbench and
TagEditor in your daily work as quickly and simply as possible. Once you have learned the
program’s basic functions, this User’s Guide will serve as a reference where you will quickly find
Help when questions arise. The individual chapters are structured as follows: At the beginning
of each chapter, we present a brief introduction to the topics that will be discussed in that
chapter. The subsequent sections in the chapter give you complete instructions on how to
perform the corresponding tasks. Since most people learn better by doing, we recommend that
you carry out the instructions on your PC as you read them.

Since Translator’'s Workbench and TagEditor are Windows programs, basic functions like
selecting commands from a menu are probably already familiar to you from other programs, such
as your word processor. If Windows is still new to you, please take some time to learn the basic
functions with the Help of your Windows User’s Guide or the Windows tutorial. Our instructions
assume you have a basic knowledge of Windows.

As with most Windows programs, Translator’s Workbench and TagEditor let you perform
operations using the mouse or the keyboard. We enclose keys that you must press in square
brackets, for example [Alt]. A plus sign + means that you should press two keys simultaneously; a
comma between key names means that you should press one key, then the other. A letter in
square brackets means that you should press the key for that letter. For example, [D] doesn’t
mean press [Shift]+[D] to create a capital D; just type the letter d.

Special key combinations that abbreviate a series of commands, for instance [Ctrl]+[O] to open a
T'ranslation Memory, are shown at the appropriate place in parentheses.

Translator’s Workbench currently has a built-in interface with the following applications:

« "TRADOS TagEditor

*  Microsoft Word, versions 6.0 and higher, including Word 97. Word 2000 integration is
currently being tested, please refer to our Web site for updated information.

e PowerPoint (via the separate application T-Window for PowerPoint).

T'ranslator’s Workbench 2.x no longer supports WordPerfect 6.1. However, there is a special
version of Translator’s Workbench 1.x on our Web site that works with both the old Workbench
1.x dongle and the new dongle shipped with Translator’'s Workbench 2.x. So you can keep
working with Workbench 1.x for WordPerfect 6.1 projects even if you “only” have the new
Workbench 2.x dongle. Exchanging translation memories between the two versions is possible.
Corresponding procedures are described in the “Importing and Exporting Translation
Memories” chapter.

1.6 Additional Documentation

This User’s Guide explains how to work with Translator’s Workbench, how to use its interface
with TagEditor and the word processors Microsoft Word 6.0, 7.0, and 97, and how to build, use,
and manage T'ranslation Memory.

MultiTerm 95 Plus!, the terminology management system included in Translator’s Workbench,
can also be purchased as a separate Windows application and also works with additional word-
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processing systems. This User’s Guide explains how MultiTerm interacts with Translator’s
Workbench, Translation Memory, and Word/WordPerfect. For more detailed information on
MultiTerm, including its use independently of Translator’'s Workbench, please refer to the
MultiTerm User’s Guide.

WinAlign, the visual text aligner used to build translation memories from previously translated
texts, is also available as a separate Windows application. For more detailed information on
WinAlign, please refer to the WinAlign documentation and product home page at
http://ww.trados. cont WnAlign.

The S-Tagger 2.0 for FrameMaker and The S-Tagger for Interleaf, the professional conversion
solutions that create TagEditor and Translator’s Workbench compatible tagged files from
FrameMaker and Interleaf documents, are available as separate Windows applications. For more
detailed information on The S-Tagger, please refer to the S-Tagger documentation and product
home page at htt p: / / www. t r ados. com St agger .

T-Window for PowerPoint, the new solution for translating PowerPoint slides with Translator’s
Workbench, is also available as a separate Windows application. For more detailed information
on T-Window for PowerPoint, please refer to the T-Window documentation and the product
home page at htt p: / / www. t rados. com Twi ndow.

Extensive information on all other *TRADOS applications, including demo versions and
tutorials, are available at the "TRADOS Web Site at ht t p: / / www. t r ados. com

1.7 Copyright Notice

Translator’s Workbench and TagEditor were developed in 1993-1999 by *TRADOS. All rights
to the software (excluding ann.dll and the Sentry spelling-checker engine) and to the printed
materials that accompany it are the property of *"TRADOS GmbH, Stuttgart, Germany. Neither
the software nor the documentation may be duplicated in whole or in part, or reproduced in any
form, without the express written permission of "TRADOS GmbH.

Use of this software is subject to the terms of the license agreement included with this product.
If the license agreement is misplaced, a copy can be requested from TRADOS GmbH.

1.8 Trademarks

« *TRADOS® MultiTerm® 95 Plus, and WinAlign® are registered trademarks and
Translator’s Workbench and TagEditor are trademarks of *"TRADOS GmbH, Stuttgart,
Germany. The S-Tagger is a trademark of " TRADOS Ireland Ltd., Dublin.

*  Microsoft is a registered trademark; Word, Word for Windows, WinWord, PowerPoint,
Windows, Windows 95, Windows 98 and Windows N'T' are trademarks of Microsoft
Corporation.

¢ Unicode™ and the Unicode logo are trademarks of Unicode, Inc.
e Novell is a registered trademark; NetWare is a registered trademark of Novell Corporation.
e Corel is a registered trademark; WordPerfect is a registered trademark of Corel Corporation.

e Netscape is a registered trademark; Navigator and Communicator are registered trademarks
of Netscape Corporation.

¢ FrameMaker, FrameMaker + SGML, and FrameBuilder are trademarks of Adobe Systems,
Inc.
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Interleaf is a trademark of Interleaf, Inc.
SYSTRAN is a registered trademark of SYSTRAN Software, Inc.
LOGOS is a registered trademark of LOGOS Computer Integrated Translation GmbH.

Other product names are generally trademarks or registered trademarks of their respective
owners. They are used without representation as to their release for general use.

1.9 System Requirements

To use Translator’s Workbench efficiently, we recommend the following setup:

PC AT with a Pentium or higher processor running at 100 MHz or more, with at least 32 MB
of RAM. Recommended is a Pentium II or higher processor, 64 MB of RAM or more, and a
17"’ monitor.

Hard disk containing the following software: Windows 95/98 or higher, N'T" 4.0 or higher,
Microsoft Word for Windows 6.0 or higher (including Word 97).

Translator’s Workbench runs on any network that supports standard DOS calls at version 3.3
or higher (for example, Windows NT, Novell NetWare, Microsoft LAN Manager). For
optimum performance, we recommend running Windows N'T on both the server and the
workstations.

If you want to process Asian languages, we recommend you work with the localised version
of the operating system (e.g. Japanese Windows 95/98/N'T") rather than with an overlay
product (e.g. Japanese Star, T'winBridge, etc.).

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



1-10 Introduction

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



2.
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Wor

kbench and TRADOS TagEditor

Notes

*  We recommend that you first install MultiTerm *95 Plus, the terminology management
system shipped with Translator’s Workbench, before installing Translator’s Workbench
itself. Please refer to the MultiTerm ’95 Plus User’s Guide for information on how to
install MultiTerm ’95 Plus.

e If you are upgrading from earlier versions (1.x) to Translator’s Workbench 2.x, please read
the notes in the section “Upgrading from Version 1.x to Translator’s Workbench 2.x”
before installing the new version.

e The installation process of Translator’s Workbench Freelance is exactly the same as for
the full version, so you can follow the installation procedures below in exactly the same
way.

e As this document goes to press, "TRADOS is in the process of converting to CD
production for product shipment. This CD-ROM will contain a visual interface guiding
you through the Setup of all "TRADOS applications. This will change the steps 1
through 4 below accordingly.

An installation program is used to install Translator’s Workbench 2.x. The program files are
shipped in compressed form on the installation diskettes labelled “T'ranslator’s Workbench, 32-
Bit Edition for Windows 9x/N'T, Program Disk.” For this reason, you must use the installation

p

rogram to install Translator’s Workbench on your hard disk.

Follow these steps to install the program:

1.

Start Windows, if it’s not already running. Translator’s Workbench 2.x runs under
Windows 95, 98 and N'T 4.0.

Insert the diskette labelled “TRADOS Translator’s Workbench 2, 32-Bit Edition for
Windows 9x/N'T, Program Disk” into drive a: (or b: if this is the letter of the drive for
small diskettes).

From the Windows Start menu, choose Run. The Run dialog appears.
Type a: set up (or b: set up) into the Open box, and click OK.

The installation program now guides you through the installation process. By default,
\ Program Fi |l es\ TRADOS\ TWAW n is suggested as the target folder for Translator’s
Workbench. It is recommended that you use this setting, but you can also adapt the folder
name to your needs.

Since Translator’s Workbench is integrated into your word processor, the Setup program
tries to determine where the word processor is located on your system. More specifically, it
looks for your word processor’s startup folder.
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If Setup can find a valid folder, it will display the following dialog and later copy the
interface files there:

Word Processor Information

Setup will copy \Workbench interface files into these paths:

File: Tw4/IN.DOT 2]
Target Location after Setup:
C:AMSOFFICE wWiIMwWORDASTARTUR

Filz: Tw/ 4w IMA7.0OT
Target Location after Setup:
C:AMSOFFICESOFFICENSTARTUR

Figure 2-1: Detecting Word Processor Startup Folders (here, for Word 7
and 97)

If Setup cannot find a valid folder, you will be asked to specify your word processor and
its startup folder. You can also Select None if you intend to use Translator’s Workbench
only with TagEditor, 'T-Window for PowerPoint or other Translator’'s Workbench
integration solutions.

How you integrate the Workbench interface files into the daily work with your word
processor is described under “Preparing your Word Processor for Interaction with
T'ranslator’s Workbench” below.

Near the end of the installation, the setup program adds a new program folder and different
program icons to your Windows environment. By default, the program group is called
“TRADOS fine translation tools”; the main icon gets the name “Translator’s Workbench 2.
The other icons let you configure the dongle drivers for your operating system. To install
the drivers, see the next step.

On the last Setup dialog, you have the following options:

You can view the Readme file with late-breaking information on Translator’s
Workbench.

You can choose to install the drivers required for the hardware copy protection
(“dongle”) shipped with Translator’s Workbench. Setup looks whether you have already
installed these drivers. (This is the case, for instance, when you are installing a
Maintenance Release of Translator’s Workbench 2.) If dongle drivers can be found, the
check box for installing the drivers is not ticked. Otherwise, it will be activated so that
the drivers will be installed. For more information on how to use the dongle, please read
the section “Hardware Copy Protection (Dongle)” below.

This completes the installation. Keep the original diskettes in a safe place.

The Dynamic Link Library (DLL) and other files that Translator’s Workbench and TagEditor
need during execution are all copied to the installation directory. No program file whatsoever is
copied to the Windows system directory (except for the dongle drivers).
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Note on TagEditor Installation

Under certain circumstances (“old” Windows 95 and N'T 4.0 installations, for instance), you
may experience problems with some TagEditor functions such as previewing documents or
setting program options via the Options dialog from the Tools menu. In most cases, this is due
an old version of a Windows Dynamic Link Library (DLL) called Conctl 32.dl1.
Translator’s Workbench and TagEditor come with a new version of this DLL, but it is #or
installed by default. To install the DLL update, follow these steps:

1. In Explorer, open the Translator’s Workbench installation folder (\ Program
Fi | es\ TRADOS\ TWAW n by default).

2. In this folder, you will find a subfolder called ConCt | Upd. Inside this subfolder, double-
click the file 40Conupd. exe. This will launch a Setup program that will install the new
version of the Conttl| 32. dl | library. After installing the DLL update and re-booting
your system, you should be able to use TagEditor without problems.

Performing this update is #of necessary under Windows 98 or on computers running Internet
Explorer 4.x.

2.1 Hardware Copy Protection (Dongle)

«

a

Dongle” is the name of a small module that protects software against unauthorised use and
llows users to install a program on several computers without violating license agreements.

2.1.1 Installing and Configuring Dongle Drivers

As mentioned above, the Setup program tries to determine whether you have already installed
the dongle drivers for a previous release of Translator’'s Workbench 2. If this is the case, you
don’t need to install the drivers. However, if you have problems using the dongle, or if an update

(0]

f Translator’s Workbench also contains new drivers, it might be useful to install or configuring

the drivers nonetheless. Depending on the operating system you are using, follow one of the
procedures below to install the drivers.

Installing/Configuring Drivers For Windows NT

IMPORTANT

To install the dongle drivers under Windows N'T', you must have administrator rights. It is not
possible to install the drivers without these rights. If you do not know if you have
administrator privileges, please ask your system administrator.

During installation, a program icon for Windows N'T" dongle driver installation has been created
in the Translator’s Workbench program folder. Follow these steps to install the driver:

1.
2.

From the Windows Start menu, choose Programs. The Programs menu opens.

Open the Translator’'s Workbench program folder (TRADOS fine translation tools by
default).

Click the icon labelled “Configure Dongle Drivers for Win N'T.” This starts a small utility
called Sentinel Driver Setup Program. You use this program to install, configure, or remove
the dongle driver.

Perform one of these tasks as required:

Translator’s Workbench, © 1994-99 by " TRADOS GmbH




Installing TRADOS Translator’s Workbench and TRADOS TagEditor

* To install the dongle driver, on the Functions menu, select Install Sentinel Driver. This
opens a dialog with a path specification. You can accept the path as is by clicking OK.

Sentinel Driver Setup Program Mi=] E3

inel Driver

LConfigure Sentinel Driver

Bemove Sentinel Diver

Cluit

Figure 2-2: Installing the Sentinel Dongle Driver

* To configure the driver, select Configure Sentinel Driver.

¢ Toremove the driver, select Remove Sentinel Driver.

5. If you have installed the driver, you should get the message “Driver Installed! Please restart
your system.” Confirm this message with OK.
6. 'The drivers are now installed. For the changes to take effect, please reboot Windows N'T.
After that, you are ready to use Translator’s Workbench.
Note

If you have any trouble installing the dongle drivers or would like further information, please
consult the Senti nel . hl p Help file located in the \ Dongl e\ W N_NT\ | 386 folder. This
folder has been created during installation and is located under the main Translator’s
Workbench installation folder (\ Program Fil es\ TRADOS\ TWAW n by default). The
Senti nel . hl p Help file contains more information on configuring the dongle driver.

Installing/Configuring Drivers For Windows 95/98

During installation, a program icon for Windows 9x dongle driver installation has been created in
the Translator’s Workbench program folder. Follow these steps to install the driver:

1.
2.

From the Windows Start menu, choose Programs. The Programs menu opens.

Open the Translator’'s Workbench program folder (TRADOS fine translation tools by
default).

Click the icon labelled “Configure Dongle Drivers for Win 9x.” This starts a small utility
called Sentinel Driver Setup Program. You use this program to install or remove the dongle
driver.

Perform one of these tasks as required:

e To install the dongle driver, on the Functions menu, select Install Sentinel Driver. This
opens a dialog with a path specification. You can accept the path as is by clicking OK.
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I[= B3

Bemowve Sentinel Driver

Luit

Figure 2-3: Installing the Sentinel Dongle Driver

e To configure the driver, select Configure Sentinel Driver.

¢ Toremove the driver, select Remove Sentinel Driver.

5. If you have installed the driver, you should get the message “Driver Installed! Please restart
your system.” Confirm this message with OK.

6. 'The drivers are now installed. For the changes to take effect, please restart Windows 9x.
After that, you are ready to use T'ranslator’s Workbench.

Note

If you have any trouble installing the dongle drivers or would like further information, please
consult the Sent wi5. hl p Help file located in the \ Dongl e\ W n_95 folder. This folder has
been created during installation and is located under the main Translator’s Workbench
installation folder (\ Program Fi | es\ TRADOS\ TWIW n by default). The Sent wd5. hl p

Help file contains more information on configuring the dongle driver.

2.1.2 Running Translator’'s Workbench With Dongle

You must plug the dongle into your computer’s parallel port in order for Translator’s Workbench
to execute without restrictions. If a printer or other peripheral is already using the parallel port,
you simply plug its cable into the back of the dongle. This does not restrict the functioning of
the device in any way. TagEditor can also be used as a stand-alone application without dongle.

2.1.3 Running Translator’s Workbench Without Dongle

If you don’t plug in the dongle, the program will run in “demo mode.” In demo mode, the full
functionality of the program is available. There are, however, some restrictions with regard to the
size of the databases that you can use:

e Translation Memories may contain up to ~ 100 translation units

e The Export Frequent Segments, Export Unknown Segments, and Create Project TM options
in the Analyse dialog box are not available

e MultiTerm 95 Plus terminology databases may contain up to ~ 200 entries for the
terminology recognition to function properly
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2.2 Installing Translator’s Workbench on a Network

Installing Translator’s Workbench on a network is the same as installing it on a local PC except
that when the installation routine asks where to install the program (step 5 above), you specify a
network drive. As with local installation, the installation program then copies all the program files
to the folder you specify as the installation folder. This is also true of the Dynamic Link Library
(DLL) files shipped with the system. So the only things you need to do on each local PC are the
following:

e create a program folder and icon pointing to Translator’s Workbench and TagEditor main
executable files (TWAW n. exe and TagEdi t or . exe);

* copy the interface files with Word to each local PC (see “Preparing Your Word Processor for
Interaction with Translator’s Workbench” below);

o perform the update of the ContCt| 32. dl | if at all necessary (see “Note on TagEditor
Installation” above);

* install the dongle drivers on each local PC and equip each PC with a dongle (see “Installing
and Configuring Dongle Drivers” above).

This completes the installation. As far as access rights to the installation folder of Translator’s
Workbench are concerned, you can make it read-only. This only applies, however, if you keep
the data created with the program—that is, the Translation Memory databases—in a separate
folder. In the database folder, make sure that each user gets #// rights. This is necessary for a lot
of program functions Workbench performs during execution.

For the actual network operation, please refer to the chapter “Network Operation.”

2.3 Upgrading from Version 1.x to Translator’s Workbench 2.x

Translator’s Workbench 2.x comes with a completely new database engine and fuzzy-matching
algorithms. This is why the program cannotr directly open Translation Memories created with
version 1.x. Instead, it will display an error message if you try to do this.

You will of course want to continue using the Translation Memories created with version 1.x. To
achieve this, you first need to expors your existing Translation Memories. In a second step, you
then /mpors them into Translation Memories created with the new version.

2.3.1 Exporting Translation Memories from Version 1.x

Follow these steps to export your Translation Memories created in version 1.x:

1. Start Translator’s Workbench 1.x.

2. Open the Translation Memory you want to export for use with version 2.x. In order to be
able to export the Translation Memory, you need to open it exclusively. To achieve this, in
the Open dialog, activate the Exclusive check box. Translator’s Workbench 1.x confirms the
exclusive open with a corresponding message in its status bar.

3. From the File menu, choose Export. The Export dialog opens.

4. Since you want to export the entire Translation Memory, you can confirm the standard
Export settings with OK. The Create Export File dialog opens.

5. Choose a drive and folder as convenient. Assign a file name to the export file, and confirm
g 1%
your settings with OK. Translator’s Workbench now exports all translation units of your
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Translation Memory to the specified text file. Depending on the size of the Translation
Memory, this may take a while.

6. Repeat the steps 2 through 5 for all Translation Memories that you want to continue using in
T'ranslator’s Workbench version 2.x.

7. You are now ready to import the exported text files into Translation Memories created with
the new version.

Important

We strongly recommend you to keep backups of the text files exported from Translator’s
Workbench 1.x for future reference.

2.3.2 Importing 1.x Export Files into Translation Memories Created with Version 2.x

Follow these steps to import the export text files created above into new Translation Memories
created with T'ranslator’s Workbench version 2.x:

1. Start Translator’s Workbench 2.x.

2. If you have not already created a Translation Memory, do so now. You achieve this via the
New command from the File menu. Make sure to choose the same language direction and
system fields as in your old Translation Memory. Otherwise the 1.x export file will not be
imported correctly, or some information may be missing after the import. Enter a name,
copyright information and description for your new Translation Memory as convenient. For
more information on how to define the basic setup of a Translation Memory, see the section
“Creating a T'ranslation Memory” in the “Translation Memory” chapter.

3. Once you have defined the settings for your new Translation Memory, click the Create
button. The Create Translation Memory dialog opens. Choose a drive and folder as
convenient. Assign a file name to your new Translation Memory, and confirm with OK.
Translator’s Workbench will now save the new T'ranslation Memory and create all associated
files.

4. You are now ready to start the import. For this purpose, from the File menu, choose Import.
The Import dialog opens. It’s best to accept the default import settings, since this makes
sure that any text and attribute fields from the import file will automatically be added to
your new Translation Memory. Confirm with OK. The Open Import File dialog opens.

5. Locate the drive and folder where you created the 1.x export file as described under 2.3.1
above. Once you have found the file, double-click its filename to start the import.

6. 'Translator’'s Workbench will now import the file exported from your old Translation
Memory, thereby taking over all information into the new one. Depending on the size of the
import file, this may take a while.

7. Repeat this procedure for each 1.x export file. Create as many Translation Memories as
required and convenient. You can also merge several 1.x export files into one Translation
Memory. For more information on import and merging, see the “Importing and Exporting
Translation Memories” chapter.

Important

We strongly recommend you to make regular backup exports of T'ranslation Memories you use
in Translator’'s Workbench 2.x. The procedure is described in the “Importing and Exporting
Translation Memories” chapter under the heading of “Using the Export Function to Create a
Backup.”
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2.4 Preparing Your Word Processor for Interaction with Translator's Workbench

One of the many unique features of Translator’s Workbench is that you do not have to leave
your word processor in order to fully explore the functionality of the program while translating
documents. You can stay inside your word processor and access Translator’s Workbench via the
program’s toolbar and special shortcut keys. Currently, Translator’'s Workbench supports
Microsoft Word for Windows versions 6.0, 7.0 (Office 95), and 97 (sometimes also referred to as
Word 8.0). We will refer to all versions as “Word” for short unless there are differences between
them.

While you can translate tagged file formats such as SGML/HTML, STF (as produced by The S-
Tagger for 2.0 for FrameMaker and Interleaf) etc. in Word, we recommend using TagEditor
since it features many specialised functions for tagged formats (tag protection and verification,
among many others).

2.4.1 Automatic Installation of the Workbench Interface

As described above, the Setup program tries to determine which word processor you are using
and where its startup folder is located. If it can find a valid folder, it will copy its interface files
there. The next time you start your word processor, the Workbench interface will then also be
started automatically. If, however, the Setup program cannot find a valid path, please read
through the following sections. They describe how to manually prepare your word processor for
use with Translator’s Workbench. If you intend to use Translator’'s Workbench only with
TagEditor, T-Window for PowerPoint or other Translator’s Workbench integration solutions,
you can ignore the following sections.

2.4.2 Preparing Word 97 (Word 8.0)

Notes

*  You only need to go through the procedures described below if the Setup program failed
to copy the Workbench interface file to Word’s startup folder, or if you are installing the
Workbench on a network and are currently preparing each local PC for use with
T'ranslator’s Workbench.

e We strongly recommend you to use Translator’s Workbench in conjunction with one of the
two available service releases of Word 97, commonly referred to as SR-1 and SR-2. These
releases are much more robust than the original version of Word 97.

The communication between Translator’s Workbench and Word 97 is performed via a Word 97
document template that has been specially developed by *"TRADOS for smooth integration.
This template is copied to Translator’s Workbench’s program directory (\ Program
Fi | es\ TRADOS\ TWAW n by default) during installation and is labelled TWAW n97. dot . To
make the template easily available in Word, we recommend you to copy it from Workbench’s
program directory to the template subdirectory of Word (\ MSOF fi ce\ OF f i ce\ Tenpl at es by
default). After copying the file, you need to change a few things in Word itself.

Installing the Workbench Interface for Word 97

In order to prepare Word 97 for the communication with Translator’s Workbench, you must
integrate the document template TWAW n97. dot that we have copied to Word’s template
directory in the previous section. Follow these steps:

1. Start Word, if it is not already running.

2. In Word, from the Tools menu, select Templates and Add-Ins. The Templates and Add-ins
dialog opens.
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3. Here you can specify templates as “Global Templates” and “Add-ins.” You can use this
template list to add the Workbench template TWAW n97. dot as a “global template” to the
standard Word template Nor mal . dot . To achieve this, click the Add... button. The Add
Template dialog opens, listing all templates available in Word’s template directory
(MBOFfice\Ofice\ Tenpl at es by default).

4. If you have copied the TWAW n97. dot file into this template directory as described above,
you can now select it. (Otherwise, you can browse to Workbench’s installation directory and
select it from there.) Confirm with OK. Word adds TWAW n97. dot to the list of global

templates and activates it.

5. Click OK again to confirm these settings. You are returned to Word’s standard program
window, where a new toolbar and a new menu called Trados are added to Word’s standard
toolbar section and menu bar. You can move the toolbar around as convenient. Please refer
to the Word documentation for more information on toolbars. Both the toolbar and Trados
menu will be explained in the “Getting Started” and “Interface With Your Word Processor”
chapters.

6. Note that after each new start of Word, you will have to re-activate the template
TWIW n97. dot. You achieve this by choosing Templates and Add-Ins from the Tools
menu in Word and checking the item TWAW n97. dot on the Global Templates list. This
will then once more give you Translator’s Workbench’s toolbar and menu. If you want these
items to appear automatically each time you start Word, follow the instructions coming next.

Permanently Adding the Document Template TW4Win97.dot to Word’s Global
Templates

If you want the Translator’s Workbench template to be active whenever you start Word 97, you
can copy the TWAW n97. dot file to Word’s start-up directory (MBOF fi ce\Of fi ce\ Startup
by default). In this case, the template is automatically attached as a global template, so you do
not need to attach it manually as described above. You can deactivate the template temporarily
by selecting Templates and Add-Ins from the Tools menu and clearing the check box next to
TWIW n97. dot . To permanently deactivate the template, delete the TWAW n97. dot file from
the start-up directory and re-start Word.

2.4.3 Manually Preparing Word 6.0 and 7.0 (Office 95)

Note

You only need to go through the procedures described below if the Setup program failed to
copy the Workbench interface file to Word’s startup folder, or if you are installing the
Workbench on a network and are currently preparing each local PC for use with Translator’s
Workbench.

The communication between Translator’s Workbench and Word 6.0/7.0 is performed via a Word
document template that has been specially developed by *"TRADOS for smooth integration.
This template is copied to Translator’s Workbench’s program directory (\ Program
Fi | es\ TRADOS\ TWAW n by default) during installation and is labelled TWAW n. dot. To
make the template easily available in Word, we recommend you to copy it from Workbench’s
program directory to the template subdirectory of Word (\ W nwor d\ Tenpl ates or
\MsOX fi ce\ Tenpl at es by default). After copying the file, you need to change a few things in
Word itself.
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Installing the Workbench Interface for Word 6.0/7.0

In order to prepare Word 6.0/7.0 for the communication with Translator’'s Workbench, you must
integrate the document template TWAW n. dot that we have copied to Word’s template
directory in the previous section. Follow these steps:

1. Start Word, if it is not already running.
2. In Word, from the File menu, select Templates. The Templates and Add-ins dialog opens.

3. Here you can specify templates as “Global Templates” and “Add-ins.” You can use this
template list to add the Workbench template TWIW n. dot as a “global template” to the
standard Word template Nor mal . dot . To achieve this, click the Add... button. The Add
Template dialog opens, listing all templates available in Word’s template directory
(\ W nwor d\ Tenpl at es or \ MsOF fi ce\ Tenpl at es by default).

4. If you have copied the TWAW n. dot file into this template directory as described above,
you can now select it. (Otherwise, you can browse to Workbench’s installation directory and
select it from there.) Confirm with OK. Word adds TWAW n. dot to the list of global
templates and activates it.

5. Click OK again to confirm these settings. You are returned to Word’s standard program
window, where a new toolbar and a new menu called Trados are added to Word’s standard
toolbar section and menu bar. You can move the toolbar around as convenient. Please refer
to the Word documentation for more information on toolbars. Both the toolbar and Trados
menu will be explained in the “Getting Started” and “Interface With Your Word Processor”
chapters.

6. Note that after each new start of Word, you will have to re-activate the template
TWIW n. dot . You achieve this by choosing Templates... from the File menu in Word and
checking the item TWAW n. dot on the Global Templates list. This will then once more
give you Translator’'s Workbench’s toolbar and menu. If you want these items to appear
automatically each time you start Word, follow the instructions coming next.

Permanently Adding the Document Template TW4Win.dot to Word’s Global Templates

If you want the Translator’s Workbench template to be active whenever you start Word 6.0/7.0,
you can copy the TWAW n. dot file to Word’s start-up directory (\ W nwor d\ St art up by
default). In this case, the template is automatically attached as a global template, so you do not
need to attach it manually as described above. You can deactivate the template temporarily by
selecting Templates from the File menu and clearing the check box next to TWAW n. dot . To
permanently deactivate the template, delete the TWAW n. dot file from the start-up directory
and re-start Word.

2.4.4 Support for WordPerfect 6.1 Discontinued

Translator’s Workbench 2.x no longer supports WordPerfect 6.1. However, there is a special
version of Translator’'s Workbench 1.x on our Web site that works with both the old Workbench
1.x dongle and the new dongle shipped with Translator’'s Workbench 2.x. So you can keep
working with Workbench 1.x for WordPerfect 6.1 projects even if you “only” have the new
Workbench 2.x dongle. Exchanging translation memories between the two versions is possible.
Corresponding procedures are described in the “Importing and Exporting Translation
Memories” chapter.
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Now that you have installed Translator’'s Workbench and TagEditor on your PC and prepared
your word processor, let’s take a look at some of the features that have been implemented into
the programs. We suggest that you try the functions on your PC as you read the chapter.

This chapter is in two main parts:

e first, we will describe how to use Translator’s Workbench from within Word;

e second, we will discuss how to translate tagged file formats (SGML/HTML, STF as
produced by The S-Tagger for FrameMaker and Interleaf, etc.) with Translator’s
Workbench and TagEditor.

Please be sure to follow both sections carefully to get a full overview of the capabilities of
T'ranslator’s Workbench.

3.1 Getting Started With Translator's Workbench and Microsoft Word

In this section, you will learn how to use the interface between Translator’s Workbench and
Microsoft Word.

3.1.1 Starting the Programs, Opening the Demo Files, Adapting Your Environment

In the Installation section, you have seen how a program group and icon for Translator’s
Workbench have been created. You can now start the program just like any other Windows
application by clicking on its program icon via the Start — Programs menu. By default, the
T'ranslator’s Workbench program icon is located in the Trados fine translation tools program
group. Clicking this icon will load Translator’s Workbench and open its main program window.

After starting Translator’s Workbench, start MultiTerm 95 Plus! (we’ll refer to it as
“MultiTerm” throughout the manual). If you have not installed this program, you should do it
now. To do this, please refer to the Installation section in the MultiTerm User’s Guide.

Once you are in MultiTerm, please open the demonstration terminology database shipped with
Translator’s Workbench, Tr ados. nt w. You will find this database in Translator’s Workbench’s
program directory (\ Program Fi | es\ TRADOS\ TWIW n by default). In order for Translator’s
Workbench to correctly work with MultiTerm databases, they must be available in “fuzzy
format.” So, before Translator’s Workbench can access the data stored in MultiTerm, you must
create a fuzzy index from the database. T'o achieve this, choose the command Create Fuzzy
Index from the File menu in MultiTerm. MultiTerm now works through the database and
creates fuzzy images of all its terms in all languages, adding them to a neural network which is
created in addition to your database. For this reason, please make sure that you have enough
space on your hard disk before starting this process. A message in the status bar confirms that
MultiTerm is currently busy creating a fuzzy index. Depending on the speed of your hardware,
this may take up to a few minutes. You should by all means wait until MultiTerm has finished
creating the fuzzy index; otherwise, the neural network may be incomplete or even damaged. A
message appears in the status bar after the fuzzy index has been created successfully. Note that
you don’t have to do this every time you use Translator’s Workbench, but only after you have
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made changes to the entries in MultiTerm. Please refer to the “Interface with MultiTerm ’95”
chapter or to the MultiTerm User’s Guide for more information.

Now we’re almost there. The only thing left to do is start your word processor and open the
demonstration document shipped with Translator’s Workbench, namely a document called
Deno. doc. You will find this file in Translator’s Workbench’s directory that was created during
installation (\ Program Fi | es\ TRADOS\ TWAW n by default). Thus, after starting your word
processor, choose the Open item from the File menu. Then choose Translator’'s Workbench’s
program directory and open the demonstration document Denp. doc. Once you’ve opened this
document, save it under a new name, for example Denp_g. doc, to indicate that it will be the
German version of the English original. Please make also sure that you have installed and
activated the Workbench interface files TWAW n. dot (Word 6.0/7.0) or TWAW n97. dot
respectively, as explained under the heading “Preparing Your Word Processor for Interaction
with Translator’s Workbench” above.

Recapitulation

You should now have three programs running:

e Translator’s Workbench

e MultiTerm ’95 Plus with the fuzzy-indexed demonstration database Tr ados. m w. Please
make sure that English is selected as source language and German as target language. This is
crucial for Translator’s Workbench’s terminology recognition feature described further
down. After setting this language direction in MultiT'erm, we suggest that you minimise its
program window.

e Your word processor with the copy of the demonstration document Deno_g. doc and the
template add-in TWAW n. dot (Word 6.0/7.0) or TWAW n97. dot (Word 97). We suggest
that you arrange Translator’'s Workbench and your word processor’s program windows in
such a way that you can see both on your screen at the same time as depicted in the screen
shot below. This arrangement of program windows is important for what follows.
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The Translator's Workbench, the leading, well-established, integrated software workstation for
translators by TRADCS, is now available as a proper 32-bit application for Windows 95 and NT.
The TRADOS developers have not only refined the proven features of the 16-bit Workbench—
translation memory with neural network technology, fuzzy matching, active terminology
recognition, concordance searching, word processor integration etc —but have also added
many innovative new functions:

Minimized MultiTerm with | |, Fy|l support for Word 97, Translator's Workbench 2 is directly integrated into Word 97, and

fuzzy-indexed database the Workbench functions make full use of the VBA programming language. OF course
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Figure 3-1: Arranging Program Windows (here with Word 97)

||

If your screen looks roughly like this, we're ready to take a look at Translator’s Workbench’s
main features.

3.1.2 Opening a Translation Memory (TM)

To open a Translation Memory (TM), select the Open command from the File menu of
Translator’s Workbench.

Entering Your User ID

If you have not entered any user ID up to this moment, you will be asked to do it now.
Translator’s Workbench must know your ID before opening a Translation Memory for the first
time. The program will remember this ID when you exit the program, so you won’t be asked to
enter it again.

Ok
Enter your Uzerid:

[BROCKMANN] izl

Help

il

Figure 3-2: The Userid Dialog

In the Userid dialog, enter your user ID, for example “Miller” or “Smith.” From now on, each
newly created or changed translation unit will get this ID.
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Opening the Demonstration TM

After entering your user ID, the Open Translation Memory dialog box appears on the screen. In

the list of available TMs, select Denp. t mwand click OK.

Open Translation Memory EHE

Translation unit
information fields

Match selection
buttons (allow you to
choose among different
fuzzy matches)

Status bar

Laak in: |-E|TW4Win j ﬁl I_
1 Dongle

£ | Lng

File name: IDemD.tmw

Open

Files of type: ITransI. bl ernary [* trw)

[T Exclusive

j Cancel

Help

Pl

Figure 3-3: Opening a Translation Memory

Translator’s Workbench will now open the demonstration TM. A message appears in the
program’s status bar confirming that the TM Denp. t nw has been opened.

Before we describe the program’s features, let’s take a look at the various parts of Translator’s
Workbench’s program window. After opening the demonstration TM, the window looks like

this:

Source window (displays
sentences to be translated)

£IZ TRADODS Translator's Workbench - Demo

File \Settings  Wiew Options Took Help

Terminology window (displays
terminology found in the MultiTerm
database)

Created an;
Created by:
Changed o
Changed by:

SR

|Tr@ati0n kemary C:A\Program FileshTradosh

WaWIRAD emo.tmw iz open.

=

Translation Memory (TM) window
(displays sentence matches from
TM and, optionally, their target-
language equivalents)

Language direction of the
current TM Deno. t mn
English (UK) -> German
(Germany)

Figure 3-4: Translator’s Workbench’s Different Program Window Areas

As we go along this chapter, you will get to know all of these different areas. You will see how
the different windows will be filled with information from your word processor, the Translation
Memory Deno. t nw, and the MultiTerm demonstration database Tr ados. nt w.
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3.1.3 Using Translation Memory Mode

Most of the time, you will use Translator’s Workbench in its Translation Memory mode, TM
mode for short. When you are not in TM mode, you can use your word processor to page through
and edit your text. In TM mode, on the other hand, you translate a text by going through it
segment by segment. Such a segment usually is a sentence.

Let’s try this out on a first example. Activate your word processor’s program window, and move
the cursor to the beginning of the paragraph starting with the sentence Whiar exactly is a
Translation Memory (TM)? Move the cursor somewhere inside this sentence.

You can now start TM mode either by clicking on the Open Get (i) symbol of the Translator’s
Workbench toolbar or by pressing the key combination [Alt] + [Home]. As its name indicates,
the “Open Get” function opens a new translation unit and tries to get, i.e. find, a perfect or
fuzzy match for the current sentence to be translated in its TM. To achieve this, your word
processor performs two steps:

1. It highlights the source sentence and places a blue field around it.

2. It passes the source sentence on to Translator’s Workbench. Translator’'s Workbench will
take the sentence and check it in several respects:

e Is the sentence similar to or exactly the same as a sentence already stored in TM? If yes,
who created the corresponding translation unit and when? Is there any further
information on the translation unit stored in the TM database?

e Are there any known terms in the sentence, that is, are there any terms that are similar
to or the same as terms stored in the MultiTerm database Tr ados. nt w?

*  Are there any other elements such as acronyms, numbers, dates that might stay the same
in the translation?

The result of this brief analysis is displayed in the various windows of Translator’s Workbench.
You will get the following screen:

TRADODS Tranzlator's Workbench - Demo

File Settings Wiew Options Toolz Help

Chianged an: [0/12/37. 00:00 | B wwhat exactly is a translation memary (Th)? @ Translation Memory
Bzzgg?d by: 15M|TH Ubersetungsspeicher o

Translation Memory »

What precisely is a translation mernory (Th)?

™= /a5 hat man sich unter einem Translation Memory
(Thf) genau worzustellen?

< |90z | > 74z |

|9IJ‘Z Fuzzy Match

=B hfatch 1 of 2
Figure 3-5: Translator’s Workbench’s Program Window After a Fuzzy Match

The Source and Translation Memory Windows

In the Source window, you can see the sentence as it was transferred from your word processor to
T'ranslator’s Workbench, symbolised by the icon of your word processor (Word 97 in the above
example). In the Translation Memory window below the Source window, Translator’s
Workbench displays an English-German translation unit from the Translation Memory
Deno. t mv. In the lower left corner of the program window, Translator’'s Workbench informs us
that the English sentence from TM bears a certain similarity to the one to be translated: we are
looking at a 90% match.
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In the left part of the window, Translator’s Workbench tells us that the translation unit from
T'ranslation Memory has been last changed by a certain Mr. Smith on 01 December 1997, and
that the unit has been used once in translations since its creation (Usage = 1).

Note

To display the date and time in such fields as Changed On in the above example, Translator’s
Workbench uses the same format as specified in your Windows environment. You can change
these settings via Start - Settings - Control Panel - Regional Settings - Time and/or Date.

Active Terminology Recognition

Second, our sentence has been analysed as to whether there is any known terminology in it. This
feature is referred to as “active terminology recognition.” A terminology management system
like MultiTerm offers quick and easy access to terminology. The slight disadvantage is, though,
that the user still has to initiate the search for a term. Not so in Translator’s Workbench: it
performs this task for you by automatically looking for known terms in the sentence to be
translated and interactively telling you that the terms are known. It marks them with a red
bracketed line and displays their translation in the Terminology Window at the right-hand side,
symbolised by a dictionary with the EU flag on it. In our example, it found an entry for
Translation Memory in the terminology database Tr ados. nt w and immediately displayed its
translations Ubersetzungsspeicher and Translation Memory in the Terminology window, together
with gender information.

Keep in mind that terminology recognition also works with a fuzzy-matching algorithm. This
means that terms in your sentence are found even if they don’t occur in the same form in the
terminology database. Further down, we will give you examples on this.

Active Recognition of Variable Elements (Acronyms, Numbers, Dates, etc.)

Last but not least, our sentence has been analysed as to whether there are any variable elements
in it. “Variable elements” are items which, typically, do not change in the translation, such as
numbers, dates, time specifications, acronyms, etc. In most cases, you simply place these
elements unchanged somewhere in your translated sentence. In our example, Translator’s
Workbench found the acronym 7M to be such an element. You recognise this by the blue
bracket that underlines it. Let’s not go into too much detail on this now. Below, under the
heading of “Working With Non-Translatable Elements”, you will find more examples on this
feature.

Choosing Among Different Matches

After having found out all these different bits of information, Translator’s Workbench passes the
German translation of the TM sentence back to your word processor. Remember that you can
still see the original English sentence in the blue field. Now, the 90% match German equivalent
from Translation Memory, Was hat man sich wunter einem Translation Memory (TM) genau
vorzustellen?, is inserted into a yellow editing field beneath the source field. This yellow field is
also referred to as “target field.” So, to recapitulate, you’ll see the English original in the blue
and the 90% match German equivalent in the yellow editing field as follows:
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Main scgment start TFuzzy match value (in our Blue source ficld
marker example, 90%)

What-exa tsa-translation-memory - (TM) 7

Wast ich-unter-einem Translation- Memory-(TM) genau-vorzustellen?
A

x Main segment end Sourceftarget delimiter Yellow target field
marker marks

Figure 3-6: Your Document After a Fuzzy Match

In your word processor, you have several possibilities to view non-textual data, such as carriage
returns. For example, it might be that you don’t see the delimiting marks inserted by
Translator’s Workbench into the document, ;o> and g}, or the match value between the current
source segment and its counterpart from Translation Memory (in our example, 90). Or it might
be that you don’t see the carriage return characters (). In this case, you can customise your
word processor to display these items. Follow one of these procedures:

e Click on the 4 button in Word’s standard toolbar. This will make visible both the carriage
returns and the delimiting tags.

* Alternatively, choose the Options item from Word’s Tools menu. In the dialog box that
follows, select the View tab as shown below:

Track Changes I User Information I Compatibility I File Locations
Yiew |General| Edit | Print I Save ISpeIIing&Grammar

Marrnal wiew options

Show
[ Draft Font [~ Bookmarks
[ Picture placeholders [ Field codes
v animaked bext Field shading:
[V ScreenTips W
[ Highlight

Monprinking characters
[ Tah characters [ optional hyphens

[~ Spaces [ Hidden text
[ Paragraph marks

Window
[V Status bar ¥ Harigontal scroll bar
Skyle area width: ¥ Vertical scroll bar
oem = [ wirap o window

[0]4 I Cancel |

Figure 3-7: The View tab in Word’s Options Dialog (here, Word 97)

Tick the All option in the Non-Printing Characters section, as depicted above, and click OK.
This will make all non-printing characters, including Translator’s Workbench’s delimiting
marks, visible.

Now let’s return to our above example. You could now simply accept the German translation
without editing it—after all, the difference between exactly and precisely is not too big. But let’s
suppose that you do not want to accept this translation as is. Instead, you would first of all like to
know what the other match (74%) looks like.
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"T'o achieve this, you can simply click on the > 74% button next to the 90% button in Translator’s
Workbench’s program window. The program will now tell you that the 74% match translation
unit from TM reads as follows:

What is meant by transiation memory (TM)? with the German equivalent Was versteht man unter
einem Translation Memory (TM)?

(The 90% match went: What exactly is a Translation Memory (TM)? with the German equivalent
Was hat man sich unter einem Translation Memory (TM) genau vorzustellen?)

As you can see, there are some changes in this sentence. For example, the adverb exact/y has
been left out in this sentence. Note that Translator’s Workbench highlights missing words in
grey. Note also the different information on the Changed By and Usage items in the translation
unit information fields. Now, if you would like to transfer the German equivalent of this slightly
changed sentence to the yellow editing field (= target field) in your word processor, you can click
the Get Translation button (*) in the Workbench toolbar. This function gets the current
translation from the 'T'M window and transfers it to the target field in your word processor, thus
replacing our 90% fuzzy-match translation with the 74% one.

Suppose you prefer this translation to the first one, so you would like to accept it and move on to
the next sentence. To achieve this, simply click on the Set Close Open Get button (&), This
function sets, i.e. accepts the translation in the target field, closes the corresponding translation
unit, moves on to the next sentence, opens the next translation unit, and tries to get a match
from TM for the next sentence. Let’s try this out—please click on the & button.

For the next sentence, Translator’s Workbench again finds a fuzzy match, this time a 95% one.
The only thing that has changed is that the TM sentence contains a word that our sentence does
not contain, namely the word /inguistic. Note that Translator’'s Workbench highlights such
inserted words in grey. Again, Translator’s Workbench displays the German equivalent of this
95% fuzzy match in its Translation Memory window and transfers it to the target field in your
word processor. The German translation reads as follows:

Ein TM ist eine linguistische Datenbank, die alle Ubersetzungen und ihre Originalsiitze aufnimmt, wihrend
Sie iiberserzen.

The German equivalent contains a translation of /inguistic, viz. linguistisch. You can now move to
the word /Jinguistisch in the yellow target field and delete it, if you like, since our English
sentence doesn’t contain the word /inguistic. After changing the German translation, we will now
temporarily leave TM mode and take a look at the other buttons available in the toolbar. To
achieve this, press the t] button, labelled Set Close. This function sets the changed translation,
i.e. adds a new translation unit to the TM with the English and German sentences that we have
just changed, and closes the translation unit after that.

Entering a New Translation

Done? Now let us move to the first sentence of the demo text, starting with 7ransiator’s
Workbench, the leading... and re-start TM mode by clicking on the & button to open a new
translation unit and try to get the best match from TM. This time, however, the sentence to be
translated is completely new. There was no similar sentence found in TM, so unfortunately
Translator’s Workbench cannot suggest a translation. However, at least the known terms are
marked with a red bracketed line; you don’t have to type the translations for these terms.

Pasting Translations of Known Terms

In your word processor, you will still see the English sentence to be translated into German in
the blue source field, but, logically, the target field is empty. Let us now find a German
translation for the English sentence, using active terminology recognition and a powerful feature
that has been integrated into Translator’s Workbench, referred to as the Concordance function.
More on that later, let’s start translating!
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The first known term shown to us by Translator’s Workbench in its Terminology window is the
German “translation” of the product name 7ranslator’s Workbench. It also shows us the gender
information for the German word, telling us that it is a feminine noun. As a consequence, we
know we have to type a Die into the yellow target field. You can now press the *# button in the
toolbar to paste the translation into the target field. Alternatively, you can choose the menu item
Get Current Term from the Trados menu or press the [Alt] + [V/] key combination. Our sentence
should now read Die Translator’s Workbench. Enter the translation for #he leading, well-established by
hand, for instance by typing die erfolgreiche, bewdlhrte.

Using the Concordance Function

Our translation should now read “Die Transiator’s Workbench, die erfolgreiche, bewdhrte.” Let us now
take a look at the Concordance function. Suppose that you know for sure that you have already
translated the word 7nfegrated in 'TM mode before, but you hadn’t added any entry to the current
MultiTerm database. As a consequence, Translator’s Workbench does not tell you that the term
is known. Still, there must be one or more English-German sentence pairs that contain the word,
and it would be nice to have a look at them. To cut a long story short, you would like to see all
English sentences from TM where you translated the word integrated, together with their
German equivalents. No problem: simply activate Translator’s Workbench’s program window
and mark the word /nzegrated in the Source window by double-clicking on it. Now press the right
mouse button. A context menu, sometimes also referred to as “popup menu,” will open
instantly. Choose the first item, Perform Concordance Search, from this menu. The following
window will open instantly:

ntegrated" [1 Hits)

5 .And, of course, TRADOS MuitiTerm for Windows Professiona has been integrated into the program, so
you don't have to warry about your existing terminology resources.

B g natirlich ist TRADOS MuwitiTerm fir Windows Professional in das Prograrmrm integriert - um lhren
bisherigen Terminologiebestand brauchen Sie sich also keine Sorgen zu machen.

Figure 3-8: The Concordance Window

This window shows you a sentence pair from TM where the word integrated in the English
sentence is highlighted in yellow. This window is called Concordance window. It always shows
you all sentences from TM where your search term appears. As you can see from the German
translation of this sentence, the equivalent of infegrated is integriert.

Using the Clipboard to Transfer Text from the Concordance Window to Target
Applications

Suppose you would like to transfer this translation to your word processor. To achieve this,
simply select the word inzegriert in the German sentence with your mouse, and again click the
right mouse button. This time, choose Copy to Clipboard from the context menu. This copies the
selection to the Windows Clipboard. You can now close the Concordance window by choosing
the Exit menu item from it’s system menu or by pressing the key combination [Alt] + [F4]. Now
go back to your word processor, and make sure the cursor is located at the end of the target field.
Now choose the Paste command from your word processor’s Edit menu. This pastes the word
integriert into the target field at the cursor position. Copying text this way works from any
window of Translator’s Workbench to any target application that allows the pasting of text.
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Note

You can also access the Concordance feature directly from within your word processor by
clicking the % button after selecting your search term. You can also open several Concordance
windows at a time, simply by selecting passages in the first Concordance window that interest
you, again clicking with the right mouse button and choosing Perform Concordance Search
from the context menu that follows. A new Concordance window will open instantly and show
you all sentence pairs where the previously marked selection occurs. And so on.

Let’s return to our above translation. You can now type the German translation of the bits in
between the known terms into the target field, adding Soffware-Losung fiir. Our sentence should
now read Die Translator’s Workbench, die erfolgreiche, bewdihrte, integrierte Software-Losung fiir. Again,
a known term appears, viz. franslators. You can paste the translation of this term into the target
field either by clicking on the = (Get Next Term) button, or by pressing the key combination
[Alt] + [2]. The = function browses forward through the known terms of the sentence to be
translated and pastes them into your document at the cursor position. The ¥ button or [Alt] +
[€] does the same thing, but browses backward through the known terms in your sentence.

Now try it yourself: translate the remainder of the sentence, using the terminology pasting
functions for the term Windows and the Concordance option for the words available and version.

In the end, our translation should read something like this:

Die Translator’s Workbench, die erfolgreiche, bewdihrte, integrierte Software-Lisung fiir Ubersetzer aus dem
Hause TRADOS, ist nun auch als echte 32-Bit-Anwendung fiir Windows 95/NT verfiighar.

You can now again press the #) button to add this new translation to TM and close the
corresponding translation unit and yellow editing field.

Working With Non-Translatable Elements

Non-Translatable Elements are elements which do not change in the translation. They can be
divided into two groups:

e graphics, fields, and other word-processor specific items

* numbers, dates, acronyms, and other word-processor independent items

Graphics, Fields, and other Word-Processor Specialities

In our next example, we will translate a small sentence containing a graphic and a page reference
field. This special functionality is available for the Word interface only. Translator’s Workbench
treats graphics and other non-translatable elements, such as most fields—for instance, the DATE
field which inserts the current date, or reference fields as in our example—as “placeable”
elements. In most cases, such elements will be left as they are in the target text. The only thing
that will change is their position within the translation. This is why they are referred to as
“placeables.” As this name indicates, it’s you who decides where to place them in your target
text as you translate.

Let’s go through an example to illustrate this. Place the cursor at the beginning of the sentence
starting on the last page of the demo text ([usert a disketre...). As you can see, it contains two
graphics: a floppy disk and a computer. Now let’s see what Translator’s Workbench does with
these. Re-start TM mode by clicking the & button once more to open a new translation unit and
try to get the best match from TM. Again, no match is found in Translation Memory. What’s
special about this sentence, though, is that once Translator’s Workbench has analysed it, you will
see that it displays special symbols in its Source window that represent the graphics and the page
reference contained in the English sentence.
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RADOS Translator's Workbench - Demo
File  Settingz Miew Options Toolz Help
EEangeg En: E Inzer a diskette into ane of your computer's disk
anged by: —_— fnir’
Usage: drives, as described on page {PAGEREF).
< |l | > |
|N0 match!

Figure 3-9: Sentence with Graphics and a Page Reference

As you can see, it underlines the graphic symbols as well as the page reference field with a blue
bracketed line. This line always tells you that Translator’s Workbench has found one or more
“placeable” element(s) in the sentence to be translated next. You can now start translating as
usual in the yellow target field, saying something like Legen Sie eine Diskette. Now you’re ready to
insert the first graphic—better: “placeable”—into your translation. In analogy to the terminology
buttons in the Translator’s Workbench toolbar, there are special buttons to transfer placeables
into your target text. Thus, to insert the currently highlighted placeable—which you recognise
by the bold blue bracketed line—, press the #% button in the toolbar. Note that the button also
has a blue bracketed line to indicate that it’s used to transfer placeables. (Alternatively, you can
also press the key combination [Alt] + [Ctrl] + [¥] or use the Get Current Placeable command
from the Trados menu.) As was to be expected, clicking the *% button copies the diskette
graphic into your translation.

Now go on translating until the next graphic placeable, saying something like in e¢ines der
Laufwerke Thres Computers, and click the =% button ([Alt] + [Ctrl] + [2]) to copy the next
placeable to your translation. Translator’'s Workbench automatically transfers the computer
graphic into the target field. After that, you can continue the translation by adding the separable
prefix ¢in to complete the verbal phrase of the main German sentence.

Continue translating until the next placeable—this time, the page reference field—for instance
by saying wie auf Seite. 'T'o insert the last placeable into the target field, again click the =% button.
"This will insert the page reference field. Finish the translation by adding the adjective beschrieben
as a translation of described. Your translation should now look as follows:

U
Legen Sie e¢ine Diskette \ ) in eines der Laufwerke lhres Computers
beschrieben.

ein, wie auf Seite 1

You can now again press the ! button to add this new translation to TM and close the
corresponding translation unit and yellow editing field. Please refer to the “Interface With Your
Word Processor” chapter for a complete description of all buttons.

Acronyms, Numbers, Dates, Time and Other Variable Elements

When analysing source sentences, Translator’s Workbench does not only identify normal words,
punctuation, graphics, and fields, but also many different types of so-called “variable elements.”
Such elements can be numbers, acronyms, but also dates, time, measurements or variable
elements that you specify (such as product names, names of cities, etc.). Typically, they do not
change in translation. To see how Translator’s Workbench handles such elements, in our next
example, we will translate a small sentence containing acronyms and numbers. In the demo
document, this example is found under the heading of “Acronyms and Numbers” and reads 77%e
DAX index hovered between 4,919.60 and 4,936.32 points.
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Re-start TM mode by clicking the & button once more. Again, no match is found in Translation
Memory. However, similar to the graphics and fields in our previous example, Translator’s
Workbench displays the acronyms and numbers as “placeable elements.”

RADOS Translator's Workbench - Demo

File  Settings Yiew Options Toolz Help

Changed or: B The DAY index hovered between 4 919,60 and 4 936,32
Changed by: St

Usage: points.

< |

|No matchl

[

Figure 3-10: Sentence with Acronyms and Numbers

Similar to the previous example, you can “place” the acronyms and numbers into the target
sentence as you translate, using the #% and =* buttons. With the acronym DAX, this is a
comparably trivial exercise. When transferring the numbers, however, Translator’s Workbench
not only places them into your translation, but also adapts the number format to the
requirements of the German language. The program replaces the English digit grouping symbol
(“,”) and decimal symbol (“.”) with their German counterparts, which have to appear exactly the
other way round. In a way, Translator’'s Workbench “localises” the numbers so that they appear
in their correct form as expected by a German reader. This is why this adapting process is also
referred to as “substitution localisation.” When finished, your translation should read something
like Der DAX-Index pendelte xwischen 4.919,60 und 4.936,32 Punkten.

Now, what happens if a sentence with the same wording but different acronyms and numbers
occurs? Let’s try this out. Confirm your sentence with &, Translator’s Workbench moves to the
next sentence, which reads 7he XETRA index hovered berween 3,687.80 and 3,699.48 points. As you
can see, all three variable elements of our previous example have changed. Despite these
changes, Translator’'s Workbench is still able to produce a 100% match and, what’s more,
automatically adapts the acronyms and numbers to fit the new translation:
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Figure 3-11: Getting 100% Matches Despite Changes in Variable Elements

To sum up, if only variable elements have changed in a new version of an already translated
document, Translator’s Workbench will be able to substitute and adapt them as required in the
new translation, without your having to do a single bit of extra work. You can imagine that this
will not only boost your productivity, especially in texts where many of these elements occur. It
will also help reduce the error rate when “translating” numbers, dates, time, measurements, and
the like.

What’s more, Translator’'s Workbench does not only adapt formats as shown in the above
examples, it can also convert measurements as appropriate. For example it can convert 7z¢k to cm
or °F to °C if you wish. For information and examples on this as well as all other substitution
types, see “Defining Automatic Substitutions” and “Defining Substitution ILocalisation
Settings” in the “Translation Memory” chapter. There are also a few more examples with
variable elements in the demo document for you to play around.

After completing the translation of the demo text or whenever you like, you can press the '+
button to add the last translation to TM and close the corresponding translation unit and yellow
editing field. Please refer to the “Interface With Your Word Processor” chapter for a complete
description of all buttons.

Switching the Dialog Language in Translator's Workbench

You can use Translator’s Workbench in different dialog languages. Follow these steps:

1.  From the Settings menu, choose Dialog Language. The Dialog Language dialog opens.

2. Choose the new language from the Select Language drop-down list. (The list of available
dialog languages is constantly expanded.)

3.  Click OK. From now on, Translator’s Workbench uses the new language for menus, dialogs,
messages, online Help, etc.
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3.2 Getting Started With Translator’'s Workbench and TagEditor

In this section, you will learn how to use the interface between Translator’s Workbench and
TagEditor. We suppose that you have worked through the previous section and are thus already
familiar with the interface between Translator’'s Workbench and Microsoft Word.

3.2.1 What Is a Tagged Format?

Tagged file formats play an increasingly important role in document authoring and translation.
For example, tags are used to define the structure and layout of Internet pages (HTML). The
“big brother” of HT'ML, the Standardised General Markup Language (SGML), is also more and
more frequently used for the structuring of complex documentation.

Besides these standardised markup languages, D'TP packages such as FrameMaker, Interleaf,
PageMaker, Ventura etc. produce exchange formats that allow further processing by third-party
applications such as Translator’s Workbench and TagEditor. However, these formats are often
not very translation-friendly and difficult to handle. That’s why "TRADOS offers special
applications that convert these formats into a Translator’s Workbench-compatible, easy-to-
translate tagged format. In this documentation, all types of these tagged 'Translator’s
Workbench-compatible formats are referred to as “Workbench RTF.”

In this Getting Started section, we will show you how to translate a HT'ML document.

Notes

e All tagged formats (SGML, HTML, and Workbench RTF) can be edited and translated
using Translator’s Workbench and TagEditor. For a complete list of supported formats,
the applications you use to convert them, and the translation workflow involved, see the
chapter “Translating Tagged Files With Translator’s Workbench and TagEditor.”

¢ Workbench RTF files can be translated using either "TRADOS TagEditor or Microsoft
Word. We recommend using TagEditor since it features many specialised functions for
tagged formats not available in Word (tag protection and verification, among many others).

*  For “normal” Word documents or RTF-based online Help files, use Word. TagEditor on/y
supports Workbench RTF files.

3.2.2 Starting the Programs, Opening the Demo Files, Adapting Your Environment

In the previous section, you have seen how to start Translator’s Workbench, MultiTerm, and
Microsoft Word and open the demo documents and databases. For the purpose of this Getting
Started section, make the following preparations:

1. Close Microsoft Word, if it is still running.

2. Start Translator’s Workbench, if it is no longer running. Once you are in Translator’s
Workbench, open the demonstration TM Denp. t nw (it should in fact be re-opened
automatically from the previous examples).

3. Start MultiTerm, if is no longer running. Once you are in MultiTerm, open the
demonstration terminology database shipped with Translator’s Workbench, Tr ados. nt w
(it should in fact be re-opened automatically from the previous examples). If you have not
already done so, create a fuzzy index for this database now. The procedure is described in
the “Getting Started with Translator’s Workbench and Microsoft Word” section above.

4. Start TagEditor. Once you are in TagEditor, open the HTML demonstration document
shipped with TagEditor, a document called Deno. ht m You will find this file in the
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TEDenp subfolder under ‘Translator’s Workbench’s installation folder (\ Program
Fi | es\ TRADOS\ TWAW n\ TEDeno by default).

Laak jr: 5 TEDemo j gl e
rY

Desktop
| Images ﬁ by Computer
= 3% Floppy &) b
a2 Ms-dos_B ()
(2 Program Files
23 Trados
(3 Twdwin

@ Drerno. b

Files of type: IHTML Documents [* kini* kel j Cancel |

™ Open as read-only

Figure 3-12: Opening the Demo HTML Document in TagEditor

Recapitulation

You should now have three programs running:

e Translator’s Workbench with the opened demonstration TM Deno. t mw

*  TagEditor with the opened demonstration HTML document Denp. ht m We suggest that
you arrange Translator’s Workbench and TagEditor’s program windows in such a way that
you can see both on your screen at the same time (similar to what you did with Word in the
previous section). This arrangement of program windows is important for what follows.

¢ MultiTerm ’95 Plus with the fuzzy-indexed demonstration database Tr ados. nt w. Please
make sure that English is selected as source language and German as target language (same

as in the previous examples). After setting this language direction in MultiTerm, we suggest
that you minimise its program window.

TRADOS Translator's Workbench - Demo

File Settings Wiew Options Toals Help

Changed on:
Changed by
Usage:

#2 "TRADDS TagE ditor - [Demo.htm] M= B
Fle Edt Wiew Workberch Tooks Window Help R

SHE% E 8o elE v
IR

=S

Z]
TITLE > MultiTerm Web Interface (JITLE) <HEAD)

Mult\Term YWeb \merfaceg
B> | erminology Access over the Internet/Intranet gz

[E>(IM5) Have youg) ever wished you could produce a company dictionary, easily accessible at all times by all your
colleagues? Mow you can - with MultiTerm ¥web Interface, the @TRADOS@ product for terminology access over the

Internet. Just put your Company Dictionary on the Intemet / Intranet so that everyone in your company can access it - wherever
hey are based, anywhere in the world. On-line, of course 3

General Infurma(iun

@Why Terminology? Because crystal clear communications with custorers - and also in-house - are \mal.@

Crealing & Distributing Terminnlngy

@The MultiTerm Web Interface is the ideal complement for MultiTerm 95 Plusl. You create and manage your terminology with

MultiTerm 95 Plus!, and use the YWeb Interface to make it accessible over the Intemet or Imranel.@ LI
[# Edt [E> Source | (1) Target [ £7) Teut | @8 Prsvisw ]
Far Help, press F1 ’_I_I_’_ i

Figure 3-13: Arranging the Windows of TagEditor and Translator’s Workbench
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3.2.3 AFirst Glance at a Tagged File in TagEditor

Activate TagEditor’s program window. Before we actually start translating a few sentences, let’s
first take a look at the demonstration HI'ML document that we have just opened. What we see
in front of us is a typical example of an HTML file. In fact, it’s a slightly modified version of a
(bigger) HTML document found on our Web site at ht t p: / / www. t r ados. com muwi .

Different Types of Tags

The HTML tags are certainly the most striking feature in the file. There are several types of
tags in the demo document. For our purpose, let’s just make a few very important, basic
distinctions:

e External vs. Internal tags: All tags have either a black border (for instance, the tag
right at the beginning) or a red border (for instance, the and tags). Tags with a bdlack
border are referred to as external tags. They typically represent structural information, are
completely ignored during translation and can only appear owsside sentences (hence the
name “external”). Tags with a red border are referred to as internal tags. They represent
formatting information, surround hyperlinks or other markers etc., and may appear inside the
text (hence the name “internal”). Most internal tags can be moved around within the
sentence to suit the translation. Some can be added or deleted as required. You will learn
more about this later.

*  Opening and Closing Tags vs. Standalone Tags: Most of the tags that you will
encounter give instructions by first placing an opening tag. The opening tag is then followed
by text and, in some cases, more tags. The instruction invoked by the opening tag must then
be revoked by inserting the closing tag. A typical example of such tag pairs are HIME> <HIML),
and ‘B). Standalone tags, as their name suggests, do not occur in pairs. You can easily
recognise them since they don’t have “sharp” edges. An example of standalone tags are the
image tags in the demo document.

*  Translatable Text Within Tags: When translating a tagged file format, no text inside any
of the tags may be changed. However, sometimes there is text inside a tag that requires
translation. In this case, TagEditor will display the tag in three parts. The text to be
translated appears as normal text and the parts of the tag that surround it will appear as
interconnected parts. For example, in the demo document we have just opened, the text

“MultiTerm Web Interface” in the “IMG” tag displays as [IME _ALT= MultiTerm Web Interface )]

As you can see, this text is the value for the “AL'T” attribute, and contains the text that is
shown in place of the image if the image is not shown. Thus it needs to be translated.

Protected Tags

By default, TagEditor protects all tags in any document to make sure they stay in place during
translation. You can test this: for instance, place the cursor after any tag and press the
[Backspace] key. The tag is not deleted and stays in place. Or select a tag with your mouse and
press the [Del] key: same result.

Sometimes, it may be necessary to temporarily deactivate tag protection to be able to delete tags
or move them around to suit the translation. Tag protection can be switched on and off via the
Tag Protection command from the Edit menu (or the & button in the TagEditor toolbar). For
more information, see the chapter “Working With Tag Protection and Verification” in the
TagEditor online Help.

Semi-WYSIWYG View

"TRADOS TagEditor is all about making the translation of tagged text much easier and more
ergonomic than ever before. In this spirit, instead of just showing you text and (protected) tags
which you then translate, TagEditor can “map” tags to formatting to allow a more WYSIWYG
view at the document. For example, a heading in HTML is usually surrounded by Heading tags
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(H1, H2 etc.). In the HTML file we have just opened, there is an example of a second-level
heading (“Terminology Access over the Internet/Intranet”). Instead of just displaying the
heading tags and text as is, TagEditor changes the appearance of the text between the Heading
tags, so that it displays in a bigger font than the rest of the document. This makes navigating and
orientation in the file of course much easier.

Now that we have taken a first look at the file, let’s start translating it. You will see that using
Translator’s Workbench from within TagEditor is very similar to using it from within Word.

3.2.4 Using Translation Memory Mode

Let’s try this out on a first example. Activate TagEditor’s program window, and move the cursor
to the beginning of the heading “Terminology Access over the Internet.”

Click the Open Get () symbol of the Translator’s Workbench toolbar, or press the key
combination [Alt] + [Home]. As we have seen above, the “Open Get” function opens a new
translation unit and tries to get, i.e. find, a perfect or fuzzy match for the current sentence in the
TM and looks for known terminology in MultiTerm.

The result of this brief analysis is again displayed in the various windows of Translator’s
Workbench. You will get the following screen:

EE; TRADOS Translator's Workbench - Demo

File Settingz View Options Tools Help

e b St | & Terminology Access over the @ terminology

i Terminologie ¢
u : 2
S8 Internet-

Terminology Access over the Internet

== Terminologieabfrage Uber das Internet

S

|84Z Fuzzy Match

™= Match1af1
Figure 3-14: Translator’s Workbench’s Program Window After a Fuzzy Match

First of all, it is important to note that the heading tags (“P” and “H2”) have been completely
left out of the opened translation unit although they surround it. TagEditor does this on purpose:
As mentioned above, tags with a black border are “external” to the translation process and can
thus be ignored completely.

Second, similar to the examples given in the Getting Started section on the Word interface,
Translator’s Workbench informs us that the English sentence from TM bears a certain similarity
to the one to be translated: This time, we are looking at a 84% fuzzy match. In the left part of
the window, Translator’s Workbench tells us that the translation unit from Translation Memory
has been last changed by a certain Mr. Smith on 07 March 1999, and that the unit has been used
twice in translations since its creation (Usage = 2).

Third, our sentence has been analysed for known terminology. In our example, Translator’s
Workbench found entries for serminology and access in the Tr ados. nt w database. As seen before,
the program marks these known terms with a red bracketed line and displays the first of them in
the Terminology window.

You will now want to adapt the German translation, adding something like /Intraner. This already
completes our translation of the first sentence in TagEditor! Let’s confirm the translation with
the by now well-known &) button.
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A Perfect Match With Tags...

The next sentence has been translated exactly as is before, so Translator’s Workbench gives us a
100% match, inserting the translation into a green target field. Let’s take a closer look at the tags
in it. We see two tags with a red border, viz. the tag pair and “B). In HTML, “B” stands for
“bold”, hence the bold formatting of the text between the starting and ending tag—again, the
semi-WYSIWYG effect.

Note

Note that all formatting shown in TagEditor is just on the surface, it’s just “display”. Unlike in
Word, any formatting in the text is zof transferred to Translator’s Workbench and will #oz be
reflected in the TM. The tags, however, will be. So what ends up in 'TM is pure text with
tags—as it should be when dealing with SGML and HTML.

The formatting information is just there to make your life easier when you translate tagged
documents. Incidentally, that’s why there’s no formatting toolbar in TagEditor. There is
nothing you could format ©. So don’t worry if you sometimes do not achieve the same
formatting in the target segment as in the source. As long as you transfer all internal tags from
the source to the translated segment, all is well. More on tags below.

Let’s confirm this sentence and move on to the third, last example: Confirm the 100% match
with &,

... and a Fuzzy Match With Tags

In this last example, we get a 90% fuzzy match. The only difference between the new sentence
and the one from TM are tags. The sentence in 'T'M doesn’t have tags, the new sentence does:
the word TRADOS is enclosed by opening and closing “A” (anchor) and “B” (bold) tags. Anchor
tags are used to link HTML pages with other pages or Internet addresses (also known as uniform
resource locators, URLs).

Displaying the Contents of Tags via “Tag Tips”

Anchor tags do not just consist of the “A”, but also of the URL they refer to. To see the full
URL in our example, move the mouse pointer over the tag and wait a small moment: a “tag tip”
appears, showing you the full contents of the “A” tag:

@TMDDS@ product for
I:H +& HREF="http:/ A tradog. com'"s |fr

Figure 3-15: Displaying a “Tag Tip”

You can always display the full contents of single tags via this special “tag tip” function. If you
want to permanently display the full contents of all tags, use the Full Tags command from the
View menu in TagEditor. This is especially useful for STF files as produced by The S-Tagger
for FrameMaker and Interleaf.

Transferring Tags from the Source to the Target Segment

The only thing we need to do in the German translation of this last example is copy the tags
from the source sentence to the target sentence. Translator’'s Workbench treats internal tags as
“placeables” in the same way as numbers, dates, and other variable elements whose treatment
we have already seen in the Getting Started with Word section. As a result, it underlines the tags
with blue bracketed lines.
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You can now move the cursor to the word 7RADOS in the target segment, and place the first two
tags by clicking the Get Current Placeable *% button. This inserts the opening “A” and “B” tags.
Then, place the cursor directly after the word 7RADOS and before the hyphen, and place the
closing tag pairs by clicking the Get Next Placeable = button twice. This inserts the closing “A”
and “B” tags. (The first time you click =%, you will note that the word TRADOS is transferred to
the target segment. This is because TRADOS is recognised as an acronym which is treated as a
placeable in the same way as tags).

Let’s confirm the last example and leave TM mode. You achieve this as usual via the *! button.

Note

After confirming any translation with internal tags, TagEditor can verify whether the tags have
been correctly transferred to the target segment. For more information, see the chapter
“Working With Tag Protection and Verification” in the TagEditor online Help.

3.2.5 Saving a Document in Bilingual Format

Now that we have put some effort into our first translations in TagEditor, let’s take a look at
what we have achieved so far. We have translated three segments. In a similar way to what we
have seen in the Getting Started with Word section, TagEditor holds the source and target
segments as so-called “translation units” in one and the same document. That’s what the @,
and <) delimiting tags are there for. These delimiting tags have exactly the same function
as the delimiting marks in Word: they identify the source segment, match value, and the target
segment.

Now let’s save our work. To achieve this, from the File menu, choose the Save (Bilingual)
command. As you can see from the name of this command, the file-saving functionality in
TagEditor is slightly different from what you know from other applications such as Word. What
does Save (Bilingual) mean exactly? As long as the document is “under translation”, that is, there
are source and target language segments in it, TagEditor will save it in a special bilingual format
and change the file name extension to Bl F (short for Bllingual Format). For example, if you
save a document called MyDoc. ht mfor the first time, it will be saved under a new name as
MyDoc. bi f. The bilingual format holds every information TagEditor and Translator’s
Workbench need to correctly identify source and target segments, delimiting tags, match values,
etc.

You may now certainly ask how you get the original file format back after you have completely
finished translating a HTML or other tagged file. Let’s hold this question back for a small
moment. First, let’s take a look at one of the most exciting features in TagEditor: previewing
HTML documents.

3.2.6 Previewing HTML Documents in TagEditor

You can preview any HI'ML document within TagEditor at any time to check how the file looks
in your browser. By default, TagEditor uses Internet Explorer 4 for previewing. To achieve this,
TagEditor does not need to launch Internet Explorer; instead, it opens an IE window wizhin the
main TagEditor application window.
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Important

This “direct” IE view is available for version 4.0 or later of Internet Explorer. If you use a
previous version of [E or another browser such as Netscape Navigator or Communicator, you
can specify that browser as an “external” viewer. For more information, see the keyword
“Preview command (View menu)” in the TagEditor online Help and the “Preparing
TagEditor for Handling HTML and SGML Files” section in the “Translating Tagged Files
With Translator’s Workbench and TagEditor” chapter.

What’s especially intriguing about the HTML preview feature is that you can choose between
previewing the source version, target version, or bilingual version of any document. That’s what
the Source, Target, Text, and Preview tabs below the active document window are there for.
Let’s play around with them a bit. Follow these steps:

1. Click the Source tab, followed by the Preview tab. You will now see the source version
exactly as it appears in Internet Explorer.

2. Click the Target tab, followed by the Preview tab. You will now see the target version
exactly as it appears in Internet Explorer.

3. Now click the Edit tab, followed by the Preview tab, and hold your breath: TagEditor
displays both the source and target version in two Internet Explorer windows at the same

time!
#2 "TRADOS TagEditor - [Demo._htm] [_[O1x]
File Edit “iew “workbench Tool: Window Help 1= x|
= R A e s = |
0@ o= (@ e e =5 S|
MultiTerm Web Interface MultiTerm Web Interface
Terminology Access over the Terminologieabfrage iiber das
Internet/Intranet Internet/Intranet
Have you aver wished you could Wollten Sie nicht schon immer ein
produce a company dictionary, Firmenwdarterbuch herausgeben,
easily accessible at all times by ’ auf das alle Ihre Mitarbeiter ’
all your colleagues? Now you can - | jederzeit Zugriff haben? Dies ist |
with MultiTerm Web Interface, the = nun endlich machbar: mit =
TRADOS product for terminology MultiTerm Web Interface, dem
access over the Internat, Just put your Company TRADOS-Produkt, das eine einfache
Dictionary on the Intermnet / Intranet so that Terminologieabfrage Gber das Internet
everyone in your company can access it - erméglicht, Just put your Company Dictionary on
wherever they are based, anywhere in the world, the Internet / Intranet so that everyone in your
On-line, of course. company can access it - wherever they are based,
o _ = arywhere in the world, Gn-line, of course. =
[7) Edit] 5 Source [ (1) Taiget[ £7) Tent @ Preview I
For Help, press F1 love | | 7

Figure 3-16: Previewing Source and Target HTTML Documents in TagEditor

You can now scroll through source and target at the same time, which makes reviewing your
translation much more comfortable. Tip: Pressing the [FF6] key switches between the source and
target window. If you use an external browser for previewing, two instances of the browser will
open, one showing the source and one showing the translated document.

Note

While the active document is in Internet Explorer Preview mode, you can print it, using the
Print command. If you use an external viewer, you can use the Print command of that
application if available.
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3.2.7 Saving the Target Version of a File in the Original File Format After Translation

After previewing our document, let’s come back to our important question: How can the original
file format of a document be restored after translation? Once you have completely finished
translating a document and want to save it in its target-language version, follow one of these
procedures:

e Ifyou have used Translator’s Workbench to translate and edit the document at all times, use
the Save As command in TagEditor and specify the original file type (SGML, HT'ML, or
Workbench RTF) from the Save as Type drop-down list. When saving the document,
TagEditor will “clean up” the document. It will strip out all source segments and delimiting
tags, thereby leaving only the target-language version. Make sure to adapt the file name of
your document as convenient.

e If you have made changes to the target segments without using Translator’s Workbench,
these changes have not yet been made in the current Translation Memory. This is the case
if you have corrected, say, typing errors, without first re-opening the translation unit and
saving the corrected translation in the TM afterwards. In this case, save the document in the
BIF format, and use Translator’'s Workbench Cleanup function to strip out the source-
language segments and update the TM at the same time. After the cleaning process,
Translator’s Workbench will also restore the original file name extension (SGM HTMor RTF).
For more information on the Cleanup feature, see the “Document Analysis, Translation, and
Cleanup” chapter.

To cut a long story short, the translation workflow with TagEditor can be summed up as follows:

Translation Workflow in TagEditor

Source document (HTML,
SGML, Workbench RTF)

\{K

Open in TagEditor, start
translation

)

Save as Bilingual File (BIF) as
long as file is "under
translation"

\/'rx

Finish translation

l

Review translation

Translator's
Workbench used at all
stages?

Save as Target Only in Save as BIF, then run Cleanup|
TagEditor, provide new file in Translator's Workbench with
name if desired Update TM option

Target document (HTML,
SGML, Workbench RTF)

w
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Note

You should not continue working on a file that you have saved as Target Only. Even though it
may look as if the file is still in bilingual format, it is not; only the target language version is
saved. This is why we recommend to close the file immediately after saving it in the target
language version.

3.3 We’re Almost Finished...

This completes our first round-up of the program’s capabilities. You have learned the following
things, among others:

e operating Translator’s Workbench from within Word and TagEditor

* opening and using a Translation Memory database

e understanding how Translator’s Workbench interprets linguistic and non-linguistic
information from your word processor and TagEditor and sends its information back

* using active terminology recognition and the bilingual Concordance feature

J ... and much more.

You may already have a sense of the productivity gains that Translation Memory makes possible.
In the remaining sections of this documentation, you will get to know the program’s many
functions in detail, telling you how to extract the greatest benefits from the program for your
daily work.

3.3.1 Starting a New Project

Here are the basic steps you need to follow when starting a new project and the references on
where to find more information in this documentation:

e If you don’t have a Translation Memory that you want to use, define a new Translation
Memory. See the “Creating a Translation Memory” section in the “Translation Memory”
chapter.

e If this is a new project or subject area for this Translation Memory, add the corresponding
text and attribute fields to the Translation Memory setup. See “Configuring a Translation
Memory” in the “Translation Memory” chapter.

e Select the Translation Memory you want to work with, the filter attributes to use for
selecting translations, and the terminology database settings. See the sections “Working
With Translation Memories” and “Defining Project Settings” in the “T'ranslation Memory”
chapter as well as the “Interface With MultiT'erm ’95 Plus” chapter.

e Set the options to your preferred settings. See “Translation Memory Options” in the
“Translation Memory” chapter.

e Depending on the type of file you want to translate, follow one of these procedures:

* If you want to translate “conventional” word-processor documents, start your word
processor (Microsoft Word 6.0, 7.0 or 97).

e For any tagged file format, start TagEditor. If you want to translate HTML or
Workbench RTF in TagEditor, no further preparation is necessary. However, if you
want to translate SGML documents, make sure you specify corresponding DTD
settings. See the “Preparing Tagged Files for Translation” chapter.
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e Open the file you want to translate, and make a copy of it by saving it under a new name. To
achieve this, use the Save as command from the File menu in your word processor or the
Save Bilingual command in TagEditor.

*  Click the & button to start Translation Memory mode and start translating! For a complete
description of the interface between Translator’s Workbench and your word
processor/TagEditor, refer to the “Interface With Your Word Processor and TagEditor”
chapter.

3.4 Using the On-line Help

When you need more information on how to do something in Translator’'s Workbench or
TagEditor, you can access the on-line Help at any time by pressing the [F1] key or clicking the
Help button in dialog boxes. To get Help for any menu item (including those that are not
followed by a dialog box, e.g. the Big Windows option in the View menu of Translator’s
Workbench), follow these steps:

1. Highlight the menu item that interests you with your mouse or the cursor keys. If you are
using a mouse, don’f release the mouse button.

2. Press the [F1] key. This will open the help page for the corresponding menu item.

The on-line Help is context sensitive, so it automatically gives you information about the
function you are using at the moment.

You can also access Help topics via the Contents tab of the Translator’s Workbench and
TagEditor online Help systems. You access the Contents tab by calling the Help Topics
command from the Help menu. The on-line Help system of Translator’'s Workbench and
TagEditor work exactly like the Help in other Windows applications.
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Translator’s Workbench’s most important feature is its ability to store completed translations in a
Translation Memory and to use them later to create suggested translations.

"This chapter explains how Translation Memory works and how to use it productively.

4.1 How Translation Memory Works

In Translation Memory (TM), a source sentence is always stored with its translation. Additional
descriptive information such as project attributes and text fields are stored with the sentence
pair, along with such administrative information as the date of the entry, the usage counter, the
user ID of the creator, and so on. The sentence pair plus these additional data make up what is
referred to as a translation unit (T'U).

Example

Ealed This is a sample sentence.
B Dics ist ein Beispielsatz.

Additional TU information:

Creation Date: 16 March 1998
Creation User: Miller

Usage Counter: 2

Client: Trados

Domain: IT, Software

Project ID code: Translation 1234/1998

In order to work with Translation Memory, the source document must be available as a
Translator’s Workbench-compatible document. Currently supported formats are:

*  Word-based formats: DOC and RTF (e.g. online Help).

e DTP formats: FrameMaker, FrameMaker + SGML, FrameBuilder (all three via The
S-Tagger for FrameMaker), Interleaf (via The S-Tagger for Interleaf), Ventura, PageMaker,
QuarkXPress (via the I'TP Filter Pack), Bookmaster

e Tagged formats: SGML, HI'ML
¢ Other formats: RC, Troff

e Of course the document can also be available in any other format that can be imported by, or
converted to, a Workbench-compatible tagged file format with Translator’s Workbench and
TagEditor. See the “Translating Tagged Files With Translator’s Workbench and
TagEditor” chapter for details.

Depending on the type of format, we recommend using Word (for DOC and RTF-based online
Help files) or TagEditor (for DTP and tagged formats) in conjunction with Translator’s
Workbench. The source text is opened in your word processor or TagEditor and translated
segment by segment (usually a sentence). In the process, the source text is replaced by the
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target text. This mode of working allows Translator’s Workbench to build translation units and
store them in Translation Memory.

4.1.1 Linguistic Fuzzy Matching

Finding a 100% identical sentence in Translation Memory is of course simple and goes very
quickly. However, one of Translator’s Workbench’s key features is its ability to quickly and
accurately find sentences in Translation Memory that are only similar to each other.

Sequentially comparing a sentence with all the other sentences in Translation Memory would be
much too slow. Instead, in addition to the translation units themselves, the sentences in TM are
stored in a neural network along with special linguistic access structures. This technology allows
a rapid and yet fuzzy access to Translation Memory. An algorithm developed by computer
linguists at *"TRADOS is able to very quickly find a set of sentences that have a certain similarity
to the search sentence. The sentence match with the highest degree of similarity is displayed by
Translator’s Workbench. The others with a lower similarity, if any, are added to the match list
which you can access by clicking on the match selection buttons in Translator’s Workbench’s
program window.

In this process, Translator’s Workbench calculates a percentage for each match, the so-called
match value, which expresses the degree of similarity with the search sentence. The higher the
match value, the more similar the sentences. The percentage is determined in a mixed
calculation based on changed sentence parts and words. In addition, consideration is also given to
whether the changes consist solely of variable elements (numbers, acronyms, etc.) or known
terminology.

To calculate the percent similarity, the fuzzy match algorithm has to determine what changed in
a sentence, that is, which words and sentence parts were exchanged, deleted, inserted, or moved.
Of course, the user needs this information later in order to efficiently adapt the suggested
translation.

4.2 Creating a Translation Memory

T'ranslation Memories and the associated neural networks are stored in several files. The main
file has the extension . t M. To create a new, empty TM database, follow these steps:

1. From the File menu, select New. The Create Translation Memory dialog opens.
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Create Translation Memory

Source Languages Target Languages
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— Spztem Fields

[V Creation Date ¥ Change Date [~ UsedDate

[V Creation User ¥ Change User [~ Usage Counter

Mame: I

Copyright Motice: I

Description:

Figure 4-1: The Create Translation Memory Dialog

2. Define the options for your new Translation Memory as convenient:

Source Languages: Use this list to specify the source language of your TM. Since
Translator’s Workbench is based on the Unicode™ standard, it supports all languages
available in Windows 95 and N'T'. The only exception are bi-directional languages. If a
language you want to use is not listed, this means that your copy of Windows does not
yet support it. Under Windows N'T', you can install new languages from the \ Langpack
folder on the N'T' Setup CD. Under Windows 95, you can install additional language
support via Start - Settings - Control Panel - Add/Remove Programs - Windows Setup -
Multilanguage Support. Look for the keyword “languages” in the Windows online Help
index for details. Once you have added the new languages and rebooted your system,
they should also figure on the Source Languages list in T'ranslator’s Workbench.

Target Languages: Use this list to specify the target language of your TM. You can
select several target languages, thereby creating multilingual Translation Memories. To
achieve this, hold down the [Ctrl] key while you click the desired number of target
languages. Note that you cannot undo your choice for source and target languages at a
later stage. However, you can add new target languages at any time via the Setup
command of the File menu.

System Fields: Use this group box to choose the system fields Translator’s Workbench
should add to each translation unit ('T'U) created with your new TM. System fields
typically store administrative information such as when a translation is created and by
whom. The following table explains all available system fields:

Field Name Description

Creation Date Specifies the date on which a TU was created.

Change Date Specifies the date on which a translation unit was last changed.
Used Date Specifies the date on which a TU was last used.

Creation User Specifies the name of the user who created a TU.

Change User Specifies the name of the user who last changed a TU.

Usage Counter | Specifies the number of times a T'U was used.

Note that for updating the information contained in the system fields Used Date and
Usage Counter, Translator’s Workbench has to perform a write access to Translation
Memory each time a TU is used. A write operation takes longer than a read operation.
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To speed up Translation Memory access, you might thus want to leave these two system
fields out. The system fields Creation Date, Creation User, Change Date, and Change
User do not require a write access to 'IT'M when a TU is used. You cannot undo your
decision for system fields at a later stage.

Copy: Use this button to copy Translation Memory setups (source and target languages,
system fields, copyright information, fields, etc.) from other Translation Memories to
your new TM.

Name: Use this box to assign a name to your new T'M, for example My first Translation
Memory. 'This name will be saved in your TM and is #ot the filename itself. The name
will be displayed in the Properties dialog of the File menu.

Copyright Notice: Use this box to specify copyright information, for example © 7998 by
TRADOS GmbH, Stutigart, Germany. This copyright information will be displayed in the
Properties dialog. You can change the copyright notice at any time using the Setup
command of the File menu.

Description: Use this box to describe the contents of your TM, for example This TM
contains all TRADOS Translator’s Workbench documentation in English and German. This
description will be displayed in the Properties dialog. You can change the description at
any time using the Setup command of the File menu.

Once you are satisfied with the settings, click the Create button. This opens the standard
Windows file dialog. Assign a file name to your TM, and save it in a folder of your choice.
Long file names are supported, so you can call it My First Transl ati on Menory, for
instance. Translator’s Workbench automatically adds the . t M extension and stores the new
TM and its associated neural network files on your hard disk.

When creating a new Translation Memory (TM), Translator’'s Workbench creates not only a
database file in which the translation units will be stored, but also the neural network files that
the program needs for its fuzzy search capabilities. After a new TM has been created, you will
find five new files in the creation folder:

Extension Description

main Translation Memory database file

mtf, romwf, *liix neural network files

For each of these files, the “*” represents the filename you assigned to the T'M, for example
“My First Translation Menory.” A Translation Memory is empty to begin with. Over
time, it is filled with translations. The longer you work with it, the more likely it is that good
matches will be found.

IMPORTANT

If you want to copy a TM with the help of the Windows Explorer, make sure to copy a//
five T'M files with the above-mentioned extensions. Otherwise, Translator’s Workbench
will display an error message when opening the copied TM.

We strongly recommend you to make regular backup exports of Translation Memories
you use in Translator’s Workbench 2.x. The procedure is described in the “Importing and
Exporting Translation Memories” chapter under the heading of “Using the Export
Function to Create a Backup.”
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4.21 Using TRADOS WinAlign to Create a Translation Memory from Existing Translations

If you already have translations in electronic form, it would of course be desirable to fill a
Translation Memory with these translations before starting. For this purpose, WinAlign, a visual,
interactive text alignment program, has been developed by "TRADOS. This powerful and
flexible tool is able to automatically generate Workbench-compatible translation memories from
existing plain documents in various formats. Please contact your local *TRAD OS dealer for more
information. You can also download an evaluation copy including documentation and a tutorial
demo athtt p://wwv. t rados. com

4.3 Configuring a Translation Memory

After creating a new 'I'M, you will first want to configure it in various respects. You achieve this
via the Setup command from the File menu. This opens the Setup dialog. This dialog consists of
the following tabs: General, Fields, Fonts, Substitutions, Segmentation Rules, Non Xlatable
Text, and Access Rights.

Setup C:AProgram Files\Trados\TW4WintDemo. tmw

General IFieIds | Fonts I Substitutions | Segmentation Rules | Mon =latable Textl Access Rights

Hame:
Il_ — Sustem Fields

™ Creation Date
Caopyright Matice: I Creation User

- I Change Date
Description:

I Change Uzer
™ Used Date

I Uzage Counter

Target Languages
— Database Information g e _I
rY

Gaelic [Scotland)
Gaelic M ales)

Source Language

Created by:
Created an

Englizh [United Kingdom)

BROCKMANN
04/02/38,12:32

German [austia

German [Germary)
German [Liechtenstein]

German [Lusembourg) |

G Switzerland
Useable until GE;::”[ witzerland)

Hebrew

Hurgarian

|celandic

Indonesian ﬂ

[ ]

Catcel | Help |

Figure 4-2: The Setup Dialog

In the General tab you specify the name, copyright notice, and description of your TM.
Moreover, this tab displays the source and target languages of your TM. See “Defining General
TM Options” below.

In the Fields tab you specify the text and attribute fields to be used in your TM. See “Adding
Text and Attribute Fields to Your TM Setup” below.

In the Fonts tab you set the default font to be used for displaying source and target language.
Moreover you can define automatic font replacements during translation into such languages as
Russian, Japanese, etc. See “Defining Font Options” below.
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The Substitutions tab allows you to define if, and which, non-translatable items such as
numbers, names, dates should be automatically replaced during translation. See “Defining
Automatic Substitutions” below.

In the Segmentation Rules tab you can set the rules governing the segmentation of your texts
based on stop characters, abbreviation lists, etc. See “Defining Segmentation Rules” below.

In the Non Xlatable Text tab you define character styles to be skipped during translation. This
tab is not described in this chapter since it refers to issues concerning the word processor
integration of Translator’s Workbench. See “Using Character Styles to Exclude Text Parts From
the Translation Process” in the “Interface With Your Word Processor” chapter.

In the Access Rights tab you define passwords to restrict access to your TM at various levels.
This tab is not described in this chapter, since it refers to network operation issues. See
“Protecting TM Databases” in the “Network Operation” chapter.

4.3.1 Defining General TM Options

You use the General tab of the Setup dialog to enter or modify the TM name, copyright
information, description, etc. You can define the following options as required:

* Name: Use this box to assign a name to your new TI'M, for example My first Translation
Memory. This name will be saved in your 'T'M and is #of the filename itself. The name will
be displayed in the Properties dialog of the File menu.

e Copyright Notice: Use this box to specify copyright information, for example © 7998 by
TRADOS GmbH, Stuttgart, Germany. This copyright information will be displayed in the
Properties dialog.

* Description: Use this box to describe the contents of your TM, for example 7his TM contains
all TRADOS Translator’s Workbench documentation in English and German. This description will
be displayed in the Properties dialog.

* Database Information: This group box displays the source language, the user ID of the TM
creator, and the date on which the TM was created. Use the Usable until box to enter a date
on which the TM will no longer be functional (unless opened in exclusive mode by the
system administrator with a corresponding password).

* Target Languages: In this list, the name of the currently selected target language is
highlighted. To add a new target language to your TM, click on the desired new target
language(s). They will be added to your current TM setup. Note that once you click OK, the
new target language(s) will be irreversibly added to your TM. You will not be able to
deselect them later on.

e System Fields: System fields are automatically added to each new translation unit and
contain administrative information. Each system field whose box is ticked is used in the
current 'TM. The list is greyed, so you cannot make any changes here. You define system
fields when creating a new Translation Memory as described under “Creating a Translation
Memory” above.
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Setup C:\Program Filezs\Trados\TwW4Win\Demo_ tmw
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Figure 4-3: Defining General TM Options

4.3.2 Adding Text and Attribute Fields to Your TM setup

You use the Fields tab of the Setup dialog to define text and attribute fields to further describe
the linguistic data stored in your Translation Memory (TM).

Setup C:\Program Files\Trados\T'wW4Win\MyFirstTM_tmw

General  Fields ]Fonts ] Substitutionsl Segmentation Hules] Mon #latable Text | Access Rights
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Figure 4-4: The Fields Tab

Information that classifies translation units in your Translation Memory, for example the names
of your clients or the domains in which you are specialised, are best managed via attribute fields.
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They are composed of an attribute field name, for example Cliens, and a picklist containing the
values the attribute Client can assume, for example New Chemicals Ltd. or BetaSoft. Each new TM
contains one sample attribute field by default: Szezus with the attribute values New, Approved,
and Read Only. This is just an example that you can modify as convenient.

Information that is rather free and changes from project to project is best stored in text fields.
For instance, you might want to store the ID code of translation projects or documents in text
fields. Text fields are composed of a text field name, for example ID code, and the contents of
the text field, which can be set at will during each translation project.

Actribute and text field contents that you define before beginning a new translation are added to
each translation unit created during that project.

The following restrictions apply to text and attribute fields:
*  You can define up to 50 text fields for each database. The length of the text field name is

limited to 24 characters, the contents that you define for it are also limited to 24 characters.

*  You can define up to 90 attribute fields for each database. The picklist itself can contain up
to 255 elements. Attribute field names and values are limited to 24 characters.

Defining Text Fields, Attribute Fields, and Attribute Values

Follow these steps to define text fields, attribute fields, or attribute values:

1. Click inside the list to which you want to add the new field or value.
e To add a text field, click inside the Text Fields list.
e To add an attribute field, click inside the Attribute Fields list.
e To add a new value to an attribute field, first select the desired attribute field name,
then click inside the Attribute Values list.
2. Click the Add button. The cursor moves to the Field input box.

3. Type a name for the new field or value. The name is added to the list of fields or value
names.

4. Repeat the same procedure for each field or value that you want to add.

Changing Text and Attribute Fields at a Later Date

Once you have worked with the database for a while, you may want to add new text fields,
attribute fields, and attribute values. Or you might want to change existing ones.

You can @dd new names to any list at any time without causing any problems. However, if you
want to change text or attribute fields, there are a few things to keep in mind. All these items are
stored in the database in compressed form rather than as complete text strings. This means that
if you want to change, say, the attribute field name Domain to Subject, you simply click on that
name and change it in the Field box. From that point onward, wherever Domain occurred in the
database, the new attribute field name Suéject now appears.
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Caution

You should never change the order of the labels on the different lists, since this would change
basic data. If a change in the order of the Text Fields list, Attribute Fields list, or picklists is
absolutely necessary, you must first export the entire database, then create a new database,
define the new ordering of setup items, and finally re-import the data, as explained under
“Importing and Exporting Translation Memories.” The same goes for deleting: Translator’s
Workbench makes sure that you cannot delete items once you have defined them. If deletion
is absolutely necessary, you must also export and re-import the entire database into a new one.

Defining Text and Attribute Fields: Example

Suppose you are working in a language service of a big institution. Normal translation projects
have the following information items:

e every document to be translated has its own identification code, consisting of the
abbreviation PROJ for project and a number consisting of the year and a number (for
example 98/105, meaning the 105th translation in the year 1998)

e you are currently working for three clients: New Chemicals Ltd., Pro Sofrware Inc., and Heavy
Engineering & Co.

e  you are specialised in the domains chemistry, software, hardware and engineering

Adding selected bits of this information to new translation units will give you the possibility to
later only activate certain parts of your TM when translating for, say, Pro Software Inc., and other
parts when translating for Heavy Engineering & Co. The following example will tell you how to
add such information to your 'I'M database setup.

Since you don’t know the identification code before actually translating the document it belongs
to, you will create a text field for this information category. This makes sure that you can add
new identification codes to existing ones in your IT'M without any problems. You will just enter
the ID code for new documents when starting a new translation. New translation units for that
document will then be stored in TM with the new ID code. In order to create a text field
labelled ID Code, follow these steps:

1. In the Fields tab of the Setup dialog, click on the first and only item in the Text Fields list,
labelled 7ext Field. 'This element is highlighted and its name transferred into the Field input
box.

2. Click inside the Field box. Change the name from Text Field to ID Code.
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Figure 4-5: Adding Text Fields to the TM Setup

This already completes defining the text fields for this Translation Memory. As mentioned
above, you will later be able to enter the actual ID code information (for example PROJ 98/105)
into this text field when starting a new translation project.

As far as the second and third type of translation project information is concerned (clients and
domain), it is fairly obvious that this information can be neatly classified. Therefore it is useful to
specify attribute fields for this kind of information. Translator’'s Workbench gives you the
possibility to enter a name for the attribute field itself and specify different elements in a picklist
which will contain all the different values the attribute can assume. Let’s try it out. To add a
Client and Domain attribute field, follow these steps:

1. Click in the Attribute Fields list to highlight the first item, Stazus.

2. We will not rename this field but rather add a new one. To achieve this, click the Add
button. The cursor moves to the Field input box.

3. Type Client into the Field box. This will be the name of our first attribute field.

4. Now it is best to add the names of your clients to the picklist. Click on the item A Va/ue in
the picklist. The item is now highlighted.

5. Click in the Field box to rename A Va/ue to the name of your first client, New Chemicals Ltd.

6. To add the two remaining clients, click the Add button, and type the clients’ names into the
Field box.
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Figure 4-6: Adding Attribute Fields and Values to the TM Setup

To create a new attribute field for the translation project domains mentioned above, first re-
activate the Attribute Fields list by clicking on the C/ient item.

Click the Add button and enter Domain in the Field box. This adds a new attribute field to

the list. Try it yourself for the different domains to be added to the picklist, i.e. Chemistry,
Software, Hardware, and Engineering.

Once completed, your setup should look as follows:

Setup C:\Program Files\Trados\T'wW4Win\MyFirstTM_tmw
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Figure 4-7: Complete Setup of Text and Attribute Fields
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4.3.3 Defining Font Options

Note

In Translator’s Workbench 2.2 or higher, the Font Translation feature has been further
improved. It is no longer necessary to define any font translations. However, if you experience

any problems with fonts not being correctly displayed either in Translator’s Workbench or
Word, please follow the instructions below.

You use the Fonts tab of the Setup dialog to define the default font used to display the source
and target language text. You can also define automatic font changes for translation into and from
such languages as Russian, Greek, Japanese, Chinese, etc.

Setup C:AProgram Files\Trados\TWAWintMyFirstTM _tmw
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Arial CYR Arial CYR

Avial Greek Arial Gresk

Ty | Ty |

Font Tranzlation List

[elete |
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all ather fants
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Figure 4-8: The Fonts Tab

Defining Default Fonts for Source and Target Language

Follow these steps to change the default font for the source or target language:

1. To change the default font for the source language, select a new font from the Source
Default Font drop-down list.

2. 'To change the default font for the target language, select the desired target language from

the Target Languages list, and select a new font from the Target Default Font drop-down
list.

By default, Translator’s Workbench uses the “Arial” font for all languages.

Defining Font Translations

For translation into or from such languages as Russian, Greek, Japanese, Chinese, Korean, etc., it
is useful to “translate” source fonts into target fonts. For example, when translating from
German to Russian, you may want to translate, say, “Arial” into “Arial CYR.”

To add one or more font translations, follow these steps:
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1. Select the source font name (usually the font used in your source-language documents) on
the Source Font list.

2. Select the appropriate target font name (usually the font of the target language you’re
translating into) on the Target Font list.

3. Click the Add button to add it to the Font Translation List.
4. Repeat this procedure for all source fonts that should be translated into different target

fonts.

To always translate whatever font might appear in your source documents to the target-language
default font, check the Translate into target default for all other fonts option.

Setup C:\Program Files\Trados\TwW4Win\EngRus. tmw
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Figure 4-9: Defining Font Translations (here, for Russian)

Explanations and Examples

Let’s assume your Translation Memory has English (United Kingdom) as the source and Greek
as the target language. That’s why you have selected Arial as default font for your source
language and Arial Greek as default font for your target language. Let’s further assume that the
documents you translate use the Arial font as default font as well. In this case, when translating
from English to Greek, you will want to automatically activate Arial Greek as the font for the

target-language segments instead of having to manually change from Arial to Arial Greek every
time. T'o achieve this, you would either

¢ define the font translation Arial->Arial Greek, or

* you would check the Translate into target default for all other fonts option. In this case,
T'ranslator’s Workbench will always activate Arial Greek as the target-language default font,
even if Arial is #oz used in your source documents.
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4.3.4 Defining Automatic Substitutions

You use the Substitutions tab of the Setup dialog to determine whether numbers, acronyms,
names and similar variable elements should be treated as variables or normal words by
Translator’s Workbench. Variables typically are elements which do not change in the translation.
Translator’s Workbench can therefore automatically substitute them. If the only thing that
changes in a new sentence are variables, the program will still produce a 100% match.

Setup C:\Program Filezs\Trados\TwW4Win\Demo_ tmw
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Figure 4-10: The Substitutions Tab

The following variable elements are available: Numbers, Acronyms, Dates, Time,
Measurements, Name, Variables. Check the element(s) which you would like to be
automatically replaced during translation.

In addition to such elements as numbers or acronyms which are automatically identified by
Translator’s Workbench, you can supply your own list of variables. In this list, you can supply
words that are interchangeable in the same way as acronyms, names, etc. The list you supply
must meet the following requirements:

e Each element must figure on a line of its own. Make also sure to write the words exactly as
they appear in your texts. Otherwise Translator’s Workbench will not be able to recognise
them. Example:

Brenen
Stuttgart

Bruxel | es
TWIW n

e The list must be provided as a plain text file (save the file as Text Only in Word, or create it
in Notepad).

To include your own list of variables in the 'T'M setup, follow these steps:

1. Create the variables list in your word processor, and save it as Text Only (*. t Xt ).

2. In Translator’s Workbench, select Setup from the File menu, and click the Substitutions
tab.
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Check the Variables option. This activates the Variable List.
Click the Add File button. The Variable List File dialog opens.
From the Look In drop-down box, choose the desired drive and folder as convenient.

Click the name of the file you created under step 1, and click Open to confirm.

N o kW

Repeat this procedure for each variable list that you want to include.

If you make changes to the lists at a later stage, click the Reload button for Workbench to update
the list.
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Figure 4-11: Adding a Variable List File

Note

If you add a variable list to a TM that already contains translation units, make sure to
reorganise the TM. Translator’'s Workbench can only process the variables correctly after a
reorganisation of the TM.

Substitutions: Explanation and Examples

When technical documentation is revised, such variable elements as certain numerical
performance data or product names are frequently changed. The rest, however, often stays the
same. Variable elements generally have no influence on translations; they are usually copied as
they appear in the source sentence. Translator’s Workbench can therefore recognise and treat
these elements as variables. If there are several of these elements in a sentence, Translator’s
Workbench notes their positions, which of course can be different in the translation.

In order for Translator’s Workbench to establish this relationship, the first time you enter a
target sentence, you must enter the variable elements exactly as they appear in the source
sentence. From then on, this first translation unit is taken as a “model” for new source sentences
where the variable element might be different. So Translator’s Workbench only has to create
one translation unit for all future translations where only the variable elements have changed. In
all other cases, a new translation unit is of course created.
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Moreover, the variable elements will automatically be substituted by Translator’'s Workbench in
the new target-language sentence if they constitute the only changes to the sentence.
Translator’s Workbench will automatically insert the new variable element and show a 100%
match in spite of the changes. The program will also try to make these automatic substitutions in
fuzzy matches, but it can only do so if the sentence part containing the variable element in the
fuzzy match has not been changed.

For each element whose check box you don’t tick, it will be treated as a normal word and not as
a variable during translation. As a result, Translator’s Workbench will not be able to
automatically substitute these elements in your new target-language sentence. Moreover, it will
create a new translation unit even if the variable element is the only thing that changed in the
sentence. On the other hand, you will be able to look for these variable elements in your TM via
the Concordance function. This cannot work if these elements are treated as variables.

Example

Let us suppose the following English-German translation unit exists in your Translation
Memory:

Faled  Thank you for purchasing TWII, the software workstation for translators by TRADOS, that has

been released on 12 October 1992.
Vielen Dank fiir den Kauf von TWII, dem Software-Arbeitsplatz fiir Ubersetzer aus dem Hause
TRADOS, der am 12. Oktober 1992 auf den Markt kam.

Let’s further suppose that you now have to translate the following sentence:

ol

Faled  Thank you for purchasing TWBWIN, the software workstation for translators by TRADOS, that
has been released on 15 February 1998.

In this example, Translator’s Workbench will be able to automatically replace TWII with
TWBWIN in the new target-language sentence because it recognises TWII and TWBWIN as
being acronyms that are interchangeable in this context. Also, it will be able to change the date
accordingly, and transfer the following—automatically adapted—translation to your word
processor:

E Vielen Dank fiir den Kauf von TWBWIN, dem Software-Arbeitsplatz fiir Ubersetzer aus dem
Hause TRADOS, der am 15. Februar 1998 auf den Markt kam.

In Translation Memory, there is only one translation unit which will be used in both examples,
since the differences between the two sentences only consist in variable elements.

Note

The prerequisite that the above example can work is of course that you have checked the
corresponding elements in the Substitutions tab.

Automatically Adapting Date, Time, Number, Measurement, and Name Formats to the
Target Language

In addition to recognising variable elements and substituting them in the target sentence as
required, Translator’'s Workbench can also change the format of these elements where necessary.
This process is referred to as “substitution localisation”—the substituted elements do not just
get transferred to the target sentence, but also adapted (“localised”) to the target-language
requirements. For instance, when translating a sentence with an English date into German, you
will want to adapt the English date format to German standards in the translated sentence.
Translator’s Workbench can do this for you automatically, according to the settings you define.
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For further information, please see “Defining Substitution Localisation Settings” in the
“Translation Memory Options” section below.

4.3.5 Defining Segmentation Rules

You use the Segmentation Rules tab of the Setup dialog to display and modify the rules
Translator’s Workbench uses to segment your source texts.
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Figure 4-12: The Segmentation Rules Tab

As already described, translation units in Translation Memory consist of at least one source and
one target language segment. A segment normally represents a sentence. When translating in
TM mode, Translator’s Workbench automatically determines the current sentence and attempts
to find it in Translation Memory. Translator’'s Workbench uses punctuation as orientation in
identifying a sentence. As a general rule, a full stop, exclamation mark, question mark, colon, or
tab end a sentence when they are followed by a space. A quotation mark (" or ’) or a close
parenthesis (“)”) may follow the closing punctuation mark and precede the space. A semicolon
(;) does not end a sentence.

To change the segmentation rules, click the name of the rule you wish to change, and make the
desired adjustments in the Rule group box. In the following sections, all available options in this
dialog will be described, along with explanations and examples where appropriate.

End Rules

Use this option to define the rules for ending segments. Each End Rule thus tells Translator’s
Workbench when a segment in your source text ends.

The default end rules Full Stop, Tabulator, Colon, Marks, and End of Paragraph are summed up
below under the heading of “Default End Rules—Summary.” The Full Stop End Rule, the most
sophisticated and important rule, is described under “The Full Stop End Rule—Explanations
and Examples.”

To change one of these rules, select the desired rule from the list, and change the parameters as
required in the Rule group box. The parameters are explained below. To remove a rule from the
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list, select the corresponding rule name, then click the Delete button and confirm this setting by
clicking the OK button. To add a new rule to the list, click the Add button, enter a new name
and define the desired settings in the Rule group box of the dialog.

Skip Rules

Use this option to define the rules that tell Translator’s Workbench to continue reading a
segment even if it has found a potential stop character, that is, a character that could end a
segment. There is only one default Skip Rule labelled Semicolon. When 'Translator’s
Workbench encounters a semicolon (“;”), it does not interpret this punctuation mark as the end
of the current segment, but continues reading until it finds the next stop character, for example a

dot (“.”) or a question mark.

T'o change this rule, that is, tell Translator’s Workbench to szop reading a segment as soon as it
encounters a semicolon, remove the rule by clicking the Delete button and confirm this setting
with OK.

To add a new rule to the list, click the Add button, enter a new name and define the desired
settings in the Rule group box of the dialog.

The Rule Group Box

In the Rule group box, you define the different parameters for each End or Skip Rule. The
following parameters are available:

Leading Characters

The numeric value you enter here governs how many characters must precede the stop character
(see “Stop Character List” below) in order for the segmentation rule to take effect. For example,
if you enter a value of 5 for the Full Stop End Rule, a dot will 7oz be interpreted as a full stop if it
is preceded by less than five characters.

If the value is set to 0, it is ignored by Translator’s Workbench and does not have any impact on
the current rule.

Leading Words

The numeric value you enter here governs how many words must precede the stop character
(see “Stop Character List” below) in order for the segmentation rule to take effect. For example,
if you enter a value of 5 for the Full Stop End Rule, a dot will #o7 be interpreted as a full stop if it
is preceded by less than five words.

If the value is set to 0, it is ignored by Translator’s Workbench and does not have any impact on
the current rule.

Stop Character List

This list contains the punctuation marks that Translator’s Workbench recognises as stop
characters, that is, characters that end a segment. It is a multiple list, so you can choose more
than one punctuation mark to define the same parameters for several stop characters in one go.
For example, the Marks End Rule covers both the question mark and the exclamation mark. You
can also define your own stop characters.
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Note

Translator’s Workbench uses different default sets of segmentation rules, one for single-byte
languages (such as all European languages) and one for multi-byte languages (such as
Japanese, Korean, Chinese). The Stop Character List will vary depending on which language
you have selected as source language in your TM.
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Figure 4-13: Default Full Stop Character for Japanese

The dot is a special stop character in so far as it does not necessarily end a sentence. For
example, it may also be the end of an abbreviation or an ordinal number, and not part of the
sentence punctuation. This is why the developers at "TRADOS have defined a very
sophisticated default End Rule covering almost every possible use of the dot. This rule is
described below under the heading of “The Full Stop End Rule: Explanations and Examples.”
You can adapt this rule to your specific needs or create a new rule governing other uses of dots in
your texts.

If the dot is selected in the list of stop characters, the Stop Character is Dot group box of the
dialog becomes accessible. You’ll find more information on this below under the heading of
“Stop Character is Dot.”

Trailing Whitespaces

The numeric value you enter here governs how many space characters must follow a stop
character (see “Stop Character List” above) in order for the segmentation rule to take effect. For
example, if you enter a value of 2 for the Full Stop End Rule, a dot will #os be interpreted as a
segment boundary marker/full stop if it is followed by less than two spaces.

Number Stop

This is a three-state option box. This means it can assume three different states: checked, not
checked, and greyed.

o If it is checked, then Translator’s Workbench on/y interprets the selected stop character(s) to
be the end of a segment if it is preceded by a number.
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o If it is not checked, then Translator’'s Workbench does not interpret the stop character to be the
end of a segment if it is preceded by a number. This is the default setting for the Full Stop
End Rule, since normally, numbers and dots (e.g. “1.”) are not the only element in a
segment. Usually, as in number lists, the number & dot precede a statement or other listed
segment that should be translated as one unit. This is why Translator’s Workbench
continues reading after numbers.

e If it is greyed, then Translator’s Workbench ignores this option, that is, it does not matter if
the selected stop character is preceded by a number or not.

Followed By Lowercase

This is a three-state option box. This means it can assume three different states: checked, not
checked, and greyed.

o If it is checked, then Translator’'s Workbench oz/y interprets the selected stop character(s) to
be the end of a segment if it is followed by a lowercase letter.

o If it is not checked, then Translator’'s Workbench does not interpret the stop character to be the
end of a segment if it is followed by a lowercase letter. This is the default setting for the Full
Stop and Marks End Rules, since normally, new sentences do not start with a lowercase
letter.

e If it is greyed, then Translator’s Workbench ignores this option, that is, it does not matter if
the selected stop character is followed by a lowercase letter or not.

Followed By Tab

This is a three-state option box. This means it can assume three different states: checked, not
checked, and greyed.

o If it is checked, then Translator’s Workbench oz/y interprets the selected stop character(s) to
be the end of a segment if it is followed by a tab character.

o If it is not checked, then Translator’'s Workbench does not interpret the stop character to be the
end of a segment if it is followed by a tab character.

e If it is greyed, then Translator’'s Workbench simply ignores this option, that is, it does not
matter if the selected stop character is followed by a tabulator or not. This is the default
setting for the Full Stop End Rule.

Stop Character is Dot

This group box governs the special uses of the dot as a stop character. The dot is a special stop
character in so far as it does not necessarily end a sentence. For example, it may also be the end
of an abbreviation or an ordinal number, and not part of the sentence punctuation. The following
options are available:

Preceded By Guessed Abbreviation & Preceded By List Abbreviation

Definitions

“Guessed Abbreviation” means that Translator’s Workbench presumes the string preceding the
dot(s) to be an abbreviation. Examples are the German z. B. and 2. Zz. “List Abbreviation”
means that Translator’s Workbench has found the string preceding the dot either on its
language-dependent internal abbreviation lists or on the current user-customisable abbreviation
list (see under “Loading User-Defined Abbreviation and Ordinal Follower Lists” below).

Both the Preceded By Guessed Abbreviation & the Preceded By List Abbreviation option boxes
are three-state option boxes. This means they can assume three different states: checked, not
checked, and greyed.
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* If they are checked, then Translator’'s Workbench only interprets the dot to be the end of a
segment if it is preceded by a guessed or list abbreviation.

o If they are not checked, then Translator’s Workbench does not interpret the dot to be the end
of a segment if it is preceded by a guessed or list abbreviation. This is the default setting for
the Full Stop End Rule since abbreviations usually do not end a sentence. In those cases
where it does end the segment, use the Shrink Segment command from the Trados menu in
your word processor to reduce the size of the suggested segment (see the “Interface With
Your Word Processor” chapter).

e If they are greyed, then T'ranslator’s Workbench ignores them, that is, it does not matter if
the selected stop character is preceded by a guessed/list abbreviation or not.

Number of Dots

The numeric value you enter here defines how many dots must appear in a row for the
segmentation rule to take effect. The default setting is 1, since one single dot normally ends a
segment. This of course also covers cases where more than 1 dot end a segment, as in 7%is is a
sentence ending in three dots... This is a normal sentence.

Single Letter Dot

This is a three-state option box. This means it can assume three different states: checked, not
checked, and greyed.

o If it is checked, then Translator’s Workbench on/y interprets the dot to be the end of a
segment if it is preceded by a single letter.

o If it is not checked, then Translator’'s Workbench does nor interpret the dot to be the end of a
segment if it is preceded by a single letter. This is the default setting for the Full Stop End
Rule, since normally, letters and dots (e.g. “a.”; “C.”) are not the only element in a segment.
Usually, as in lists, the letter & dot precede a statement or other listed segment that should
be translated as one unit. This is why Translator’s Workbench continues reading after single
letters followed by dots.

e If it is greyed, then Translator’'s Workbench simply ignores this option, that is, it does not
matter if the dot character is preceded by a letter or not.

Ordinal Follower

This is a three-state option box. This means it can assume three different states: checked, not
checked, and greyed.

o If it is checked, then Translator’s Workbench on/y interprets the dot to be the end of a
segment if it is preceded by a number and followed by a word typically following numbers.
This word, also referred to as “ordinal noun” or “ordinal follower” is either found on
language-dependent internal lists or is part of the user-customisable list of ordinal nouns that
you can define to further enhance the segment boundary recognition phase. You’ll find more
information on this below under “Loading User-Specified Lists of Abbreviations and/or
Ordinal Followers”.

o If it is not checked, a dot is not interpreted as a segment boundary marker if it is preceded by a
number and followed by an ordinal noun. This is the default setting for the Full Stop End
Rule, since normally, numbers followed by a dot and an ordinal noun do not end a segment.

e Ifitis greyed, Translator’'s Workbench ignores this option, that is, it does not matter if the dot
is preceded by a number and followed by an ordinal noun.

Loading User-Defined Abbreviation and Ordinal Follower Lists

In the Segmentation Rules tab, you can also specify user-specified lists of abbreviations and/or
ordinal followers. T'o achieve this, click the User Lists button. This opens the User Lists dialog:
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Figure 4-14: The User Lists Dialog

Use this dialog to specify the filenames of your own Abbreviation List and/or a List of Ordinal
Followers. You can use these lists to support and further enhance Translator’s Workbench’s
segmentation algorithms. Enter the path and filename of the file into the input boxes, or use the
Browse button to locate it on your system. Workbench-compatible abbreviation list files have
the extension *. abr, ordinal follower list files have the extension *. or d. To create your own
abbreviation and/or ordinal follower file, follow the procedures described below.

Explanation on Abbreviation Files

Translator’s Workbench uses internal lists of abbreviations when segmenting text. If a string that
is followed by a full stop (“.”) in the text occurs in this abbreviation list, Translator’s Workbench
interprets this full stop as an abbreviating punctuation mark and thus keeps reading until the

next full stop.

In addition to these internal lists of abbreviations that are language-dependent, you can create
and include your own, language-independent list of abbreviations to further enhance
Translator’s Workbench’s segmentation algorithms. This list must be in “Text Only” format,
that is, standard ANSI Windows text. You can use any text editor or Windows word processor to
create this format.

When creating your own list of abbreviations, make sure to stick to the following rules:

e Always put one abbreviation on a line, followed by a period. Example:

dr.
mast .
engl .

*  Only use lower case spelling in the abbreviation list, even if the abbreviations include one or
more upper case letters. For example, the German abbreviation for VAT (value-added tax) is
MwSr. (Mehrwertsteuer). You would include this abbreviation in the user-specified
abbreviation list as mwst.

*  You can use any text editor or Windows word processor to create your own abbreviation list.
Make sure to save it as “T'ext Only” (ANSI = standard Windows text format).

e Add the extension *. abr to the filename of your abbreviation lists. For example, you could
give the name Myl i st. abr to your own abbreviation file.
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Explanation on Ordinal Follower Files

Note

"This file is only necessary after you have changed the default segmentation rules in such a way
that a dot may represent a sentence boundary marker, even if it occurs after a number (see the
explanations under “Number Stop” above). If you haven’t changed the End Rules, you don’t
need a user-specified ordinal follower file. Otherwise, please read through the following
explanations.

[T31}

When segmenting a text, Translator’'s Workbench tries to exclude the uses of the that are
potentially misleading. This phase of the segmentation process is not relevant for all languages,
but it is particularly useful with the German language. In German, the “.” is very often used after
ordinal numbers, for example, in frequently used date formats such as /2. Januar. Consider the

following example:

Gliltig ist der BeschluR vom 12.03. nur bis zum 31. Zudem wurde am 22.03.1988 vor der 12.
Kammer des Landgerichts Hamburg festgehalten, daf3 der Jahresabschlul? am 13. Januar
1988 yorgelegt und am 18. Februar bestatigt wurde und guiltig ist bis zur Revision im Jahre
1989.

In this example, if you have changed the default segmentation rules for numbers preceding dots,
Translator’s Workbench will not be able to segment the text correctly, but stop after each dot
that is preceded by a number and followed by a space and an uppercase letter (in the above
example, this concerns the numbers 31, 12, 13, and 18). There is only one true sentence
boundary after a number, namely after 31. All the other cases are not sentence boundaries,
because they are followed by what is referred to as ordinal followers, that is, nouns typically
following a number in German, such as month names or names of institutions.

In order to solve problems involving ordinal uses of numbers, as in /2. Kammer or 13. Januar, you
can create and include your own list of ordinal followers to further enhance Translator’s
Workbench’s segmentation algorithms. When creating your list, keep to the following rules:

e The lists must be in “Text Only” format, that is, standard ANSI Windows text. You can use
any text editor or Windows word processor to create this format.

* In the list, every noun must appear in a line of its own. Example:

Januar

Febr uar
Kanmer
Landgeri cht

e When saving the list in your word processor or editor as “Text Only,” add the extension
*.ord to the filename you assign to the list. For example, you could give the name
Myl i st. ord to your own ordinal follower file.

The Default End Rules—Summary

A full stop, tabulator stop, exclamation mark, question mark, or colon end a sentence when the
following conditions are met:

e They are preceded by at least one word (see the Leading Words value described above).
Thus, those source segments which only consist of a number (for example in a table cell) are
simply ignored, since normally, you don’t change numeric values in a translation.

Translation: The decision of 12 March is only valid until the 31st. In addition, the 12th chamber of the Hamburg
district court stated on 22 March 1988 that the annual report had been submitted on 13 January 1988 and confirmed
on 18 February 1988, and that it would be valid until the audit in 1989.
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e With the exception of the tab character, they are followed by at least one space (see the
Trailing Whitespaces value described above).

e A quotation mark (" or’) or a close parenthesis (“)”) may follow the closing punctuation mark
and precede the space.

Of course, a full stop may also be the end of an abbreviation or an ordinal number, and not part
of the sentence boundary punctuation. Translator’s Workbench therefore tries to determine
whether it is dealing with an abbreviation or the end of the sentence. In the following cases,
Translator’s Workbench assumes that it has encountered an abbreviation, and therefore
continues reading:

*  The letter before the full stop is uppercase or is not an entire word (see the Leading Words
value described above).

e  The character before the full stop is a number (the Number Stop option is 7#of checked).
e The first character after the full stop is a number.

*  Workbench presumes the string before the full stop to be an abbreviation (the Preceded By
Guessed Abbreviation option is 7of checked).

e The string before the full stop is found on Translator’s Workbench own or on a user-
customisable abbreviation list (the Preceded By List Abbreviation option is 707 checked; see
also “Loading User-Defined Abbreviation and Ordinal Follower Lists” above).

e The full stop is followed by a word found on Translator’s Workbench own or on a user-
customisable list of ordinal followers (the Ordinal Follower option is #os checked; see also
“Loading User-Defined Abbreviation and Ordinal Follower Lists” above).

A semicolon (;) does not end a segment. This may be changed by modifying the Semicolon Skip
Rule.

You can change all these rules by adapting the parameters of the individual rules as appropriate
in the Rule group box of the Segmentation Rules dialog.

The Full Stop End Rule—Explanations and Examples

‘This section contains detailed information on the default rule governing all kinds of uses of the
full stop (“.”) during the segment boundary recognition carried out by Translator’s Workbench
for each new segment.

“Kon

The Full Stop End Rule stipulates the following uses of the dot (“.”) as a Stop Character, that is,
as a full stop character that ends a segment:

e A dotis on/y interpreted as a segment boundary marker (full stop) if it is preceded by at least
one word: the Leading Words option contains the value “17.

* A dotis only interpreted as a segment boundary marker if it is followed by at least one space:
the Trailing Whitespaces option contains the value “17.

e A dot is not interpreted as a segment boundary marker if it is preceded by a number: the
Number Stop option is #either checked nor greyed.

* A dot is nor interpreted as a segment boundary marker if it is followed by a lowercase
character: the Followed by Lowercase option is neither checked nor greyed.

* In the segment boundary recognition phase, it does not matter if the dot is followed by a tab
character: the Followed by Tab option is greyed.

When the stop character is a dot, as in the present case, the Stop Character is Dot group box of
the Segmentation Rules tab is accessible. For the Full Stop End Rule, this section stipulates the
following rules for special uses of the dot:

Translator’s Workbench, © 1994-99 by " TRADOS GmbH



Configuring a Translation Memory 4-25

* A dot is not interpreted as a segment boundary marker if it is preceded by a presumed
abbreviation: the Guessed Abbreviation option is neither checked nor greyed. “Guessed
abbreviation” means that Translator’s Workbench presumes the string preceding the dot(s)
to be an abbreviation. Examples are the German z. B. and z. Zz.

e Adotis #or interpreted as a segment boundary marker if it is preceded by an abbreviation to
be found on user-customisable abbreviation lists: the Preceded By List Abbreviation option
is neither checked nor greyed. These abbreviations are listed in language-independent
abbreviation lists that you can define to further enhance the segment boundary recognition
phase. You’ll find more information above under “Loading User-Defined Abbreviation and
Ordinal Follower Lists.”

* A dot is nor interpreted as a segment boundary marker if it is only preceded by a single
letter: the Single Letter Dot option is #either checked nor greyed.

e A dotis nor interpreted as a segment boundary marker if it is followed by a word to be found
on a program-internal or a user-customisable list of nouns typically following numbers, i.e.
ordinal followers: the Ordinal Follower option is #neither checked nor greyed. These nouns
are either listed in language-dependent internal lists or on lists that you can define to further
enhance the segment boundary recognition phase. You’ll find more information above under
“Loading User-Defined Abbreviation and Ordinal Follower Lists.”

* A dotis only interpreted as such if it occurs at least as one single dot: the No. of Dots value

issetto 1.

If you’d like to change one or more parameters of this rule, change the corresponding setting
according to your needs and confirm your settings by clicking on OK. Americans might for
example change the Trailing Whitespaces value to “2”, because a dot in American English texts
only ends a sentence if it is followed by two spaces. Or you might want to increase the Leading
Words value to, say, “5”, to tell Translator’s Workbench to 7oz interpret a dot as a sentence end
marker if it is preceded by less than five words.

Examples
1. a. c. This is a sample sentence.
Despite the dots, the above example is interpreted as one entire segment for several reasons:

e  There is no leading word before the first dots (the Leading Words value is set to 1).

* The Number Stop option is 7oz checked, that is, numbers followed by dots do not end a
segment.

e The Single Letter option is #os checked, that is, single letters followed by dots do not end a
segment.

* The Followed by Lowercase option is #of checked, that is, dots followed by lowercase

letters do not end a segment.

Die Zentrale ist z. Zt. nicht erreichbar; versuchen Sie es ab 10. August 1993 wieder, dann
sind wir evtl. wieder fur Sie da.?

Despite the dots and the semicolon, the above example is interpreted as one entire segment for
several reasons:

e Translator’s Workbench presumes the string z. Z# to be an abbreviation, i.e. treats it as a
“guessed abbreviation.” As a result, it keeps reading until the next punctuation mark.

2 “I'ranslation: You cannot reach our head office at the moment; please try again after 10 August 1993—after that date,
we will perhaps answer the phone again.
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e The semicolon (“;”) does not represent a sentence boundary marker for Translator’s
Workbench (see the corresponding Skip Rule).

e Translator’s Workbench does not stop after the /0. before the month name Augusz, since the
Number Stop option is #of checked, and the proper noun Axgust is a typical ordinal follower
which Translator’'s Workbench finds on its internal, language-dependent ordinal follower
list.

* Translator’s Workbench does not stop after the dot preceded by the abbreviation evil.,
because the word following it is in lowercase. If it was in uppercase, Translator’s Workbench
would have stopped. In this case, you could add this abbreviation to your list of
abbreviations and load it by choosing it in the User Lists dialog. Translator’s Workbench
would then even read past this abbreviation. You could also use the Expand Segment
command from the Trados menu in your word processor to size the above segment past the
abbreviation ¢v#/. Please refer to the “Interface With Your Word Processor” chapter.

This is a sentence.
7543.
This is another sentence.

In this example, Translator’s Workbench will ignore the number in between the two sentences,
because there must at least be one leading word in each segment—the Leading Words value is
set to 1. In the second sentence, there is no leading word. Ignoring such “non-linguistic”
segments is very useful, if you have to translate, say, tables in which many cells only consist of
numbers. Translator’'s Workbench ignores these source segments since in the translation,
numeric values are not supposed to be changed and, as a result, do not need to be translated.

4.3.6 Defining Options for Non-Translatable Text

In the Non Xlatable Text tab you define character styles to be skipped during translation. This
tab is not described here since it refers to issues concerning the word processor integration of
Translator’s Workbench. See “Using Character Styles to Exclude Text Parts From the
Translation Process” in the “Interface With Your Word Processor” chapter.

4.3.7 Defining Access Rights

In the Access Rights tab you define passwords to restrict access to your TM at various levels.
This tab is not described here, since it refers to network operation issues. See “Protecting TM
Databases” in the “Network Operation” chapter.

4.4 Working With a Translation Memory

In order to show you what options you have when working with TMs, let us go through a
practical example. Please open the demonstration TM Deno. t mw, start MultiTerm with the
demo database Trados. ntw, and start your word processor and load the demonstration
document Denp. doc (Word) or Denp. wpd (WordPerfect) which you’ll find in Translator’s
Workbench’s program directory (\ Program Fi | es\ Trados\ TWAW n by default). For the
purposes of this example, the demonstration TM Denp. t mw was configured as explained in the
section above (“Configuring a Translation Memory”).

4.4.1 Defining Project Settings

Let’s assume that you are about to start an English-German translation project for your client Pro
Software Inc. The document you will translate contains information on a new program by this
company. You have already translated several documents for Pro Software Inc. in the past, that’s
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why you have added the company’s name to the Clienr attribute picklist in the TM setup (see
“Defining Text and Attribute Fields: Example” above). Now you would like to add the
following information to each translation unit created during the new translation project:

e the name of your client, that is, Pro Sofrware Inc.

e the ID code of the document that you are going to translate. In this example, let’s assume
that the ID code is PROJ 98/105.

e youruser ID

e the overall domain of the translation project: Sofrware

Setting Text Field Contents

To add such text information as the 1D code PROJ 98/105 to each new translation unit, you

define a “translation project text field content.” Follow these steps:

1.  From the Settings menu in Translator’s Workbench, select Project Settings. This opens the
Translation Project Settings dialog.

Tranzlation Project Settings

Text Fieldz oK

|0 Code

Cancel

Help

il

TextField Cantent

Attribute Fields Attribute Picklist

Client
Cramain

Figure 4-15: The Translation Project Settings Dialog

2. 'This dialog displays the current setup of your TM with regard to text and attribute fields.
To define the ID Code, click in the Text Field Content input box and enter PROJ 98/105.
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Translation Project Settings

Test Field:

D Code

TextField Content

)8
Cancel

Help

il

PROJ 98108
Aftribute Fields Attribute Picklist

Domain

ID Code: PROJ 934105

Figure 4-16: Defining Text Field Contents For Translation Projects

Since the ID Code has been set up as a text field, you will be able to enter new contents at any
moment as needed. When you start a new translation project labelled PROJ 98/106, you will just
follow the same steps, and each new translation unit will then receive this new ID code.

Text field contents allow for any kind of free text, up to a length of 24 characters.

Setting Project Attributes

To add such project information as your client’s name, Pro Software Inc., and the domain,
Software, to each new translation unit, you define what is referred to as “translation project

attributes.” Follow these steps:

1. In the Translation Project Settings dialog, click the C/ient item in the Attribute Fields list.

The Client picklist appears.

2. Click the item Pro Sofrware Inc. on the Attribute Picklist.
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Translation Project Settings
Test Field:

=

Aftribute Fields

)8
Cancel

Help

dis

TextField Content
|PFID.J 3B105

Attribute Picklist

| Status

Domain

MWew Chemicals Ltd.
‘Pro Software [nc
Heavy Engineering & C

-

ID Code: PROJ 934105
Cliznt: Pra Software Ine.

Figure 4-17: Defining Translation Project Attributes

3. To set the second project attribute, click the Domain item in the Attribute Fields list and
then click on Sofrware. To confirm your text and attribute fields, click OK.

Notes

possible.

* You can choose several values at once from any attribute picklist. So you could for
example set several domains for each new translation unit or define several clients or
whatever attribute fields you define for your own TM.

*  Using the Show Project Settings option in the General tab of the Translation Memory
Options dialog, you can force Translator’'s Workbench to display the Translation Project
Settings dialog whenever a 'T'M is opened. This includes the start-up of the program.
Thus you can make sure to check your current translation project settings as often as

Each new translation unit will now get all the information we have just defined: your user ID
(via the Creation User and/or Change User system field), the ID Code PROJ 98/105, and the
project attributes Client: Pro Software Inc. and Domain: Software. A typical translation unit created
in the project will look like this:
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1 This is a sentence that was translated from English into German.
E Dies ist ein Satz, der vom Englischen ins Deutsche Ubersetzt wurde.

Additional TU information (system fields, text and attribute fields):

Creation Date: 20 September 1998
Creation User: MILLER

ID Code: PROJ 98/105

Client: Pro Software Inc.

Domain: Software

4.4.2 Using Project Attributes as Filters

Translator’s Workbench can use attributes as a filter when searching in a TM database. This
assures that given several possible target language sentences for the same source sentence, the
correct or desired translation will be found. To select filter attributes, follow these steps:

1. From the Settings menu in Translator’'s Workbench, select Filter. This opens the
Translation Memory Filters dialog.

Tranzlation Memory Filters
Attribute Fields Attribute Picklist
M
Client Approved Cancel |
Domain Read Orly

Help |

Figure 4-18: The Translation Memory Filters Dialog for the Demo TM

2. In this dialog, click on the attribute whose picklist item(s) you would like to select as
filter(s). For example, if you want to give all translation units with the project attribute
Domain: Software priority over other translation units, you would click on Domain in the
Attribute Fields list and then select the Soffware item on the picklist.

Now, if a database search finds several 100% or fuzzy matches, Translator’s Workbench selects
the match whose project attribute is included in the set of filter attributes. If the project attribute
does not match an active filter attribute, Translator’s Workbench chooses a translation unit from
another project.

Note

You can also “punish” translation units whose attributes don’t match the currently selected
filter attributes. This is explained in the following section, “Setting Translation Memory
Options,” under the heading of “Not Matching Attributes Penalty.”
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4.5 Translation Memory Options

To work with Translation Memories as effectively as possible, you can define various TM
options such as fuzziness, update modes, penalties, substitution settings, Concordance options
etc. To achieve this, from the Options menu in Translator’s Workbench, select Translation
Memory Options. This opens the Translation Memory Options dialog:

Translation Memory Options 1]

General IPenaItiesI Substibution Localisationl Concoldancel Toolz I

Minimum M atch Yalue % |ﬁ '—J—
b awimurm Mumber of Hits |5 —J—

i~ Switche
¥ Display Time [~ Show Project Settings
[ Copy Source on Mo-Match [~ Inser Blank after Tag

— Updating Attribute and Text Field

Uzed Translation Units: Changed Tranzlation Unitz:
' |eave Unchanged " Leave Unchanged

" Merge &+ Menge

 Ovenwrite  Ovenwrite

(u] 4 I Cancel | Help

Figure 4-19: The Translation Memory Options Dialog

The Translation Memory Options dialog consists of the following tabs: General, Penalties,
Substitution Localisation, Concordance, and Tools.

* In the General tab you set the fuzziness level for TM searching, activate certain switches as
convenient, and define update modes for text and attribute fields.

* In the Penalties tab you define how T'Us from alignments, machine translation, “wrong”
projects etc. should be “punished.”

* In the Substitution Localisation tab you specify how the format of variable elements such as
dates, time, numbers, measurements, and names should be adapted to the target language.

* In the Concordance tab you set the fuzziness level and other options for Concordance
searching.

e In the Tools tab, you set various options for the Analyse, Translate, and Cleanup batch

utilities from the Tools menu of Translator’s Workbench.

The different options are listed below in more detail, along with explanations and examples
where appropriate.
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4.5.1 Defining “General” Translation Memory Options

You use the General tab to set the fuzziness level for TM searching, activate certain switches as
convenient, and define update modes for text and attribute fields.

Minimum Match Value (%)

The Minimum Match Value expresses the degree of similarity between the source sentence and
the sentence found in T'M. The higher the value, the more similar the sentences. The more
dissimilar the sentences, the greater the amount of work required to adapt the suggested
translation. After a certain point, the differences are so great that displaying a suggested
translation no longer makes sense.

You can therefore set a boundary value in the Minimum Match Value box. Fuzzy matches that
fall below this value are not shown; they are treated as “No matches.” Translators will work with
different values according to their tastes and preferred work methods. Experience has shown
that the minimum match value will generally lie between 60% and 75%. To find your preferred
value, it’s best to start with a low value, say 50%, and increase it step by step until you find your
ideal value.

Maximum Number of Hits

Use the Maximum Number of Hits value to define how many sentence matches Translator’s
Workbench collects as a maximum before displaying them in its program window. You can set a
Maximum Number of Hits value between 1 and 99, the default is 5. Let’s assume that a sentence
to be translated has five similar sentences in TM whose fuzziness ranges from 98% to 75%. In
this case, at a Maximum Number of Hits value of 5, Translator’s Workbench will collect all these
matches and display the one with the highest fuzziness value (98%) as “best match.” You can
access the four lower-percentage matches by clicking on the match selection buttons in
Translator’s Workbench’s program window.

= TRADOS Translator's Workbench - Demo
File  Settings Miew Options Toolz Help
Changed on: - 27/02/35 ¥ Thig is another sentence
Changed by:  MULLER . ’
Uzage: 0

This is yet another sentence.
B Dics ist noch ein weiterer Satz.

85% < |{BAE| > 7%

|842 Fuzap Match -+ [atch 20f 3>

Figure 4-20: Choosing Among Different Matches

Note

The higher the Maximum Number of Hits value, the longer it takes Translator’s Workbench to
search Translation Memory. It makes a considerable difference for the performance of
T'ranslator’s Workbench whether it has to look for 20 potential fuzzy matches or for only five.
That’s why we recommend you work around a value of five hits. This will be an absolutely
satisfactory setting for everyday translation purposes.
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Translation Memory Switches

Use the Switches group box in the General tab to set the following options as convenient:

e Display Time: Check this option if you want to display the time in the system fields Creation
Date, Change Date, and Used Date in addition to the date itself.

*  Show Project Settings: Check this option if you want Translator’s Workbench to bring up
the Project Settings dialog each time you start the program or open a TM.

e Copy Source on No-Match: Check this option if you want Translator’s Workbench to copy
the source sentence to the target field each time it cannot find a match in Translation
Memory.

* Insert Blank After Tag: Check this option if you want Translator’s Workbench to
automatically insert a blank after each tag you place in the target field. For more
information, see the “Internal Tags and Blanks” section in the “T'ranslating Tagged Files
with Translator’s Workbench and TagEditor” chapter.

How Translation Memory Is Updated

Updating Attribute and T ext Field

Uszed Tranzlation Units: Changed Transzlation Units:
' Leave Unchanged " Leave Unchanged

" Merge ' Merge

© Ovenarite © Ovensiite

Figure 4-21: Translation Memory Options for Updating Translation Units

The two Translation Memory options depicted above can only be explained by taking a close
look at how Translation Memory is updated.

As you work your way through a text, the TM is automatically updated in the background. The
basic principle to keep in mind is that a Translation Memory does #or contain duplicate
translation units: there is only one translation allowed for a given source sentence and set of
project attributes. For instance, there cannot be two different translations for the same sentence,
the same client, and the same domain. Otherwise the coherence and consistence of your
translations would be impaired. When translating with Translator’'s Workbench, four basic
situations arise which have an impact on how Translation Memory is updated:

e (Case 1: you translate the new sentence from scratch

e Case 2: Translator’s Workbench finds a 100% match in 'T'M for the new sentence, and you
don’t make any changes

* Case 3: Translator’s Workbench finds a 100% match in TM for the new sentence, and you
do make changes

e (Case 4: Translator’s Workbench finds one or several fuzzy matches for the new sentence,

and you edit the translation as needed

Let’s explain what happens in these four cases one by one.

Case 1: Entering New Translations From Scratch

Each sentence you translate from scratch is stored in TM with its translation. If you have set any
translation project attributes or text field contents, they will be attached to the sentences as
additional information. Together with the system fields, the sentences, text and attribute fields
form a new translation unit in TM.
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Case 1: Entering New Translations From Scratch

New sentence?

No Continue with
Case 2, 3,0r 4

Yes

v

Enter & confirm
translation

l

Translator's Workbench creates a new translation
unit and adds system, text, and attribute fields as
currently defined

End

Figure 4-22: Entering New Translations

Case 2: Updating Attribute and Text Fields of Used Translation Units

If a 100% match is found, and you 4oz’ make any changes, the two system fields Usage Counter
and Used Date of the matching translation unit are updated, if applicable. Beyond that, the
current Updating Attributes and Text Fields of Used Translation Units setting determines what
should happen to the text and attribute fields of the 100% matching TM translation unit
(TMTU):

* they should stay untouched: the Leave Unchanged option is selected

e they should be merged with the currently selected project settings: the Merge option is
selected

* they should be replaced by the currently selected project settings: the Overwrite option is
selected

When you choose Leave Unchanged, the attributes and text fields of the TMTU stay the same.
Currently selected project settings are ignored by Translator’s Workbench, even if they differ
from those in the TMTU.

When you choose Merge, the attributes and text fields of the TMTU are merged with the
currently selected project settings. If there is a new text field, it is added to the text fields of the
TMTU. If a new attribute picklist item, for example the name of a client, is selected as a project
setting, it is added to the attributes already present in the TM'TU.

When you choose Overwrite, the currently selected project attributes and text fields replace
those of the TMTU.

The following flowchart sums up what has just been said. An example follows after that.
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Case 2: Accepting 100% Matching Translations As Is

New sentence?

No

100% match?

Accept translation as is?

Yes

v

Update system fields "Usage
Counter" and "Used Date" in the
100% matching TMTU

l

No

Continue with
Case 1

Continue with
Case 4

No Continue with
Case 3

TMTU = Translation
Memory Translation
Unit

Compare currently selected translation project
attribute and text fields with those of the TMTU

Leave Unchanged

Merge

Overwrite

fields of the TMTU, ignore currently
selected attribute and text fields

Do not change the attributes and text

Add new attributes and text
fields to those in the TMTU as
required

Replace the TMTU's text and
attribute fields with currently selected
ones

Figure 4-23: Accepting 100% Matching Translations As Is

Example:

Let’s assume the following sentence occurs in your English-German translation project:

Thank you for purchasing our video recorder VR101.

Furthermore, you have selected the following project settings:

text field content: Project Code: Trans 1998/107
attribute: Client: ConsumE lectro Inc.

attribute: Domain: Electronics

Translator’s Workbench analyses the sentence above and finds the following 100% matching
translation unit in the TM:
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Ealed  Thank you for purchasing our video recorder VR101.
E Vielen Dank fur den Kauf unseres Videorecorders VR101.

System Fields:

Creation User: MILLER
Creation Date: 05/05/95
Change User: SMITH
Change Date: 10/06/97
Usage Counter: 10

Attribute Fields:

Client: ConsumElectro Inc., VideoSys Ltd.
Domain: Audio/Video
Status: Approved

Text Fields:
Project Code: Trans 1995/122

You accept this translation as is. In this case, what happens to the attributes and text fields of the

translation unit you just used? This is where the Updating Attribute and Text Fields setting for
Used Translation Units comes into play:

* Leave Unchanged: The text and attribute fields of the above TU stay exactly the same,
your project settings are ignored. As far as the project attribute Client: ConsumElectro Inc. is
concerned, this doesn’t matter: it was already present in the TMTU. However, the other
project attribute you set, that is, Domain: Electronics, is not added to the TMTU. Likewise,
the project code of the new translation, Trans 1998/107, is not added to the corresponding
text field. The Usage Counter is incremented to 11.

* Merge: The information contained in your project settings is added to the TMTU as
follows: 'The Electronics value is merged into the Domain attribute. The text field Project
Code, up to now filled with the information 7rans 1995/122, is completed with the
information Trans 1998/107. The other information in the TMTU stays untouched. To sum
things up, it will now look like this:

2l Thank you for purchasing our video recorder VR101.
E Vielen Dank fur den Kauf unseres Videorecorders VR101.

System Fields

Creation User: MILLER
Creation Date: 05/05/95
Change User: SMITH
Change Date: 10/06/97
Usage Counter: 11

Attribute Fields

Client: ConsumElectro Inc., VideoSys Ltd.
Domain: Audio/Video, Electronics
Status: Approved

Text Fields
Project Code: Trans 1995/122, Trans 1998/107
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*  Overwrite: The current project settings replace those in the TMTU. In our example, after
you have accepted the translation, the translation unit will look like this:

il Thank you for purchasing our video recorder VR101.

E Vielen Dank fiir den Kauf unseres Videorecorders VR101.

System Fields

Creation User: MILLER
Creation Date: 05/05/95
Change User: SMITH
Change Date: 10/06/97
Usage Counter: 11

Attribute Fields

Client: ConsumElectro Inc.
Domain: Electronics

Text Fields
Project Code: Trans 1998/107

The attributes Client: VideoSys Ltd., Status: Approved, and Domain: Audio/Video have disappeared,
as well as the contents Trans 1995/122 of the Project Code text field. The current project settings
have been added to the TMTU instead.

Recommendations

e Merging project settings with existing translation units is the safest way to keep as much
information in your translation units as possible. Old attributes and text fields are kept,
new items are added as needed. On the other hand, heavily used translation units can
soon become quite large with respect to attribute and text field contents.

* To keep project information of translation units at a certain sfafus quo, you might choose to
leave unchanged attributes and text fields of existing translation units. New project settings
are not added to existing translation units.

e Choosing Overwrite is the most “dangerous” option for used translation units, since all
former attribute and text field contents are lost once you replace them with the current
project settings. Still, it might be useful to “clean up” translation units this way, stripping
them of information that is no longer needed.

Choosing the most appropriate option depends on yo#r mode of working, on your translation
context.

Case 3: Updating Attribute and Text Fields of Changed Translation Units

This option is only relevant under the following conditions:

e a100% match is found;
* you change the target sentence;

* the currently selected project settings are a subser of the project settings of the 100%
matching TU.

In this case,

e the Leave Unchanged option will replace the old target-language sentence with the new one
and leave the project settings in the T'U untouched

* the Merge option will also replace the old target-language sentence with the new one and
leave the project settings in the T'U untouched (since they are a superset anyway)

Translator’s Workbench, © 1994-99 by " TRADOS GmbH




4-38

Translation Memory

the Overwrite option will overwrite the TU’s attributes and text fields with the currently

selected project settings and will replace the old target sentence with the new one

The flowchart below sums up what has just been said.

Case 3: Modifying 100% Matching Translations

New sentence?

No

100% match?

Yes

Modify translation?

Yes

No

Continue with
Case 1

Continue with
Case 4

No. Continue with
Case 2

Compare currently selected translation project
attribute and text fields with those of the TMTU

Leave Unchanged

Are the current project
settings a subset of the TMTU's
project settings?

Yes

Look at Updating Attribute
and Text Fields: Changed
Translation Units Setting

Merge

|

Create a new translation unit
and add system, text, and
attribute fields as currently

defined

Overwrite

Replace the old target sentence with
the new one, leave attribute and text
fields of TMTU untouched

Replace the old target sentence with

the new one, leave attribute and text

fields of TMTU untouched (since they
are a superset anyway)

selected project settings and replace

Overwrite the TMTU's attributes
and text fields with the currently

the old target sentence with the new
one

Figure 4-24: Modifying 100% Matching Translations

Note

The default Translation Memory Options setting for Attributes and Text Fields of Changed
Translation Units is Merge, which means that if you change a translation, the translation in the
corresponding translation unit is replaced, and any project attributes are merged, as described
above. Workbench always applies this merging algorithm to the translation unit currently
displayed in the Workbench Source window. Thus, if the current project attribute setting is
different from the attribute of the displayed translation unit, a new unit will be added to 'TM
regardless of whether another translation unit with the same attribute already exists. To avoid
creating multiple translation units for the same source sentence, always set the Filter to the
same attribute(s) as the Project Settings. This will cause the translation unit with matching
attribute(s) to be displayed and thus updated.

Translator’s Workbench, © 1994-99 by " TRADOS GmbH




Translation Memory Options 4-39

Case 4: Fuzzy Matches

Fuzzy matches occur much more frequently than 100% matches. Fuzzy matching is the process
by which Translator’s Workbench looks for one or more sentences in Translation Memory that
are as similar as possible to the source sentence. We will refer to the sentence from Translation
Memory as Translation Memory sentence (TM sentence). Fuzzy matching is based on the
assumption that the similarity between source sentences will also exist between the TM
sentence’s translation and the translation you’re creating. Exact matches with penalties (Not
Matching Attributes, Formatting, etc.) are also regarded as fuzzy matches.

The similarity between the source sentence and the database sentence, as explained above, is
expressed as a percentage value. This match value is displayed in Translator’'s Workbench’s
program window. If Translator’s Workbench finds more than one fuzzy match, it treats the most
similar match as “best match” and displays it in the Translation Memory window. You can

choose between different matches by clicking on the match selection buttons in T'ranslator’s
Workbench’s program window.

TRADODS Tranzlator's Workbench - Demo

File Settings Wiew Options Toolz Help

EE::gzg E: EEEEE?:‘S W This is . another sentence.

zage: 0

his is yet another sentence.

E8 Dics ist noch ein weiterer Satz.

85% ¢ |34z|—m

|84‘Z Fuzzy Match

o B CMatch 2 of 30

Figure 4-25: Choosing Among Different Matches

If a fuzzy match is found, then a new translation unit is created in Translation Memory. The
current project settings (attributes and text fields) become the project information for the new
translation unit. The Usage Counter of the old (fuzzy match) translation unit is incremented, and

the newly created one gets the currently selected user ID if the current Translation Memory
contains the system fields Creation User or Change User.

The following flowchart sums up what has just been said.
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Case 4: Fuzzy Match

Continue with
Case 1

New sentence?

N

o
100% Match? Yes

No

v

Continue with
Case 2o0r3

Adapt fuzzy-match
translation as needed

l

Translator's Workbench creates a new translation
unit and adds system, text, and attribute fields as
currently defined

Figure 4-26: Editing a Fuzzy Match

4.5.2 Defining “Penalties”

You use the Penalties tab of the Translation Memory Options dialog to define how TUs with
formatting differences or TUs from alignments, machine translation, “wrong” projects etc.

should be “punished.”

Tranzlation Memory Options

General  Penalties |Substituti0n Localisationl Concoldancel Tools I

Formatting Differences Penalty % -J—
Mot matching Attributes Penalty % |2_ '—Ji
Placeable Differences Penalty % |2— —J—

Alignment Penalty % |3— J—

Machine Translation Penalty % IT -—J—

Apply Placeable Penalty also when Source Tags differ [T

Ok I Cancel

Help

Figure 4-27: The Penalties Tab
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Formatting Differences Penalty (%)

When comparing the current source sentence with the TM sentences, Translator’s Workbench
not only evaluates linguistic differences, but can also take formatting into account. Let’s suppose
the current source sentence reads T7%e VR 101 is our brilliant new video recorder. In this case, the
author chose bold formatting for the adjective phrase brilliant new. Suppose that in your TM,
there is a linguistically 100% identical sentence with different formatting: 7%e VR 101 is our
brilliant new video recorder. In this instance, the adjective phrase does not carry a special
formatting.

In contrast to all other TM systems on the market, Translator’s Workbench recognises an “exact
match,” but reduces the match value by 1% because of the formatting difference:

:EE. TRADOS Translator's Workbench - Demo

File  Settings Miew Options Toolz Help

Changed or: - 27/02/38 B¥ The /R 101 is our brilliant new video recorder
Changed by:  MULLER ’

Uzage: 1

The %R 101 is our brilliant new video recorder.

== Der R 101 ist unser genialer neuer Videorecarder.

< |eax| - |

|EHact Matck@ % FormattingD

=] idatch1 of 1

Figure 4-28: Example of Formatting Penalty

Formatting penalties are not only valid for 100% matching sentences but also for fuzzy matches.
You can choose a value between 0 and 20%. The default is one percent per formatting
difference, since formatting differences are not as important as linguistic ones.

Not Matching Attributes Penalty (%)

It’s best to explain the Not Matching Attributes Penalty with the help of an example.

As was explained at the beginning of this chapter, a TM is made up of translation units (T Us)
that, as a minimum, contain a source-language sentence together with its target-language
equivalent. However, TUs will often also contain classifying information in the form of such
attributes as client, domain, etc. Let us suppose that you have translated the sentence Press the
[Enter] key to continue during two translation projects, one for Pro Software Inc., the other one for
BetaSoft Unlimited. Pro Software Inc. required you to translate [Enter] key with [FEingabetaste]
into German, whereas BetaSoft wanted you to translate it with /Return]-Taste. To keep these two
translations separate, you decided to define two different project attributes for them: Client: Pro
Software Inc. and Client: BetaSoft Unlimited. As a result, Translator’s Workbench created two
different T'Us for these two different translations of the same source-language sentence:

TU for Pro Software Inc.:

Press the [Enter] key to continue.

®= Dricken Sie die [Eingabetaste], um fortzufahren.
Client: Pro Software Inc.

TU for BetaSoft Unlimited:

3 Press the [Enter] key to continue.

E Driicken Sie die [Return]-Taste, um fortzufahren.
Client: BetaSoft Unlimited
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Suppose now that you’re starting a new translation for Pro Software Inc. and set the
corresponding filter attribute (Client: Pro Software Inc.) before translating, as explained above
under “Using Project Attributes as Filters.”

Now, if the sentence Press the [Enter] key to continue occurs in your new translation project,
Translator’s Workbench will find 7wo identical matches in its TM. Only one, however, has the
“right” project attribute: Client: Pro Software Inc.. This is where the Not Matching Attributes
Penalty comes into play: at a penalty value of, say, 2%, Translator’s Workbench will treat the
“wrong” match as a 98% match only. Even if the sentence itself is of course 100% identical, its
attributes are not 100% identical with the selected filter attributes, and Translator’s Workbench
“punishes” this with the penalty.

:EE. TRADOS Translator's Workbench - Demo

File  Settings Miew Options Toolz Help

EE:QS:S E: EEEEE?:? B¥ Press the [Enter] key to continue.

Uzage: 0

Llient: BetaSoft Unlimited

Press the [Enter] key to continue.
™= Dricken Sie die [Retumn]-Taste, um fortzufahren.

w0z 9sz| > |

=== bfatch 2 of 2

| Exact Match, -2% Attlibute(ﬂﬂ:_ﬁo Software Inc.

Figure 4-29: Example of Not Matching Attributes Penalty

Note that in the case of several project attributes, T'ranslator’s Workbench decreases the match
value by 2% every time a project attribute does not match the currently selected filter attributes.
Thus, for a 100% identical sentence with four “wrong” project attributes, Translator’s
Workbench will display a match value of only 92%.

You can set a Not Matching Attributes Penalty value between 0 and 20%. The default is 2%.

Placeables Difference Penalty (%)

This penalty is only relevant under the following conditions:

* the segment you are translating contains placeables (in most cases, tags);
e amatch for the segment is found in TM;

e the tags in the target segment differ from the source segment of the matching TU. As a
result, Translator’s Workbench cannot place tags automatically in the new translation.

In this case Translator’'s Workbench applies the Placeables Difference Penalty. The penalty is
not only valid for 100% matching sentences, but also for fuzzy matches. You can choose a value
between 0 and 20%. The default is 2%.

Example

When comparing the current source sentence with the TM sentences, Translator’'s Workbench
not only evaluates linguistic differences, but can also take tagging into account.

When Translator’'s Workbench matches sentences containing tags with segments in TM, the
program always tries to automatically determine the tagging order for the new target sentence by
comparing it to the matching TU. In ideal circumstances, the source and target of a T'U contain
the same tags in the same positions. This, of course, poses no problem. Even if tags occur in a
different sequence in the target segment of the TU, as long as the same tags are used,
Translator’s Workbench will be able to correctly determine the tagging order.
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As soon as the tags in the target segment of the TMTU differ from those of the source, however,
Translator’s Workbench cannot be sure to correctly place the tags for the new translation. This is
where the Placeables Difference Penalty comes into play.

For instance, let’s suppose you have to translate the sentence:

The VR 101 is our <B>brilliant new</B> video recorder.

There are tags before and after the adjective phrase brilliant new.

Suppose that in your current TM, Translator’s Workbench can find the following TU with the
same text but with different tagging in the source and target segments:

i

Faled The VR 101 is our <I>brilliant new</I> video recorder.
E Der VR 101 ist unser <u>toller neuer</u> Videorecorder.

In the translation, the tagging differs from the source sentence. Rather than proposing a 100%
match, using the <B> and </B> tags from the new source sentence--which might result in
incorrect tagging in the new target--, Translator’s Workbench will propose the following target
sentence and apply a Placeables Difference Penalty:

Der VR101 ist unser <u>toller neuer</u> Videorecorder.

Now you can decide whether you want to accept the tagging of the TM target sentence, or
whether you want to use the new tags from the new source sentence.

Apply Placeable Penalty also when Source Tags differ: Use this check box if you want to apply
the Placeable Differences Penalty every time the tags in the new sentence differ from those of
the source segment from the TM. Normally, Translator’s Workbench tries to automatically
substitute changed tags in the new translation, as described in the example above. You can de-
activate this behaviour and a/ways apply the Placeable Differences Penalty as soon as there is a
difference between the tags of the new source sentence and those of the matching TM source
sentence.

Alignment Penalty (in %)

As has already been mentioned in the “Create Translation Memories” section, " TRADOS offers
a tool called WinAlign that generates Translation Memories from existing documents and their
translations. It is an interactive, very flexible and versatile tool, offering a wide range of options
to help you get optimum alignment results. These results are available as files that you import
into Translator’'s Workbench. See the section on “Importing and Exporting Translation
Memories” and the WinAlign User’s Guide and product information on the Web at
http://ww.trados. conf wi nal i gn for more information.

Despite its alignment power, it may happen that parts of your texts are “misaligned,” that is,
they don’t actually represent sentence pairs that are translations of each other. This is why
Translator’s Workbench offers you the possibility to set a “penalty” for translation units that
have been created by WinAlign (or its predecessor TAlign). A typical WinAlign-generated TU
will look like this:

i

Ealid  Press [F1] for help.
= Dricken Sie die Taste [F1], um Hilfe zu erhalten.
Change User: WinAlign!
Change Date: 01/01/98

If the sentence Press [F1] for help occurs in your translation project, Translator’s Workbench will
obviously find the above sentence in the TM as an exact match, but will deduct 3%, which is the
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default percentage for the Alignment Penalty. Once you confirm the translation, your user ID
will replace WinAlign! as the Change User in the translation unit, which makes the Alignment
Penalty obsolete. You can define a value between 0 to 20% for the Alignment Penalty. The
default is 3%.

Machine Translation Penalty (in %)

Machine Translation (MT) systems offer the possibility to translate texts automatically.
However, in many cases, these translations are prone to a variety of errors—at least if you
consider the current state of the art. Still, in some contexts, they can be useful for pre-translation
purposes of technical documentation. Against this background, it is useful that Translator’s
Workbench treats translation units created by M'T systems differently than those created by
“human” translators.

This is what the Machine Translation Penalty is there for. By default, it is set at 15%. Thus, even
if T'ranslator’s Workbench finds a perfect match for a new sentence in the Translation Memory,
it will display a match value of only 85% if the corresponding 'T'U was created by an M'T system.

Example:

Falid Press [F3] if you would like to continue.

E Drucken [F3] wenn Sie wirden mdgen zu fortsetzen.
Creation User: MT!

Creation Date: 01/01/98

Now, if the sentence Press [F3] if you would like to continue occurs, T'ranslator’s Workbench will
obviously find the above sentence in the TM as an exact match, but will deduct 15%, which is
the default percentage for the Machine Translation Penalty. Once you confirm the translation,
your user ID will replace MT! as the Change User in the translation unit, which makes the
Machine Translation Penalty obsolete. You can define a value between 0 to 20% for the Machine
Translation Penalty.

4.5.3 Defining “Substitution Localisation” Settings

You use the Substitution Localisation tab of the Translation Memory Options dialog to specify if,
and how, Translator’s Workbench should automatically adapt the format of such variable
elements as numbers, dates, etc. to the target language during translation. Depending on how
your TM has been set up, you can define substitution localisation settings for Dates, Time,
Numbers, Measurements, and Names as explained below.
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Translation Memory Options E

Generall Penalties  Substitution Localizatian I Concoldancel

v Dates
Calendar Type IGregorianischel Kalender j
Shart Date | dd M.y =] [z20298
Long Date [ MbMM =] [23Maz 1398
[+ Times
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Diigit Grouping I j |1.234.58?,89
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Measurement System IMe"iC j
¥ Mames: Use Localized Form of Address
Other Substitutions: Acranyns, Yariable Lists

(u] 4 I Catcel | Help

Figure 4-30: The Substitution Localisation Tab

Important

If one or more options in the Substitution Localisation tab are greyed out, this means that the
TM has not (yet) been set up to automatically replace the corresponding elements. See
“Defining Automatic Substitutions” in the “Configuring a Translation Memory” section
above.

Defining Substitution Settings for Dates

The Calendar Type drop-down box shows which calendar is being used. The options in this box
are determined by the regional settings defined in the Windows setup of the target language of
your T'M. Translator’s Workbench can switch calendar types during translation if necessary. This
is especially useful for translation into languages that use a calendar type different from the
Gregorian Calendar, such as Japanese and Chinese. Use the Short Date and Long Date boxes to
change the way the short and long date formats in the source language are adapted to the target
language during translation.

The following calendar types are supported by Translator’s Workbench for the automatic
substitution localisation feature:

e Gregorian calendar

e Japanese Era: Year of the Emperor

*  Year of the Republic of China (Taiwan)

e Tangun Era (Korea)

e Hijri (Arabia, some countries)

e Thai calendar

J Hebrew calendar
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Examples

Short Dates

Let’s suppose the following sentence occurs in your English (UK)-German translation: 7oday is
19/03/98. In this example, Translator’s Workbench will recognise 79/03/98 as a short date and
display it as a placeable. When you place the date in the target sentence, the program looks at
the setting in the Short Date box of the Substitution Localisation dialog. If you have defined the
date format dd.MM.yy for German short dates, the transferred date will be inserted as 79.03.98.

:EE. TRADOS Translator's Workbench - Demo

File  Settingz Miew Options Toolz Help

Changed on; T ;
Changed by, Today is 19/03/93.

Uzage:

< |

|N0 matchl

|

Figure 4-31: Recognising Dates as Placeables

Long Dates

Let’s suppose the following sentence occurs in your English (UK)-German translation: 7oday is
19 March 1998. In this example, Translator’s Workbench will recognise 79 March 1998 as a long
date and display it as a placeable. When you place the date in the target sentence, the program
looks at the setting in the Long Date box of the Substitution Localisation dialog. If you have
defined the date format & MMMAM. yyyy for German long dates, the transferred date will be
inserted as /9. Mdarz 1998.
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Note

If a sentence with the same wording but a different date occurs, Translator’s Workbench will
still be able to produce a 100% match and transfer the new date in the correct target-language
format to your word processor.

22 TRADOS Translator's Workbench - Demo
File Settingz “iew Options Toolz Help

Changed o 23/03/98, 1233 [ Today is 75 Sentember 1959
Changed by:  BROCKMANN BB Today is 25 September 1999
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ﬁ File Edit Yiew Insert Format Tools Table Window Help Trados ;Iilﬂ|
DeHaRy|i 2Bt n-o a@
Marmal ~  Arial -z ~| B I U ”EEE =
o v F o @W[ Y | s o & eS|
Today is 25 September 1999, a

-
+
—_ =]
¥
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Figure 4-32: Recognising and Automatically Substituting Variable Elements

Defining Substitution Settings for Time Specifications

Use the Time Style box to change the way how the time format in the source language is adapted
to the target language during translation.

Example

Let’s suppose the following sentence occurs in your English (UK)-German translation: 7%e new
German chancellor will arrive ar 10:45. In this example, Translator’s Workbench will recognise
10:45 as a time specification and display it as a placeable. When you place the time specification
in the target sentence, the program looks at the setting in the Time Style box of the Substitution
Localisation dialog. If you have defined, say, the style H.mm’ Ukr for German time
specifications, for instance, the transferred time will be correctly adapted and inserted as 70.45

Uhr.

Note

If a sentence with the same wording but a different time specification occurs, Translator’s
Workbench will still be able to produce a 100% match and transfer the new time in the correct
target-language format to your word processor.

Defining Substitution Settings for Numbers

You use the Digit Grouping box to specify the symbol that is used in the target language to group
the digits in large numbers. Use the Decimal Symbol box to specify which symbol indicates
decimal values in the target language.
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Examples

Let’s suppose the following sentence occurs in your English (UK)-German translation: 7oday, the
DAX was down 11.98 points (= 0.55%) to 4,312.79. In this example, Translator’s Workbench will
recognise all numbers (even the percentage specification) and display them as placeables. When
you place the numbers in the target sentence, the program looks at the settings in the Digit
Grouping and Decimal Symbol box of the Substitution Localisation dialog. By default, the dot
(*.”) is the digit grouping symbol and the comma (“,”) the decimal symbol in German. (So it’s
exactly the other way round as in English.) As a result, the numbers will be correctly transferred

as 11,98, 0,55%, and 4.312,79.

Note

If a sentence with the same wording but different numbers occurs, Translator’s Workbench
will still be able to produce a 100% match and transfer the new numbers in the correct target-
language format to the target field in your word processor.

Defining Substitution Settings for Measurements

You use the Measurement System box to determine which system of measurement is used in the
target language. Translator’'s Workbench can automatically switch the measurement system
during translation and determine the correct value for the new measurement unit. For instance,
the measurement 3 /z will be automatically “translated” to 7,62 ¢m during translation from
English to German.

Supported Measurement Units

The following measurement systems and units are supported by Translator’s Workbench for the
automatic substitution localisation feature:

Metric System
* Length: Millimetre (mm), centimetre (cm), decimetre (dm), and kilometre (km).

e Area: Square millimetre (mm?), square centimetre (cm?), square meter (m?2), are (a), hectare
(ha), and square kilometre (km?).

e Mass: Milligram (mg), gram (gr), kilogram (kg), and metric ton (t).

e (Capacity: Millilitre (ml), cubic centimetre (cm3), centilitre (cl), decilitre (dl), litter (1), and
cubic meter (m?3).

British Imperial System

* Length: Inches (inch, inches, in), foot (feet, foot, ft), yard (yard, yards, yd), furlong
(furlong), and miles (mile, miles, mi).

e Area: Square inch (sq in, in?), square foot (sq ft, ft?), square yard (sq yd, yd?), acre (acre,
acres), and square mile (sq mi, mi?).

*  Avoirdupois weight/mass: Avoirdupois ounce (oz avdp, 0z), avoirdupois pound (Ib avdp, #,
Ib), stone, short hundredweight (short cwt), long hundredweight (long cwt), short ton, and
long ton.

e Capacity (British imperial liquid and dry measure): UK fluid ounce (fl oz), UK pint (pt), UK
quart (qt), UK bushel (bu), and UK gallon (gal).

e USliquid measure: US fluid ounce (fl oz), US fluid pint (pt), and US fluid gallon (gal).
e USdry measure: US dry pint (pt) and US dry bushel (bu).
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Temperature Conversion

Degrees Centigrade (°C), degrees Fahrenheit (°F), and degrees Kelvin (°K).

Examples

Let’s suppose the following sentence occurs in your English (US)-German translation: Mary is
used to working in temperatures as high as 105°F. In this example, Translator’s Workbench will
recognise /05°F as a temperature measurement specification and displays it as a placeable. When
you place the measurement in the target sentence, the program looks whether the Measurement
option in the Substitution Localisation dialog is checked. If it is, Translator’s Workbench will
convert the temperature to °C (as used in Germany) and insert it as 40,56°C.

Notes

e If a sentence with the same wording but a different measurement specification occurs,
Translator’s Workbench will still be able to produce a 100% match and transfer the new
measurement in the correct target-language format to your word processor.

e In the case of the metric vs. the U.S. measurement system, you can use the Measurement
System box to determine which system of measurement is used in the target language.
"This way you can avoid undesired conversions of, say, inches, to centimetres.

4.5.4 Defining Options for Concordance Searching

You use the Concordance tab of the Translation Memory Options dialog to specify some settings
for the Concordance function of Translator’s Workbench. For more information, please refer to
the chapter “Working With Bilingual Concordances.”

4.5.5 Defining Options for Translator's Workbench's Batch Tools

You use the Tools tab to set various options for the Analyse, Translate, and Cleanup batch
utilities from the Tools menu of T'ranslator’s Workbench.

Translation Memory Options

Generall F'enaltiesl Substitution Localisationl Concordance  Tools |

— Switches
¥ Stip Unused Fonts [ Stip Thwidbafin Styles
[ Strip Unused Styles v Keep Backup

¥ Multi-Segment Footnates (word 8 and later]

—DTD Settings File:

HTML  [C:\Program Files\TRAD OS5 TwW4win\HTML4.ini

7 [

SGEML |D:\F'rogram Files\TRADD ST W it b yD T D ini

0K I Cancel Help

Figure 4-33: The Tools Tab
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Setting Options for the Processing of “Normal” Word Documents

You use the Switches group box to set the following options as convenient (these switches are
only valid for the interface between Translator’s Workbench and Word):

e Strip Unused Fonts: Check this option if you want Translator’s Workbench to remove all
unused fonts from documents during batch translation or cleanup. For more information, see
the “Style and Font Issues” section in the “Tips & Tricks” chapter of the online Help and
the “Document Analysis, Translation and Cleanup” chapter.

*  Strip Unused Styles: Check this option if you want Translator’'s Workbench to remove all
unused styles from documents during batch translation or cleanup. For more information,
see the “Style and Font Issues” section in the “Tips & Tricks” chapter of the online Help
and the “Document Analysis, Translation and Cleanup” chapter.

e Strip TW4Win Styles: Check this option if you want Translator’s Workbench to remove all
of its styles (rdwinExternal, rwdwinlnternal, rwdwinlerm, etc.) during cleanup. See the
“Document Analysis, Translation and Cleanup” chapter.

*  Keep Backup: Check this option if you want Translator’s Workbench to create a backup file
(extension . bak) of each document processed by the Translate and Cleanup batch tools.
See the “Document Analysis, Translation and Cleanup” chapter.

e Multi-Segment Footnotes (Word 8 and later): Check this option if you work with Word 97
documents and therefore want to benefit from the multi-segment footnote handling not only
in interactive mode, but also in batch mode. For more information on multi-segment
footnotes, see the “Footnote Handling in Batch Mode” section in the “Interface Between
Translator’s Workbench and Word” chapter. This feature is only available for Word 97 or
later. If you work with Word 7.0 or earlier, uncheck this option.

Setting Options for the Batch Processing of SGML/HTML Files

In the DTD Settings Files group box, you specify which initialisation files Translator’s
Workbench should use when analysing, batch-translating or cleaning up HTML and/or SGML
files. D'TD settings files are created and maintained using the DTD Settings Wizard of
TRADOS TagEditor. For more information, see the “Translating Tagged Files With
Translator’s Workbench and TagEditor” chapter or the online Help of TagEditor.

4.6 Maintaining Translation Memories

The longer you work with a Translation Memory, the larger it gets. When several people are
using the same TM over a network, it will grow even more quickly. So it is essential to always
have the maximum possible control over the contents in the 'T'M and to be able to modify them
at a global level, if required. Translator’s Workbench offers ways to directly edit TM contents at
two levels:

* Spot editing: You can edit or delete any translation unit from the Concordance window or
the TM window at any time, provided you have write access to the TM. Procedures are
described under “Editing & Deleting Translation Units” below.

e Global editing: You can also modify the T'M contents at a more global level via the
Maintenance function. See “I'ranslation Memory Maintenance” below.

A further, more indirect possibility to globally change a TM is to export its contents, modify
them in the exported text file in any word processor, and to re-import the file into a new TM.
See the “Importing and Exporting Translation Memories” chapter for more information.
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4.6.1 Editing & Deleting Translation Units

When translating your documents, you might make mistakes that you will only realise after
storing the translation in Translation Memory. Other corrections might be given to you by an
editor after revising the translation. In both cases, you will want to make the corrections not only
in your target text, but also in Translation Memory. This is why Translator’s Workbench offers
possibilities to edit and delete translation units from the Concordance or Translation Memory
window. Follow these steps:

1. In Translator’s Workbench, open the Translation Memory that you want to edit, if you have
not already done so.

2. Perform a Concordance search to identify the sentences that need editing. To achieve this,
from the Tools menu, select the Concordance command, or press [F3]. Enter one of the
words of the source sentence to be edited. After that, click the Search button. This will start
the Concordance search and bring up the Concordance window containing all translation
units containing your search criterion.

Concordance E

. Search
Enter search string:

Catcel

I fuzzy|
Optiots. ..

udd

Help

Figure 4-34: Performing a Concordance Search

3. Look for the translation unit you would like to edit or delete.

4. Move the mouse pointer to one of the flags preceding the translation unit in question and
press the right mouse button or press [Shift] + [F10]. This opens the translation unit context
menu. [t contains two commands: Edit Translation Unit and Delete Translation Unit.

“fuzzp” [6 Hits)

uzzy terminology recognition, together with the concordance option mentioned above, leave virtually =]
nothing to be desired in terms of powerful, user-friendly search functions.

B8 7usammen mit der oben erwdhnten Konkordanzoption stehen lhnen also nun Suchfunktionen zur
“Werflgung, deren Leistungsfahigkeit und Benutzerfreundlichkeit keine Wilnsche mehr offen lassen darften.

PP O |

"’:' =Sy matching algorithm that finds similar sentences with lightning speed and enables
L on g several different matches

B8 Delete Translation Unit — hing-Algorithmus, der pfeilschnell inhaltlich ghnliche Satze findet und
Auswahlmdglichkeiten bietet

Figure 4-35: The Translation Unit Context Menu

e To remove the translation unit from Translation Memory, select Delete Translation
Unit. This highlights the T'U, and Translator’s Workbench asks whether you really want
to delete it or not. Choose Yes to irreversibly remove it. This action cannot be undone.
Choose No to return to the Concordance window.

* To modify the translation unit, select Edit Translation Unit. This opens the Edit
Translation Unit dialog, which displays the T'U (including all additional information) and
allows you to edit it:
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Figure 4-36: The Edit Translation Unit Dialog

5. In the Edit Translation Unit dialog, change any information as required. You can even
modify the translation unit information (text and attribute fields) and, if you are using the
Translation Memory in exclusive access mode, such system fields as Creation User and

Change Date.

6. Once you are satisfied with the changes, click the Save button or press the [Enter] key. This
will save vyour edited translation unit, thus updating the Translation Memory and
Concordance window which will now show you the corrected translation unit.

7. Start further Concordance searches as needed, and correct or delete all translation units as

described in this instruction.

There are two further buttons in the Edit Translation Unit dialog labelled Style Sheet and Font

Table. These two buttons will now be explained.

Used Character Styles (from Style Sheets)

Click the Style Sheet button to bring up Used Character Styles dialog:

Used Character Styles

Mo, Name

bwedwinE rror

tidwinPopup Example

Help

tedwindump
twsdwinE stermnal
teedwinlnternal
bwsdwin Term —
teedwinLink,
twdwinT ags

0 Detault Paragraph Font

— 000 O e Lo P —

Mormal

Figure 4-37: The Used Character Styles Dialog
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This dialog lists all character styles from the source documents that have been translated using
the current Translation Memory. In addition, this list is used by Translator’'s Workbench to mark
up your translated documents in various ways. You cannot edit the list, it is for information
purposes only. The No. column shows you the number of the character style as used in the RTF
format stored in TM (see further down for an example). The Name column lists the character
style names. The Example box shows you examples of what the character styles look like in your
documents.

As you might know, word processors such as Word or WordPerfect ensure the consistency of your
document formats by means of what is referred to as style sheets. These style sheets work at two
levels, paragraph and character. For example, when you open a new document in Word based on
the standard document template Nor mal . dot, the style “Normal” is the default paragraph
style automatically assigned to the first paragraph.

In Translator’s Workbench, paragraph styles are treated as external styles (since they are external
to the text) and character styles as internal styles. In order to keep track of formatting in your
document and to store it in Translation Memory together with your source and target text,
Translator’s Workbench checks each sentence for paragraph (= external) and character (=
internal) style formatting. External styles are stripped from the text and not stored in Translation
Memory. Internal styles and font changes, however, are recognised and added to the Used
Character Styles and Font Table lists which Translator’'s Workbench updates as you translate
your texts.

Consider the following example:

In this sample sentence, the word bush has been formatted in a character style that is
different from the rest of the sentence: Century Gothic, 14 point, bold, italic characters.

If you chose to edit the corresponding translation unit, Translator’s Workbench would display
the following text in the Edit Translation Unit dialog:

In this sample sentence, the word {\cs16 bush} has been formatted in a character style that is
different from the rest of the sentence: Century Gothic, 14 point, bold, italic characters.

In this example, the word dush is enclosed in curly braces and preceded by RTF-encoded
information. This information is interpreted as follows: “The word ‘bush’ is formatted in
character style number 16 (=‘\cs16’).” If you consult the Used Character Styles list, it will give
you an example of what character style 16 looks like: just look for its number in the left column
to get the name and an example of the style. To change the character style of the word dush, look
for the number of the character style you would like to use, remember the number, and replace
the old character style number in the sentence with the new one. From now on, the sentence
part enclosed in the curly braces will appear in the new character style.

Note

In every TM, character styles are added to the Used Styles list in the order in which they
appear in the source documents. So each TM has its own individual Used Styles list (the only
exception being some reserved styles used by Translator’'s Workbench to mark up your
documents). If documents are heavily formatted with character styles, this may affect the
overall performance of Translator’s Workbench on the long run. To avoid overly long Used
Styles lists, you can “strip” superfluous styles from your documents before and during
translation. See the keyword “Styles” and the topic “Style and Font Issues” in the online
Help of Translator’s Workbench for more information.
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Figure 4-38: The Used Fonts dialog

This dialog lists all fonts from the source documents that have been translated using the current
Translation Memory. You cannot edit this list, it is for information purposes only. The No.
column shows you the number of the font as used in the RTF format stored in TM (see further
down for an example). The Name column lists the font names. The Example box shows you
examples of what the fonts look like.

In order to keep track of formatting in your document and store them in Translation Memory
together with your source and target text, Translator’s Workbench checks each sentence for
character styles (see above) and font changes. These font changes typically occur within a
sentence. Consider the following example:

In this sample sentence, the word t r ee is formatted in Courier New 10 point.

In the sentence above, the author chose to format the word #¢e in a font that’s different from the
rest of the sentence. Translator’s Workbench can automatically recognise this font, assign an
internal number to it and add it to the list of fonts used as shown in the Used Fonts list.

This kind of font management is crucial when editing translation units (TUs). You might for
example want to change a certain font in a given target sentence of a TU. Since Translator’s
Workbench stores all TUs in Rich Text Format (RTF), the above sample sentence would read
as follows in the Edit Translation Unit dialog:

In this sample sentence, the word {\f1\fs10 tree} is formatted in Courier New 10 point.

In this example, the word #ve is enclosed in curly braces and preceded by RTF-encoded
information. This information is interpreted as follows: “The word ‘tree’ is formatted in font
number 1 (=’\f1’), and the font size of the characters is 10 (=‘\fs10’).” In our example, the Used
Fonts list would give you the information that font number 1 is indeed Courier New. Now, in
order to change the font, you need to know the number that Translator’s Workbench assigned to
it. This is where the Used Fonts list helps you. On the list, look for the font you would like to
use, remember its number, and replace the old font number with the number of the font you
would like to use. From now on, the sentence part enclosed by the curly braces will appear in the
new font.
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Note

In every TM, fonts are added to the Used Fonts list in the order in which they appear in the
source documents. So each TM has its own individual Used Fonts list. If documents are
heavily formatted with fonts, this may affect the overall performance of Translator’s
Workbench on the long run. To avoid overly long Used Fonts lists, you can “strip”
superfluous fonts from your documents before and during translation. See the keyword
“Fonts” and the topic “Style and Font Issues” in the online Help of Translator’s Workbench
for more information.

4.6.2 Translation Memory Maintenance

When more exhaustive corrections have to be made for a large number of translation units, the
method described above for spot-editing and deleting translation units can become somewhat
tedious. In this case, it is recommendable to use the Maintenance command from the File menu
instead. The Maintenance feature lets you directly modify the contents of your Translation
Memory at a global level, without having to export or import data. Using the Maintenance
function, you can:

* find & replace text in translation units (T'Us)
e find & alter information in system fields

¢ find & alter information in attribute and text fields

Notes

e This function is designed for advanced users only, since it allows you to radically change
the contents of your translation memory at all levels.

e We recommend in all cases that you make a backup copy of your Translation Memory
before making any global changes. If for some reason the global changes do not give the
desired results, it is often easier to start over with the unchanged Translation Memory
than to try to reverse undesired changes.

T'he Maintenance process typically comprises the following steps:

1. Open the TM in which you would like to carry out your maintenance operations.

2. From the File menu in Translator’s Workbench, choose the Maintenance command. The
Translation Memory Maintenance dialog opens.
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Figure 4-39: The Translation Memory Maintenance Dialog

If you want to confine your maintenance operations to a well-defined subset of translation
units, you first specify constraints. This is useful, for example, if you want to only change
translation units whose English segment contains a certain word or phrase. To specify such
restrictions, click the Constraints button and make the desired settings as needed. For a
description of defining constraints, see “Defining Constraints for Translation Memory
Maintenance” below.

If you want to define global search & replace actions, click the Global Changes button. For
instance, you might want to replace an English search term in all translation units with a
synonym. For a description of defining global changes, see “Defining Global Changes for
Translation Memory Maintenance” below.

Set the desired global Maintenance options:

* In the TUs Processed at a time input box, you specify how many translation units
should be displayed at any given moment in the Maintenance dialog. This gives you
more control over global changing procedures.

e If you want to display translation unit information such as system or attribute fields, tick
the Display Translation Unit Information check box.

Click the Begin Search button to start searching the first set of TUs which match the
constraints defined under step 3. Translator’'s Workbench will display the first set of
matching T'Us in the TU window. Additionally, in the title bar, the program shows you the
numbering range in which the matching TUs have been found. For example, if the program
finds five matching TUs in the TU range 17-30, it will display this range information (“T'U
No. 17-30”) in the title bar. This makes it easier for you to keep track of where you are
located at the moment, especially in larger TMs. To get hold of the total number of TUs in
your TM, use the Properties command from the File menu.

If you have defined global changes under step 4, you can now decide if, and how, you want
to apply these changes.
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If you want to change a single translation unit, click one of its flags with the right mouse

button, and choose the Change Translation Unit command from the context menu.
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Figure 4-40: Applying a Change to a Single Translation Unit

If you want to change all translation units iz the current window in one go, click the

Change button.

If you want to change all translation units in the entire Translation Memory in one go, click
the Change All button. Depending on your Global Changes criteria, this may take a

while. Note that the Change All function is only available in exclusive access mode.

8. To continue searching for the next set of matching T'Us, click the Next button. To return to
previously displayed set of matching T'Us, click the Previous button (this can only work if
you have not performed global changes in the source segments). To start a new, fresh search
after you have defined new constraints or global changes, click the Reset Search button.

9. Repeat the steps 3-8 for all Maintenance actions that you want to take. Once you are
satisfied with the results, click the Close button.

Defining Constraints for Translation Memory Maintenance

As mentioned above, you can confine your maintenance operations to a well-defined subset of
translation units. To achieve this, in the Translation Memory Maintenance dialog, click the
Constraints button. This opens the Constraints dialog.
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Figure 4-41: The Constraints Dialog

The following is a recapitulation of all options in the Constraints dialog. For examples, see the
section “Translation Memory Maintenance: Examples” below.

Constraints List

‘This list contains all items that specify the restrictions you select for the data to be manipulated
in your Translation Memory. If you leave this list empty (by just clicking on OK), the searches
you perform in the Maintenance dialog will affect your entire TM. If you would like to
manipulate only a certain subset—for example, only those translation units that have been
created by a certain user, or all T'Us containing a certain text—, you need to define constraints as
explained below.

Field List

Here you choose the labels of language segments, system fields, attribute fields, and text fields
to define constraints for your maintenance operations. Click on the item that you want to use,
then click on Add or Or followed by Add, depending on whether you would like to add a logical
AND or a logical OR to the Constraints List. See the examples below for a detailed description.

Criterion

After making your selection in the Field List, you define a criterion in the Criterion field, for
example “>1” for the system field Usage Counter, which would mean that you would like to only
manipulate all TUs that have been used at least twice during translation projects. Or you would
specify the criterion *user-friendly* for the [Segments] field English (United Kingdom) to
manipulate only 'T'Us whose English segment contains the word wuser-friendly somewhere.

Important

T'ranslator’s Workbench’s Maintenance function is case-sensitive. This means that it makes a
difference whether you enter the criterion *wuser-friendly*, *USER-FRIENDLY* or *User-
friendly* into the Criterion field. To make sure all these cases are taken into account for your
Maintenance operation, you must add them all to the Constraints List, separated by a logical
OR. You achieve this by clicking the Or button before defining the different criteria.
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The Criterion Input Box

With the exception of attribute fields, all fields allow you to enter a criterion in the Criterion
input box. Here you specify the criterion for the field that you add to the Constraints List.

The following conventions apply to Maintenance constraints criteria:

Criterion | Description

text The segment or field referred to must contain precisely this text and no other.

text* The segment or field referred to must begin with this text.

*text The segment or field referred to must end with this text.

*text* The segment or field referred to must contain this text somewhere in its contents.

Ptext The segment or field referred to must contain this text, preceded by any single character.

You can specify any number of "?"s to indicate a sequence of any characters.

Ptext? The segment or field referred to must contain this text, preceded and followed by any single
character. You can specify any number of "?"s to indicate a sequence of any characters.

PFtext* None of the segments or fields referred to may contain this text.

>... The field must contain a value that is greater than the criterion. Can only be used by the
system date fields Creation Date, Change Date, and Used Date as well as the system field Usage
Counter.

<... The field must contain a value that is less than the criterion. Can only be used by the
system date fields Creation Date, Change Date, and Used Date as well as the system field Usage
Counter.

Attribute Picklist

If you select an item from the [Attribute Fields] section in the Field List and click the Add
button, the corresponding picklist opens automatically and is displayed in the Attribute Picklist.
At the same time, the first item of the picklist is used as the default criterion in the Constraints
List. To use another picklist item, select it with your mouse. Translator’s Workbench will
automatically update the Constraints List accordingly.

Defining Global Changes for Translation Memory Maintenance

As mentioned above, you can use the Maintenance function to globally find & replace
information in your Translation Memory. To achieve this, from the Translation Memory
Maintenance dialog, click the Global Changes button. This opens the Global Changes dialog.
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Figure 4-42: The Global Changes Dialog

Use this dialog to define any global search & replace actions for the Maintenance process. You
can specify global change criteria at three levels:

e system fields

* text and attribute fields

* source and/or target segments

System Fields
To globally change the value of any system field, follow these steps:
1. Enter the desired new value into the input box of the system field that you want to change.

Depending on what system fields are available in your translation memory, some system
field input boxes will be greyed out.

2. Click OK. You are returned to the Maintenance dialog, where you can apply the changes as
described under step 7 of the Maintenance process.

Text Fields

To globally change the value of any text field or add new text fields to TUs, follow these steps:

1. Click the name of the text field whose content you want to change or which you want to
globally add to T'Us.

2. Enter the new contents in the Text Field Content box.
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Figure 4-43: Setting Text Field Contents for Global Changes

3. Set the desired TU update option:

e The Merge option will 2dd the new text field contents to all T'Us which contain the text
field specified in step 1. If the text field does not exist in the TUs to be changed, it will
be created.

*  The Overwrite option will 7¢place the text field contents of all T'Us which contain the
text field specified in step 1. If the text field does not exist in the TUs to be changed, it
will be created.

4. Click OK. You are returned to the Maintenance dialog, where you can apply the changes as
described under step 7 of the Maintenance process.

Attribute Fields
To globally change the value of any attribute field or add new attribute fields to TUs, follow

these steps:

1. Click the name of the attribute field whose content you want to change or which you want
to globally add to T'Us. The corresponding picklist is displayed in the Attribute Picklist.

2. Select the new item(s) from the Attribute Picklist.
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Figure 4-44: Setting Attribute Values for Global Changes

3. Set the desired TU update option:

e The Merge option will 2dd the new attribute field contents to all TUs which contain the
attribute field specified in step 1. If the attribute field does not exist in the TUs to be
changed, it will be created.

*  The Overwrite option will rgplace the attribute field contents all T'Us which contain the
attribute field specified in step 1. If the attribute field does not exist in the TUs to be
changed, it will be created.

4. Click OK. You are returned to the Maintenance dialog, where you can apply the changes as
described under step 7 of the Maintenance process.

Source and Target Segments

To globally change text in source and/or target segments, follow these steps:

1. To specify what words to search for, enter them in the Find What box of the language you
want to change.

2. 'To replace the text in the Find What box, type the replacement text in the Replace With
box of the language you want to change. To delete the text in the Find What box, leave the
Replace With box blank.

3. To distinguish between uppercase and lowercase characters, select the Match Case check
box.
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Figure 4-45: Changing Text in Segments

To search for occurrences that are whole words, and not part of a larger word, select the
Match Whole Word Only check box.

Click OK. You are returned to the Maintenance dialog, where you can apply the changes as
described under step 7 of the Maintenance process.

4.6.3 Translation Memory Maintenance: Examples

You can try the following examples with the demonstration TM shipped with Translator’s
Workbench, Denp. t mw. In all examples, we assume that you have already opened this TM.
Note that you can combine any of the search and replace items at will.

Example 1: Searching All Translation Units Changed After a Certain Date

Let’s assume you want to use the Maintenance function to display all TUs that have been
changed after a certain date. This is useful, for example, to proof-read or spot-check translations
at regular intervals. Follow these steps:

1.

From the File menu in Translator’s Workbench, choose the Maintenance command. The
Translation Memory Maintenance dialog opens.

To only look for TUs that have been changed after a certain date, you need to specify
corresponding constraints for the Change Date system field. To achieve this, click the
Constraints button. This opens the Constraints dialog.

In our example, let’s assume you want to look at all TUs changed after 1 January 1997. To
specify this constraint, on the Field List, click the Changed On system field, and click Add to
add it to the Constraints List. By default, Translator’s Workbench assumes you want to
search all T'Us changed after 31 December 1997. Change this to 01 January 1997 as depicted
below. (Note that the date format depends on your regional settings as defined in Windows
Control Panel. In the status bar of the Constraints dialog, Translator’'s Workbench gives you
an example of what the date format should look like.)
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Constraints

Cotstraints List
Field Criterion ok

»01.01.97

Changed or

Cancel

Help

Field List

[Seaments] -
Englizh [United Kingdam)
German [Germary)]

Sistem Fields

|Jzage:
Changed by:

Liriterion
|>n1_u1.9?1 Add

Attribute Picklist Delete

ik

[Text Fields]
ID code

[&sttribte Fields] LI

Figure 4-46: Defining System Field Constraints for Maintenance Searches

4. Click OK to confirm these settings. You are returned to the Maintenance dialog. To start

searching for the first set of matching TUs, click the Begin Search button.

Translation Memory Maintenance - TU MNo. 1-5

Constraints... |
Global Changes. .. |

Beset Search |

|5 TUs processed at a time

[ Display Translation Uit Information

CHEE T

< Brevious | [Ehange |

Cloze: |
Help |

Bl |

: Professional Terminology Access over the Internet
% Professionelle Terminologieabfrage (ber das Internet

Changed or: 09.03.99, 17:29
Changed by: Z1AD
|Jzage: 2

unabhéngig vorn Standort jederzeit bequern abgefragt werden.

net / Intranet so that everyone in
hre based, anywhere in the warld.

minologie von allen Mitarbeitern

-

Figure 4-47: Maintenance Search Results

5. In our example, after a brief moment, the first set of five matching TUs is displayed. In your
Maintenance searches, use the TUs Processed at a Time input box to specify how many
translation units should be displayed at any given moment, and the Next>> and <<Previous
buttons to sequentially browse through sets of matching T'Us.

Example 2: Searching All Translation Units Changed After a Certain Date AND By a

Certain User

In our second example, let’s assume you want to use the Maintenance function to display all
TUs that have been changed after a certain date AND modified by a certain user. Follow these

steps:

1. From the File menu in Translator’s Workbench, choose the Maintenance command. The
Translation Memory Maintenance dialog opens.
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2. To only look for TUs that have been changed after a certain date and modified by a certain
user, you need to specify corresponding constraints for the Change Date and Change User
system fields. To achieve this, click the Constraints button. This opens the Constraints
dialog.

3. In our example, let’s assume you want to look at all TUs changed after 1 January 1994 by a
user called MILLER. To specify these constraints, on the Field List, click the Changed On
system field, and click Add to add it to the Constraints List. By default, Translator’s
Workbench assumes you want to search all TUs changed after 31 December 1997. Change
this to 01 January 1994.

4. To specify MILLER as the Change User, on the Field List, click the Changed By system
field, and click Add to add it to the Constraints List. After that, in the Criterion box, type
M LLER, as depicted below.

Cotstraints List
Field Criterion
| ChanEed on »01.01.54 Cancel |
Help |
Mot
Eield List Liriterion
[Segments] - |MILLEF|| Add
Englizh [United Kingdam)
German [Germary)] [islek
Attribute Picklist 4|—'3 itk
[Swztem Fieldz] or |
Changed on —
i saie:
[Text Fields]
ID code
[ttribute Fields] d

Figure 4-48: Defining System Field Constraints for Maintenance Searches

5. Click OK to confirm these settings. You are returned to the Maintenance dialog. To start
searching for the first set of matching T'Us, click the Begin Search button.

6. In our example, after a brief moment, the first set of five matching TUs is displayed. In your
Maintenance searches, use the TUs Processed at a Time input box to specify how many
translation units should be displayed at any given moment, and the Next>> and <<Previous
buttons to sequentially browse through sets of matching T'Us.

Example 3: Searching Translation Units According to Project Settings

In our third example, let’s assume you want to use the Maintenance function to display all TUs
that have certain project settings in the form of attribute and/or text fields. This is useful, for
instance, when you want to spot-check or proof-read TUs from specific projects. Follow these
steps:

1. From the File menu in Translator’s Workbench, choose the Maintenance command. The
Translation Memory Maintenance dialog opens.

2. 'To only look for TUs that have certain project settings, you need to specify corresponding
constraints for the text and/or attribute fields in question. To achieve this, click the
Constraints button. This opens the Constraints dialog.

3. In our example, let’s assume you want to look at all TUs that have been created for the
client Pro Software Inc. OR that have the ID code PROJ 94/105. To specify these constraints,
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on the Field List, click the Client attribute field, and click Add to add it to the Constraints
List. This opens the picklist for the Client attribute field. Pick Pro Sofrware Inc. from this list.

4. To define a logical OR, click the Or button. This adds an [Or] to the Constraints List.

5. To specify the second constraint, on the Field List, click the ID code text field, and click
Add to add it to the Constraints List. T'ype PROJ 94/ 105 into the Criterion box.

Constraints

Cotstraints List
Field Criterion ok

Client Pro Software Inc. Cancel

|0 code FROJ 34105

Eield List Liriterion
[Spstem Fields] ﬂ IPHDJ 94105 Add
Changed or

Uzage: Delek
Changed by: Atribute Picklist e

Text Fields

[Attribute Figlds]
Status

Client

Domain

il

Figure 4-49: Defining Project Settings as Constraints for Maintenance Searches

6. Click OK to confirm these settings. You are returned to the Maintenance dialog. Since we
are looking for project settings, which are part of the TU information, it’s useful to tick the
Display Translation Unit Information check box.

7. To start searching for the first set of matching T'Us, click the Begin Search button.

8. In our example, only one TU matches our search criteria. In your Maintenance searches, use
the TUs Processed at a Time input box to specify how many translation units should be
displayed at any given moment, and the Next>> and <<Previous buttons to sequentially
browse through sets of matching TUs.

Example 4: Changing All Translation Units With Certain Project Settings

In our fourth example, let’s assume you want to use the Maintenance function to change all TUs
that have certain project settings. This is useful, for instance, when you want to globally assign
new or changed fields to TUs from specific projects. Follow these steps:

1. From the File menu in Translator’s Workbench, choose the Maintenance command. The
Translation Memory Maintenance dialog opens.

2. 'To only look for TUs that have certain project settings, you need to specify corresponding
constraints for the text and/or attribute fields in question. To achieve this, click the
Constraints button. This opens the Constraints dialog.

3. In our example, let’s assume you want to change all TUs that have been created for the
client Pro Software Inc. into T'Us for the client New Chemicals Ltd. To specify these
constraints, on the Field List, click the Client attribute field, and click Add to add it to the
Constraints List. This opens the picklist for the Client attribute field. Pick Pro Software Inc.
from this list.

4. Click OK to confirm these settings. You are returned to the Maintenance dialog. Now, to
replace all matching 'T'Us with the new project setting Client: New Chemicals Ltd., we need to
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8.

define a “global change” for the Clienr attribute field. To achieve this, click the Global
Changes button. The Global Changes dialog opens.

From the Attribute Fields list, select the Client attribute field, and choose New Chemicals Ltd.
from the picklist. Since we want to rgplace all T'Us created for Pro Software Inc. with the new
setting, choose the Overwrite option. (If you wanted to @dd the information to the TU, you
would choose the Merge option).

Global Changes 1]
Swyatem Field -
Ok
[Ereation [Uate I [Ereatian | zer I e |
arce |
Change Date I Change User I
Hel
Wzed ate I Uzage Counter I il
r— Text and Attribute Field
Tegt Fields
TextField Content
Aftribute Fields Attribute Picklist
Statug Mew Chemicals Ltd,
Pro Software Inc.
Domain Heavy Engineering & C
— Segment:
Fird ‘Wwhat Feplace With
Source I I
Target I I
™ Match Caze ™ Match Whale Wward Orily

Figure 4-50: Defining Global Changes for an Attribute Field

Click OK to confirm these settings. You are returned to the Maintenance dialog. Since we
are looking for project settings, which are part of the T'U information, it’s useful to tick the
Display Translation Unit Information check box.

To start searching for the first set of matching T'Us, click the Begin Search button.

Translation Memory Maintenance - TU Ho. 47-47

Constraints. .. |
Global Changes... |

FBeset Search I

<< Previous

|5 Tz proceszed at a time

Cloge |
Help |

Change &1l |

W Display Tranglation Uit Information

[HERt >3 Change I

twice.

== Die Wyarkbench sorgt dafir, da Sie keine Ubersetzung zweimal einzugeben

brauchen.

Changed ore 01/12/34, 00:00 Changed by MILLER  Usage: 0 €C)ent: Pro Software Ing, 40 code:

FROJ 34/105

the Warkbench makes sure that you never have to translate the same sentence

Figure 4-51: Matching TUs

In our example, only one TU matches our search criterion. In your Maintenance searches,
use the TUs Processed at a Time input box to specify how many translation units should be
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displayed at any given moment, and the Next>> and <<Previous buttons to sequentially
browse through sets of matching TUs.

You can now decide if, and how, you want to apply the change to the C/ient attribute field:

* To change a single translation unit, click one of its flags with the right mouse button, and
choose the Change Translation Unit command from the context menu.

e To change all translation units 7z #he current window in one go, click the Change button.

* To change all translation units in the entire Translation Memory in one go, click the
Change All button. Depending on your Global Changes criteria, this may take a while.
Note that the Change All function is only available in exclusive access mode.

Translation Memory Maintenance - TU Ho. 47-47
Constraints... | |5_ TUs processed at a time Cloze |
Global Changes... | ¥ Display Translation Urit Information Help |

FBeset Search I << Previous | [HERt >3 I Change I Change All I

the Warkbench makes sure that you never have to translate the same sentence
twice.

== Die Wyarkbench sorgt dafir, da Sie keine Ubersetzung zweimal einzugeben
brauchen.

Changed or 01/12/34, 00:00 Changed by MILLER  Usage: 0 CClient: Mew Chemicals Lid_3D

code: PROJ 944105

|'I of 1 Tranglation Units changed!

Figure 4-52: Changing Translation Units

10. Once you are satisfied with the changes, click the Close button to dismiss the Translation

Memory Maintenance dialog.

Example 5: Performing Global Text Changes

In our fifth example, let’s assume you want to use the Maintenance function to change all TUs
that have a certain German text. This is useful, for instance, when you want to globally find and
replace text in your Translation Memory as a result of terminology changes or similar global
modifications. Follow these steps:

From the File menu in Translator’s Workbench, choose the Maintenance command. The
Translation Memory Maintenance dialog opens.

To only look for TUs that have a certain German text, it’s best to specify corresponding
constraints (otherwise your change operation will be cluttered by unnecessary TUs). To
achieve this, click the Constraints button. This opens the Constraints dialog.

In our example, let’s assume you want to replace the German word Dazenbank with the word
Datenbasis throughout your TM. To only look for TUs whose German segment contains the
word Datenbank, on the Field List, click German (Germany), and click Add to add it to the
Constraints List.

In the Criterion input box, you can now type what you’re looking for, in our example, the
word Datenbank. It’s best to enclose it in asterisks (“*”) to make sure that every occurrence
of this word is found, not only those segments o7/y consisting of it.
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Constraints
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Changed on
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Figure 4-53: Defining Constraints for Text Searches

5. Click OK to confirm these settings. You are returned to the Maintenance dialog. Now, to
replace all occurrences of Datenbank with Datenbasis, we need to define a “global change” for
target segments. 'To achieve this, click the Global Changes button. The Global Changes
dialog opens.

6. To specify the word Datenbank as search text, enter it in the Find What box of the Target
segment. Type the replacement text, Datenbasis, in the Replace With box the Target
segment.

Global Changes 1]
Swyatem Field -
ak
[Ereation [Uate I [Ereatian | zer I e |
aFCE |
Change Date I Change User I
Hel
Wzed ate I Uzage Counter I il
 Text and Attribute Field
Tegt Fields
TextField Content
: : . - &+ Merge
Altribute Figlds Attribute Picklist ® Eeie
Clignt
Damnain
— Segment:
Fird ‘Wwhat Feplace With
Source I I
Target | Datenbank | Datenhasis|
™ Match Caze ™ Match Whale Wward Orily
Figure 4-54: Defining Global Text Changes
7. Click OK. You are returned to the Maintenance dialog.
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8. To start searching for the first set of matching T'Us, click the Begin Search button.

Translation Memory Maintenance - TU Mo. 7-76
Eonstraints. .. | |5_ Tls processed at a time Clase |
Global Changes. .. | [ Display Translation Uit Information Help |

S Heset Search

<< Brevious | TlEwtes [Ehange | Changesl |

You create and manage your terminology with MultiTerm ‘95 Plus!, and use the
YWeb Interface to make it achessthe over the Internet or Intranet.

™= Erstellen und verwalten Sie lhre Terminalogie mit MultiTerm 95 Plus!, das Web
Interface ermaglicht die Abfrage lhrer Datenbank Ober das Internet bzw. Intranet.

Just wisit some sample on-line databases, and see for yourself what the MultiTerm
Wyeh Interface can do for you.

™= | Intemet stehen einige Online-Datenbank zur Verfiiguny, welche lhnen die
Maglichkeiten von MultiTerm Web Interface demonstrieren.

A This a linguistic database that collects all of your translations and their
source-language equivalents as you translate.

™= Ein Th ist eine linguistische Datenbank, die alle Ubersetzungen und ihre
Criginalsatze aufnirmmt, wihrend Sie dbersetzen.

If there is an entry in the MutiTerm database containing the term screen dispiay, it
will be shown in the terminology window of the Translator's Workbench, sven
though the term screen dispiay did not occur in this form int ke ariginal sentence!

= wenn in der MultiTerm-Datenbank ein Eintrag zu Biidachirmanzeige existien, so
wird dieser in das Terminologiefenster der Transfator's Workbench eingeblendet,
obwohl das Wort Bidschirmanzeige gar nicht in dieser Form im Aus gangssatz
varkaml

|
Figure 4-55: TUs Whose German Segments Contain the Word Datenbank

9. In our example, four T'Us match our search criteria. In your Maintenance searches, use the
TUs Processed at a Time input box to specify how many translation units should be
displayed at any given moment, and the Next>> and <<Previous buttons to sequentially
browse through sets of matching TUs.

10. You can now decide if, and how, you want to apply the text change:

* To change a single translation unit, click one of its flags with the right mouse button, and
choose the Change Translation Unit command from the context menu.

e To change all translation units 7z #he current window in one go, click the Change button.

* To change all translation units in the entire Translation Memory in one go, click the
Change All button. Depending on your Global Changes criteria, this may take a while.
Note that the Change All function is only available in exclusive access mode.
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Translation Memory Maintenance - TU Mo. 7-76
Eonstraints. .. | |5_ Tls processed at a time Clase |
Global Changes. .. | [ Display Translation Uit Information Help |

T Hesel Seach e e Change | _ Changeal |

3 Wou create and manage your terminology with MultiTerm 95 Plus!, and use the
Web Inteface to make it accessible over the Internet or Intranet.

™= Erstellen und verwalten Sie lhre Terminologie mit MultiTerm 95 Plus!, das Web

Interface ermaglicht die Abfrage lhre "her das Intermet bzw. Intranet.

Just wisit some sample on-line databases, and see for yourself what the MultiTerm
Weh Interface can do for you.

™= I Intemet stehen einige OnlinurVerngung, welche lhnen dieg

Maglichkeiten von MultiTerm Web Interface demonstrieren.

A This a linguistic database that collects all of your translations and their
source-language equivalents as you translate.

== Ein Th ist eine Iinguistischdie alle Ubersetzungen und ihre

Originalsatze aufnimmt, wihrend Sie dbersetzen.

If there is an entry in the MuwitiTerm database containing the term screen display, it
will be shown in the terminology window of the Translator's Workbench, sven
thaugh the term screen dispiay did not occur in this form int ke ariginal sentence!

== wenn in der MutiTen in Eintrag zu Bildschirmanzeige existiert, so
wird dieser in das Terminologiefenster der Transfator's Workbench eingeblendet,
obwohl das Wort Bildschirmanzeige gar nicht in dieser Form im Aus gangssatz
varkaml

|? of 3 Tranglation Units changed!

Figure 4-56: Performing Global Text Changes

11. Once you are satisfied with the changes, click the Close button to dismiss the Translation
Memory Maintenance dialog.

This completes the round-up of the Maintenance function. As you have seen, it is a very flexible
and powerful feature. Please be aware that any changes you make cannot be undone, so we
recommend you to carry out your Maintenance operations with great care.
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5. Working With Bilingual Concordances

Translator’s Workbench lets you access previous translations at three levels:

e sentence level

* term level

e  ‘“anytext” level

As already mentioned, Translator’'s Workbench automatically looks for identical or similar
sentences in Translation Memory and performs an automatic term recognition in the MultiTerm

database. In addition, you can search Translation Memory for any part of text that has been
translated before. This kind of search is referred to as Bilingual Concordance Search.

5.1 Performing Bilingual Concordance Searches

To perform Concordance searches, follow these steps:

1. Open the Translation Memory you would like to work with, if you have not already done so.

2. From the Tools menu, choose Concordance, or press [F3]. The Concordance dialog
appears.

Concordance

. Search
Enter zearch sting:

I fuzz 5"| j Cancel
Options...

I= | SearchEirstin Backaraund Tk

didd

Help

Figure 5-1: Starting a Concordance Search

3.  Enter any word(s) or sentence parts you want to look for in the current TM—in our
example, the word “fuzzy”’—and click the Search button. Translator’s Workbench now
identifies all source-language segments containing your search term or something similar. All
matching translation units will then be displayed in what is referred to as the Concordance
window. If you use the demonstration TM shipped with Translator’s Workbench,
Deno. t nw, the following Concordance window opens:

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



5-2 Working With Bilingual Concordances

Fuzzy terminology recognition, together with the concordance option mentioned above, leave
virtually nothing to be desired in terms of powerful, user-friendly search functions.

™ 7sammen mit der oben erwahnten Konkardanzoption stehen lhnen also nun Suchfunktionen
zur Werfigung, deren Leistungsfahigkeit und Benutzerfreundlichkeit keine Winsche mehr offen
lagsen darften.

extended linguistic fuzzy matching algorithm that finds similar sentences with lightning speed
and enables the userto select amang several different matches

™ oreiterter Fuzzy-Matching-Algorithmus, der pfeilschnell inhaltlich ahnliche Sétze findet und
Auswahlmaglichkeiten bietet

colour highlighting of changes after a fuzzy match
™ arhliche Hervorhebung van Anderungen nach einem Fuzzy-Match

active, fuzzy terminology recognition with morphological reduction
™™ aitive, "unscharfe” Terminologieerkennung mit marphalogischer Reduktion

The fuzzy matching technology used to find similar sentences has been extended in the
Windows Yersion of the Translator's Workbench:

™™ Dabei wurde die Technologie des Fuzzy-Matching - also des Aufindens inhaltlich &hnlicher
Satze - in der Windows-Yersion der Transfator's Workbench erweitert:

now it also waorks with a fuzzy-matching algorithm.
= Sic arbeitet nun "unscharf.

Figure 5-2: The Concordance window, after searching for “fuzzy” in the demo TM

4. 'To start further Concordance searches from any open Concordance or other Workbench
window, select the sentence part that interests you and click the right mouse button ([Shift]
+ [F10]). This opens the text context menu. From this menu, choose Perform Concordance
Search as depicted below.

"fuzzy” (6 Hits)

Fuzzy terminology recognition, together with the concaordance option mentioned above, leave =
wirtually nothing to be desired in terms of powerful, user-friendly search functions.
B 7uzammen mit der oben erwdhnten Konkordanzaption stehen Ihnen also nun Suchfunktianen zur

“erflgung, deren Leistungsfahigkeit und Benutzerfreundlichkeit keine Wiinsche mehr offen lassen
diirften.

extended linguistic fuzzy matching sl
enables the user to select among several diffe

™ .rweiterter Fuzzy-Matching-Algarithmus, der | Searchin MultiTern. . ke findet und
Auswahlmiglichkeiten bietet Fuzzy Search in MultiTam...

asightning speed and

e Copy to Clipboard
colour highlighting of changes after a fuzzy remcm

B farbliche Hervarhebung von Anderungen nach einem Fuzzy-Match Ei

Figure 5-3: Starting further Concordance searches

5. In this example, we performed a Concordance search based on the word algorithm.
Translator’s Workbench will open a new Concordance window showing all translation units
whose English source sentence contains our search word.
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Notes

T'ranslator’s Workbench keeps a list of the last 20 Concordance search strings. You can
access them from the drop-down list in the Concordance dialog.

You can also start Concordance searches from within your word processor or TagEditor via
the # button. For more information, please refer to the “Interface With Your Word
Processor and TagEditor” chapter.

You can edit or delete translation units from within the Concordance window. See
“Editing & Deleting Translation Units” in the “T'ranslation Memory” chapter.

For a full overview of mouse and keyboard functions in the Concordance window, see
“Translator’s Workbench’s Windows—Mouse Functions and Key Assignments.”

To close a Concordance window, follow one of these procedures:

Press [Alt] + [F4].
Click the “x” button in the upper right corner of the Concordance window.

Double-click the Concordance window’s system menu.

5.2 Setting Concordance Options

Since the Concordance function also works with a fuzzy-matching algorithm, you can set options
for the Concordance search precision. In addition, you can choose a second, read-only
“background” Translation Memory for your Concordance searches, and you can restrict the
number of translation units to be displayed in the Concordance window.

To set these options, follow one of these procedures:

From the Options menu, choose Translation Memory Options. The Translation Memory
Options dialog opens. Click the Concordance tab.

Click the Options button in the Concordance dialog box shown at the beginning of this
chapter. This opens the Concordance tab of the Translation Memory Options dialog.

Concordance Options

Digplay Tranzlation Unit Information
’7(' Ho * Hidden ™ Visible

—
Minimum Match Value % |70 .—J_
Cancel |

bl aximurn Mumber of Hits [1-39) |3U '—J—
Help |
Background Bead-Only Th IE:'\Tlados'\LargeTMDnCD.th Browse. .. |

Search First in Background T [

Figure 5-4: Setting Concordance Options
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5.2.1 Examples

Define any of the following options as required:

*  Minimum Match Value: Here you set the boundary value for the fuzziness of the
Concordance function. Generally, a value ranging from 65 to 75% vyields the best results.
Default: 70%. Please refer to the next section for examples.

e Maximum Number of Hits: Here you define the maximum number of translation units to be
displayed in the Concordance window. The default is 30. This means that if the search
criterion occurs in more than 30 sentences, only the first 30 will be found and shown in the
Concordance window. You can set a value between 1 and 99. Note that the higher the
Maximum Number of Hits value, the longer the Concordance search will take.

* Background Read-Only TM: Use this input box to specify the location of a second TM for
Concordance searches. You can also use the Browse button to locate it on your system. Since
the contents of the background TM cannot be modified, it may reside on a CD-ROM or
write-protected network folder.

e Search First in Background TM: Check this box if you want to first use the background TM
for Concordance searches.

* Display Translation Unit Information (No/Hidden/Visible): You can also decide whether to
display or hide translation unit information from the T'M, such as “Change User: Miller” or
“Project: Software for Europe.”

. No means that translation unit information will not be shown at all.

* Hidden means that you can click on any flag in the Concordance window to visualise
translation unit information in a small popup window. This is the default setting.

* Visible means that the translation unit information will be displayed explicitly under
each translation unit.

The following examples can be tried on the Translation Memory shipped with Translator’s
Workbench, Denp. t nw.

Suppose you want to look for all sentences in this TM where the word memory has been
translated.

A Minimum Match Value of 90% to 100% will only find exact matches, that is, sentences where
the word memory has been used in exactly this form. A value of around 70%, however, will also
find sentences where this word starts with a capital letter (Memory) or the plural form occurs
(memories).

The same goes for multi-word units. Looking for every sentence where the word memory has
been used at one place, and the word #ransiation at some other, will only be successful if you set
the Minimum Match Value at a value below 100%. Otherwise, you will only find those sentences
where the compound #ranslation memory has been used as such.

In conclusion, the Concordance function opens new ways to retrieve valuable Translation
Memory information that pushes translating creativity and flexibility to new heights.

Note

As a general rule, setting the Minimum Match Value to 70% will be more flexible and versatile
than setting it to higher, “stricter” values. Again, we recommend that you “play around” with
this value until you find a setting that best fits your needs.
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Interface With Your Word Processor
and TRADOS TagEditor

In this chapter, you will get detailed information on how to use Translator’s Workbench from
within your word processor and TagEditor. Differences between the two applications are
mentioned wherever appropriate with the help of icons ( is used for Word, and for

TagEditor). Additional information on terminology features will follow in the chapter “Interface
With MultiTerm 95 Plus.”

In the Installation section, you have seen how to prepare your word processor for interaction with
Translator’s Workbench. After activating the template TWIW n. dot (Word 6.0 and 7.0) or
TWIW n97. dot (Word 97), the toolbar below appears in your word processor (for TagEditor, no
special preparation is necessary):

‘Translation Unit Commands ‘ ‘Placeable Commands ‘

|
[ & v xo|@m@|[n )|
| L

‘Concordance Command ‘ ‘Terminology Commands ‘

4—++:>|4T-W-Tr

—_

Figure 6-1: Translator’s Workbench Toolbar in your Word Processor and TagEditor

Trados

{ open
(¥ openfGet
Open Mexk no 100%//Get

+ Get Translation

(}K Restare Source
<y Copy Source

e Setflose Mext OpenfGet
SetiClase Mext no 100% Open/Get
) Tramslate to Fuzey

+) SetfClose
i Close

Shrink Segment
Expand Segment
Search Resized Segment

&+
'/{‘\’ Concordance

= Get Previous Placeable
2+ Get Current Placeabls
—* et Mext Placeable

= Get Previous Term
34 Get Current Tetm

— Get Mexk Term

Fix Docurnent
Toggle Tag Prokection

Figure 6-2: The Trados Menu in Word (Workbench in TagEditor)*

In both "T'agliditor and Word 97, the menu is available in different languages. At the time of printing, the menu is
available in English, French, German, and Japanese. When starting up Word, Translator’s Workbench checks which

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



6-2 Interface With Your Word Processor and TRADOS TagEditor

The following table explains the functions of each toolbar button and menu item. Some
functions are on/y available in the menu. The table is in two columns. The left column lists the
button icons and their names as well as shortcut assignments to use to activate the corresponding

functions; the description column tells you what the functions do exactly.

Button, Menu Item,
Shortcut

Description

Translation Unit Commands

'i

Opens the current sentence and searches for potential matches in
Translation Memory.

Open
i+ Opens the current sentence, searches for potential matches in
Open Get Translation Memory and transfers the translation—if any—to your

[Alt] + [Home]

document (combination of & and #). Use this button to start
translation mode.

+
Get Translation

Transfers the translation currently displayed in Workbench’s
Translation Memory window to your document. This is useful if you
would like to transfer a fuzzy match other than the one initially
suggested by the * Open Get function.

(%

Restore Source

Undoes the last translation and restores the original source sentence.
This is useful if you would like to get your source text back without
having to enter a translation.

[Alt] + [Del]
Ly Copies the source sentence to the target field. This button is helpful
Copy Source if the target sentence is very much the same as the source sentence.

[Alt] + [Ins]

3
Set Close Open Get

[Alt] + [+] on the numeric keypad

Closes the currently open translation unit, saves it in Translation
Memory, opens the next sentence and transfers the translation—if
any—to your document (combination of [#) and ). Use this button
to confirm a translation and move on to the next sentence.

*
Translate to Fuzzy

[Alt] + [x] on the numeric keypad
([Alt] + [*] on some systems)

Translates all 100% matches automatically, starting from the
currently open translation unit, and stops at the next fuzzy match.

)

Set Close
[Alt] + [End]

Closes the currently open translation unit and saves it in Translation
Memory. Use this button to end translation mode.

)

Close

Closes the currently open translation unit without saving the
translation in Translation Memory and ends translation mode. This is
useful if you would like #of to save your current translation to TM. If
the target field is empty, Translator’s Workbench will restore your
original source text in the same way as % Restore Source.

Additional Menu Functions in TM Mode

Open Next non-100% Get
[Ctrl] + [Alt] + [Home]

Skips all 100% translated sentences and opens the first fuzzy match
or no match sentence. This command is very useful in texts that have
already been partly translated using the Translate function from
Translator’s Workbench’s Tools menu.

language version of Word you are using. If you are working with the German Word, for instance, the menu will be

German, too.
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Set Close Next non-100%
Open Get

[Ctrl] + [Alt] + [+] on the numeric
keypad

Closes the currently open translation unit, saves it in Translation
Memory, skips all 100% translated sentences and opens the next
fuzzy match or no match sentence. This command is very useful in
texts that have already been partly translated using the Translate
function from Translator’s Workbench’s Tools menu.

Shrink Segment
[Ctrl] + [Alt] + [Page M

Reduces the current source segment by one sentence. When
segmenting your text, Translator’s Workbench may sometimes read
past an abbreviation or number at the end of a sentence, thus
suggesting a segment for translation that is too long. This is what the
Shrink Segment command is there for. If the segment cannot be
reduced any further, a beep sounds and Translator’s Workbench
displays the message “Cannot resize segment.”

After resizing the segment, you may want to search Translation
Memory for a potential match. To do this, choose the Search
Resized Segment command from the Trados (TagEditor:
Workbench) menu, or press the shortcut [Cerl] + [Alt] + [N]. If
Translator’s Workbench can find a match, it will transfer the target
segment to your document.

Expand Segment
[Ctrl] + [Alt] + [Page V]

Expands the current source segment by one sentence. During
translation, you may decide to translate two source sentences with
one target sentence. This is what the Expand Segment command is
there for. A segment cannot be expanded past a paragraph end
marker (). In this case, a beep sounds and Translator’'s Workbench
displays the message “Cannot resize segment.”

After resizing the segment, you may want to search Translation
Memory for a potential match. To do this, choose the Search
Resized Segment command from the Trados (TagEditor:
Workbench) menu, or press the shortcut [Cerl] + [Alt] + [M]. If
Translator’s Workbench can find a match, it will transfer the target
segment to your document.

Search Resized Segment
[Cerl] + [Alt] + [N

After resizing a segment using the Expand Segment or Shrink
Segment command, you may want to search the Translation
Memory for a potential match. This is what the Search Resized
Segment command is there for. If Translator’s Workbench can find
a match, it will transfer the corresponding target segment to your
document.

Concordance Command

Concordance
[Alt] + [N

After selecting a word or other sentence part in your document, use
the Concordance command to search the Translation Memory for
the selected text. If Translator’'s Workbench can find the same or
similar text, it will open a Concordance window showing all matching
translation units.

Shortcuts For Choosing Between Matches

[Alt] + [Page N &
[Alt] + [Page V]

If Translator’s Workbench finds more than one match for the current
source segment, you can use shortcuts to choose between them from
within your word processor or TagEditor. [Alt] + [Page V] browses to
the next match with a lower percentage value. [Alt] + [Page ]
browses to the previous match with a higher percentage value.

“Placeable” Commands

‘_

—_

Get Previous Placeable
[Al] + [Cerl] + [€]

Copies the previous placeable (tag, graphic, field, hyperlink, or other
non-translatable element) to the target field at the cursor position.
You recognise placeable elements by a blue bracketed underlining.

ﬁ
Get Current Placeable
[Alf] + [Crr]] + [V]

Copies the current placeable to the target field at the cursor position.
You recognise the current placeable element by the bold blue
bracketed underlining.

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



Interface With Your Word Processor and TRADOS TagEditor

—+

—_

Get Next Placeable
[Al¢] + [Cerl] + [D]

Copies the next placeable to the target field at the cursor position.

Terminology Commands

—/

‘_

Get Previous Term
[Alt] + [€]

Transfers the translation of the previous term to the target field.

5%

Get Current Term
[Alf] + [V]

Transfers the translation of the currently highlighted term (bold red
bracketed line) to the target field.

—

=

Get Next Term
[Ale] + [=2]

Transfers the translation of the next term to the target field.

Switching the Workbench Toolbar and Menu on/off ( 97 only)

3

Translator's Workbench

Switches the Translator’s Workbench toolbar and menu on or off.

In Case of Problems ( only)

Fix Document If you run into problems during interactive translation—if

Translator’s Workbench cannot open a translation unit or you
inadvertently try to open two translation units at the same time, for
instance—this function helps you to restore your document to its
previous state.

6.1 How To Use Translator's Workbench in Your Word Processor and TagEditor

The following are suggestions on how to proceed when using Translator’'s Workbench from
within your word processor or TagEditor.

6.1.1 Before Starting: Some Background Information & Useful Settings ()

In your word processor, you have several possibilities to view such nonprinting data as paragraph
marks or tabs. Another important nonprinting category is what is referred to as “hidden text.”
Translator’s Workbench makes extensive use of hidden text to perform several tasks:

When opening a sentence using the [, & or & button, Translator’s Workbench inserts
hidden marks into your document. These marks typically are {05, <03, and < n>, # being the
match value between the current source segment and the matching segment from
Translation Memory. For example, 100> means that Translator’s Workbench has found an
exact match, 4 gs;> means that it has found a 85% fuzzy match, and ;o;> means that it could
not find any match at all. The two other marks, ;o> and g}, delimit the current segment pair,
that is, the source and target segment:

{0>

This is a sample sentence.
<}92{>

Dies ist ein Beispielsatz.

<0}

Among other things, the delimiting marks play a crucial role for recognising already
translated parts of documents.
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e After translating, the source segment and all delimiting marks are kept in your document as
hidden text. The target text, that is, your translation, is formatted as visible text with all
formatting intact. Example:

Beispielsatz, der bereits libersetzt wurde..o

This is why we recommend you to set your word processor’s view options to display hidden text.
To display hidden text in Word, click the I button in Word’s standard toolbar. This will make
visible all nonprinting characters, including paragraph and delimiting marks. Repeatedly clicking
1 toggles between displaying and hiding nonprinting characters. If you want to control which
nonprinting characters should be displayed, you can use the Options command from Word’s
Tools menu. In the Options dialog, select the View tab as follows:

Options B E
Track Changes | User Infarmation | Campatibiliey I File Lacations
Yiew | General | Edit I Print I Save | Spelling & Grammar

Mormal view options

Show
™ Draft fonk I™ Bookmarks
™ Picture placeholders I Field cades
V' animated text Field shading:
= ScreenTips W
[V Highlight

Monprinting characters
™ Tab characters ™ optional hyphens
™ spaces ™ Hidden text
™ Paragraph marks E

Window
v status bar ¥ Horizontal scroll bar
Style area width: ¥ Wertical scroll bar
0cm = [~ ‘Wrap ko window

OK I Cancel I

Figure 6-3: The View tab in Word’s Options dialog (here, Word 97)

Check the desired items in the Non-Printing Characters section, and confirm with OK. In our
example, we checked the All option, which has the same effect as the I button.

Also, we strongly recommend that you work in Normal view mode when translating documents
with Translator’s Workbench. This speeds up your work considerably, and makes using the
different Workbench functions much smoother. If you translate documents with footnotes, you
must work in the Normal view mode, otherwise problems will occur.

Note ()

In a similar way to Word, TagEditor holds the source and target segments in one and the same
document. That’s what the %>, and 1 delimiting tags are there for. These delimiting
tags have exactly the same function as the delimiting marks in Word: they identify the source
segment, match value, and the target segment.

6.1.2 Segmenting a Text ( and )

As has already been described in detail, Translator’s Workbench automatically determines the
current sentence and attempts to find it in Translation Memory during interactive translation.
The program uses punctuation as orientation in identifying a sentence. As a general rule, a full
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stop, exclamation mark, question mark, colon, or tab end a sentence when they are followed by a
space. A quotation mark (” or ’) or a close parenthesis (“)”) may follow the closing punctuation
mark and precede the space. A semicolon (;) does not end a sentence. If required, you can
change these basic settings in the Segmentation Rules tab of the Translation Memory Setup
dialog which is used to configure a Translation Memory. Please refer to the section on “Defining
Segmentation Rules” in the “Translation Memory” chapter for details.

Note ( only)

Translator’s Workbench also uses your word processor’s built-in language features to segment
your text. If the program always interprets, say, the German abbreviation Jzw. to be the end of
a sentence, it’s useful to check in which language your source text has been formatted. To
achieve this, select the text part that interests you, and choose the Language command from
your word processor’s Tools menu. If the text is formatted in English, for instance,
Translator’s Workbench “thinks” it deals with English language, thus interpreting bzw. to be
the end of a sentence. To change the language formatting, select the desired text portion,
assign a new language via your word processor’s Language command.

Excluding Text Parts From the Translation Process ( only)

In the following two sections, you learn how you can leave text parts out of the translation
process. Translator’s Workbench can ignore text units ranging from whole paragraphs to single
characters.

Using Paragraph Styles to Exclude Paragraphs From the Translation Process (
only)

Leaving entire paragraphs out of the translation process is useful, for instance, if your text
contains paragraphs with nothing but program code, non-translatable examples, or other text that
should be left untranslated. When opening a translation unit, Translator’s Workbench checks the
name of the current paragraph style and compares it with the names on a list of so-called “non
translatable” paragraphs that you can define. If the current paragraph style is non-translatable,
Translator’s Workbench will skip it and all paragraphs with the same style until it finds a
paragraph whose style does not figure on the list. As a result, in order for Translator’s Workbench
to recognise “non-translatable” text parts as such, the paragraphs in question must be formatted
in styles with unique names. Let’s suppose that you are about to translate the following text:

This is a sample paragraph that should be translated, formatted in the paragraph style
“Normal.”

This is a sample paragraph that should be skipped, formatted in the paragraph style
“SkipDuringTranslation.”

This is a sample paragraph that should be translated, formatted in the paragraph style
“Normal.”

In this example, Translator’s Workbench can ignore the second paragraph when moving from the
first to the third one. In order for this to work, the paragraph style name SéipDuringlranslation
must figure on the list of Non-Translatable Paragraphs. To achieve this, you would follow these
steps:

1. In Translator’s Workbench, choose the Non Translatable Paragraphs command from the
Settings menu. The Non Translatable Paragraphs dialog appears. Here you specify the
names of the paragraph styles that should be skipped by Translator’s Workbench during
translation.
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Mon Tranglatable Paragraphs

Enter style names of paragraphs which are nat ta be proceszed. ok

o |
Cancel |
_ tep |

Help

Add

DElete

<« Copy

L

DOpenFile.... |

Figure 6-4: The Non Translatable Paragraphs Dialog

To add a style name to the list, follow one of these procedures:

Click inside the input box. The cursor starts blinking. Enter the name of the paragraph
style representing the text that should be left untranslated. In our example, you would
enter “SkipDuringTranslation.” Click Add to confirm.

Mon Tral able Paragraphs

Enter style namesz of paragraphz which are not ta be proceszed. oK

Cancel

Help

Pl

SkipDuring T ranzlation

uringT ranzlation Delete |
<< Copy |

OpenFile.... |

Figure 6-5: Adding Non Translatable Paragraph Styles “By Hand”

You can also pick the styles from existing Word documents. To achieve this, click the
Open File button. The Style List File dialog opens. Locate the desired Word document
on your system, and click Open. Translator’'s Workbench will now quickly scan the
document and then display a list of all its paragraph styles. Select the desired style

names and click the << Copy button. The style names are copied to the list of non-
translatable paragraph styles.
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Mon Tranglatable Paragraphs

Enter style names of paragraphs which are nat ta be proceszed. oK

Cancel

Pl

Help

Stylez in Demo.doc:

Add
SkipDuringT ranslation Delete | Body Text
— Camment Text

heading 1
[ arrnal
S kipDluring T ranslation
Small

DOpenFile.... |

Figure 6-6: Picking a Non Translatable Paragraph Style from a Document

3. The name is added to the list on non-translatable paragraphs.
4. Ifrequired, repeat steps 2-3 for other paragraph style names.

5. Click OK to confirm your settings. From now on, Translator’s Workbench takes into account
which paragraph styles are to be ignored during translation.

Hint

If you’re not familiar with styles, you can find more information in your word processor’s
documentation. In Word, for example, it’s all in the on-line Help under “Automatic
Formatting and Styles.”

Using Character Styles to Exclude Text Parts From the Translation Process ( only)

In addition to paragraph styles, Translator’s Workbench can skip text formatted with specific
character styles during interactive or batch translation. This is especially useful for on-line Help
files or other document types with character styles designed to identify jump and popup context
IDs or similar non-translatable information.

Translator’s Workbench treats non-translatable text as “external” or “internal”. If you define a
character style as external, Translator’s Workbench will completely ignore the corresponding
text during translation and treat all text formatted with that style as the end of a segment. This is
more or less similar to the non-translatable paragraph feature described above. Sometimes,
however, non-translatable text can also occur within a segment, for example a jump topic ID
following double-underlined jump text in the middle of a sentence. In this case, you can define
the character style of the jump topic ID as “internal.” Translator’s Workbench will then treat the
jump topic ID text as a “placeable” element. See below for examples and further information on
placeable elements.

You define the list of non-translatable character styles in the Translation Memory setup. Follow
these steps:

1. From the Translator’s Workbench File menu, choose Setup. To be able to access the Setup
menu item, you need to open the Translation Memory exclusively. The Setup dialog opens.

2. Click the Non Xlatable Text tab.
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Setup E:\Program FilesA\TRADOSATWAWIN\Demo tmw B
Generall Fields I Fonts I Substitutionsl Segmentation Aules  Monxlatable Text |Access Hightsl

Enter character style names of text which is not ta be processed.

| Add

elete

L

<< Copy

" Extemal &+ |ntemal Open File.... |

oK I Cancel Help

Figure 6-7: The Non Xlatable Text Tab

Here you compile the list of non-translatable character styles. You can enter the style names
“by hand” or pick them from one or more Word documents.

e  To pick the styles from Word documents, click the Open File button. The Style List File
dialog opens. Locate the desired Word document on your system, and click Open.
Translator’s Workbench will now quickly scan the document and then display a list of all
its character styles. Select the desired style names and click the << Copy button. The
style names are copied to the list of non-translatable styles.

Setup E:\Program FilesA\TRADOSATWAWIN\Demo tmw B
Generall Fields I Fonts I Substitutionsl Segmentation Aules  Monxlatable Text |Access Hightsl

Enter character style names of text which is not ta be processed.

I fdd Stylez in Demadoc:

in JurnpContextD Delete | D efault Paragraph Font

" Extemal &+ |ntemal Open File.... |

oK | Cancel | Help |

Figure 6-8: Picking Non Translatable Character Styles from Documents

You can also simply type the style names into the input box and click the Add button.
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Setup E:\Program FilesA\TRADOSATWAWIN\Demo tmw B

Generall Fields I Fonts I Substitutionsl Segmentation Aules  Monxlatable Text |Access Hightsl

Enter character style names of text which is not ta be processed.

|J urnpContestiD

i JumpContext D Delete |
¢ Copy |

" Extemal &+ |ntemal Open File.... |

oK | Cancel | Help |

Figure 6-9: Manually Adding Non Translatable Character Styles

4. For each character style, the Internal option is activated by default, meaning that text
formatted in the corresponding style will be treated as a placeable element. For each style to
be completely ignored during translation, highlight it and click the External radio button.

5. Click OK to confirm the list.

Example

o

Textformatted in character style Textformatted in character style
"JumpText" "JumpContext|D"

Figure 6-10: Example of Character Styles

In this example, the text jump link would have to be translated, whereas the hidden text MyJump
following it must remain the same in the target version, since it contains a unique context 1D
used by the Help compiler to identify the page with the related topic.

As a consequence, you would add the character style name JumpContextID as an “internal” style
to the list of non-translatable character style names.

For more information on translating on-line Help files, see the “Translating Online Help Files
with Translator’s Workbench” chapter.

6.1.3 Using Colouring To Identify Translated Parts of Documents ( only)

Colouring can help you identify which parts of a text have already been translated and which
remain to be dealt with. It may also be desirable to easily distinguish between source and target
text, in addition to Translator’'s Workbench’s delimiting marks described above under “Before
Starting: Some Background Information & Useful Settings.”

To change the colouring of translated parts of text, follow these steps:
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1.

From TTranslator’'s Workbench’s Options menu, select the Translated Text Colours
command. The Translated Text Colours dialog appears.

Tranzlated Text Colours [ X]

Source Calaur Target [100% katch]
nichanged I Unchanged < l Cancel
Target [Fuzzy Match] Help |
IUnchanged j

Suggestion |

This sentence has been skipped. . This English
sentence is diffcult to translate .y go - Digser deutsche
Satz ist schwer ZU Ubersezen .,

(o> THis English sentence is hard to translate . qq-Dieser
deutsche Satz ist schwer zu Obersetzen ., This sentence
still has to be translated.

Figure 6-11: The Translated Text Colours Dialog

In this dialog, choose the desired colours from the Source Colour and Target Colour drop-
down lists. There are two target colour lists, one for exact and one for fuzzy matches. By
default, Translator’s Workbench does not change the colouring of your text (All drop-down-
lists are set to Unchanged). Click the Suggestion button if you want to use the same colours
as those used for the source and target field during interactive translation in your word
processor: blue for already translated source text, dark green for exact matches, and dark
yellow for fuzzy matches. The small window below the colour drop-down lists shows you the
effects your changes will have on your translation work. Translator’s Workbench will
remember the changes you make for future re-use.

The Translated Text Colours option is especially useful in combination with the Translate
function described in the “Document Analysis, Translation, and Cleanup” chapter. After pre-
translating files, you will see immediately which parts of text must still be translated (original
colour), edited (dark yellow colour for fuzzy matches) or those which can be accepted as is (dark
green colour). But it’s also useful for interactive translation work from within your word
processor: for instance, if you re-open a file that you have already started translating before, you
will find out immediately where to re-start working, thanks to the colours that help you find
those parts that still have to be translated.

Notes and Recommendations

Make sure to use colours that don’t already exist in your source texts in order to avoid
confusion.

As mentioned above, changes to the colour settings affect both your interactive translation
work in your word processor as well as the Translate function used to pre-translate
documents in batch mode described in the “Document Translation” chapter. To remove the
colouring after finishing all your translation work, use the Clean Up function described in
the “Cleaning Up Translated Documents” chapter.

Once you have made a choice for source and target colours, you must stick to that choice
until the clean up stage in order to avoid errors. So do not start translating with one colour
setting and then change colours in the middle of the translation work. Apart from confusing
you, it will make the cleaning process impossible.

Translated text colours are not supported in TagEditor.
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6.1.4 Standard Translation Situations with Translator's Workbench ( and )

To start TM mode, it’s best to use ¥ (Open Get). This makes sure that Translator’s Workbench
transfers potential 100% or fuzzy-matching translations to the target field in your document.

Note

The first time you click the & button, it might take some time for Translator’s Workbench to
perform its different analysing tasks with your source text. Do not interrupt this function in
any way. Just wait until Translator’s Workbench inserts the blue source and yellow/green
target field into your document.

After analysing your source sentence, several possibilities arise:

e Translator’s Workbench may find one or more 100% matches. This case is explained under
“Case 1: 100% Match.”

e Translator’s Workbench may find one or more fuzzy matches. This case is explained under
“Case 2: Fuzzy Matches.”

e Translator’s Workbench may not find any match at all. This case is explained under
“Case 3: No Match.”

*  You might want to edit one or more translations at a later stage and store these changes not
only in your document, but also in Translation Memory. This case is explained under
“Case 4: Making Corrections to Already T'ranslated Segments.”

* Another special case is the translation of subsegments. A subsegment is a “segment within
the segment,” typically a footnote, index entry, and the like. This case is only valid for the
interface between Translator’'s Workbench and Word (not TagEditor). Read more in the
section “Case 5: Handling Footnotes, Index Entries, Table of Contents Entries, etc.”

* Another speciality are non-translatable elements occurring within sentences, such as tags,
graphics, date or name fields, numbers, acronyms, and so on. These elements are referred to
as “placeables.” This is explained under “Copying Placeable Elements to the Target Field.”

Let’s go through each translation situation in a separate section.

Case 1: 100% Match

Of course, 100% matches are the best. A 100% match means that exactly this sentence was
already translated, and the suggested translation can therefore be accepted as is. The match
value is displayed in the lower left corner of Translator’s Workbench’s program window.

In your document, you can immediately recognise a 100% match from the colour of the target
field. If the colour is green, then this means that Translator’s Workbench has just transferred a
100% match.

Automatic Translation

If Translator’'s Workbench finds a 100% match and the data in your Translation Memory is
reliable, the program could of course translate a 100% match without confirmation from you. If
several 100% matches follow one another, Translator’'s Workbench should only stop at the next
fuzzy match. The Y] button, also labelled Translate to Fuzzy, tells T'ranslator’s Workbench to do
precisely this. You can also use the shortcut [Alt] + [x] ([Alt] + [*] on some systems) on the
separate numeric keypad to start this function.
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Note

The Translate to Fuzzy command can only be started from an open translation unit.

Interrupting Automatic Translation

To interrupt the Translate to Fuzzy function, click with the left mouse button somewhere inside
Translator’s Workbench’s program window. The program will stop translating automatically after
the next translation unit.

Case 2: Fuzzy Matches

When one or more fuzzy matches are found, you will need to adapt the suggested translation in
most cases, since it is the translation of the Translation Memory sentence and not the translation
of the new source sentence. Translator’'s Workbench displays the new source sentence in both its
Source window and the source field in your document. It displays the T'M sentence in its TM
window and the translation of this sentence in the yellow target field in your document. The
differences between the new source sentence and the Translation Memory sentence are
highlighted in different colours.

Colours For Identifying Differences

To allow the translator to see the differences between the source sentence and its fuzzy match
equivalent from Translation Memory (=TM sentence) as quickly and easily as possible, changed
words are highlighted in different colours. The following conventions are used:

Colour |Meaning

Yellow |is used for all words that were replaced in a certain part of the sentence. For instance, if a
different product name is used in the source sentence than in the fuzzy-match equivalent from
T'M, both product names will be shown in yellow.

Grey is used to identify all words that have either been added or left out in the source sentence.
That is, these words make the source sentence longer or shorter than the 'I'M sentence. As a
general rule, the translation of these words must be adapted accordingly. As a consequence, if
something has been added to the new source sentence, you will probably have to add the
corresponding words to the suggested translation. Likewise, if something has been left out in
the source sentence, you will have to delete the corresponding parts in the suggested
translation as well.

Blue indicates that a part of the sentence has moved. A clause like for instance can occur in several
different places in the sentence without changing its overall meaning. This means that
frequently the suggested translation does not need further adaptation.

Automatic Substitution of Interchangeable Elements

As was already explained in the “The Substitutions Tab” section of the “Translation Memory”
chapter, you can decide whether numbers, acronyms, names, and similar variable elements are
treated as variables or normal words by Translator’'s Workbench. This has an influence on how
your Translation Memory looks and how target-language sentences are transferred to your
document in the case of a fuzzy match. If you have decided to have Translator’s Workbench
automatically substitute numbers, Translator’s Workbench will automatically adapt all numerical
data in the target sentence to match the values from the new source sentence, even if the TM
sentence contains different numbers.
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Note

If a number or other variable element is the only thing that changed in the new source
sentence, Translator’s Workbench treats it as a 100% match. This means that it will transfer
the adapted translation as a 100% match to your document. As a result, even if the numbers
have changed, you will see a green target field in your document.

Please read through the “T'he Substitutions T'ab” section for examples and further explanations.

Case 3: No Match

A “no match” refers to the situation when no similar sentence was found in Translation Memory,
or when the match value is less than the Minimum Match Value that you specify using the
Translation Memory Options command (see the corresponding section in the “Translation
Memory” chapter for details).

If Translator’s Workbench cannot find any fuzzy match, it will display a corresponding message
(“No match!”) in its status bar, and you will be presented with an empty yellow target field. Of
course you will still see the source sentence in the blue source field and in the Source window of
T'ranslator’s Workbench.

However, even when you get a “no match,” Translator’s Workbench offers several functions to
make the translation process faster and easier.

Copying Terminology

As mentioned in the “Getting Started” chapter, Translator’s Workbench highlights known terms
with red bracketed lines in the Source window, and displays the first translation of a term in its
Terminology window. You will want to insert translated terms into the target field while entering
the new translation. Follow these steps:

1. Start translating until you want to insert the first known translation of a term.

2. Click the ®* button ([Alt] + [\]). The translation for the current term is now inserted. It
remains selected.

3. Press [2] to get out of the selection. Adapt the inserted term linguistically if required.

4. Go on translating until you want to insert the next translation. Click the = button ([Alt] +
[=]) to move to the next known translation of a term and insert it into your target field.

Repeatedly pressing the = or & button ([Alt] + [D] or [Alt] + [€]) lets you browse through the
different translations of known terms. You also use the = button to paste the second, third etc.
translation of a known term in case of synonymes.

Using the Concordance Function to Copy Known Translations of Sentence Segments

If certain terms or other sentence parts interest you but are not known terminology-wise, you can
always use the Concordance function (#) to search the Translation Memory for the selected part
of text. Follow these steps:

1. Select the sentence part that interests you, usually one or more words in the source field.

2. Click the # button. Translator’s Workbench will search for the text in the current TM. If it
can find one or more translation units containing the text, it will open a Concordance
window with all matching TUs.

You will note that the more your Translation Memory grows, the more useful the Concordance
function gets. We recommend that you make heavy use of this feature to push your productivity
to new heights.
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To transfer text parts from the Concordance window to the target field in your document, follow
these steps:

1. Select the text to be copied in the Concordance window, usually the translation of the term
or sentence part that you have searched for.

2. Press the right mouse button ([Shift] + [F10]), and select Copy to Clipboard from the context
menu that opens.

3. Close the Concordance window by double-clicking on its system menu or by pressing the
shortcut [Alt] + [F4].

4. Change back to your document, position the cursor where you wish to insert the text, and
choose the Paste command from the Edit menu.

Copying Placeable Elements to the Target Field

Source segments often also contain non-translatable elements, such as tags, graphics, fields,
numbers, dates, etc. In most cases, these elements will be left as is in the target text. The only
thing that will change is their position in the target segment. Therefore, these elements are
referred to as placeables, since you decide where to place them during translation. To make this
task as easy as possible, Translator’s Workbench marks placeable elements with a blue bracketed
line in analogy to known terminology and offers special buttons and key combinations to transfer
them to the target segment.

To transfer the currently highlighted placeable to your target segment, click the *% button or
press [Alt] + [Ctrl] + [\V]. To transfer the following placeable—if any—click the = button ([Alt]
+ [Ctrl] + [2]). Repeatedly pressing the = or the #= button ([Alt] + [Cerl] + [2] or [Alt] + [Cerl]
+ [€]) lets you browse and transfer the different available placeables.

Exploring Your Word Processor and TagEditor as a Translation Editor

In your word processor, you have countless possibilities to manage your text when it comes to
moving, copying, and formatting it in any way. Since Translator’s Workbench does not impede
this rich functionality, you can continue exploring it as before. Sometimes, for instance, certain
words are not translated. In these cases, you don’t have to manually retype the words that appear
in the source window but can use the Copy and Paste functions. The same goes for formatting
( only): If parts of the source sentence are formatted differently from the rest and you want to
transfer this formatting to the corresponding parts of the target sentence, use your word
processor’s quick-formatting facilities (the ¥ button in Word). Please refer to your word
processor’s extensive on-line Help and documentation for more information on copying and
formatting text.

Case 4: Making Corrections to Already Translated Segments

If you would like to make corrections to translations after their initial creation, you should always
do this in TM mode so that the corrections will be stored in Translation Memory as well as in
your document. Follow these steps:

1. Place the cursor somewhere in the sentence to be corrected.

Click the & button to re-open the translation unit in TM mode.

Make the desired changes to the target segment.

el

After the correction, click the * button. This will update the translation unit both in
Translation Memory and in the text.

If you have more exhaustive corrections to make, for instance general terminology or style
changes that occur in many sentences, the method described above can become somewhat
tedious. In this case, we recommend you correct the sentences in one go, for instance by using
the Find & Replace command. That of course implies that TM mode is not active during such
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corrections. This means that changes are made to the document but not to Translation Memory at
the same time. This is where Translator’s Workbench’s Cleanup function comes into play. This
function can update your TM based on the corrections you made in the text. For more
information, see “Cleaning Up Translated Documents” in the “Document Analysis, Translation,
and Cleanup” chapter.

There are also various ways to edit the translation units directly in Translation Memory:

e For spot corrections, you can edit translation units from within the Source or Concordance
window. See “Editing and Deleting Translation Units” in the “Translation Memory”
chapter.

e For more exhaustive corrections, it’s best to use the Maintenance utility from Translator’s
Workbench’s File menu. Among other things, this tool lets you carry out global replacement
operations on a specific number of translation units. See “Translation Memory
Maintenance” in the “Translation Memory” chapter.

Case 5: Handling Footnotes, Index Entries, Table of Contents Entries, etc. ()

In today’s word processors, text does not only occur in the form of a neat sequence of sentences
and paragraphs. It can also contain all kinds of elements occurring wizhin sentences, for example
index entries or footnotes. In Word, for instance, index and TOC entries are represented in
“XE” and “TC” fields, whereas footnotes are created using a footnote reference symbol and
footnote text. In Translator’s Workbench terminology, these elements are referred to as
“subsegments,” since they occur as segments within segments.

How does Translator’s Workbench treat such subsegments? For those cases where subsegments
do 7ot contain translatable text—for instance, graphics, date or time fields—the program treats
them as “placeable” elements. Refer to the “Getting Started” chapter and to “Copying
Placeable Elements from the Source Field to the Target Field” above for more information on
this.

As soon as translatable text is contained in the subsegment, you need to do two things:

* place the subsegment at the appropriate location in the target sentence
e translate the information in the subsegment

It’s best to go through an example to illustrate this. Let’s assume you have to translate the
following sentence with an index entry:

In Workbench terminology, this sentence consists of fwo segments: the main segment (the
sentence itself), and the subsegment (the index entry in the XE field). To translate this
example, follow these steps:

1. Since index entries are formatted as “hidden text” in Word, make sure that hidden text is
visible. To achieve this, choose the Options command from Word’s Tools menu, click the
View tab, and check the All item in the Non-printing characters section.

2. After opening the translation unit with & or @ Translator’'s Workbench displays the
segment and its sub-segment in the blue source field as follows:

{0>

formatted as hidden characters, which you can recognise by the dotted line under them.
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4. As you can see, the main segment has the number 0 (it’s delimited by (o> and < marks),
whereas the subsegment has the number 1 (it’s delimited by (1> and <13 marks). Further
subsegments would be numbered accordingly. As a general approach, it’s best to first
translate the main segment completely and then deal with the subsegments. In our example
you would translate T%e apple is a fruit growing on a tree, saying something like Der Apfel ist cine
Obstsorte, die auf Bdumen wdchst.

5. Once you have translated the main segment, place the cursor where you would like the first
subsegment to go. In our example, you would place the cursor after the word Apfe/. Now
press the key combination [Alt] + [1]. Translator’s Workbench inserts an empty “XE” field
at the current cursor position and delimits it with 1> and <1y marks as follows: [1-{XE ""}<1;.
After that, it places the cursor inside the quotation marks. Now you can translate the index
entry (fruits:apple), saying something like Obstsorten:Apfel. Your target field will now look like
this:
<}0{>
Der Apfel {1-{XE"Obstsorten:Apfel"}<1; wachst auf Baumen.
<0}

6. You can now confirm the translation unit and move on to the next sentence as usual by
clicking the &) button.

Note

Internally, Translator’s Workbench treats the main segment (0) and subsegment (1) as two
separate translation units. As a result, it stores two separate translation units in Translation
Memory. If one of the above segments comes up again in the same or a similar form,
Translator’s Workbench will automatically retrieve the corresponding translation unit. Also, if
both come up again as one segment, the corresponding TUs will be retrieved and the
corresponding match will be treated as a 100% one.

If more than one subsegment occurs, follow the same procedure:

el

o

Translate the main segment (0).
Place the cursor where you would like to insert the first subsegment (1) and press [Alt] + [1].
Translate the first subsegment.

Place the cursor where you would like to insert the second subsegment (delimited by (- and
<23 marks) and press [Alt] + [2].

Translate the second subsegment.
Repeat this procedure for all other subsegments.

Confirm the entire translation with 3.

Footnotes: a Special Case

Depending on your version of Word, Translator’s Workbench handles footnotes in quite
different ways. We will first describe the footnote handling in Word 6.0/7.0, followed by
Word 97.
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Footnote Handling in Word 6.0 and 7.0

Note

You cannot translate footnotes in Layout view mode. Before translating a text containing
footnotes, make sure to change to Normal view mode by choosing the Normal command from
Word’s View menu.

When the subsegment is a footnote, once you place the subsegment via [Alt] + its number,
Translator’s Workbench will automatically insert a footnote reference symbol into the target
field and open your word processor’s footnote pane used for editing footnote text. Here you can
enter the translation of the footnote text into the yellow target field as usual. After completing
the entire translation (main segment and footnote), click the #! button to move to the next
segment.

Improved Footnote Handling in Word 97 or Higher

In contrast to earlier Word versions, footnotes in Word 97 documents are not treated as single
segments. Instead, as soon as you place a footnote inside the target segment, Translator’s
Workbench opens a temporary document called TWAW n  Foot not e. doc, where you translate
the footnote just as any other document, using the full Workbench functionality. After
translating the footnote, you return to the main segment in your document and continue
translating as usual. To translate a segment containing one or more footnotes, follow these steps:

1. Be sure to always work with hidden text turned on. Click the ¥ button in Word’s standard
toolbar to achieve this.

2. As soon as you open a sentence containing footnotes, Translator’s Workbench will
automatically assign a subsegment number to each footnote in the source field, using its
segmentation marks. The subsegment numbers assigned to the footnotes always start
from 1. So, for example, if a segment contains five footnotes, their subsegment numbers will
range from 1 to 5, whereas their absolute numbers might range from 6 to 10 or 70 to 74.
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Figure 6-12: Opening a Segment With Footnotes (the subsegment numbers are 1
and 2, the absolute numbers are 5 and 6)

3. You can now start translating the segment. We recommend you to first translate the main
sentence and only then the footnotes (as before), but you are also free to start with the
footnotes without entering any text into the main segment at all, or translate the footnotes in
a different order. When translating the footnotes, there is one simple rule: do not look at the
absolute numbering of the footnotes, only at the subsegment marks Workbench has assigned
to the footnotes.
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4.

To start translating any footnote, press [Alt] + its subsegment number. For instance, if
Translator’s Workbench has assigned subsegment number 3 to the footnote you want to
translate, press [Alt] + [3].

From now on, the behaviour is different from the one you were used to. Translator’s
Workbench no longer opens the footnote pane below the main document to show the
footnote text. Instead, a new document is opened, always called TWAW n Foot not e. doc.
Inside this document, normal segmentation takes place, as shown below. In other words,
long footnotes are no longer treated as a single segment.
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Figure 6-13: Translating footnotes in the Document TW4Win Footnote.doc

Translate the footnote text just as any other text, making full use of Translator’s
Workbench’s functionality along the way. Please keep a few things in mind, however:

* Do not close the document TWAW n Foot not e. doc. Translator’'s Workbench will
automatically close it as soon as you confirm the last segment in the footnote (see step 7
below).

*  You can switch over to the main document at any time, for instance to take a look at the
text in the main segment. You will see that Translator’s Workbench highlights the
footnote you are currently translating. Be sure to not alter this or anything else in the
main document at this stage; instead, switch back to TWAW n Foot not e. doc to
complete the translation of the footnote.

When you have finished translating the last segment in your footnote, follow one of these
procedures to get back to the main document:

+  To return immediately to the main document, click &),

e If you want to review the footnote translation or perform similar tasks prior to switching
back to the main document, click .. This makes sure that you remain in the footnote
document, where you can now edit the translation as usual. After the review, to get back
to the main document, press [Alt] + [0].

After returning from TWAW n Foot not e. doc, you will find the cursor at the position
where you placed the footnote into the target segment. To continue translating the main
segment, move the cursor out of the subsegment by placing the cursor after the ) tag after
the footnote and press [Ctrl] + [Space]. This applies the default formatting to the cursor
position and thus prevents you from typing the further translation in the wrong style.

You can now continue translating the main segment or the other footnotes in the main
document. Repeat steps 4 through 8 for all other footnotes the main segment contains.
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Notes

e Translator’'s Workbench 2.x supports a maximum of 19 subsegments (footnotes or index
entries) per main segment. To place subsegments 1 through 9, press [Alt] + [1] through [Alt]
+ [9]. To place subsegments 10 through 19, press [Alt] + [Shift] + [0] through [Alt] + [Shift]
+[9].

*  Once you have translated a footnote and you have come back to your main document, its
absolute (not subsegment) number in the source language disappears. The superscript no
longer contains a number, but the code ™ instead. The absolute numbers have changed
accordingly, both in the source and in the target fields: the numbering now begins or
continues from the first untranslated footnote in the source segment until the last translated
footnote in the target segment. For example, in the screenshot below, the first footnote has
already been translated, so it has got the ™ code; the other two footnotes have not yet been
translated. Absolute numbering continues from the previous paragraph, now skips the
translated footnote with the ™ code, goes to the first untranslated footnote in the source
segment (absolute number 5, subsegment number 2), and continues with the translated
footnote in the target segment (absolute 7, subsegment 1).
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Figure 6-14: Footnote Numbering in Partly Translated Segments

e This numbering system tells you which footnotes have already been translated and are
already in the memory; moreover, when you have finished, your target segment should
contain the same number of footnotes as the original, and with the same numbering, while in
the source segment every footnote should have got its fn code. In fact, everything it is very
easy if you stick to the golden rule: do not look at the absolute numbering of the footnotes,
only at the subsegment marks Workbench has assigned to the footnotes.

e As for Word’s footnote pane (where you usually edit footnotes), it is possible at any time to
place the cursor inside the footnote pane inside an already translated segment and use & to
re-open it. In this case, Translator’'s Workbench will re-open the corresponding footnote
document TWAW n Foot not e. doc to allow you to edit your translation as usual. After
finishing the editing process with #, press [Alt] + [0] as described under step 7 above to
return to the main document.
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Figure 6-15: Re-opening Footnotes from within the Footnote Pane

e Be sure to never delete a footnote that you have already placed inside the target segment. It
will not be possible to re-place the footnote since in the meantime, its counterpart from the
source segment has already been replaced by the fn code.

* By the same token, be sure to translate all footnotes inside a segment, so that each fn code
in the source is matched up by a corresponding footnote in the target. If large parts of text in
a footnote are left untranslated, use the = Copy Source function inside TWIW n
Foot not e. doc to copy the source text as is into the target.

e After you finish the translation inside TWAW n Foot not e. doc, do #or use close the
document via the Close command from Word’s File menu. Rather, use [Alt] + [0] to return
to the main document as described under step 7 above. Translator’s Workbench will then
automatically close the document and place the translated footnote where it belongs into the
main document.

Footnote Handling in Batch Mode

The footnote handling in Word 97 also has some impact on the batch functions Analyse,
Translate, and Cleanup. If you can be sure that all translators you’re working with have Word 97
and do not use previous Word versions, you need to activate the Word 97 footnote handling
feature for the batch functions. To achieve this, follow these steps:

1. In Translator’s Workbench, from the Options menu, choose Translation Memory Options.
T'he Translation Memory Options dialog opens.

2. In the Tools tab, activate the switch Multi-Segment Footnotes (Word 8 or later). During the
Analyse, Translate, and Cleanup functions, Translator’s Workbench will then treat footnotes
in the same way as in Word 97 in interactive mode.

If you plan to send pre-translated documents to translators using Word 6.0 or 7.0, you must de-
activate the Multi-Segment Footnotes switch.
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New Footnote Handling and Keyword (K) Footnotes in RTF-Based Online Help Files

Due to the changes in the footnote handling in Word 97, it’s now possible to handle keywords in
RTF-based online Help files as separate segments within semicolon-delimited keyword (K)
footnotes. For more information, see the “Translating On-line Help Files with Translator’s
Workbench” chapter.

Case 6: Expanding and Reducing Segments

When segmenting your text, Translator’s Workbench may sometimes read past an abbreviation
or number at the end of a sentence, thus suggesting a segment for translation that is too long. On
the other hand, you may decide to translate two source sentences with one target sentence.

Workbench therefore offers commands for expanding and reducing source segments. Choosing
Shrink Segment ([Ctrl] + [Alt] + [Page P]) from the Trados menu reduces the current segment
by one sentence. If the segment cannot be reduced any further, a beep sounds and Translator’s
Workbench displays the message “Cannot resize segment.” Likewise, choosing Expand
Segment ([Ctrl] + [Alt] + [Page V1) from the Trados menu extends the current segment by one
sentence. A segment cannot be expanded past a paragraph end marker (). In this case, a beep
sounds and Translator’s Workbench displays the message “Cannot resize segment.”

After resizing the segment, you may want to search Translation Memory for a potential match.
To do this, choose the Search Resized Segment command from the Trados menu, or press the
shortcut [Ctrl] + [Alt] + [M]. If Translator’s Workbench can find a match, it will transfer the
target segment to your document.

Confirming the Translation & Moving on to the Next Sentence

After you have finished translating a sentence and you want to move on to the next one, click the
#) button. This saves the new translation unit in TM, and you move on to the next text segment,
and open a new translation unit. If a perfect or fuzzy match is found, Translator’s Workbench
will automatically transfer its translation into the target field in your document.

Leaving TM Mode

In order to leave TM mode, use the *! button ([Alt] + [End]). This makes sure that the new
translation unit is stored in TM. If, for any reason, you do zor want to store the translation in
TM—e.g. since further terminology research is necessary before the translation can be
completed—click the ¥ button.

6.1.5 Tips & Tricks For Word

The following is a list of useful tips & tricks while working with Translator’s Workbench in
Word.

*  Make sure that you never delete the delimiting marks used by Translator’s Workbench to
identify the main and subsegments of a translation unit ({gs, {15, {25 <0}, <1} <2}, €tc.). To
prevent the accidental deletion of these vital non-printing characters, make hidden
characters, such as the q, visible. In Word, you achieve this by clicking the ' button in
Word’s standard toolbar. You find more information on view options in the section “Before
Starting: Some Background Information & Useful Settings” in this chapter.

¢ Make sure not to delete the carriage return (q) character at the end of the source and target
field, because this deletes the source and target field colour formatting. Translator’s
Workbench can still store the translation unit even without the formatting, but you might be
irritated.

e IfTranslator’s Workbench does not seem to be able to store your translation unit in TM or if
you cannot confirm your translation and move on to the next sentence, you might get such
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an error message as “Bookmark still exists, run Fix document from the Trados menu.” In
this case, choose the Fix document command from the Trados menu to clean up bookmarks,
source and target fields etc. that might still be present in your document at the current
problematic position. After that, click the & button to try again.

*  Once you have a TM of a reasonable size, make extensive use of the Concordance option.
Select the word or sentence part that interests you and click the Concordance button (#).
You will see that the Concordance function will push your productivity to new heights,
because it not only gives you the translations of the selected sentence parts, but also usage
examples.

e As far as the View mode in your word processor is concerned, always work in Normal mode
rather than Page Layout / Outline. This will speed up your translation work considerably,
because your word processor does not have to repaginate each time you start translating a
new sentence. In Word, you set Normal view mode in the View menu by selecting the item
Normal.

e If your documents contain many graphics, we recommend that you set Word to display
placeholders instead of the graphics themselves. This speeds up working considerably. To
achieve this, choose the Options... item from the Tools menu, and select the View tab. Here,
activate the Picture Placeholders option. Confirm with OK. You’ll now see empty boxes
where the graphics used to occur. This causes Word to work much faster with Translator’s
Workbench.

e To save space on your screen (e.g. if you're working with a low resolution), you can de-
activate Word program window elements that you do not need during translation with
Translator’s Workbench. We would recommend you to check if you can do without the
horizontal scroll bar or one or more toolbars. To activate and de-activate scroll bars, use the
View tab of the Options dialog. To select and de-select toolbars, right-click in the toolbar
section, and uncheck all toolbars that you don’t want to see at the moment.

*  Word 97 only: For advanced users, we recommend changing some Registry settings that can
speed up Word considerably. The most effective way to achieve this is using the
RegOptions macro from the Support 8. dot template shipped with Word 97. This
template provides macros that can be used for manipulating the Registry. It is not installed
by default; be sure to select it during Setup. You can also install it at a later stage, or
download it from the Web (the address at the time of writing was
http://support. mcrosoft.com support/downl oads/ dp2750. asp?FR=0.
The Registry Options that most speed up Word are the “CacheSize” value (by default, it is
set to 64; we recommend a value of 512 or 1024) and the “BitmapMemory” (again, use 512
or 1024 instead of 64).

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



6-24 Interface With Your Word Processor and TRADOS TagEditor

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



7. Translating RTF-Based On-line Help
Files With Translator's Workbench

Translator’s Workbench offers special functionality for translating RTF-based on-line help files.
The following chapter describes how you can go about translating this type of files, using your
word processor and Translator’s Workbench as described in the “Interface With Your Word
Processor and TagEditor” chapter. The information contained in this chapter is only valid for the
interface between Translator’'s Workbench and Word (not TagEditor). We will describe the
special features of Translator’s Workbench when translating on-line Help files; we will not deal
with specialities of the Help files themselves (for instance, hot spot graphics or the difference
between, and appearance of, first- and second-level keywords). If you would like more
information on Help files in general, we recommend specialised literature, for example the
“Microsoft® Windows 95 Help Authoring Kit” or the manuals of help authoring tools that might
be used at your site.

To translate HT'ML-based on-line Help files, please follow the instructions in the “Translating
Tagged Files with Translator’s Workbench” chapter.

7.1 Characteristics of On-line Help Files

Generally, translatable on-line Help files come as specially formatted RTF (Rich Text Format)
files. In most cases, these files have been created in a word processor such as Word and/or a help
authoring tool like HelpMagician®, ForeHelp®, RoboHelp® or other.

RTF on-line help files differ from conventional documents in so far as they typically contain the
following elements:

e Custom footnotes (“$”, “#”, “K”, “+”, and others). Among other things, these footnotes are
used to identify help pages with a unique ID—also referred to as “context string” or “topic
ID”—, or to indicate browse sequences later allowing the help user of the compiled help file
to browse through topics sequentially.

*  Specially formatted text, for example double or single underlined. Such formatting indicates
a link to a related topic (hypertext function).

e Hidden text. Hidden text normally follows double or single underlined text immediately.
Hidden text is used to link help topics with related topics (so-called “jumps” and “popups”).

Some of these elements must be translated whereas others should or must be ignored during the
translation process, for example the “#” footnote containing the context string/topic ID of a help

page.

Below you’ll find a typical example of a help page.
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These are custom footnotes
containing information on
identifying the help page (see
footnotes below). They nor-
mally precede the title text.

This is a reference to a
graphic file to be displayed
on this help page.

The “#" footnote contains the
topic ID (context string) used
to uniquely identify this help
page. It must not be
translated.

The “+” footnote indicates a
browse sequence. It must not
be translated.

A typical help page looks like this:

i+ This line contains the title of the help page.

The title text is normally the same as in the
“$” footnote. See the “$” footnote below.

My First On-line Help Page <————

{bmc c:\help\sample.bmp}

This is normal text on the help page.

<—— |Generally, links to other help pages are

e

followed by hidden text.

This is a popupMyPopup link to a related topic.

formatted as double or single underlined text

$ ; T The “$” footnote contains the title of the help
| My First On line Help Page page. It must be translated.

*  MyFirstPage

K Help Contents; First Page;

+ . \ The “K” footnote contains keywords that will
7 Introduction:001 later appear in the Help Index to help users

locate help pages. It must be translated.

7.2 Special Functions in Translator's Workbench for On-line Help Files

Translator’s Workbench offers a series of functions that take account of the special formatting of
on-line Help files. It’s best to go through a detailed example to describe these special features.

The following step-by-step instructions tell you how Translator’s Workbench would react when
translating the above example. Simply apply the instructions to your own Help files. To translate
the above example, you would follow these steps:

1.

Open the RTF on-line Help file in Word. Make sure that Word is set to display hidden text
(see “Before Starting: Some Background Information & Useful Settings” in the “Interface
With Your Word Processor” chapter) and to normal view mode (from Word’s View menu,
choose Normal). Since there are footnotes on each Help page, we also highly recommend to
save as much space as possible on your screen, removing Word’s superfluous scroll and status
bars (see “Special Tips and Tricks for Word” in the “Interface With Your Word Processor”
chapter).

Make sure that Translator’s Workbench is running and that Word’s Workbench toolbar and
menu are active.

Place the cursor before the “$” footnote and click the & button ([Alt] + [Home]).
Depending on which Word version you use, Translator’s Workbench works differently, due
to the different footnote handling (see “Footnotes: a Special Case” in the previous chapter):

* In Word 6.0 and 7.0, Translator’s Workbench opens Word’s footnote pane, presenting
you with blue and yellow source and target fields as usual. The cursor is blinking at the
beginning of the target field in the footnote pane. Word also displays a source and target
field in its main document window, showing the footnote reference symbol “$”.
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Figure 7-1: Word 95’s Program Window after Opening a Footnote Segment in
the Footnote Pane

e In Word 97, Translator’s Workbench opens the temporary document TWIW n
Foot not e. doc, where it inserts the contents of the $ footnote in the blue source field.
The advantages of this way of handling footnotes are described in detail in the
“Interface with Your Word Processor or TagEditor” chapter.
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Figure 7-2: Word 97’s Program Window after Opening a Footnote in the
Temporary Document TWAWin Footnote.doc

Type the translation of the “$” footnote into the target field, saying something like Meine
erste Online-Hilfeseite. If you see only part of the footnote pane in Word 95 (for instance, only
the target but not the source field), drag the separator bar between the document and
footnote pane to enlarge the footnote window.

Confirm the translation as usual by clicking the @ button. Translator’s Workbench will now
automatically skip the “#” footnote since it must be left untranslated. It will open the “K”
footnote containing the keywords that will later appear in the Help index of the translated
Help file. Again the cursor will be blinking at the beginning of the target field in the
footnote pane (Word 95 and earlier) or the temporary document TWAW n Foot not e. doc
(Word 97 and later). As a translation, type something like Inhalt der Hilfe; erste Seite;. Respect
the syntax of keywords, that is, include semicolons and commas exactly as they appear in the
source field. This is important for the correct functioning of first- and second-level keywords
in the Help index. Note: Due to the multi-segment footnote handling in Word 97, it is
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10.

11.

possible to handle keywords in RTF-based online Help files as separate segments within
semicolon-delimited keyword (K) footnotes. See “New Footnote Handling and Keyword
(K) Footnotes in RTF-Based Online Help Files” below for more information.

Again, confirm the translation. Translator’s Workbench will again skip a “non-translatable”
footnote (the “+” footnote indicating a browse sequence) and move on to the title. As you
will notice, it will offer an “Exact Match” for the title itself, since it is the same as the “$”
footnote we have translated in steps 3 to 4. You can thus simply confirm the translation.

Translator’s Workbench will now open the graphic reference {bmc c:\help \sample.bmp). Since
this part should be left untranslated, you can use the Copy Source button (*+, [Alt] + [Ins])
to transfer the text exactly as is to the target field. You can also leave this kind of “text” out
of the translation process by turning it into a “placeable” element. See “Turning Graphic
References Into Placeables” below.

Confirm the translation. Translator’s Workbench will now move to the first “normal”
sentence of the help page, viz. This is normal text on the help page. You can translate it without
any special precaution, saying something like Dies ist normaler Text auf der Hilfeseite.

After confirming the translation, Translator’s Workbench will open the first example with a
jump link in it. The program treats jump and popup links as “placeables,” that is, non-
translatable elements that you will want to place somewhere in the target sentence. As a
result, it places a blue bracketed line under the jump ID:

5= TRADODS Translator's Workbench - Demo
File Settingz Miew Options Toolz Help
Changed on: P8 This is & jurnp{ JUMP} link to a related topic.
Changed by: e
Uzage:
L I
|No matchl

Figure 7-3: A Segment with a Jump

In our example, you would start translating, saying something like Dies ist eine Hypertext
(Jump)-Verkniipfung. After that, you would apply the double underlined formatting of the
word jump to the translation Hypertext (Jump)-Verkniipfung. 1’s easiest to use Word’s quick-
formatting capabilities to achieve this (use the ¥¥ button in Word’s toolbar or the shortcuts
[Shift] + [Ctrl] + [C] to copy the formatting of selected text and [Shift] + [Ctrl] + [V] to paste
it to the target selection).

Now you are ready to place the actual jump ID into the target field. Place the cursor
immediately after the double-underlined Hypertext (Jump)-Verkniipfung. You can now use the
“Get Current Placeable” button (2%, shortcut [Alt] + [Ctrl] + [V]) to copy the jump ID
MyJump to the target field. If there are more than one jump or popup IDs, you can use the
other two “Get Placeable” buttons to browse to the placeable you would like to insert. Note
that Translator’s Workbench inserts an extra blank into the target field after the jump ID.
(To prevent Workbench from inserting the additional blank, refer to the “Internal Tags an
Blanks” section in the “Translating Tagged Files With Translator’'s Workbench” chapter.)
The jump label remains selected. To continue typing the translation, press the [2] key to
get out of the selection, and press the [Backspace] to remove the extra blank, if desired. You
can now continue translating, saying something like mit e¢inem verwandten Thema. Your
translation unit should now look something like this:
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{O>ﬂ
This is a jumpMy Junp link to a related topic.

<} 0{ >ﬂ
Dies ist eine Hypertext (Jump)-VerknupfungMyJunmp mit einem verwandten Thema.
<O}ﬂ

12. Note that Translator’s Workbench applies special character styles to popup and jump IDs,
called “tw4winJump” and “tw4winPopup” respectively. These character styles might look
different from the original jump and popup IDs of your help files. This does not affect the
compilation process of the finished help file in any way.

13. You can now confirm the translation and continue with the next sentence. The translation of
this sentence works exactly as for the previous one, except that this time, the placeable
element is the popup ID text MyPopup, and the text that precedes it is single underlined.

This completes the round-up of special elements in Help files and Translator’s Workbench’s

functionality in this respect. You have seen that the program ignores footnotes that should be left

out of the translation process, and that jumps and popups are recognised as placeable elements.

For exceptions and limitations, see the “Exceptions and Special Issues” section below.

7.3 Word 97 Footnote Handling and “K” Footnotes in RTF-Based Online Help Files

Due to the multi-segment footnote handling in Word 97, it’s possible to handle keywords in
RTF-based online Help files as separate segments within semicolon-delimited keyword (K)
footnotes. For this to work, you need to do two things:

*  modify the existing Semicolon Skip Rule in your TM(s);

* add a new segmentation rule for the semicolon to the existing End Rules.

Follow these steps:

1. In Translator’s Workbench, open the TM in which you want to change the segmentation
rules. Be sure to open it in exclusive access mode.

2. From the File menu, choose Setup. The Setup dialog opens.

3. Click the Segmentation Rules tab.

4. Let’s first change the existing Semicolon Skip Rule. Click the Skip Rule option to display
the Semicolon rule.
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Figure 7-4: The Semicolon Skip Rule for the Demo TM

In the Trailing Whitespaces box, change the value to 1, as depicted below. From now on,

T'ranslator’s Workbench will on/y interpret the semicolon as a skip character if it is followed
by at least one space character.

Setup C:AProgram FilesATRADDSATW AW intDemo.tmw [ %]

Generall Fields | Fonts I Substitutions  Segmentation Rules | Mon #latable Textl Access Hightsl

| ISemlcoIon Reset |

Deleta | User Lists... |
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* Skip Fules

— Fule

IU_ Leading Characters Stop Character 1| Trailing ‘Whitespaces
ID_ Leading *ords I: 'I

= Mumber Stop

[F Fallowed by Lowercaze

[¥ Followed by Tab
Stop Eharactens et

¥ | Fiecededlbyimiessedltreyiamtion = Eirinl= B Dl
¥ | Fieceded Bl Enbreyiatit I | Ol Ewer

ID_ Gy af Dots

(u] 4 I Catcel Help

Figure 7-S: Changing the Semicolon Skip Rule
Click the End Rules option. Workbench now lists the set of End Rules that have been
defined for the current TM.

Click the Add button to add a new rule to the existing ones. Provide a name, e.g. Semicolon
in Keyword FNs.
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8. From the Stop Character drop-down list, choose the semicolon (";").

9. In the Trailing Whitespaces box, change the value to 0. From now on, Translator’s
Workbench will @/ways interpret the semicolon as a stop character if it is 7oz followed by at
least one space character. This is typically the case in Keyword footnotes of online Help
files.

10. Make also sure to grey the options Followed by Lowercase and Number Stop. When
finished, your new Stop Rule should look as depicted below:

Setup C:\Program Files\TRADOSATW AW in\Demo. tmw E

Generall Fields | Fonts I Substitutions  Segmentation Rules I Mon xlatable Te:-:tl Aoocess Hightsl

Add ISemicoIon in Kewword FNs Beszet |
Lelete |

Colon Abbreviation List:
Marks
End of Paragraph
@ Eud Fles Ordinal Follower List:
" Skip Rules
— Fule

ID_ Leading Characters
ID_ Leading Words

<7 Number Stop >

Stom Characten s Dt
I™ | Bieceded by Fues sedl S htreyiation = | SiraleLetter [t
™| Breceded by st &bbreviation ™| Orditial Fallawer

|1_ I, af Dots

0| Trailing Whitespaces
1 Followed by Lowercase

¥ Fallwed By Tab

Ok | Cancel Help

Figure 7-6: Defining a New Semicolon Stop Rule

11. Click OK to confirm your two new rules. From now on, whenever a semicolon is followed by
a space, Translator’'s Workbench will continue reading until the next stop character (same
behaviour as in previous versions).
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Figure 7-7: Normal Segmentation in Sentences with Semicolons

12. However, when it is nor followed by a space, as is the case in Keyword footnotes,
Translator’s Workbench will treat the text within the semicolons as single segments:
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Figure 7-8: Segmentation in a Keyword Footnote

13. Define the same rule settings for all TMs whose semicolon Skip and End Rules you want to

modify to handle keyword footnotes.

7.4 After Translating...

After you have finished the translation of an on-line Help file, follow these steps:

1.

Edit the translation as necessary, using your preferred method (interactive editing with
Translator’s Workbench in the background, editing without Translator’s Workbench and
subsequent update of the Translation Memory with the Clean Up tool).

Clean the files of the source text and update the Translation Memory if necessary, using the
Clean Up function described in the “Cleaning up Translated Documents” chapter.

Translate other bits and pieces that belong to the help project (for instance, translatable
parts of the Help project (*.HP]) file.

Compile the translated help file, using the Help compiler or the Help tool that you normally
work with.

7.5 Exceptions and Special Issues

7.5.1 Non-Standard Help Files

Footnote Issues

The functionality described above is fully available if the Help file is written according to
general Help standards. In some cases, however, Help authors format their files differently. For
instance, the “K” or other footnotes are sometimes located after the title, or there might be other
footnotes than the ones described above.

If the “K” or any other footnote is located after the title, you can treat it as a subsegment. See
“Footnotes: A Special Case” in the “Case 5: Handling Index Entries, Footnotes, Table of
Contents Entries, and the like” section in the previous chapter.
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If the file contains other footnotes than the ones mentioned above, Workbench might treat them
as normal footnotes, thus including them in the translation process. If this is the case and the
footnote should be left untranslated, it’s always best to use the “Copy Source” button (%, [Alt] +
[Ins]) to transfer the source text exactly as is to the target field. Thus you make sure that the
footnote text will be left unchanged in the target-language version of the Help file.

Also make sure that footnotes are always formatted properly, that is, using Word’s built-in
“Footnote Reference” character style. Otherwise Translator’'s Workbench may not be able to
recognise footnotes as such, which leads to undesired behaviour when opening segments
containing footnotes.

Link Issues (Jumps and Popups)

If jumps/popups and jump/popup IDs are formatted with character styles, Translator’s
Workbench does not automatically recognise them as “placeables.” However, you can compile a
list of character style names for jump/popup IDs and add them to the list of “non-translatable
text” names in the Translation Memory Setup. As a result, Translator’s Workbench will treat the
IDs as placeables. See “Excluding Text Parts From the Translation Process Using Character
Styles” in the “Interface With Your Word Processor” chapter.

7.5.2 Translating On-line Help Files Authored in RoboHelp

The most widely used on-line Help authoring system these days is certainly RoboHelp® by
BlueSky® Software. Translator’s Workbench works especially well with RoboHelp files since
they are always authored in Word and not some help editor that produces non-standard RTF.
The only thing you should keep in mind is that you should de-attack the RoboHelp template
Robohel p. dot during translation with Translator’s Workbench and use Nor mal . dot (or
some other template of your choice) instead. Among other things, de-attaching is necessary due
to clashing keyboard shortcuts and other irregularities between Robohel p. dot and the
Translator’s Workbench template TWAW n( 97) . dot . Once you are ready with the translation
and want to compile the translated Help file, simply re-aztach Robohel p. dot . De-attaching and
re-attaching the RoboHelp template does #of impede the functionality of the Help file in any
way. You attach templates via the Templates and Add-ins command in Word.

7.5.3 Turning Graphic References Into “Placeables”

It is possible to exclude graphic references, such as the {bmc c:\help\sample.bmp} in our above
example, from the translation process by applying a special character style called
“tw4winlnternal” to it. Text formatted with this character style is recognised by Translator’s
Workbench as being a “non-translatable” element that is then treated as a placeable during the
translation process.

To create this character style, follow these steps:

1. In Word, from the Format menu, choose Style. The Style dialog appears.
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Figure 7-9: The Style Dialog in Word (here, Word 97)

Click New... The New Style dialog appears.
In the Style Name text box, type “tw4winlnternal” (exactly as shown).
From the Style Type drop-down list, choose Character.

Click the Format... drop-down button and choose Font... The Font dialog appears.

AR

Assign font attributes according to your choice, for example Courier New font, bold, red
colour, then click OK twice to confirm. You are returned to the Style dialog which should
now look like this:
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Figure 7-10: Defining the Character Style tw4wininternal

7. Click Close to dismiss the Style dialog.

To apply the character style “tw4winlnternal” to any text enclosed in curly braces, you can now
use Word’s Replace function. Follow these steps:
1. Move the cursor to the beginning of the document to replace all occurrences of the desired

search criterion.

2. From Word’s Edit menu, choose Replace ([Ctrl] + [H]). The Replace dialog appears.
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3. In Word 97, click More to display the entire Replace dialog. This is not necessary in earlier

Word versions.
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Special * |

Figure 7-11: The Find and Replace Dialog (here, Word 97)

4. In the Find What input box, type “\{bm*\}”. Activate the Use wildcards check box (in
Word 7.0 and earlier, this option is referred to as Use Pattern Matching). The “\{bm*\}”
search criterion means “the string bm followed by any text, all enclosed in curly braces.” For
more information on pattern matching and advanced searching, see Word’s extensive on-line
Help (it’s easier to find the information in Word 6.0, but it’s also included in version 7.0 and
97—1look for “search criteria” or “searching criteria” in the Help Index).

5. In the Replace With box, type “A&”. This means that Word will replace the Find What with,
indeed, the Find What text, that is, the graphic reference text will remain exactly as is.

6. Remain in the Replace With box, and click the Format drop-down button. From the drop-
down list that opens, choose Style... The Replace Style dialog appears.

Replace Style

Replace With Style

1 TOCS =]

Descripkion
Default Paragraph Font + Fonk: Courier Mew,
EBold, Red, {no proofing)

(o4 I Cancel |

Figure 7-12: The Replace Style Dialog

7. From the Replace With Style list, choose twdwininternal, and click OK to confirm. The
Replace dialog should now look as follows:
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Find and Replace

Find Replace | Go To |

Find wwhat: I'l,{bm*'l,}- LI _ﬂnd Mext
Options:  Use Wildcards Cancel
Format:

Replace with: I’\&I Ll Replace

Format: Style: bwdwinInternal
Replace Al

4

Search: all - [™ Match case Less %
™ Find whole waords only
[V Use wildcards
[~ Sounds like
[ Find all ward Farms

Replace
Mo Formatking | Format = | Special * |

Figure 7-13: Using Word’s Replace Function to Apply the Character Style
“tw4winInternal” (here, Word 97)

8. Click the Replace option of your choice (Find Next/Replace or Replace All). Word will now
apply the twdwinlnternal character style to all graphic references. If your on-line Help file
contains other elements that match the above search criterion, they will of course also get
the twdwininternal style, which you might want to avoid. In this case, make the Find What
text more specific. In our example, the search criterion could also have been “\{bmc*}”. It’s
best to test this out on your specific Help files to avoid unpredictable replacements.

9. During translation of the Help file, Translator’s Workbench will ignore segments solely
consisting of graphic references. If the graphic reference occurs inside a segment, the
program will treat it as a “placeable.”
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8. Translating Tagged Files with
Translator's Workbench and TagEditor

This chapter contains information on how to translate tagged documents (e.g. SGML/HTML,
FrameMaker, Interleaf, Ventura, PageMaker, QuarkXPress, RC, Bookmaster) with Translator’s
Workbench and TagEditor, the new companion of Translator’s Workbench for translating tagged
file formats.

8.1 What Is a Tagged Format?

Tagged file formats play an increasingly important role in document authoring and translation.
For example, tags are used to define the structure and layout of Internet pages (HTML). The
“big brother” of HT'ML, the Standardised General Markup Language (SGML), is also more and
more frequently used for the structuring of complex documentation.

Besides these standardised markup languages, D'TP packages such as FrameMaker, Interleaf,
PageMaker, Ventura etc. produce exchange formats that allow further processing by third-party
applications such as Translator’s Workbench and TagEditor. However, these formats are often
not very translation-friendly and difficult to handle. That’s why "TRADOS offers special
applications that convert these formats into a T'ranslator’s Workbench-compatible, tagged format
that is easy to translate. In this documentation, all types of tagged Translator’s Workbench-
compatible formats are referred to as “Workbench RTF.” Workbench RTF documents are files
that comply with the Translator’s Workbench standard for tagged R'TF. They typically contain
tags marked up with the tw4dwinExternal and twdwinInternal tag styles.

Note

Workbench RTF files can be translated using either TRADOS TagEditor or Microsoft Word.
We recommend using TagEditor since it features many specialised functions for tagged
formats (tag protection and verification, among many others).

8.2 Processing Tagged Files with Translator’s Workbench and TagEditor

In this section, we describe the workflow for the various tagged formats that Translator’s
Workbench and TagEditor support from preparation via translation to cleanup and further
processing.
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8.2.1 List of Tagged File Formats Supported by Translator's Workbench and TagEditor

Currently, Translator’s Workbench and TagEditor support the following tagged file formats:

e SGML/HTML (no special filter or conversion tool required)

*  FrameMaker, FrameMaker + SGML, FrameBuilder (all via The S-Tagger 2.0 for
FrameMaker). For more information on The S-Tagger 2.0 for FrameMaker, visit us on the
Web athtt p: //ww. t rados. com st agger .

* Interleaf ASCII (through The S-Tagger 2.0 for Interleaf). For more information on The S-
Tagger 2.0 for Interleaf, visit us on the Web at ht t p: / / www. t r ados. coni st agger .

e Ventura Publisher, PageMaker, QuarkXPress (all through the I'TP Filter Pack). For more
information on the I'TP Filter = Pack, visit us on the Web at
http://ww.trados.comfilters/fi_pack.htm At the time of writing,
"TRADOS was developing a tool to further optimise the translation of PageMaker files. Be
sure to visit us at our Web site for details.

*  Windows Resource (RC) Files, Bookmaster DCF, and Troff (all via special preparation
macros included in the TWAW n. dot and TWAW n97. dot template for Word)

Depending on the type of tagged documents, the translation workflows differ slightly. For more
information, be sure to read the following sections.

8.2.2 Preparing TagEditor for Handling HTML and SGML Files

For HT'ML, no special preparation is necessary. TagEditor ships with a file named HTM_L4. | NI
which contains all settings necessary for correctly processing HTML files that are based on the
HTML 4.0 DTD. Of course, you can adapt these settings to your requirements. To achieve this,
you use TagEditor’s DTD Settings Wizard, described in detail below.

If you want to translate SGML documents, some preparatory steps are required. Among other
things, you will want to specify on which document type definition (D'TD) they are based, how
to handle SGML elements such as tags, character entities, and so on.

What is a DTD?

The structure for an SGML document is stored in an ASCII file separate from the text of the
document. This file is called the document type definition (D'TD). The DTD defines the
structure, elements, and conventions to which a document must conform. The DTD serves as
the “rule” book for creating an SGML document. While everyone can develop their own
DTD, many standard D'TDs have been designed, such as ISO 12083, which includes book,
article, and serial D'T'Ds. Other standard D'TDs have been written for a number of specific
types of publications.

Among other things, TagEditor scans D'TDs to get hold of all external (=structural) and
internal (=formatting etc.) tags. The most prominent example of a DTD is the HTML 4.0
DTD. All HTML 4.0 documents are based on this D'TD.

To prepare TagEditor for handling all kinds of SGML files, you use TagEditor’s D'TD Settings
Wizard. It’s best to show this wizard with the help of an example. In this example, let’s presume
that the following files exist on your system:

¢ the DTD (in our example, we will use a D'TD that defines the rules for writing letters in
SGML)

e a set of representative SGML files that make use of this D'TD (in our example, letters
written in SGML)
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In your context, you would also need to meet both these requirements, otherwise it will be very
difficult to successfully adapt TagEditor for handling your SGML documents correctly.

In our example, we follow the steps below. We suggest that you try the functions with your
DTD and SGML files as you read this section.

1. From the Tools menu in TagEditor, choose DTD Settings. This opens the DTD Settings
dialog.

DTD Settings

e DOCTYFE | Filename (]9

fault HTHML Settings HTML C:“Program FileshTRADD. ..

Cancel

Help

il

Add...
Bemove

Edit..

il

Figure 8-1: The DTD Settings Dialog

2. You use the DTD Settings dialog to manage the settings list for D'TDs. You can perform the
following tasks:

e define new settings for D'TDs to be added to the list;

e edit existing DTD settings (for instance, the default HTML settings shipped with
TagEditor);

e remove existing DTD settings from the list.

In our example, we want to add a new D'T'D and define settings for it. To achieve this, click
the Add button. This opens the New DTD Settings dialog.

MHew DTD Settings

& iCreate new DTD Settings using the DTD Settings *Wizand

" Create new default HTML 4.0 DTD selttings
" DOpen an existing DTD Settings file

Ok I Cancel | Help |

Figure 8-2: The New DTD Settings Dialog

3. You use this dialog to perform one of the following tasks:
e create new D'TD settings using the DTD Settings Wizard;

e create new default settings for HTML (for instance after changing them and finding out
that after the changes the HT'ML processing doesn’t work correctly anymore);

* open an existing settings file which may reside on your network or have been given to
you by a colleague.

In our example, we want to create new DTD settings from scratch. So we can confirm the
first option by clicking on OK. As was to be expected, this opens the DTD Settings Wizard.
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DTD Settings Wizard

= ~ Welcome ta the DTD Settings Wizard, the eazy way to
(), ._.r-Q e cuztomize markup settings for your SGMLAHTML documents!
~

You can use thiz wizard to create new DTD settings fram
JJJJ e GJ scratch, o to edit and customise exizting DTD zettings.

I the nest steps you can cuztomise the following items:

1. DTD type and location

2. Default farmatting

3 SGMLAHTHML element formatting
4. Character entity management

5. Preview mode

It any of the steps, press F1 for Help.

Click Mext to continue.

2HiEcEk

Cahcel | Help

Figure 8-3: The DTD Settings Wizard

4. Take a moment to read the introductory text which sums up the steps of the wizard. After
that, click Next. This opens “Step 1: Document Type Definition” which lets you specify
general D'TD settings such as DTD filename etc.

DTD Settings Wizard - Step 1 of 5

= ~ Pleaze specify the filename of the Document Type Definition
~" =~ [DTDJ

Pleaze provide a descrptive name for the DTD zettings:

What iz the name of the oot element™?

fhoserens

Choose a filename for the DTD zettings:

!
Browse. .. |

<Back Cancel | Help |

Figure 8-4: DTD Settings Wizard (Step 1): Document Type Definition

5. In this dialog, follow these steps:

*  Specify the filename of the D'T'D you want to use. Click the Browse button to locate it
on your system. You may have to get in touch with the originator of the SGML files to
get hold of the D'TD. In our example, we assume the D'TD is called Let t er . dt d.

¢ Provide a descriptive name for the DTD settings you are going to define. Note that this
is not a filename or whatever, just a “friendly” name that describes the D'TD settings.
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For instance, you could provide such a name as My DTD Settings or, in our example, Letter
DTD.

e If you know the name of the root element, type it into the corresponding input box
(optional). For instance, for HI'ML documents, the name of the root element (often also
referred to as DOCTYPE) is “HTML”. If you do not know the name of the root
element, TagEditor will attempt to identify it for you once you click Next. You may also
want to get in touch with the originator of the D'TD to get hold of the name of the root
element. In our example, we assume the root element is Letfer. Very often, the name of
the D'TD is the same as the name of the root element, but this is not necessarily the
case.

e Specify a filename for the D'TD settings you are going to define in the next steps of the
wizard. Use the Browse button to open the standard Windows file dialog. Here you can
provide the name and location for the file in which TagEditor should save the DTD
settings. By default, it is recommended to take the same file name as the DTD with an
. I ni extension. In our example, since the DTD is called, Let t er . dt d, we would call
the INI file Letter.ini.

DTD Settings Wizard - Step 1 of 5

= ~ Pleaze specify the filename of the Document Type Definition

HJJQMPP’“J_,J” DTD}:
JJ_;—’ O‘C:S JJC IE:\Data'\SGML'\DTDS\Letter.dtd

Pleaze provide a descrptive name for the DTD zettings:
Letter DTD

What iz the name of the oot element™?

ILeller

Choose a filename for the DTD zettings:
IE: WData\SGMLADTDshLetter. ini

Browse. .. |

Cancel | Help |

Figure 8-5: DTD Settings Wizard (Step 1): Specifying Basic DTD Settings

Once you’re done with these basic settings, click Next. TagEditor will now open the DTD
specified above in the background and allow you to proceed with the DTD Settings Wizard.
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DTD Settings Wizard - Step 2 of 5
= o Here pou specify it which farmatting plain text should
r—fJJ e e ~~ appearin TagEditor. In the nest step, you can then
G o define additional farmatting for specific SGMLAHTML
_/J‘FJ ey elements,
o ._f-’JJ JJJQ@J Fant: Size:
7 @C o [FER——c] [ -]
" ~Effects
[~ Eold [ Subscript
[ ltalic ™ Superscript
[ Underline [ Small Caps
[ Stikethrough Colour: I- vl

<Back I Mest > I Cahcel | Help |

Figure 8-6: DTD Settings Wizard (Step 2): Default Formatting

6. In this step, you specify how plain text should appear in the TagEditor window. The default
is Arial, 10 point, no effects, black colour. Make any changes as required. For more
information, see the TagEditor on-line Help. Once finished, click Next to proceed with the
DTD Settings Wizard.

DTD Settings Wizard - Step 3 of 5

Here pou customize the farmatting of each SGML/HTML
element as convenient. You can also add new elements or
remaove existing ones.

Elements:
Mame Attributes
addresses External
date External
emphasis Irternal
greeting Esternal
letter Esternal —
zalutation Esternal
sender External j
Add... | Bemaove | Properties... |
- Preview
(address > Sample teid address)

[T Eeep &l Line Breaks

<Back I Mest > I Cahcel | Help |

Figure 8-7: DTD Settings Wizard (Step 3): Element Properties

7. 'The Element Properties step is the central step in the DTD Settings Wizard. You use this
step to perform one or more of the following tasks:

e classify the tags contained in the currently used document type definition (D'TD) as
external, internal, or non-translatable

e define translatable attributes within tags (for example, the ALT attribute within the
IMG tag in HI'ML)
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10.

e assign special formatting to text between specific tags (for example, headings or
emphasised text)

e add or remove tags from the list of elements

* specify whether all line breaks should be kept in all files to be translated with TagEditor

For more information on this step, press [F1] in TagEditor. This will give you an overview
of what you can achieve here. Another good idea is to look at the default HI'ML settings to

see what tag formatting and classification the developers at "TRADOS have defined for
HTML.

In our example, we want to show you how to map formatting to tags, since this is highly
recommendable for more ergonomic and user-friendly translation.

As you can see in the above screen shot, there’s one internal tag in our DTD called
Emphasis. 'This would be a typical example of an internal tag for which you may want to
define formatting. (Another example would be heading tags that are almost always present
in a DTD; e.g. <H1>, <H2> etc. in HTML.) In our example, let’s define that any text
between Emphasis tags should be formatted in bold. Follow these steps:

In the Elements list, select the Emphasis tag, and click Properties. This opens the Element
Properties dialog for the Emphasis tag.

Element Properties 1]
— Formatting —Tygpe—————————
mE Iﬁ & |ntermal
r s m " External
- ok Iﬁ " Nonslatable
 Boid [ Subseript — Tranzlatable Attributes
7 ltalic 7 Superscript
7 Underline 7 Small Caps
[7 Stikethrough
’TI Cancel | Help

Figure 8-8: The Element Properties Dialog

In this dialog, click the Bold option, and confirm with OK. You are returned to the Element
Properties step of the D'T'D wizard, where the text formatting has been changed according
to your specifications. You can see what the tag will look like in TagEditor in the Preview
box. Repeat this procedure for each tag whose formatting properties you wish to change.

Translator’s Workbench, © 1994-99 by " TRADOS GmbH



8-8 Translating Tagged Files with Translator’s Workbench and TagEditor

DTD Settings Wizard - Step 3 of 5

Here you customize the farmatting of each SGMLAHTML
element as convenient. You can also add new elements or
remaove existing ones.

Elements:
Mame | Type | Attibutes | -
address Esternal
addresses External
date Esternal
= Internal
greeting Esternal |
letter Esternal
zalutation Esternal
sender External j
Add... | Bemaove | Properties... |
Preview

fhasi» Sample text anghasg

[T Eeep &l Line Breaks

<Back I Mest > I Cancel | Help

Figure 8-9: Mapping Tags to Formatting

11. After customising the properties of each SGML element, click Next to proceed with the
DTD Settings Wizard.

DTD Settings Wizard - Step 4 of 5

= ~ Here pou customize character entity converzsion. To
o ._.r-Q e add or remaove entities other than the ones listed
ey

below, chaose User Defined from the Sats list.

__/JJJ QQ o Sets:
| |Cléadded Math Sembols: Arrove relations -

[ 1Added Math Symbals: Binary Operators j

[ |&dded Math Symbols; Delimiters

[ 1Added Math Syrbals: Ordinan

[ |&dded Math Symbols: Relations

["1Box and Line Dirawing

[ R uzzian Cyrilic LI

— Entitie:

s

Bemaye |

<Back I Mest » I Cancel | Help |

Figure 8-10: DTD Settings Wizard (Step 4): Entity Conversion Management

12. You use this step to specify which SGML/HTML character entities should be converted to
“real” characters and which should be left untouched. TagEditor formats unconverted
entities as internal tags, using the SGML markup with the ampersand and semicolon
delimiters. For example, the entity “&gt;” (Greater Than symbol) is displayed as in
TagEditor. It is reccommended not to make big changes to the default settings for character
entity conversion. The default setting makes sure that all character entities are handled
properly by TagEditor: All entities that have Windows character equivalents will be
converted, all others will be left as is and treated as internal tags. If you want to adapt the
default setting to your needs, please proceed with great care. Generally, this should only be
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13.

done by SGML/HTML experts. For more information on this step, press [F1] in TagEditor.
This will give you an overview of what you can achieve here. After customising character
entity conversion, click Next to proceed with the last step of the DTD Settings Wizard:
preview mode settings.

DTD Settings Wizard - Step 5 of 5

T

Flease specify which application to uze for previewing pour
documents, For HTML pou can choose the built-in Internet
Explorer preview. To specify aty ather viewer, select External
and locate it on your system,

(\%

-
Jf‘” O
Jf’J JJJ@

" External
“gfj“”f r

-
%O Browse, |
- o & L4
*

<Back I Einigh I Cancel | Help |

Figure 8-11: DTD Settings Wizard (Step 5): Preview Mode Settings

Use this step to specify which application you want to use to preview files you translate in
TagEditor. By default, Internet Explorer 4 (IE 4) is used as internal browser (or viewer).
“Internal” means that TagEditor does not have to launch IE in an external window; instead,
it opens a special window w@i##in the main TagEditor application window. You may want to
use another application for previewing files. For instance, if you prefer the Netscape browser
suite to Internet Explorer for viewing HTML files, you can specify Netscape Navigator as
external viewer. In the case of SGML files, as in our example, you will of course also want to
use a different external viewer. To achieve this, click the External radio button, and use the
Browse button to locate the desired application on your system.

From now on, as soon as you click the Preview tab, TagEditor will launch the external
application you specified. In addition, a message (“In external preview mode”) will appear
in the TagEditor application window. Some more notes on the preview mode settings:

*  For viewing HI'ML files, we strongly recommend using a recent browser, for instance
the built-in Internet Explorer 4.x or Netscape Communicator/Navigator 4.x. Older
browsers may not be fully supported.

* For viewing SGML files, use any current SGML browser, such as MultiDoc Pro from
Citec.

e Before returning from the external application to TagEditor, we recommend you close
the file in the external application (or the application itself) to avoid potential conflicts
with the open file in TagEditor.

e Since TagEditor only sends a temporary file to the external application, do not modify it
outside TagEditor. Instead, if you want to make changes to the file, do them within
TagEditor itself. Otherwise changes will be lost.

e When you return from the external application, the external preview mode will still be
active in TagEditor. To continue translating or otherwise editing the file in TagEditor,
switch back to Edit, Source, or Target view.
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14. This completes our round-up of the D'TD Settings Wizard. When you are satisfied with the
settings in the last step, click the Finish button. You are returned to the DTD Settings dialog,

where the new DTD setting is now displayed, along with the DOCTYPE (root element)
and file name:

DTD Settings

Hame | DOCTYPE | Filename | ok,
Default HTML Settings HTHL C:%Program FileshTH...

Letter Cancel

Help

il

Add..

Bemove

il

Edit..

Figure 8-12: Our Letter DTD Settings Have Been Added to the List

15. You could now add further settings to the list, or edit existing settings. For instance, you
could edit all settings, except “Step 1: Basic DTD Settings”, of the DTD you have just
added to the list.

After defining all DTD settings as desired, an SGML file based on the Letter DTD would
typically look like this (we have added a few more formatting mappings):

#& " TRADODS TagEditor - [Letter5 ample_sgm =] H=lE
File Edit “iew “Workbench Tools Window Help _|5|1|
@ & & 5 8o o8]
(R Nt e e [ 2

IDOCTYPE
LETTER

saLOTaTon;Dear Daniel, csamrarion

thank you for sending us the infarmation on TRADOS TagEditnr and
TRADOS Translator's Workhench. YWe like your tools and think they are certainly
the most powerful translation tools available on the market today. We especially like the DTD Settings
izard. It has helped us to set up support for our SGML files in a flash. We have already downloaded the
[atest version from the Web and would now like to order 20 licenses. Please send us a quote. Keep up the
good wark!

TERT

GREETING ) ' ours sincerely, {GREETING
sEnaTRE) L ul Smith GEnaioee
EDDRESS > 3mith and Company Ltd. ¢ Z0DRESS
ADDRESS » Smithtown (A0DRESS

WEBLINE :hitp: feesner. smith-company-Itd. com« S7EBLINE]
LETTER

= ==

B] Edit |_E> Sourcel <I| Targetl @ Te:-:tl @' F'reviewl
For Help, press F1 i

Figure 8-13: Opening an SGML File Based on the Letter DTD

You are now ready to translate this type of SGML files using Translator’s Workbench. How you
go about this is described in the “Translating Tagged Files” section below.
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Note

With the DTD Settings Wizard, the developers at *"TRADOS have made setting up SGML
support as easy as possible. Still, if you would like further help with adapting your DTDs for
translation with TagEditor, do not hesitate to contact your local "TRADOS office for
consultancy services in this area.

8.2.3 Preparing Other Tagged File Formats for Translation in TagEditor

In this section, you will learn how to prepare the other tagged formats for translation with
Translator’s Workbench and TagEditor.

FrameMaker & Interleaf

To prepare FrameMaker, FrameMaker + SGML, FrameBuilder, and Interleaf documents, it’s
best to use TRADOS’ conversion solutions for these DTP packages, The S-Tagger 2.0 for
FrameMaker and/or The S-Tagger 2.0 for Interleaf. For more information on The S-Tagger 2.0,
visit us on the Web at ht t p: // ww. t rados. com st agger .

Ventura Publisher, PageMaker, QuarkXPress

To prepare all of these tagged formats, it’s best to use the I'TP Filter Pack. For more information
on this free application, visit us on the Web at
http://ww. trados. conifilters/fi_pack. ht m At the time of writing, "TRADOS is
developing a tool to further optimise the translation of PageMaker files. Be sure to visit us at our
Web site for details.

Windows Resource (RC) Files, Bookmaster DCF, Troff

To prepare these formats, you can use special Word preparation macros included in the
TWIW n. dot and TWAW n97. dot templates shipped with Translator’s Workbench. Follow
these steps:

1. In Word, activate the document template TWAW n. dot (Word 6.0/7.0) or TWAW n97. dot
as explained in the Installation chapter in the “Preparing Your Word Processor” section.

2. If you have not already done so, de-activate the AutoCorrect option Change Straight Quotes
To Smart Quotes. This is achieved differently depending on the Word version you use:

e In Word 6.0, select the AutoCorrect command from the Tools menu, and uncheck the
above-mentioned option.

¢ In Word 7.0, select the Options... command from the Tools menu. In the Options dialog
that follows, select the AutoFormat tab, and uncheck the Straight Quotes With Smart
Quotes option in the Replace as You Type section.

o In Word 97, select the AutoCorrect command from the Tools menu, click the
AutoFormat tab, and uncheck the Straight Quotes With Smart Quotes option in the
Replace section.
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AutoComect HE
AutoCorreck I AutoFormat As You Type | AutoTexk
Apply
[ Headings ™ automatic bulleted lists
[ Lisks [ other paragraphs
Replace

[ Crdinals {TsE) with superscript
[~ Fractions (12} with fraction character (14)
[~ symbal characters {--1 with symbols {—)

[~ *Bold* and _underline_ with real Formatting

[~ Internet and netwark paths with hyperlinks

Preserve
[~ akyles

Always AutcFormat
[~ Plain text Wordmail documents

[0]4 I Cancel |

Figure 8-14: The Replace Straight Quotes with Smart Quotes Option

3. Select the Open command from Word’s File menu to open the tagged text files.
* In Word 6.0, make sure to check the Confirm Conversion option box in the Open dialog.

* In Word 7.0 and Word 97, if you have not already done so, activate the Confirm
Conversion at Open option. You achieve this by selecting the Options... command from
the Tools menu. In the Options dialog that follows, select the General tab, and check
the Confirm Conversion at Open option.

Track Changes I User Information I Compatibility I File Locations
Wit General | Edit | Print I Save ISpeIIing&Grammar

General options
[ Background repagination
[~ Help For ‘WordPerfect users
[~ Mavigation keys for WordPerfect users
[ EBlue background, white test
[ Provide feedback with sound
v Provide Feedback with animation

[v ‘Canfirm conversion At Open ;
V¥ Update automatic links at Open
¥ Mail as attachment

v Recently used file lisk: |9 E‘ entries

¥ Macro virus prokection

Measurement units: ICentimeters hd |

[0]4 I Cancel |

Figure 8-15: The Confirm Conversion at Open Option (here, Word 97)

4. After a small moment, Word suggests converting the selected file from “Text Only.” Accept
this setting if the text is in ANSI; choose “MS-DOS Text”, however, if it is in ASCII. In
both cases, click OK to confirm your choice.
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5. Word now opens the tagged ASCII/JANSI document. It is now very important that you
save the documents immediately as “real” Word documents (*. doc extension by
default). To achieve this, select the Save As... command from Word’s File menu. In the
Save As dialog that follows, from the Save as Type drop-down list, choose Word document.
Assign a file name of your choice and click OK to confirm. Word now saves the file in its
internal format. After translation, we will convert the files back to text only (see “Cleaning
Up Tagged Files After Translation” below).

6. Depending on the type of tagged file, you will certainly recognise that it contains lots of
information that needn’t—or even mustn’t—be translated but contains mere typesetting
information of all sorts (see “Translating Tagged Files” below for an example). In order to
separate translatable from non-translatable text, the template TWIW n. dot or
TWIW n97. dot contains macros that prepare your texts. Special macros are available for
each of the tagged formats mentioned above. The names of the macros all start with
“t wdwi nPr epar e” and continue with the name of the tagged format, for instance “RC” for
Windows Resource files. Thus, to prepare a RC file for translation, for instance, select the
Macro... command from Word’s Tools menu, choose “t wAwi nPr epar eRC” from the
Macro name list, and click the Run button. Macros currently available include:

e twdwinPrepareRC: Prepares Windows application-based resource files (*. RC
extension by default).

* twdwinPrepareDCF: Prepares Bookmaster/DCEF files.

* twdwinPrepareTroff: Prepares TROFTF files.

7. 'The macro now starts and modifies the tagged text in such a way that it looks for tags and
translatable text. One of the difficulties in doing so is to accurately distinguish between what
is referred to as “external” and “internal” tags. Internal tags can occur within a sentence, for
instance bold on/off. External tags usually define the beginning of a new paragraph format
like a heading or other paragraph. External tags always end a segment. When translating
tagged files, internal tags are read in with the segment and stored in Translation Memory. If
an internal tag occurs at the beginning of a sentence, however, it is ignored.

8. When Translator’'s Workbench prepares the tagged documents, it applies special character
styles to internal and external tags. The character style “tw4winExternal” (Courier New
font, dark grey colour) is applied to external tags, the character style “tw4winlnternal”
(Courier New font, light red colour) to internal tags. Depending on the size of the document
to be prepared, this may take a moment.

9. After this preparatory step, you're ready to start translating the tagged document. Refer to
the “Translating Tagged Files” section below for detailed explanations on how to go about
the actual translation.

8.2.4 Translating Tagged Files

Let’s assume you have to translate an HT'ML document. After opening it in TagEditor, it will
typically contain tagged text as follows:

EGet your E>free® evaluation copy of Translator's Workbench now!<B

"This line contains two external tags (@ and <E|) and two internal tags ( and , which means
bold on/off in HTML). During translation, it is necessary to ignore external tags, thus leaving
them out of the translation process entirely. The internal tags, however, must be present in the
target text as well. That’s why, after opening the sentence for translation—as usual with the £,
# or @) button—Translator’s Workbench will open a translation unit that contains the following
tagged text in the source field:
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Figure 8-16: TagEditor’'s Program Window After Opening a Segment With Internal

Tags

As you can see, the internal tags have been read in with the segment. In the Source window of

Translator’s Workbench, these internal tags are marked as “placeable elements,’

]

which you can

recognise by the blue bracketed line that underlines them:

TRADDS Translator's Workbench - Sample
Toolz: Help

File  Seftings  Wiew Options

Changed o
Changed by:
zage:

< 11

B Get your {Tacfree TG evaluation copy of Translator's

Workbench nowl
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Figure 8-17: Source Window After Reading a Segment With Internal Tags

Placeable elements typically are non-translatable elements occurring within a segment. These
can be graphics, fields, numbers, or, as in our example, tags. Please refer to “Copying Placeable
Elements” in the “Interface With Your Word Processor and TagEditor” chapter for more
information on placeables.

To translate the above example, you would follow these steps:

1. First of all start typing the translation of the English sentence into the target field in
TagEditor, saying something like Holen Sie sich lhre.

2. Now you’re ready to insert the first tag. To achieve this, simply click the Get Current
Placeable button (#%). The tag is inserted into the target field, followed by a blank. (To
prevent Workbench from inserting the additional blank, refer to the “Internal Tags and
Blanks” section below.) The tag remains selected.

3. 'To continue typing the translation, press the [2>] key to get out of the selection, and press
the [Backspace] to remove the extra blank, if desired.
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4. You can now go on translating until the next tag, and then click the Get Next Placeable
button (=%) to insert the tag into the target field. If more internal tags were present, you
would repeat the procedure for each internal tag until all tags would have been copied to the
target field of the currently open translation unit.

5. To confirm your translation and move on to the next segment, you use the & button as
usual. Translator’s Workbench then looks for the next “translatable” segment, that is,
ignores all external tags until it finds the next actual sentence.

Internal Tags and Blanks

By default, Translator’'s Workbench inserts a blank after each internal tag that you place inside
the target field, which is necessary for historic reasons (the interface for tagged files between
Translator’s Workbench and Word). It is no longer necessary for the interface between
Translator’s Workbench and TagEditor, however.

To prevent Translator’s Workbench from inserting the extra space, deactivate the Insert Blank
After Tag option in the General tab of the Translation Memory Options dialog.

Hint

Deactivating the Insert Blank After Tag option is especially useful for those people who prefer
keying in the translation first and then place the tags. In this case the additional blank is
annoying because you always have to explicitly delete the blank after the placed tag.

Tip for Translating Documents With Many Internal Tags

Should your documents contain many internal tags, the method described above for placing
them into your target segment may become somewhat tedious. Translator’s Workbench offers a
useful option for this called Copy Source on No-Match. When this option is active, Translator’s
Workbench copies the source segment as is into the target field each time it cannot find a match
in the Translation Memory (the same as clicking the *# button interactively). You can then leave
the tags in place and just overtype the text in the target segment with the translation. To
activate the Copy Source on No-Match option, follow these steps:

1. In Translator’s Workbench, from the Options menu, choose Translation Memory Options.
This opens the Translation Memory Options dialog.

2. In the General tab, activate the Copy Source on No-Match option.

Tip for Translating Workbench RTF Files in TagEditor

By default, TagEditor displays all tags in a short form to make translating tagged documents
easier. For translating STF files, that is, Workbench RTF files that have been converted using
The S-Tagger for FrameMaker or The S-Tagger for Interleaf, this may not be the desired
behaviour, since The S-Tagger makes extensive use of tags with important content. This
content is not displayed due to the shortened tags. For example the tag “<:v "Rolling
Stones™ 1>” will only be displayed as “<:v”. To change this behaviour, use the Full Tags
command from the View menu in TagEditor.

Working with Full Tags switched on may also be a useful option for other Workbench RTF files.
For SGML/HTML, however, we recommend not to switch this option on since this may reduce
the clear layout of the document in TagEditor. To see any full tag, you can move with your
mouse over it and wait for the tag tip to appear. The tag tip always shows the full contents of any

tag.
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8.2.5 Cleaning Up Tagged Files After Translation

When saving a file in TagEditor, it will be saved in a special bilingual format known as BIF. For
more information on this format, see the “Saving a Document in Bilingual Format” section in
the “Getting Started” chapter.

After finishing and editing the translation of the tagged document, it will still contain the source
text, and it will contain other information, such as delimiting marks, as explained in the “Before
Starting: Some Background Information & Useful Settings” in the “Interface with Your Word
Processor and TagEditor” chapter. It is therefore necessary to “clean” the translated document
in such a way that it does not contain elements that impede its re-import into the D'TP program
or other application for further processing.

There are two ways to achieve the cleanup once you have completely finished translating a
document and want to save it in its target-language version.

Cleaning a File Translated and Edited Using Translator's Workbench At All Times

If you have used Translator’s Workbench to translate and edit the document at all times, use the
Save As command and specify the original file type (SGML, HTML, or Workbench RTF) from
the Save as Type drop-down list in TagEditor. When saving the document, TagEditor will
“clean up” the document. It will strip out all source segments, thereby leaving only the target-
language version. Make sure to adapt the file name of your document as convenient.

Cleaning a File Translated and Edited Without Using Translator's Workbench At All
Times

If you have made changes to the target segments without using Translator’'s Workbench, these

changes have 7ot yet been made in the current Translation Memory.

There are several reasons why Translator’'s Workbench may not be active at all times at the
document editing stage:

*  You correct, typing errors, without first re-opening () the translation unit and saving (‘)
the corrected translation in the TM afterwards

*  You use the Replace command to make global text changes.

In these cases, you can use Translator’'s Workbench Clean Up command to strip out the source-

language segments and update the TM at the same time. Follow these steps:

1. In TagEditor, save the tagged document as Bl F, and close it.

2. Run the Cleanup command from Translator’s Workbench’s Tools menu to clean the
document from source text and delimiting marks, as explained under “Cleaning Up
Translated Documents” in the “Document Analysis, Translation, and Cleanup” chapter.
Any changes made to the target-language version will be reflected in the 'T'M provided you
use the Update TM option.

To cut a long story short, the translation workflow with TagEditor can be summed up as follows:
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Translation Workflow in TagEditor

Source document (HTML,
SGML, Workbench RTF)

x/vrx

Open in TagEditor, start
translation

l

Save as Bilingual File (BIF) as
long as file is "under
translation”

%\

Finish translation

l

Review translation

Translator's
Workbench used at all
stages?

Save as Target Only in Save as BIF, then run Cleanup
TagEditor, provide new file in Translator's Workbench with
name if desired Update TM option
A
Target document (HTML,
SGML, Workbench RTF)

Further Processing of Cleaned Files

Depending on the type of tagged documents you have cleaned up, the steps required before
further processing differ slightly.

HTML & SGML

No special step is necessary for HI'ML or SGML after saving the file in TagEditor as Target
Only or after running the Cleanup of the BIF file in Translator’'s Workbench. You can give the
translated file away as is for further processing.

FrameMaker & Interleaf

When saving the files in TagEditor as Target Only or after running the Cleanup of the BIF file in
Translator’s Workbench, they will be saved in Workbench RTF format.

To convert these files back to their original format, use The S-Tagger 2.0 for FrameMaker or
The S-Tagger 2.0 for Interleaf. Follow the instructions in the User Guides for these programs for
more information.
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Ventura Publisher, PageMaker, QuarkXPress

When saving the files in TagEditor as Target Only or after running the Cleanup of the BIF file in
Translator’s Workbench, they will be saved in Workbench RTF format.

To convert these files back to their original format, use the I'TP Filter Pack. Follow the
instructions in the online Help for the I'TP Filter Pack for more information.

Windows Resource (RC) Files, Bookmaster DCF, Troff

To clean up these formats, you need to use Word. Follow these steps:

1. After saving the files in TagEditor as Target Only or after running the Cleanup of the BIF
file in Translator’s Workbench, re-open the document in Word. To achieve this, use the
Open command from Word’s File menu. If you are asked whether to convert it from Rich
Text Format, confirm this setting with OK.

2. After opening the tagged document, you will see that it contains the target-language version
of your text, with all external and internal tags intact. You can now save the translation—
preferably under a new name—in the format from which it was originally converted (see
“Preparing Tagged Files for Translation” above). To achieve this, select the Save As...
command from Word’s File menu. In the Save As dialog that follows, choose the format
from which you converted the file by selecting it from the Save as Type drop-down list (MS-
DOS Text for ASCII texts, Text Only for ANSI texts). Assign a file name of your choice and
click OK to confirm. Word now saves the file in the desired format.

3. You can now re-import the file to the D'TP program or other application that you want to use
for further processing. Please refer to the documentation on the corresponding program for
more information on how to achieve this.

Translator’s Workbench, © 1994-99 by " TRADOS GmbH



9. Document Analysis, Translation, and
Cleanup

In addition to interactive translation in your word processor or TagEditor, where you work your
way from sentence to sentence, Translator’s Workbench offers a series of “batch functions” to
analyse, pre-translate, or clean up documents in one go. This chapter describes in detail what the
individual functions do. You’ll find all of them in Translator’s Workbench’s Tools menu.

For more information on the overall workflow of document analysis and translation, we highly
recommend you to read the “Translator’s Workbench Workflow Manual” that is available for
free from our Web Site www. t r ados. com At the time of printing, the exact address is
http://ww.trados. coniftexts/workflow zip.

9.1 Document Analysis

The Analyse function is one of Translator’s Workbench’s most interesting features. It analyses
one or more Word or TagEditor (SGML/HTML, S-Tagger/FrameMaker, S-Tagger/Interleaf,
PageMaker, Ventura, RC, etc.) documents for their match values by comparing them to the data
contained in the currently selected Translation Memory. This means the program reads the
text(s) segment by segment and determines the corresponding match value by searching for
identical or similar sentences in your TM. In addition, Translator’s Workbench examines the
texts for repetitions (= exact matches) occurring within the same Analyse run. The first
occurrence of a sentence with no match in TM will be interpreted as a “no match;” the second
occurrence of the same sentence will be counted as a repetition. A repetition is different from a
100% match in so far as it has no match in TM but occurs once or several times within the same
document(s) and will thus have to be translated only once and used several times in the same
translation project.

After the analysis, you can create what is referred to as a Project Translation Memory. A Project
Translation Memory contains only a project-relevant subset of the TM used for the analysis. You
can also export frequent and unknown segments from the analysed documents into different text
files for further processing, e.g. by Machine Translation systems.

The calculated match values are accumulated in a table for each file and for all files combined. In
addition, the program counts the number of segments, words, and placeable elements, such as
tags, graphics, fields, and so on. The data is displayed on the screen as well as being written to
log files that you can consult after the analysis. In the case of placeables, the information is
written to the log files only.

This means that before a project starts, you can use the Analyse function to determine accurately
what kind of productivity gains using Translator’s Workbench will bring. The budget and time
required to complete the project are also easier to estimate.
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To perform an analysis of one or more documents, follow the steps below. Note that these
instructions are basic steps; special options are described under “Analyse Results: Options and
Explanations” at the end of this section.

1. Perform the following preparation tasks as necessary:

If you want to analyse Word documents, make sure to start Word and activate the
template TWAW n. dot (Word 6.0/7.0) or TWAIW n97. dot (Word 97) before the
analysis. Workbench needs Word running to perform the conversion from Word’s DOC
format to RTF (Rich Text Format) and back. If the files are already available in RTF
format, this step is not necessary.

If you want to analyse SGML or HTML documents, make sure the correct DTD
settings files have been specified in the Tools tab of the Translation Memory Options
dialog. For more information, see the “Defining Options for Translator’s Workbench’s
Batch Tools” in the “Translation Memory” chapter.

If you want to analyse Workbench RTF documents (as produced by the S-Tagger 2.0
for FrameMaker and Interleaf, for instance), make sure to prepare them as described
under “T'ranslating Tagged Files with Translator’s Workbench and TagEditor”.

2. In Translator’'s Workbench, choose the Analyse command from the Tools menu. The
Analyse Files dialog opens.

Analyse Files - Demo [English-German]

[ %]
Add... | Bemove | LClear | fraluze |

Filez to Analyze

= sz Tk from Erevicus &nalisis
Help |
Lo File... | |E:\F'rogram FileshTradosh T 4WwWink

| 0% |
| 0% |
Match Types Segments Words  Percent
Repetitions 0 0 0%
100% a 1] 0%
955 - 99% ] 1] 0
855 - 94x ] 1] 0
ThE - B4E ] 1] 0
A% - 7% ] 1] 0
MHa Match a 0 0%
4| | | Total 0 0 0%
= AalvsiE Eesults
wiewiliag bles | ErparibErequentEeamentes | |5 or mare Dccurmences
[Ereate Brajest THL.. | Export Unknowm Seaments:. . | |85 % or lower Match Value

Figure 9-1: The Analyse Files Dialog

3. In this dialog, add the files to be analysed to the Files to Analyse list. There are different
ways to achieve this:

Click the Add... button. The Files to Analyse dialog opens. Select the desired drive,
folder, and file type as convenient. Select as many document files as desired, and click
Open to add them to the Files to Analyse list.

Drag & drop the file(s) from the Windows Explorer, Find Files dialog, or File Manager
into the Files to Analyse list.
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e To remove undesired files from the list, select them and click the Remove button. You
can also delete the entire list by clicking the Clear button.

Analyse Files - Demo [English-German) E

Add... Bemove | LClear |
Filzs to Analyze Bamc] |

C\Pragram Files\Tradosh Twidwin\Demo.doc [T se T from Brevious &naliss

C:AMy DocumentsiManual\Chapter01. doc Help |

C:AMy DocurnentsiManualChapter02. doc

A Documents'Manual\Chapter03. doc . - -

C:Ay Documentsii anualChapter04. doc LogFile... | |C:\Program Files\T radosh Tw/diwin'
| 0% |
| 0% |
Match Types Segments Words  Percent
Repetitions 0 0 0%
100% a 1] 0%
955 - 99% ] 1] 0
855 - 94x ] 1] 0
ThE - B4E ] 1] 0
A% - 7% ] 1] 0
MHa Match a 0 0%

4| | | Total 0 0 0%

= AalvsiE Eesults
wiewiliag bles | ErparibErequentEeamentes | |5 or mare Dccurmences
[Ereate Brajest THL.. | Export Unknowm Seaments:. . | |85 % or lower Match Value

Figure 9-2: Adding Files to the Files to Analyse List

4. Select the name of the log file where Translator’s Workbench saves the statistical
information. Translator’s Workbench creates two log files, one in text format with a *. | og
extension, one in comma-separated form with a *. ¢SV extension. The CSV format is ready
for direct import into spreadsheet applications such as Microsoft Excel and presents the
analysis results in a tabular form. This then makes it easier for you to process the analysis
results for budgeting and similar purposes. By default, the log files are located in the same
folder and have the same file name as the current Translation Memory. For instance, the
logs for the demonstration Translation Memory Denp. t nw are written to files called
Deno. | og and Deno. csv.

5. Click the Analyse button to start the analysis. Translator’s Workbench will display its
progress on two progress indicators, one for the current file and one for the total number of
files.

After the analysis has been performed, Translator’s Workbench offers you a range of options in
the Analysis Results group box of the Analyse Files dialog. The functionality and implications
of these options are explained in detail below.
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9.1.1 Analysis Results: Options and Explanations

View Log File

‘This button allows you to take a look at the log file that contains the statistical information of the
analysis (number of different match types, number of segments, words, etc.). In addition to the
information that is also displayed on your screen during the analysis, Translator’s Workbench
includes the number of characters per word and the number of “placeable” elements in the log
file information. This information helps you to estimate how much “non-translatable” elements
your analysed source documents contain. Note that Translator’s Workbench does not count
placeable elements as words.

As soon as you click the View Log File button, it is automatically loaded into the Windows
Notepad where you can browse through or edit it.

Note

T'ranslator’s Workbench also creates a second log file in comma-separated form with a *. CSV
extension. The CSV format is ready for direct import into spreadsheet applications such as
Microsoft Excel and presents the analysis results in a tabular form. This then makes it easier
for you to process the analysis results for budgeting and similar purposes.

Create Project TM

‘This option is particularly interesting. Many firms and translation agencies give translations out
to freelancers who do not need the big Translation Memory of the corresponding firm or agency.
Rather, they will need a smaller part of it that is relevant for the particular project the freelancers
will be working on. This is why a project-orientated TM will be much handier for them to use
than a big T'M containing data that won’t be used. So, in an ideal situation, the translation agency
would first want to analyse all files that are going to be translated by freelancers and then create
a project TM that they will hand out together with the files to be translated. The freelancers will
then use Translator’s Workbench together with the project TM for the translation that they have
to do. This way, they can be sure that the TM contains all data that they will really need for their
particular translation.

This is what the Create Project TM option is there for. As explained above, during analysis,
Translator’s Workbench compares all documents against the Translation Memory. This means
that the program also analyses which parts of the Translation Memory are actually needed for
subsequent translation. For example, in the case of a rather large 'T'M, only a small portion might
be needed for the documents of a particular project. To obtain such a filtered, project-orientated
T'ranslation Memory after the analysis of your documents, click the Create Project TM button
and assign a file name to it. Translator’s Workbench will then extract the relevant translation
units from the current TM and add them to your project T'M.

Export Frequent Segments

You use this option to create a text file consisting of all segments that occur more than a specific
number of times in your source texts and that are 707 contained in the TM used for the analysis.
You specify the minimum number of times a segment should occur in the Or More Occurrences
box. The default is 5.

In the case of frequently used segments, it is very important that their translation be consistent.
That’s why, before translating documents, it may be useful to know all frequent segments and
pre-translate them before actually translating the documents themselves. Translator’s
Workbench can therefore export these segments into a text file in its native text format. The
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program will produce a file containing “translation” units that consist of repeatedly used source-
language segments that don’t have any target-language equivalent. Example:

<Tr >

<ChD>13031998

<ChU>BROCKMANN

<UsC>1

<Seg L=EN GB>This is a frequently used segnent.
<Seg L=DE_DE>n/a

</ TrU>

Then, using Translator’s Workbench, you could translate these segments and add them to your
Translation Memory before actually starting to translate the analysed documents. This way you
make sure that translations exist for frequently used segments, thus ensuring consistency in their
translation.

For more information on Translator’s Workbench’s text format, refer to “Translator’s
Workbench’s Text Format” in the “Importing and Exporting Translation Memories” chapter.

Export Unknown Segments

You use this option to create a text file consisting of those segments that are not contained in the
Translation Memory used for the analysis, that is, which fall below the fuzzy-match value that
you specify in the % or lower Match Value ficld (default: 85%). Translator’s Workbench then
exports all sentences falling below this match value into a text file in its native text format. You
will thus get a file containing “translation” units that consist of unknown source-language
segments that don’t have any target-language equivalent. Example:

<Tr U

<ChD>13091995

<ChU>BROCKVANN

<UsC>1

<Seg L=EN _GB>This is an unknown segnent.
<Seg L=DE_DE>n/a

</ TrU>

You can for example feed a Translator’'s Workbench-compatible Machine Translation (MT)
system, such as LOGOS™ or Systran® Professional for Windows, with this text file.

Note

It is also possible to export all unknown segments directly into a file that LOGOS or Systran
can process without further ado. T'o achieve this, from the Export Unknown Segments dialog,
choose Systran (*.rtf) or Logos (*.sgn) from the Save as Type drop-down list.
Translator’s Workbench will then create a specially formatted text file that can be directly
processed by Systran or LOGOS.

The M'T system can then produce a rough translation of all unknown segments. After this rough
translation, you can import the machine-translated units back into the project TM (see above).
As a result, you will get a mixed project TM: on the one hand, it will contain high-quality
translation units from the current TM (see “Create Project TM” above); on the other hand, it
will consist of roughly translated segments generated by a Translator’'s Workbench-compatible
MT system. Of course, Translator’'s Workbench will use its Machine Translation penalty to
make sure you do not accept the rough translation units as is. See “Machine Translation
Penalty” under “Translation Memory Options” for more information.

For more information on Translator’'s Workbench’s text format, please refer to “Translator’s
Workbench’s Text Format” in the “Importing and Exporting Translation Memories” chapter.
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Use TM from Previous Analysis

‘This option is particularly useful if you would like to compare different translation projects with
each other even if you have an empty translation memory. Let’s go through an example to
illustrate what this option does.

Let’s assume you want to analyse two different releases or versions of a manual. Let’s further
assume that the manual files are called Manual 1. doc and Manual 2. doc and that you've got a
Translation Memory called Manual s. t mw. To find out the leverage and differences between
the two, follow these steps:

1. Analyse the first version of the manual (Manual 1. doc), running it against your T'ranslation
Memory Manual s.t mv. When analysing files, Translator’s Workbench builds up a
temporary Translation Memory that contains all source sentences from the analysed files. In
our case, after the analysis, Translator’s Workbench would have created a temporary 'TM
containing all sentences of Manual 1. doc. We will benefit from this functionality in the
next step.

2. Clear the file Manual 1. doc from the Files to Analyse list and add the second file,
Manual 2. doc, to it instead. Now check the Use TM from Previous Analysis option, and
click Analyse again. During the second analysis, Translator’s Workbench will not run
Manual 2. doc against the TM manual s. t my, but against the temporary TM which was
created during the first analysis and which contains all source sentences from
Manual 1. doc. The results of this second analysis will then show you the differences
between the two manuals, enabling you to see exactly to what extent they are different and,
more interestingly, to what extent they are identical or roughly the same.

This procedure is also highly useful to determine whether an alignment of old translation
material is worth the effort or not. The more similar two document generations are, the more
useful an alignment will be.

9.2 Document Translation

In many firms and translation agencies, translations are done by freelancers who do not have
access to modern tools like Translator’s Workbench. To circumvent this limitation, the Translate
function lets you give these freelancers access to the data accumulated in Translation Memories
and MultiTerm 95 databases.

T'he Translate function can perform the following tasks as required:

e automatically translate all segments from one or more Word or tagged documents that reach
a certain match value in the current Translation Memory

e replace translations of known terms or insert them as annotations in segments for which no
match is found in TM

e segment unknown sentences in your document so that they can be more easily translated
without Translator’s Workbench and later imported into TMs

e If the document to be processed has already been partially or entirely translated using
Translator’s Workbench and changed after that, it might happen that target sentences in the
translated document differ from those in 'T'M. In this case, you can decide whether the 'TM
or the document should be updated, or if changes should be ignored.

When translating files, the program counts the number of terms and segments that could be
translated. The data is displayed on the screen as well as being written to a log file that you can
consult after the translation.
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Note

When finished, the translated files are stored back to disk. By default, Translator’s Workbench
makes a backup copy of each file processed during the Translate function for later use. The
backup copy gets the same name as the original version with the extension . bak. If you do
not want this, deactivate the Keep Backup option in the Tools tab of the Translation Memory
Options dialog. See “Translation Memory Options” in the “Translation Memory” chapter for
more information.

To perform a translation of one or more documents, follow these steps:

1.

2.

3.

Perform the following preparation tasks as necessary:

If you want to translate Word documents, make sure to start Word and activate the
template TWIW n. dot (Word 6.0/7.0) or TWAW n97. dot (Word 97) before the
translation. Workbench needs Word running to perform the conversion from Word’s
DOC format to RTF (Rich Text Format) and back. If the files are already available in
RTF format, this step is not necessary.

If you want to translate SGML or HTML documents, make sure the correct D'TD
settings files have been specified in the Tools tab of the Translation Memory Options
dialog. For more information, see the “Defining Options for Translator’s Workbench’s
Batch Tools” in the “T'ranslation Memory” chapter.

If you want to translate Workbench RTF documents (as produced by the S-Tagger 2.0
for FrameMaker and Interleaf, for instance), make sure to prepare them as described
under “Translating Tagged Files with Translator’s Workbench and TagEditor”.

In Translator’s Workbench, choose the Translate command from the Tools menu. The
Translate Files dialog opens.

Translate Files - Demo [Enghsh-German) 1]
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Figure 9-3: The Translate Files Dialog

In this dialog, add the files to be translated to the Files to Translate list. There are different
ways to achieve this:
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* Click the Add... button. The Files to Translate dialog opens. Select the desired drive
and folder as convenient. Select as many document files as desired, and click Open to
add them to the Files to Translate list.

e Drag & drop the file(s) from the Windows Explorer, Find Files dialog, or File Manager
into the Files to Translate list.

¢ To remove undesired files from the list, select them and click the Remove button. You
can also delete the entire list by clicking the Clear button.

Set the desired Translate options as follows: Use the % or higher Match Value field to set
the minimum match value for segments to be translated. If you set it to 100%, only those
segments from the documents that have an exact match in the current Translation Memory
will be translated. If you set it to a lower value, say, 95%, all segments whose match value is
higher than 95% will be translated. Segments whose match value falls below 95% will be left
untranslated. Note that the Translate function takes account of penalties that you may have
set in the Translation Memory options. For more information, see “I'ranslation Memory
Options” in the “Translation Memory” chapter.

Check the Segment Unknown Sentences option if you would like to have Translator’s
Workbench put its delimiting marks not only around translated segments, but also around
those segments for which the program can’t find any match in the Translation Memory. This
is useful for translating documents without using T'ranslator’s Workbench, since it will be a
much easier task to import new translations into TMs after the translation. It is also very
handy in combination with the Translate Terms option explained below. For more
information on ‘T'ranslator’s Workbench’s segmentation algorithms, see “Defining
Segmentation Rules” in the “Configuring a Translation Memory” section; for information
on how Translator’s Workbench segments your texts in your word processor, see “Before
Starting: Some Background Information & Useful Settings” in the “Interface With Your
Word Processor and TagEditor” chapter.

The Translate Terms group box is only applicable to those segments for which Translator’s
Workbench can’t find a match in the Translation Memory. The following selections are
available: Don't, Replace, and Insert.

J Don't means that Translator’s Workbench will not translate known terms at all.

* Replace means that the program will replace known terms with their translations from
the MultiTerm database. If multiple translations are present, the first is used.
Translated terms are formatted in a special character style called “tw4winTerm”
(default paragraph font + blue colour) to help you identify more easily what terms could
be translated. If you choose to replace known terms, we highly recommend that you also
activate the Segment Unknown Sentences option. Thus you’ll make sure that
translations are only inserted into the target sentence; your source sentences will be left
as they are as hidden text.

¢ Insert means that translated terms are inserted into the sentence as annotations (Word
6.0 and Word 95) or comments (Word 97). If multiple translations are present, they are
separated by a comma inside the annotation or comment. Annotations/comments are
notes that Translator’'s Workbench adds to your translated document(s). Each
annotation/comment has an identifying mark, usually the annotator’s initials and a
number. So, if Translator’s Workbench inserts translated terms into your files, they will
appear with the identifying mark [twl], [tew2], [tw3], and so on. Annotations/comments
appear in a separate annotation/comment pane; double-click the annotation/comment
mark in Word to open the pane and read the translations that Translator’s Workbench
has found for the known terms of the current sentence. The annotation/comment mark
appears in your document as hidden text. To display annotation/comment marks and all
other nonprinting characters in a Word document, click the Show/Hide 4 button on
Word’s Standard toolbar. Click the same button again to hide annotation/comment
marks. For further information on working with annotations/comments, see Word’s on-
line Help and documentation.
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7. 'The Update Changed Translations group box is only applicable to those documents that
meet the following requirements:

e They have already been partially or entirely translated with Translator’s Workbench. As
a consequence, they contain translation units (hidden source text with target text
translation).

e The TM used for the Translate function is the same as the one that had been used for
the previous translation.

e Later on, changes have been made to the translation units in the document without use
of Translator’s Workbench, which means that these changes have #of been made in the
corresponding TM. As a result, some translation units in the document differ from those
in TM.

In this case, you can decide what should happen to the pre-translated document and the
corresponding 'I'M. You have three options: Don't, Update TM, and Update Document.

e Don't means that changes made to the translation units in the document stay untouched
and are not reflected in the corresponding TM.

* Update TM means that the changes made to translation units in the document are also
reflected in the TM used for the Translate function. As a result, the TM will be updated
according to the changes made to the document.

e Update Document means that the changes made to the translation units in the document
are undone—the translations from the TM will be used instead.

8. Select the name of the log file where Translator’'s Workbench saves the statistical
information. Translator’s Workbench creates two log files, one in text format with a *. | og
extension, one in comma-separated form with a *. ¢SV extension. The CSV format is ready
for direct import into spreadsheet applications such as Microsoft Excel and presents the
analysis results in a tabular form. This then makes it easier for you to process the logged
results for budgeting and similar purposes. By default, the log files are located in the same
folder and have the same file name as the current Translation Memory. For instance, the
logs for the demonstration Translation Memory Denp. t nw are written to files called
Deno. | og and Deno. csv.

9. Click the Translate button to start the translation process. Translator’'s Workbench will
display its progress on two indicators, one for the current file and one for the total number of
files.

After the translation, click the View Log File button to take a look at the log file that contains the
statistical information of the translation (number of translated and/or updated segments and
words, number of translated/inserted terms, characters per word, number of placeables, etc.).

9.3 Cleaning Up Translated Documents

As described under “Before Starting: Some Background Information & Useful Settings” in the
“Interface With Your Word Processor and TagEditor” chapter, Translator’s Workbench retains
the source-language together with their target-language counterparts during translation. After
finishing and editing your translation, you will certainly want to “clean up” your document, that
is, remove all source text from it so that it does not remain in your finished translation. It is also
desirable to be able to edit translations in your documents without use of Translator’s
Workbench—for instance to do some spell checking or global changes without Translator’s
Workbench being active, or have somebody proof-read and correct your translation directly in
the word processor or TagEditor. Afterwards, it is of course necessary to reflect changes made in
this way in Translation Memory since it wasn’t active during these changes.
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"This is where the Cleanup function comes into play: It compares your finished translation with
all segments in Translation Memory, and removes all source sentences from your target text. You
can choose whether changes made to documents without use of Translator’s Workbench will be
reflected in Translation Memory or not. Or vice versa: It is also possible to update your
document based on the data stored in your TM.

If you have used the Translated Text Colours option to change the colouring of already
translated parts of text, the Cleanup function restores the original colouring of your text during
the cleaning process. Translated Text Colours are not supported by TagEditor.

In addition to this, the program counts the number of segments and words that have been
updated. The data is displayed on the screen as well as being written to a log file that you can
consult after the cleaning.

Note

When finished, the cleaned up files are stored back to disk. Since Translator’'s Workbench will
remove the hidden source text during cleanup, the link to Translation Memory will be
irreversibly lost. As a result, you will not be able to make corrections to the cleaned up version
in interactive mode—that is, using your word processor and Translator’s Workbench to update
the document and Translation Memory at the same time, as described under “Making
Corrections to Already Translated Segments” in the “Interface With Your Word Processor”
chapter. You should therefore make copies of the files to be cleaned up before performing the
Cleanup function if you want to keep the “non cleaned up” files for future reference. By
default, Translator’'s Workbench does this for you: it makes a backup copy of each file
processed during the Cleanup function for later use. The backup copy gets the same name as
the original version with the extension . bak. If you do not want this, deactivate the Keep
Backup option in the Tools tab of the Translation Memory Options dialog.

To clean up one or more documents, follow these steps:

1.  Perform the following preparation tasks as necessary:

e If you want to clean up Word documents, make sure to start Word and activate the
template TWIW n. dot (Word 6.0/7.0) or TWAW n97. dot (Word 97) before the
cleanup. Workbench needs Word running to perform the conversion from Word’s DOC
format to RTF (Rich Text Format) and back. If the files are already available in RTF
format, this step is not necessary.

e If you want to clean up TagEditor bilingual documents (BIF), make sure the correct
DTD settings files have been specified in the Tools tab of the Translation Memory
Options dialog, so that the target SGML/HTML files can be created successfully. For
more information, see the “Defining Options for Translator’s Workbench’s Batch
Tools” in the “Translation Memory” chapter.

2. In Translator’s Workbench, choose the Clean Up command from the Tools menu. The
Cleanup Files dialog opens.
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Cleanup Files - Demo [English-German) 1]
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Figure 9-4: The Cleanup Files Dialog

3. In this dialog, add the files to be cleaned to the Files to Clean up list. There are different
ways to achieve this:

Click the Add... button. The Files to Clean up dialog opens. Select the desired drive and
folder as convenient. Select as many document files as desired, and click Open to add
them to the Files to Clean up list.

Drag & drop the file(s) from the Windows Explorer, Find Files dialog, or File Manager
into the Files to Clean up list.

T'o remove undesired files from the list, select them and click the Remove button. You
can also delete the entire list by clicking the Clear button.

4. Set the desired Changed Translations option. This option only comes into play for those
documents that meet the following requirements:

They have been translated with Translator’'s Workbench. As a consequence, they
contain translation units (hidden source text with target text translation). The TM used
for the Cleanup function is the same as the one that had been used for the translation of
the documents.

Changes have been made to the translation units in the document withour use of
T'ranslator’s Workbench, which means that these changes have #or been made in the
corresponding T'ranslation Memory. As a result, some translation units in the document
differ from those in the Translation Memory. This is the case, for instance, after the
document has been spell-checked or edited otherwise.

In this case, you can decide what should happen to those translation units in the document
that differ from the corresponding translation units in TM. You have four options: Don't
Update, Don't Clean Up, Update TM, and Update Document.

Don't Update means that during the Cleanup process, changes made to the translation
units in the document stay untouched and are nor reflected in the corresponding TM.
The hidden source text and delimiting marks are cleaned throughout the document.

Don't Clean Up means that the translation units in the document that differ from their
counterparts in T'M are nor touched ar all during the Cleanup process. Unlike the Don't
Update option, Don't Clean Up does 70f remove the hidden source part and delimiting
marks of the changed document translation units. This allows you to check the
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differences between the translation units in the document and those from T'ranslation
Memory after the Cleanup process, and thus gives you additional control over changes
between the translated documents and the corresponding TM. Note that the Don't
Clean Up option is 7of available for TagEditor BIF documents.

* Update TM means that the changes made to translation units in the document are also

reflected in the 'I'M used for the Cleanup function. As a result, the TM will be updated
according to the changes made to the document. This is especially useful after spell-
checking or otherwise enhancing the translated document without use of Translator’s
Workbench. Please note also that if source text has been changed in one or more
document translation units, Translator’s Workbench compares the new source text to
Translation Memory. If a corresponding translation unit exists in TM, it will be
overwritten. Otherwise a new translation unit will be created in TM with the new source
text from the document together with its translation.

e Update Document means that the changes made to the translation units without use of

Translator’s Workbench are wndone in the document—the initial translations from the
T™M will be used instead.

Select the name of the log file where Translator’'s Workbench saves the statistical
information. Translator’s Workbench creates two log files, one in text format with a *. | og
extension, one in comma-separated form with a *. ¢SV extension. The CSV format is ready
for direct import into spreadsheet applications such as Microsoft Excel and presents the
analysis results in a tabular form. This then makes it easier for you to process the logged
results for budgeting and similar purposes. By default, the log files are located in the same
folder and have the same file name as the current Translation Memory. For instance, the
logs for the demonstration Translation Memory Denp. t nw are written to files called
Deno. | og and Denp. csv.

Click the Clean Up button to start the cleaning and updating process. Translator’s
Workbench will display its progress on two indicators, one for the current file and one for the
total number of files. When cleaning up, Translator’'s Workbench performs the following
tasks:

e It compares the translation units of your text with sentences stored in Translation

Memory. Depending on the setting of the Changed Translations option, Translator’s
Workbench will update your TM if changes have been made to your document(s) that
have not already been reflected in TM.

e Unless you chose the Don't Clean Up option for Changed Translations, it removes all

hidden source segments and delimiting marks from your documents. If you chose the
Don't Clean Up option, all changed translation units are still in the document, with
hidden source segments and delimiting marks.

* If you have used the Translated Text Colours option from the Options menu to change

the colouring of already translated parts of text, the Clean up function also restores the
original colouring of your text during the cleaning process. This option is not available
for TagEditor BIF documents.

After cleaning, click the View Log File button to take a look at the log file that contains the
statistical information of the cleaning process (number of updated segments and words,
characters per word, number of placeables, etc.).

You can open the cleaned Word or TagEditor documents in your word processor or any other
target application that supports the format of your cleaned up target files. If you want, you can
now save the files as “normal” word-processing documents or give them out for printing or
further processing.
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9.4 Troubleshooting Batch-Processed Files

The information in this section is only valid for Word (DOC or RTF) documents. With
TagEditor, the problems described below cannot occur, since delimiting tags are always
protected.

During document translation and cleanup, Translator’'s Workbench segments your texts, or it
removes existing segmentation tags. If it runs into problems doing so, it displays corresponding
error messages, for example “Start of mainsegment not found”, during the batch process. You
can find a complete list of these error messages in the error message appendix. These error
messages are also written to the log file.

Since these errors occur during a batch process, it’s not possible for you to interactively
troubleshoot them. That’s why Translator’s Workbench inserts a special tag into the document at
the location where an error occurs, and then continues with the batch process. This special tag is
a double arrow, pointing in the direction where the error occurred (“>>" or “<<”). The arrow is
formatted in a character style called “tw4winError.” This makes it easier to find the critical spots
after the batch process. To locate those spots, follow these steps:

1. Open the file(s) containing the error(s) in your word processor.

2. From your word processor’s Edit menu, choose Find. In Word 97, click More to display the
entire Replace dialog. This is not necessary in earlier Word versions.

3. Since you don’t know in which direction the arrow points, you cannot enter any search text.
However, you can search for any character formatted with the character style “tw4winError.”
To achieve this, click the Format button, and choose Style from the drop-down list. In the
Find Style dialog that follows, choose twdwinError, and click OK. The Format specification
for the Find What box should now read “tw4winError.”

Find and Replace

Find |Rep_|ace| Go To |

Find what: || =] Find Mext
Format: Style: bwdwinError Eemee]

Less &

i

Search: Al - [~ Match case
[~ Find whole words only
[~ Use wildcards
[~ Sounds like
[ Find all ward Farms
Find

Mo Formatking | Format = | Special * |

Figure 9-5: Finding the Character Style “tw4winError” in Word (here, Word 97)

4. Click the Find Next button. Your word processor will now jump to the first location of a
double arrow formatted in the character style “tw4winError.” The error will almost certainly
have come up because of a segmentation tagging error (a start of mainsegment has been
accidentally deleted, or a subsegment start mark couldn’t be found). Please refer to the error
messages appendix for a complete description of errors and troubleshooting options you
have.

5. After troubleshooting all error causes in the document files, you will certainly want to batch-
process them again. To achieve this, save and close the files in your word processor, and run
the Translator’s Workbench batch tool again (Translate or Cleanup).
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9.4.1 Removing the “tw4winError” Markers From Troubleshot Files

After you have removed the causes for segmentation errors and re-translated or re-cleaned the
corresponding files successfully, the “tw4winError” markers will still be present in your
documents. To remove them, follow these steps:

1. Open the file(s) containing the error marker(s) in your word processor.
2. From your word processor’s Edit menu, choose Replace.

3. Since you don’t know in which direction the arrow points, you cannot enter any search text.
However, you can search for any character formatted with the character style “tw4winError”
and replace it with nothing. Make sure the cursor is blinking in the Find What box. Then
click the Format button, and choose Style from the drop-down list. In the Find Style dialog
that follows, choose twdwinError, and click OK. The Format specification for the Find What
box should now read “tw4winError.” From the Search drop-down list, choose All. You can
now replace all error markers in one go by clicking the Replace All button.

Find and Replace
Find Replace | Go To |
Find wehat: I LI Find Mext
Format:  Skyle: bwedwinError Cancel |
Replace with: I Ll Replace |
Format:
Replace Al |
Search: Al - ™ Match case LI
[~ Find whole words only
[~ Use wildcards
[~ Sounds like
[ Find all ward Farms
Replace
Mo Formatking | Format = | Special * |

Figure 9-6: Replacing all “tw4winError” Occurrences with Nothing

4. After removing all error markers successfully, save your documents again. The files are now
ready for further processing.
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MultiTerm ’95 Plus! (MultiTerm for short) is integrated into Translator’s Workbench. However,
it is included as an independent program as well. This means that you can also access your
terminology databases when you’re not working in Translator’s Workbench.

This section describes the interface between Translator’s Workbench and MultiTerm. For
further information on MultiTerm, please refer to the MultiT'erm ’95 Plus User’s Guide.

10.1 Accessing MultiTerm from Translator’s Workbench

There are many ways in which Translator’'s Workbench and its terminology module,
MultiTerm ’95 Plus, interact. First and most important of all, there is the active, “fuzzy”
terminology recognition feature. What is this? Active, “fuzzy” terminology recognition is an
extremely powerful feature whereby Translator’'s Workbench compares the current source
sentence with the data in MultiTerm. Every known term—which of course includes those
consisting of multiple words—, or every term that is only similar to terms stored in the
MultiTerm database, is highlighted by a red bracketed line in the Source window of Translator’s
Workbench. In addition to that, the first known term is displayed in the Terminology window of
Translator’s Workbench, along with its translation in the target language you set in Multi Term.
To take a look the other terms and their translations, click on the red line that marks them in the
Source window, and Translator’s Workbench will display the corresponding term and its
translation(s) in its T'erminology window.

A click on the mouse button or a keystroke pastes the corresponding translation into your
document as described in the “Interface With Your Word Processor” chapter. Translator’s
Workbench displays all translations of known terms together with their attributes, so you can
choose the one which fits best into the current context. Thus, for example, if one of your
German clients prefers the translation Anwendung to Anwendersoftrware for the English word
application, Translator’'s Workbench will display both German translations and you can decide
which one fits best into your current context. Of course, you can also activate MultiTerm at any
time and have a closer look at the whole entry for app/ication.

10.1.1 Activating and Deactivating Terminology Recognition

The toggle Term Recognition in Translator’s Workbench’s Options menu determines whether
Translator’s Workbench should automatically activate terminology recognition, thus integrating
MultiTerm into the translation process. If the Term Recognition menu item is checked,
Translator’s Workbench automatically displays the Terminology window and displays known
terminology in it. If it is not checked, Translator’s Workbench assumes that you do not want to
work with MultiTerm at the moment. As a result, the program will maximise its Source and
Translation Memory windows, thereby hiding the Terminology window.

Deactivating the Term Recognition option can be useful, for example, if you want to create or
update the Fuzzy Index in MultiTerm, used for the automatic terminology recognition carried
out by Translator’s Workbench for each source sentence. For more information, please refer to
“Terminology Recognition—What Is It?” in the “Introduction” chapter and “Common
Questions: Current MultiTerm Has No Fuzzy Index” below.
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10.1.2 “Fuzzy” Terminology Recognition: Examples

The active, fuzzy terminology matching carried out by Translator’'s Workbench also required the
development of special fuzzy-matching algorithms. For instance, it is desirable to find not only
morphologically reduced forms, for example base forms of verbs or singular forms of plural
nouns, but also base forms of compound words, even if the elements of these compound words
are spread over the sentence. Consider the following example:

One of the companies located on the Danube river produces steamboats.

Now, if there is an entry in MultiTerm for Danube steamboat, it would be nice to find it even if it
this compound has been split up in the source sentence and occurs in the plural. Also, it would of
course be desirable to find entries for /ocate and produce, even if the past participle and 3rd person
singular form of these verbs are used in the sentence to be translated. In order for Translator’s
Workbench to successfully carry out terminology recognition, you can set terminology
recognition options. Let’s first explain these options and then come back to the above example.

10.1.3 “Fuzzy” Terminology Recognition: Options

You specify the terminology recognition settings via the Term Recognition Options command
from the Options menu. You can define the following parameters:

Minimum Match Value: The match value expresses the degree of similarity between the
terminology in your sentence and the terminology found in MultiTerm. The greater the value,
the more similar the terms must be. The more dissimilar the terms in your sentence and in
MultiTerm, the greater the amount of work required to find matching terms. You can therefore
set two values for terminology recognition, the Minimum Match Value and the Search Depth.
The Minimum Match Value option sets the boundary value for the fuzziness of term recognition.
Translators will work with different values according to their tastes and preferred work methods.
Experience has shown that the minimum match value will generally lie between 65% and 75%.
The default is 70%, you can choose a value between 30 and 100%.

Search Depth: When scanning a sentence for terminology, Translator’s Workbench evaluates
not only single words but also multi-word units, trying to find similar terms in your current
MultiTerm database. The Search Depth value defines the number of fuzzy hits Workbench
should examine as possible candidates from the MultiTerm database. As a consequence,
increasing the Search Depth value slows down terminology recognition, lowering it speeds it up.
You can set a value between 10 and 999; however, high values are only necessary if you are
working with large terminology databases (see “Back to Our Example” below). For medium-
scale terminology databases, a value of as few as 20 should yield perfect results.

Back to Our Example...

Let’s return to our above example. Suppose you have to translate the sentence Owe of the
companies located on the Danube river produces steamboats. Suppose furthermore that in your current
MultiTerm database, there are three entries that Translator’s Workbench should find, if
possible: /locate, produce, and, much more interestingly, Danube steamboat.

If you set a Minimum Match Value of 100% for the terminology recognition, Translator’s
Workbench will not find a single one of these terms. This is because in the sentence, these
words do not occur in their base form, which would be 100% identical to the terms in the
MultiTerm database. Located occurs as a past participle, produces as the inflected form of the verb
produce in the third person singular, and the individual elements of the compound Danube
Steamboats have been split up and moved. To find this compound, Translator’s Workbench does
not only have to reduce the plural noun steamboats to its singular form, but also re-order the
elements occurring in the sentence in such a way that it can find the matching term entry in
MultiTerm.
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Of course it would be very desirable to find all these terms. This is why you can define your own
preferred fuzziness and search depth values for the active terminology recognition. For the
above example, setting a Minimum Match Value of, say, 97%, and a Search Depth of, say, 20, will
find the Danube Steamboar compound, but not the verbs Jocate and produce. Further reducing the
fuzziness value to below 95% will also find the two verbs.

We recommend that you work with fuzziness value settings of around 70% to make sure that
even complex compounds like the above example can be found, even if their parts have been
moved around a lot in your sentence. It is also important to work with a sufficiently high Search
Depth value to make sure that Translator’s Workbench evaluates enough candidates from the
MultiTerm database before it suggests them as matching terms. Experience has shown that as a
general principle, the bigger the terminology database gets, the higher the Search Depth value
needs to be in order to find even complex terms. In this case, it might be recommendable to
increase the Search Depth value beyond 200. Please note, however, that the higher the search
depth, the more time Translator’s Workbench needs in order to evaluate term candidates. For
everyday purposes and medium-scale terminology databases, a search depth of 20 to 40 should
yield absolutely satisfying results.

Hint

We recommend that you play around with these settings to find the values that best meet your
everyday requirements.

10.1.4 Displaying a MultiTerm Entry

In its Terminology window, Translator’s Workbench shows you the term, its translation(s), and
term attributes (e.g. gender information) as found in the current MultiTerm entry. However,
terminology databases often contain additional information besides terms and their attributes, for
instance definitions, examples, source references, and so on. Especially when multiple
translations are displayed or the term found is a homonym, you may want to look at the full
MultiTerm entry for the term so you can make the correct choice.

To take a closer look at an entry in MultiTerm, double-click on the dictionary icon preceding it
in the Terminology window. This activates the MultiTerm program window with the
corresponding entry.

It is also possible to click once on the dictionary icon preceding found terms. This toggles
between showing and hiding the translation(s) of the terms. If there is no translation in the
currently selected target language in the terminology database—usually the same as the current
target language of your Translation Memory—Workbench displays a corresponding message:
“No target term available in MultiTerm entry.”

10.1.5 Performing Terminology Searches From Translator’s Workbench

In any of Translator’s Workbench’s windows (Source, Translation Memory, Terminology, or
Concordance window), after selecting text with the left mouse button, clicking the right mouse
button brings up a context menu. In this context menu, there are two options for performing
terminology searches in MultiTerm:

e Search in MultiTerm: Use this command to start a simple search in MultiTerm, based on
your current text selection. “Simple search” means that MultiTerm will perform a search by
looking through the index of the current source language selected in the MultiTerm
database—usually the same as the one selected as the source language of the current TM—
and display the first entry whose headword begins with the search term. MultiTerm will
then pop up and show you the corresponding entry. If it cannot find the term you have
looked for, a corresponding message (“Not found”) will be displayed in MultiTerm’s status
bar.
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Fuzzy Search in MultiTerm: Use this command to start a fuzzy search in MultiTerm, based
on your text selection. If MultiTerm can find matching entries, it will pop up and show you
a hit list with all entries that could be found. If it cannot find anything, it will display a
corresponding messages (“No matching entries found”) in its status bar.

10.2 Using Filters in MultiTerm

10.2.1 Examples

Filters that you define in MultiTerm are recognized by Translator’s Workbench. When a
MultiTerm filter is active, Translator’s Workbench uses the following conventions to display
found terms:

If a term does not match the MultiTerm filter and does not have homonyms, Translator’s
Workbench will still display it. To make you aware that the term does not match the
MultiTerm filter, the dictionary icon is grey. (For a discussion of homonyms and similar
linguistic cases, please consult the “Special Linguistic Cases” section in the “Editing
Entries” chapter of the MultiTerm User’s Guide.)

In case of homonyms, Translator’s Workbench attempts to find the term(s) matching the
MultiTerm filter. If the program can find a matching term, it will be displayed with a normal
(blue) dictionary icon. If several terms match the filter, they will all be displayed with blue
icons. If none match the filter, they will all be displayed with grey icons.

Let’s assume your MultiTerm database contains two homonym entries for the English term
keyboard, one with the computer meaning (German translation: Tastatur), one with the music
meaning (German translation: Keyboard). To distinguish between the two entries, you have
created a global Subject attribute field in both MultiTerm entries with the corresponding
attribute values (Computer and Music).

Now, if a sentence with the word 4eyboard occurs in your translation and you don’t set any filter
in MultiTerm, Translator’s Workbench will display both found entries as usual:

5 TRADODS Translator's Workbench - Demo

File Settings Wiew Options Toolz Help
Changed o B - computer usually comes with a keyhoard. @ keyboard
Changed by: Keyhoard o
zage:

@ keyhoard

Tastatur »
o

|No ratehl -+ =

Figure 10-1: Displaying MultiTerm Entries With No Filter Activated

As you can see, in this example, you have to explicitly choose the second translation in the
current context.

If you set a filter in MultiTerm for the Computer domain, Translator’'s Workbench will only
display the term matching this filter:
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ISSS————————————_—_———_
Filter Definition 1]
Field or Field Group Criterion
Entry Number -> Subject “Computer™
Delete
[” Only Use Matching Fields Criterion I*Computer*| Or...

Figure 10-2: Setting a Filter in MultiTerm

TRADOS Translator's Workbench - Demo

File  Settingz “iew Options Toolz Help
Changed or: Bl A computer usually comes with a keyhoard,  keyboard
Changed by: Tastatur »
Uzage:

S
|N0 matchl

Figure 10-3: Displaying MultiTerm Entries with an Active Filter

If you set a filter to a different domain (say, Chemistry), Translator’s Workbench will again display
both entries. This time, however, it greys out the dictionary icons to let you know that the terms
don’t match the current filter in MultiTerm:

= TRADOS Translator's Workbench - Demo

File Settings Wiew Options Toolz Help
Changed o B - computer usually comes with a keyhoard. keyhoard
Changed by: Kevhoard «
zage:

keyhoard

Tastatur »
o

|No matchl

Figure 10-4: Displaying Non-Matching Terms

10.2.2 Further Reading

For a full description on filtering in MultiTerm, please see the “Filtering Entries” chapter in the
MultiTerm User’s Guide.

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



10-6 Interface With MultiTerm ’95 Plus

10.3 Common Questions

Below, you will find commonly asked questions about the interaction between Translator’s
Workbench and MultiTerm and the problems that you might encounter.

10.3.1 Terminology is not Correctly Recognised

After opening a new translation unit from my word processor, Translator’s Workbench does not display
known terms in its Terminology window, although the terms are definitely in the MultiTerm database. Wiy
is that?

If Translator’s Workbench’s active terminology recognition does not seem to work correctly,
check the following settings in Translator’'s Workbench and Multi Term:

e In Translator’s Workbench, check the current settings for the terminology recognition
options. You define them by selecting the Term Recognition Options item from the Options
menu. It might be, for example, that the Minimum Match Value is set to a too strict
percentage, e.g. 95%. We recommend that you work with fuzziness settings of around 70%.
Likewise, it might be that the Search Depth value is set too low, e.g. 10. For medium-scale
terminology databases, we recommend a Search Depth value of 20-40. Note that you can
also set maximum values stretching far beyond 900. Note, however, that with these high
settings, the search time of the terminology recognition takes considerably more time than
with settings of, say, 100.

e In MultiTerm, check the current language direction. As you might know, MultiTerm uses
index fields to store terminology in different languages. You know that in Translator’s
Workbench, the language direction is more or less fixed. An English-German Translation
Memory will always have English as the source language. A MultiTerm database, on the
other hand, can of course be multi-lingual. This is why, before being able to work correctly
with Translator’s Workbench’s terminology recognition feature, you have to set a language
direction in MultiTerm that reflects the direction of the current TM. For instance, if your
current TM is English(UK)-German, set the same language direction in the current
MultiTerm database. Otherwise, MultiTerm will be searching in the wrong source language
(index) and hence not find any matching entries.

e It might also be that the fuzzy index of the MultiTerm database is not current. If this is the
case, Translator’s Workbench’s active terminology recognition cannot find entries that you
have added affer creating the fuzzy index the last time. Always remember that a fuzzy index
of a MultiTerm database is szazic and therefore only contains those terms that were present
when you last created it. Newly created entries are 7o automatically added to the fuzzy
index. Therefore, you must re-create a fuzzy index every time that you have entered a
number of new entries to the MultiTerm database and would like to include them in the
automatic terminology search carried out by Translator’s Workbench for each new sentence.
We recommend that you do this regularly, at the end of each week, for instance.

Note

In order for MultiTerm to be able to create a fuzzy index, make sure that no translation unit is
currently open in 'Translator’s Workbench. Alternatively, deactivate term recognition
temporarily via the Term Recognition toggle from the Options menu.

10.3.2 MultiTerm is not Running

1 alkways get the following messages:  “MultiTerm not running” or “DDE timeout while communicating
with MultiTerm.” What do these messages mean?

These messages can mean two different things:
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*  You are using Translator’s Workbench without Multi Term. Translator’s Workbench’s active
terminology recognition feature can only work if you have started MultiTerm and opened a
terminology database with a fuzzy index (see next section for further information on this).

*  You have started MultiTerm, but it is in edit mode, that is, you are currently editing an
entry. In this case, Translator’s Workbench cannot access MultiTerm. MultiTerm must be
in display mode in order for Translator’s Workbench to send messages to it.

If you ignore the message, Translator’'s Workbench assumes that you do not want to work with
MultiTerm at the moment. It will maximise its Source and Translation Memory windows, thus
hiding the Terminology window. If, later on, you would like to start MultiTerm and use the
active terminology recognition feature (a step that we highly recommend), Translator’s
Workbench automatically recognises that MultiTerm is now running and will thus re-display its
Terminology window.

10.3.3 Current MultiTerm Database Has No Fuzzy Index

1 always get the message: “Current MultiTerm database has no fuzzy index.” What does this mean?

This means that you have opened a terminology database in MultiTerm for which you have not
yet created a “fuzzy index.” In order for Translator’'s Workbench to correctly work with
MultiTerm databases, they must be available in “fuzzy format.” So, before Translator’s
Workbench can access the data stored in MultiTerm, you must create a fuzzy index for the
terminology database. To achieve this, select the Create Fuzzy Index command from the File
menu in MultiTerm. MultiTerm now works through the database and creates fuzzy images of all
its terms in all languages, adding them to neural network files which are created in addition to
your terminology database. For this reason, please make sure that you have enough space on
your hard disk before starting this process. A message in the status bar confirms that MultiTerm
is currently busy creating a fuzzy index. This will take up to a few minutes. You should by all
means wait until MultiTerm has finished creating the fuzzy index; otherwise, the neural network
may be incomplete or even damaged. A message appears in the status bar after the fuzzy index
has been created successfully. For more information on fuzzy indexes in MultiTerm, please
consult the MultiTerm "95 Plus User’s Guide.

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



10-8 Interface With MultiTerm ’95 Plus

Translator’s Workbench, © 1994-99 by ® TRADOS GmbH



11. Importing and Exporting Translation
Memories

This chapter shows you how to export and import TMs as a whole or in part. It also shows you
how to invert the language direction of a Translation Memory.

11.1 Importing

You can use the Import function of Translator’s Workbench’s File menu to load a text file in the
format of the Windows or DOS Translator’s Workbench (TW II) into the current Translation
Memory. Import files in TMX level 1 format are also supported. Import text files of the
Windows Workbench and WinAlign are in ANSI code (file extension *. t Xt ), those in TMX are
in XML format, and those of the DOS Translator’s Workbench or TAlign in ASCII (*. asc,
*al ). If you would like to import Translation Memories created with the DOS Translator’s
Workbench or TAlign, please refer to the section on “Importing TW II or TAlign ASCII text
files into a TM of the Windows Workbench” at the end of this section.

The Import menu item can only be activated when opening a TM in exclusive mode. To achieve
this, check the Exclusive box in the Open Translation Memory dialog. If the TM database is
password-protected, you need to know the SuperUser password in order to have exclusive
access.

Note

In Translator’s Workbench Freelance Edition, there is no Exclusive check box in the Open
Translation Memory dialog. This is because Translator’'s Workbench Freelance Edition
automatically opens each 'T'M in exclusive mode.

11.1.1 Translator’'s Workbench’s Text Format

The text files created with the export function of the Windows Workbench consists of two main
sections: first, what is referred to as the “RTF Preamble,” and second, the translation units as
well as translation unit information such as Change User or project attributes and text fields.

RTF Preamble

The following is an example of a typical RTF preamble in Translator’s Workbench text format:

<RTF Preanbl e>

<Styl eSheet >{\ styl esheet {\sO normal;}{\csl\cf5\f1\sub\v

twdwi nTags; }{\ cs15\b\f4\fs24\i Test;}{\cs15\b\f5\fs24 Trados;}}
<Font Tabl e>{\fonttbl {\f1\fnodern\fcharsetO\fprgl Courier New }
{\f2\fswi ss\fcharsetO\fprg2 Arial;}

{\f3\fcharsetO\fprq2 Bookman A d Style;}

{\f4\fcharsetO\fprq2 Wde Latin;}

{\f5\fcharsetO\fprq2 Century CGothic;}

}
</ RTF Preanbl e>
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In this header, preceded by the tag <RTF Preanbl e>, Translator’s Workbench lists the
character styles and fonts that were used when building up the Translation Memory. These
styles and fonts are referenced in RTF tags in the translation units. Please refer to the section on
“Used Character Styles” and “Used Fonts” in the chapter on “Editing & Deleting Translation
Units” for further information. The RTF preamble ends with the tag </ RTF Pr eanbl e>.

Translation Units

The following is an example of a typical translation unit in Translator’s Workbench text format:

<Tr U>

<Cr D>17071994

<Cr U>M LLER

<ChD>18071994

<ChU>SM TH

<UsD>18071994

<UsC>1

<Att L=Client>Pro Software Inc.

<Att L=Donmi n>Sof t war e

<Txt L=ID code>TR 1994/ 123 AB

<Seg L=EN _CGB>What exactly is a Translation Menory (TM?
<Seg L=DE_DE>WAs hat man sich unter einem Translation Menory (TM genau
vor zustel | en?

</ TrU>

The following table provides a brief description of what the tags at the beginning of each line

mean:

Tag name Description

<TrUs>, </TrU> Means that a new Translation Unit starts/ends here.

<CrD> Specifies the Date of Creation of this translation unit in the format
DDMMYYYY.

<CrU> Specifies the User ID of the person who Created the translation unit.

<ChD> Specifies the Date of the last Change to this translation unit in the format
DDMMYYYY.

<ChU> Specifies the User ID of the person who last Changed the translation unit.

<UsD> Specifies the Date when the current translation unit was last Used in the format
DDMMYYYY.

<UsC> Shows how often a translation unit has been used, i.e. specifies the Usage
Counter.

<Att L=Attribute Specifies the Label of one of the translation unit’s project Attributes. In the

Field Label> above example, the first attribute is called Client and its contents are Pro
Sofrware Inc., meaning that this translation unit was created during a translation
project for this company.

<Txt L=Text Field Specifies one of the translation unit’s Text field Labels. In the above example,

Label> the text field label is ID code.

<Seg L= Segment Contains the Language label of the Segment that follows. In the above

Language Label> example, EN_GB stands for English (United Kingdom), DE_DE for German
(Germany). Lines starting with a <S¢g L> tag contain the actual sentences and
their target-language equivalents.

In the text format of Translator’s Workbench 2.x or higher, the labels used for the
<8eg L=Segment Language Label> tag are in two parts. The first part lists the language, the second
part the country or region where the language is spoken. The codes used for the language follow
the ISO 639 norm of two-letter language codes. The codes for the country follow the ISO 3166
norm of two-letter country codes. You can find a complete listing of ISO 639 codes at many sites
on the Internet, for example at http://ww. st onehand. conf uni code/ st andar d/
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i s0639. html . ISO 3166 codes are listed at http://eexpert.com _gp_dng. ht m or
http://nic.xlink.net/domins/iso3166-codes. htm |, for instance.

Examples: DE_DE stands for German (Germany), DE_CH for German (Switzerland), ZH CN for
Chinese (China), and ZH_SG for Chinese (Singapore). If a language is only spoken in one
country, “00” is used as country code. Examples: FI _00 stands for Finnish, JA 00 for
Japanese.

11.1.2 Defining Import Options

To define import options, choose Import from the File menu. The Import dialog appears.

— Impaort Maode

% Small Import File [no Reorganization)

L arge Impoart File [with Fearganization) Cancel |
MewFields — Heb |

" Leave Unchanged ' |gnare
™ Keep Most Recent * Add e Setup
" Keep Oldest
* Merge

€ Dwenwrite

— Exigting Tranzlation Unitz

[ Check Matching Sub-Languages

Figure 11-1: The Import Options dialog

Import Mode

T'he Import Mode group box gives you the following options:

¢ Small Import File (no Reorganisation): This option is useful if you only want to import a
small import file with few translation units. When importing a small import file, Translator’s
Workbench reads the translation units from the text file and simply @dds them to the current
TM and its associated neural network files. In the neural network used by Translator’s
Workbench, it takes a bit more time to add new translation units than to merge them with it.
Merging, however, requires a complete reorganisation of the network after the import,
whereas adding data doesn’t. It is therefore advisable to use the “slow” import only if you
would like to import, say, 50 translation units into a TM of 10.000 units. Since a
reorganisation isn’t necessary, this import mode is a better choice in this case.

e Large Import File (with Reorganisation): 'This option is useful if you want to import a large
import file with many translation units. During a fast import, Translator’s Workbench first
reads and analyses all translation units from the text import file and then merges them with
the existing data in the neural network files. It takes less time to merge a translation unit
with the neural network data than to add it (see above). However, merging requires a
reorganisation of the network after the import, which might take some time, depending on
the size of the T'M database and its associated files. Nevertheless, this import mode is the
normal choice, since merging and reorganising are generally faster with larger import files
than the Small Import File mode which needs no reorganisation.

Existing Translation Units During Import
This group box gives you the following options: Leave Unchanged, Keep Most Recent, Keep
Oldest, Merge, and Overwrite.

The options Keep Most Recent and Keep Oldest are straightforward: Keep Most Recent means
that Translator’s Workbench will always keep the TU that is “youngest.” So if an imported unit
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has the same source sentence as a unit in TM and is newer than the unit in TM, it will be
imported. If it is older, it will be rejected. The Keep Oldest option has the opposite effect. It will
always keep the older TU.

Explaining the remaining three options, Leave Unchanged, Merge, and Overwrite, is a bit more
complex. The following chart diagram clarifies what Translator’s Workbench does during import,
depending on the setting you choose (I'T'U stands for Imported Translation Unit, TMTU stands
for Translation Memory Translation Unit):

Read new translation unit from the
import file

Is the ITU valid? No— Reject ITU.

Yes

Is the source
sentence of the ITU the same
as one or more TMTU source
sentences?

No— Add ITU to TM.

Yes

v

Compare attribute fields of ITU with attribute
fields of the TMTUs; find "best match". ‘

Leave Unchanged I Overwrite
Merge
v
. ITU overwrites the TMTU
Reject ITU. Compare target sentence of .ITU with target whose attributes match best
sentence of best matching TMTU
the ITU.
Is the ITU’s target Attributes and text fields of the
sentence different from the TMTU’s No— ITU are merged with those of
target sentence? the TMTU.
Yes
Do the ITU’s attributes
match those of the TMTU?
Yes No
ITU target sentence overwrites old A new TMTU is created with
TMTU target sentence. Attributes new project attributes and the
and text fields of the ITU are new target sentence. The old
merged with those of the TMTU. TMTU is kept.

Figure 11-2: Existing Translation Units During Import

New Fields in the Import File

The New Fields group box of the Import dialog box gives you two options: Ignore and Add to
Setup.
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If you choose Ignore, Translator’s Workbench will ignore all new attribute fields and text fields
that might be part of the import file. This means they will not be added to the setup of your
current TM.

Choosing Add to Setup, on the other hand, will add all new attribute and text fields to your
current 'T'M setup. So, for example, if the following line crops up in your import file:

<Att L=dient>Trados

and you did not have the attribute field Client in your TM setup, Translator’'s Workbench will
automatically add this item to it. Likewise, if you did have a Client attribute field but Trados
hadn’t been on the attribute picklist up to now, it will automatically be added to the picklist.

Check Matching Sub-Languages

Check this box on/y if you want to make sure that Translator’'s Workbench compares the sub-
language codes from the import file with the languages specified in the Translation Memory
used for the import. If you leave this check box empty, Translator’s Workbench will also import,
say, English (United Kingdom) segments even if the 'TM has English (United States) as source
or target language. If you check this option, however, all English (United Kingdom) segments
will be regarded as invalid and thus not be imported. For more information on the concept of
language codes and sub-languages as used in Translator’s Workbench 2.x import files, see
“Translator’s Workbench’s Text Format” above.

11.1.3 Starting the Import

After you have made your import settings as described above, click OK to confirm. The Open
Import File dialog opens.

Open Import File
Lookjn: |53 Twidwin

File narne: IDemo. b=t Open

Files of bype: I Towd For Wi [ et wal) j Cancel

Pl

Help

Figure 11-3: Opening an Import File

In this dialog, the desired file type, TW for Windows/WinAlign (*.txt), is already selected in the
Files of Type list. From the Look In drop-down box, choose the desired drive and folder as
convenient. After that, click the desired file name, and click Open to confirm. The import will
now start. Translator’s Workbench automatically adds the translation units to your TM as
defined in the “Defining Import Options” section.
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11.1.4 Importing a WinAlign File Into a Translator's Workbench Translation Memory

Follow these steps to import a text file created with TRADOS WinAlign into a Translation
Memory:

1.

If you have not already exported the alignment results from WinAlign into a text file, do so
now. The procedure is explained in the WinAlign manual in the “Exporting the Alignment
Results” section of the “Getting Started” chapter.

If you have not already created a Translation Memory in Translator’s Workbench, do so
now. The procedure is described in the “Creating a new Translation Memory” section of
the “T'ranslation Memory” chapter.

Open the Translation Memory that you would like to use for the import. Make sure to open
it in exclusive access mode.

From the File menu, choose Import. The Import dialog box opens.

Make the appropriate selections as explained in the section “Defining Import Options”
above. Click OK to confirm your settings. The Open Import File dialog opens.

In the Open Import File dialog, choose TW for Windows/WinAlign (*.txt) from the Files of
Type list. Choose the desired drive and folder as convenient.

Click the desired file name, and click Open to confirm. The import will now start.
Translator’s Workbench automatically adds the translation units to your TM as defined in
the “Defining Import Options” section.

11.1.5 Importing TW Il or TAlign ASCII text files into a TM of the Windows Workbench

If you are upgrading from the DOS Translator’'s Workbench (TW II) to the Windows version,
you will of course like to continue using your old Translation Memories. To achieve this, follow
these steps:

1.

If you have not already exported your old DOS Translation Memory into an ASCII text file,
do so now. The procedure is explained in the TW II manual in the “Exporting” section of
the “Utilities” chapter.

If you have not already created a Translation Memory in Translator’s Workbench, do so
now. The procedure is described under “Creating a new Translation Memory” in the
“Translation Memory” section.

Open the Translation Memory that you would like to use for the import. Make sure to open
it in exclusive access mode.

From the File menu, choose Import. The Import dialog box opens.

Make the appropriate selections as explained in the section “Defining Import Options”
above. Click OK to confirm your settings. The Open Import File dialog opens.

In the Open Import File dialog, choose TW for DOS/TAlign (*.asc;*.al) from the Files of Type
list. Choose the desired drive and folder as convenient.

Click the desired file name, and click Open to confirm. The import will now start.
Translator’s Workbench automatically converts the data to Translator’s Workbench
Translation Memory format and add translation units to your TM as defined in the
“Defining Import Options” section.
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11.1.6 Migrating from IBM's Translation Manager to TRADOS Translator's Workbench

If you are migrating from IBM’s TM/2 or TM/Win programs to "TRADOS Translator’s
Workbench, you will of course want to continue using your old Translation Memories. To
achieve this, follow these steps:

1. If you have not already exported your old TM/2 or TM/Win Translation Memory into a text
file (by default, it has the extension *. exp), do so now. The procedure is explained in the
"TM/2 and TM/Win manuals respectively.

2. If you have not already created a Translation Memory in Translator’s Workbench, do so
now. The procedure is described under “Creating a new Translation Memory” in the
“Translation Memory” section.

3. From the File menu, choose Import. The Import dialog box opens.

4. Make the appropriate selections as explained in the section “Defining Import Options”
above. Click OK to confirm your settings. The Open Import File dialog opens.

5. In the Open Import File dialog, choose IBM TM/2 (*.exp) from the Files of Type list. Choose
the desired drive and folder as convenient.

6. Click the desired file name, and click Open to confirm. The import will now start.
Translator’s Workbench automatically converts the data to Translator’s Workbench
Translation Memory format and adds translation units to your TM as defined in the
“Defining Import Options” section.

11.1.7 Importing Translation Memory Exchange (TMX) Files Into a Translator's Workbench Translation
Memory

Follow these steps to import a text file created with other 'T'M systems that support “Level 17 of
the Translation Memory Exchange (TMX) format:

1. If you have not already exported the 'T'M from the other TM system into a TMX Level 1-
compliant text file, do so now. The procedure should be explained in the manual of the
other TM system.

2. If you have not already created a Translation Memory in Translator’s Workbench, do so
now. The procedure is described under “Creating a new Translation Memory” in the
“Translation Memory” section.

3. From the File menu, choose Import. The Import dialog box opens.

4. Make the appropriate selections as explained in the section “Defining Import Options”
above. Click OK to confirm your settings. The Open Import File dialog opens.

5. In the Open Import File dialog, choose TMX (*.tmx) from the Files of Type list. Choose the
desired drive and folder as convenient.

6. Click the desired file name, and click Open to confirm. The import will now start.
Translator’s Workbench automatically converts the data to Translator’s Workbench
Translation Memory format and adds translation units to your TM as defined in the
“Defining Import Options” section.

Note

“TMX Level 17 means that internal formatting information inside the imported units is lost
during the import. For more information on TMX, see the TMX Web site at
http://ww. lisa.org/tnx.
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11.2 Exporting

An export writes the contents of a Translation Memory to a file in the Translator’s Workbench
2.x text format (*. t Xt ) as specified in the section above. Optionally, you can export the TM to
a file in the Translator’s Workbench 1.x or the DOS Translator’s Workbench (TW II) text format
for further use in the old versions. Exporting into the “TMX Level 1” format mentioned in the
note above is also supported. For more information on TMX, see the TMX Web site at
http://ww.lisa.org/tnx.

When doing an export, you can specify various criteria to export only parts of a Translation
Memory. Specifying an attribute or only one element of a picklist of that attribute lets you
export a certain subset of the data, for instance to use for creating a new Translation Memory.
Likewise, such system fields as Creation Date or Change User let you export all translation units
that have been added since the beginning of a project, for instance. The usage counter lets you
export those translation units that have actually been re-used. You can also specify the user ID as
an export criterion, and so on.

To perform an export, you have to open the TM in exclusive access mode. You achieve this by
checking the Exclusive box in the Open Translation Memory dialog. If the TM database is
password-protected, you need to know the SuperUser password in order to have exclusive
access.

Note

In Translator’s Workbench Freelance Edition, there is no Exclusive check box in the Open
Translation Memory dialog. This is because Translator’'s Workbench Freelance Edition
automatically opens each 'T'M in exclusive mode.

11.2.1 Defining Export Options

T'o define export options, select Export from the File menu. This opens the Export dialog.

Export
Congtrainte List
Field Criterion
Cancel |
Help |
Hot
Field List Lriterion
Add
Germn [Germany)
Attibute Picklist R
[System Fields)] ar
Changed on: —
Uszage:
Changed by:
[Text Fields]
1D code
[Attribute Fields] [ |

Figure 11-4: The Export dialog with the Field List of the demonstration TM Demo . tmw

The following is a recapitulation of all options in the Export dialog. You will find an example at
the end of this section.
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Constraints List

‘This list contains all the items that specify the restrictions you select for the data to be exported
from your Translation Memory. If you leave this list empty (by just clicking on OK), you will
export your entire 'I'M, thus creating a backup of it in text form. If you would like to export only
a certain subset—for example, only those translation units that have been created by a certain
user, or all TUs belonging to a certain domain—, you have to define constraints as explained
below.

Field List

Here you choose the labels of language segments, system fields, attribute fields, and text fields
to define constraints for your export. Click on the item that you want to use, then click on Add or
Or followed by Add, depending on whether you would like to add a logical AND or a logical OR
to the Constraints List. See the examples below for a detailed description.

Criterion

After making your selection in the Field List, you define a criterion in the Criterion field, for
example “>1” for the system field “Usage Counter,” which would mean that you would like to
only export all TUs that have been used at least twice during translation projects. Or you would
specify the criterion “*user-friendly*” for the [Segments] ficld English (United Kingdom) to
export only T'Us whose English segment contains the word wser-friendly somewhere.

Important

Translator’s Workbench’s export function is case-sensitive. T'his means that it makes a
difference whether you enter the criterion “*user-friendly*”, “*USER-FRIENDLY*” or
“*User-friendly*” into the Criterion field. To make sure all these cases are taken into account
during export, you must add all these cases to the Constraints List, separated by a logical OR.
You achieve this by clicking the Or button before defining the different criteria.

The Criterion Input Box

With the exception of attribute fields, all fields allow you to enter a criterion in the Criterion
input box. Here you specify the criterion for the field that you add to the Constraints List.

The following conventions apply to export constraints criteria:

Criterion | Description

text The segment or field referred to must contain precisely this text and no other.

Text* The segment or field referred to must begin with this text.

*text The segment or field referred to must end with this text.

*text® The segment or field referred to must contain this text somewhere in its contents.

Ptext The segment or field referred to must contain this text, preceded by any single character.

You can specify any number of "?"'s to indicate a sequence of any characters.

Ptext? The segment or field referred to must contain this text, preceded and followed by any single
character. You can specify any number of "?"s to indicate a sequence of any characters.

P*text*® None of the segments or fields referred to may contain this text.

>... The field must contain a value that is greater than the criterion. Can only be used by the
system date fields “Creation Date,” “Change Date,” and “Used Date” as well as the system
field “Usage Counter.”

<en The field must contain a value that is less than the criterion. Can only be used by the
system date fields “Creation Date,” “Change Date,” and “Used Date” as well as the system
field “Usage Counter.”

Translator’s Workbench, © 1994-99 by " TRADOS GmbH




11-10

Importing and Exporting Translation Memories

Attribute Picklist

If you select an item from the [Attribute Field] section in the Field List and you click the Add
button, the corresponding picklist opens automatically and is displayed in the Attribute Picklist.
At the same time, the first item of the picklist is used as the default criterion in the Constraints
List. To use another picklist item, select it with your mouse. Translator’s Workbench will
automatically update the Constraints List accordingly.

11.2.2 Exporting: An Example

Let’s try an example with the demonstration TM Denp. t mv. You can see its setup (system,
text, and attribute fields) in the Field List section on the screen shot above. If you just clicked on
OK in this dialog, you would export the whole T'M, since you would not specify any export
constraints (the Constraints List is empty, meaning all translation units will be exported). For
our purposes, though, let’s assume that we would like to export only a part of our TM
Deno. t W, namely all translation units that fulfil the following criteria:

e they have at least been used twice

OR

e their ID code is PROJ 94/105 (meaning the 105th project in the year 1994)
AND

e the client of the translation project PROJ 94/105 was Pro Software Inc.

To export only the translation units matching these criteria, you have to add corresponding items
to the Constraints list. To achieve this, follow these steps:

1. First of all, we would like to specify a criterion telling Translator’s Workbench to only export
translation units that have at least been used twice. To do this, click on the item Usage in
the [System Fields] section of the Field List in the Export dialog. After that, click on the
Add button. This will automatically add the item Usage Counter to the field list. At the
same time, the Criterion input box is filled with a value, in this case “>0”. This means that
all translation units that have at least been used once will be exported. However, we would
like to export only those that have been used swice. So we will have to replace the “>0” with
a “>1”. You can make this slight yet important correction in the Criterion input box.

Constraints List
Field Criterion

Export

Cancel

Help

Field List Lriterion

[Segments] = P —
Erglish [United Kingdar)
German [Germary)

Attribute Picklist Delete
[Swstem Fields] -
Changed an:

fi

Changed by:

[Text Fields]
1D code

[AMrbute Fields] =l

Figure 11-5: Adding the Usage Field to the Constraints List
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Before defining the second criterion, we have to keep in mind that we would EITHER like
to export all translation units having been used at least twice OR all units bearing the ID code
PROJ 94/105 and having been translated for Pro Software Inc. So the first thing will be to
click on the Or button. This adds an [Or] item to the list of export constraints. After that
click on the item ID code in the [Text Fields] section of the Field List. Now click on the Add
button again. This will automatically add the item ID code to the list of export criteria. To
specify the export criterion PROJ 94/105, simply type this text into the Criterion box where
the cursor is already blinking. This completes specifying the second export criterion.

Export

Constraints List
Field Criterion

Uzage: 1 Cancel

FROJ 94105

Field List Lriterion
[System Fields] d |F'F| 0J 944105
Changed on:

Uszage: Delet
Changed by: Attribute Picklist LEEE

T est Fields

[Attribute Fields]
Status

Client

Domain

Figure 11-6: Adding a Text Field to the Constraints List

Now let’s set the third export criterion, namely the attribute Client Pro Software Inc. To do
this, click on the item Cl/ient in the [Attribute Fields] section of the Field List. After that, click
on the Add button again. The attribute Client is automatically added to the list of export
criteria, and its picklist appears automatically. In this picklist, the item Pro Software Inc. is
already highlighted as the criterion of the attribute field C/ienr. This completes defining our
export constraints. Your Export dialog should now look as follows:

Export

Constraints List
Field Criterion

Usage: »1 Cancel

10 code

Help

Field List Lriterion
[System Fieldz)] -
Changed on: J I
Uszage: Delet
Changed by: Attribute Picklist LEEE

i HE

[Text Figlds]
1D code

[Attribute Fields]
Status

Domain

Figure 11-7: Finished Export Definition
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If your screen looks like this, you can now click the OK button to export the part of our TM
matching the export criteria defined under steps 1-3. This opens the Create Export File
dialog.

Choose the desired drive and folder as convenient.

Type a name into the File Name box, for example My First Export, and Click Save.
Translator’s Workbench will automatically add the . t Xt extension and start writing the

translation units to the export text file. To overwrite an existing export file, you can double-
click its name in the files list. You will then be asked whether you want to replace it or not.

Create Export File HE
Save jn: I {23 Twdwin j gl IE_
95 drr
ME_drer
File name: IM_l,l Firat E sport. ke Save I
Save as tupe: |TW for Windows 2. [ tat] j Cancel |
Help |

Figure 11-8: Creating an Export File

The export now starts. In its status bar, Translator’s Workbench informs you of the progress
of the export. When completed, the program informs you of the total number of translation
units that were exported.

11.3 Using the Export Function to Create a Backup

The most secure method to create a backup of your Translation Memory is to completely export
the data to a text file. Follow these steps:

1.

Open the Translation Memory for which you would like to create a backup. Make sure to
open it in exclusive access mode.

From the File menu, select the Export command. The Export dialog opens.

Since you normally want to save all data in a backup, you do not need to define any
constraints. Just click OK to confirm the empty constraints list. The Create Export File dialog
opens.

Choose the desired drive and folder as convenient.

Type a name into the File Name box, for example Backup, and Click Save. Translator’s
Workbench will automatically add the . t Xt extension and start writing the translation units
to the export text file. To overwrite an existing export file, you can double-click its name in
the files list. You will then be asked whether you want to replace it or not.

The export now starts. In its status bar, Translator’s Workbench informs you of the progress
of the export. When completed, the program informs you of the total number of translation
units that were exported.
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11.4 Creating Export Files for Earlier Versions of Translator’s Workbench

You can export the contents of your Translation Memory in such a way that they are compatible
with earlier versions of Translator’s Workbench (version 1.x, TW II for DOS). Follow these

steps:

1. Open the Translation Memory which you would like to export. Make sure to open it in
exclusive access mode.

2. From the File menu, select the Export command. The Export dialog opens.

3. Specify any export constraints as explained above under “Defining Export Options.”

4. Click OK to confirm your settings. The Create Export File dialog opens.

5. Set the desired export format from the Save as Type drop-down list.

* To export the TM for use with Translator’s Workbench 1.x, choose TW for Windows 1.x
(*.txt).

e To export the TM for use with Translator’s Workbench II for DOS, choose TW for DOS
(*.asc).

6. Choose the desired drive and folder as convenient.

7. 'Type a name into the File Name box, for example Export For Ver si onl, and Click Save.
Translator’s Workbench will automatically add the . t Xt extension and start writing the
translation units to the export text file. To overwrite an existing export file, you can double-
click its name in the files list. You will then be asked whether you want to replace it or not.

8. The export now starts. In its status bar, Translator’s Workbench informs you of the progress

of the export. When completed, the program informs you of the total number of translation
units that were exported.

11.5 Inverting Translation Memories

If you have a bilingual Translation Memory, you might want to also use it in the opposite
language direction. This is easily achieved by using the Export and Import function. Follow these

steps:

1. Open the Translation Memory you want to invert. Make sure to open it in exclusive access
mode.

2. Use the Export command from the File menu to export the Translation Memory into a text
file, as described above.

3. Create a new Translation Memory, using the New command from the File menu. Make sure
to set the language direction that is opposite to the TM you’ve exported under step 2. You
can also open an existing TM which has the opposite language direction of the exported
TM.

4. Use the Import command from the File menu to re-import the exported text file created

under step 2. Translator’s Workbench will automatically assign the translation units in the
inverted order. After the import, you will have a new TM with the opposite language
direction.
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12. Network Operation

Building and maintaining a Translation Memory (TM) can be quite time-consuming. It is
therefore particularly worthwhile where several people work together, and their combined
knowledge needs to be available to everyone.

Translator’s Workbench is therefore fully networkable. When used on a network, you should
have the program files and databases on a central disk that all users can access. Of course, users
can continue to maintain private databases locally.

This chapter explains the aspects of Translator’'s Workbench that are important to network
operation. The chapter is primarily intended for the network administrator in charge of
T'ranslator’s Workbench installation.

Note

The Freelance Edition of Translator’'s Workbench is not network-enabled. This means that it
cannot be used to share TMs with several users in a network. TMs opened with the Freelance
Edition are always opened in exclusive access mode, giving the user the SuperUser rights
mentioned below. By extension, this means that you can only open a password-protected 'TM
in the Freelance Edition if you know the SuperUser password.

12.1 System Settings

When Translator’s Workbench is run on a network, the central translation memories should be
installed in a special directory. The users need a7 /east the following access rights to the network
directory:

*  Open existing files

¢ Read files

e Write files

e Create files

. Erase files

If one of these rights is missing, you will experience problems with crucial Workbench functions.
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12.2 Protecting Translation Memory Databases

Translation Memories can be protected at multiple levels. This is done via defining passwords
that are linked to specific access rights. The following password levels are available:

*  SuperUser Password. 'This password grants users the following rights:

v' Exclusive TM access mode. The exclusive mode gives users access to the Setup,
Import, Export, and Reorganise commands from the File menu.

v" Access to the Change All function in the Maintenance dialog. This function is designed
to perform global changes throughout the T'M in one go. See the “Maintaining a
T'ranslation Memory” section for more information.

If a SuperUser password does not exist, each user can open the TM in exclusive mode. The
SuperUser Password includes all access levels described in the next bullets.

*  Maintenance/Reorg Password. This password grants users the following rights:

v' Exclusive TM access mode, but only to the Reorganise and the Maintenance
commands;

v" Access to the Maintenance command from the File menu in exclusive and read-write
mode. If the Maintenance function is used in read-write mode, the Change All function
is disabled. If the Maintenance function is used in exclusive mode, however, the
Change All function is enabled.

The Maintenance/Reorg Password is especially useful for companies who usually work with
external translation agencies and want to protect the T'M against altering the setup or against
exporting its contents while still allowing them to reorganise the memories and use the
Maintenance function.

* Read-Write Password. This password grants users the following rights:

v' Read-write TM access mode. The read-write mode allows users to add or modify those
translation units which are 7oz protected by specific project passwords (see below).

v' If a Maintenance/Reorg Password does 7or exist, the Read-Write Password also gives
users access to the Maintenance command from the File menu, excluding the Change
All function.

*  Project Passwords. These passwords grant users the following rights:

v" Read-write TM access mode (see above).

v' Create and modify translation units in specific projects. Project passwords can be
defined for each attribute field and attribute value contained in the TM setup. You
define project passwords for attributes that you want to specifically protect against
unauthorised writing. If users only know the Read-Write Password, they will not be
able to change translation units whose attributes have been protected with project
passwords.

v' Project passwords also include the right to use the Maintenance function, however not
the Change All function.

* Read-Only Password: This password allows users to open the 'T'M in read-only mode only.
The read-only mode allows users to open the T'M and use all translation units. However,
they cannot change them in any way.

12.2.1 Defining a SuperUser Password

T'o define a SuperUser password, follow these steps:

1. Open the TM for which you want to define the password in exclusive mode.
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2.
3.

From the File menu, choose the Setup command. The Setup dialog opens.

Click the Access Rights tab.

Setup C:\Program Files\TradosATW4Win\Demo. tmw B

Generall Fields I Fonts I Substitutionsl Segmentation Hulesl Mon ¥latable Test  Access Rights |

SuperUser Pazzword || LConfirmn SU Passwaord I

Maintenance/Reorg Password I
Read\wiite Password I

Read-Only Password I

— Project Pazswords (Create and Modify)

Attributes Pazzwords

I il
Status-»Approved
Statuz-»Fead Only
Cliert->New Chericals Ltd. e

Client-»Pra Software Inc.
Client-*Heawy Engineering & Co.
Client-»Trados

Drornain-» Chernizstyg
Dromain-»Software
Dromnain-»Hardware
Dramain-+Engineering

oK I Cancel Help

Figure 12-1: The Access Rights Tab

Enter the password into the SuperUser Password box. Note that Translator’s Workbench
only displays asterisks while you enter the password.

Confirm your password by entering it again into the Confirm SU Password box.

12.2.2 Defining a Maintenance/Reorg Password

T'o define a Maintenance/Reorg password, follow these steps:

Sl A

Open the TM for which you want to define the password in exclusive mode.
From the File menu, choose the Setup command. The Setup dialog opens.
Click the Access Rights tab.

Enter the password into the Maintenance/Reorg Password box.

12.2.3 Defining a Read-Write Password

T'o define a general Read-Write password, follow these steps:

Sl A

Open the TM for which you want to define the password in exclusive mode.
From the File menu, choose the Setup command. The Setup dialog opens.
Click the Access Rights tab.

Enter the password into the Read-Write Password input box.
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12.2.4 Defining a Read-Only Password

To define a general Read-Only password, follow these steps:

1. Open the TM for which you want to define the password in exclusive mode.

Click the Access Rights tab.

el

12.2.5 Defining Project Passwords

From the File menu, choose the Setup command. The Setup dialog opens.

Enter the password into the Read-Only Password input box.

To define project-specific passwords, follow these steps:

1.  Open the TM for which you want to define the password in exclusive mode.

Click the Access Rights tab.

el

From the File menu, choose the Setup command. The Setup dialog opens.

If you have not yet defined a SuperUser password as described above, you need to do this

now. Project passwords can only be defined once a SuperUser password has been set.

o

In the Attributes list, click the attribute that you want to password-protect.

6. Enter a password into the Passwords input box.

Setup C:\Program Files\TradosATW4Win\Demo. tmw

Generall Fields I Fonts I Substitutionsl Segmentation Hulesl Mon ¥latable Test  Access Rights |

SuperUser Pazsword [#+

Maintenance/Reorg Password Iwerder
Read\wiite Password Iab?395

Read-Only Password Iguest

LConfirmn SU Passwaord I’““‘

— Project Pazswords (Create and Modify)
Attributes

Pazzwords

|l

Clignt->Mew Chemnicals Ltd.
Client-»Pra Software Inc.
Client-*Heawy Engineering & Co.
Client-»Trados

Drornain-» Chermizty
Dromain-»Software
Domain-»Hardwsare

Dromain-+ Engineering

Add

LDelete |

oK | Cancel | Help |

Figure 12-2: Entering Project Passwords for the Attribute “Status - Approved”

7. Click the Add button. The password is added to the list. To assign multiple passwords to
one and the same attribute, enter them one by one into the Passwords list and click the
Add button. To delete an undesired password, highlight it, and click the Delete button.

8. Repeat this procedure for all attributes that you want to protect. Only those users who know
the project passwords will then be able to add or modify any translation units in that project.
Attributes for which a project password has been defined are all marked with an asterisk as

depicted above.
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Notes

*  Project passwords can only be defined once a SuperUser Password has been set.

*  Project passwords also include the right to use the Maintenance function, however not the
Change All function.
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13. Translator’s Workbench’s Windows—
Mouse Functions and Key Assignments

In all of Translator’s Workbench’s windows, particularly the Concordance and Maintenance
windows, you can perform a lot of tasks. You can for example move through the text, select any
part of text, copy selections to the clipboard, perform searches in MultiTerm, display translation
unit information, and edit and delete translation units. The following pages recapitulate all
available mouse functions and key assignments. Unless stated otherwise, all functions described
in this chapter are available in the Source, Translation Memory, Terminology, Concordance, and
Maintenance window.

13.1 Left Mouse Button

To select any part of text in any Translator’s Workbench window, press and hold the left mouse
button and “drag” across the part of text you would like to select. You can double-click on any
word to select it immediately.

13.1.1 Displaying Translation Unit Information

In the Translation Memory and Concordance window, clicking with the left mouse button on
one of the flag icons preceding each translation unit makes the current T'U information (system,
text and attribute fields) visible. This is useful, for instance, when working in Big Windows
mode.

i TRADOS Translator's Workbench - Demo - Englizch [United Kingdom] -»> German [Germany]

File Settngs View Options Tools Help

Bl what exactly is a translation memary (Th)? @ Translation Memory
Ubhersetzungsspeicher «

Translation Memory »

What precisely is a translation memary (T

Changed on 14.02.1998, 1535 proory (TM) genau vorzustellen?
Changed by: BROCKMANM
Uszage: 1
Clignt: Trados

< | 90% | »74% || [90% Fuzey Maich [Match1 of 2

Figure 13-1: Displaying Translation Unit Information in “Big Windows” Mode

13.1.2 Activating MultiTerm

If your mouse pointer is located on the dictionary icon of the Terminology window, a single click
will toggle between displaying and undisplaying the translation of the current term. Double-
clicking the left mouse button will bring up the MultiTerm window. This is useful if you would
like to take a closer look at the current entry in MultiTerm.
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13.2 Right Mouse Button

After selecting text with the left mouse button as described above, clicking the right mouse
button in any window opens a context menu at the current selection cursor position. In this

context menu, you have four options:

Perform Concordance Search: If Translator’s Workbench can find the part of text that you
have selected in one or more source-language sentences of the current TM, it will
immediately open a new Concordance window where it displays all corresponding sentence
pairs containing the found text. From here you can start further Concordance searches in the
same way as just described. If Translator’s Workbench cannot find any Concordance based
on your selection, a corresponding message will appear in the status bar of the main program
window.

Search in MultiTerm: Use this command to start a simple search in MultiTerm, based on
your current text selection. “Simple search” means that MultiTerm will perform a search by
looking through the index of the current source language selected in the MultiTerm
database—usually the same as the one selected as the source language of the current TM—
and display the first entry whose headword begins with the search term. MultiTerm will
then pop up and show you the corresponding entry. If it cannot find the term you have
looked for, a corresponding message (“Not found”) will be displayed in MultiTerm’s status
bar.

Fuzzy Search in MultiTerm: Use this command to start a fuzzy search in MultiTerm, based
on your text selection. If MultiTerm can find matching entries, it will pop up and show you
a hit list with all entries that could be found. If it cannot find anything, it will display a
corresponding messages (“No matching entries found”) in its status bar.

Copy to Clipboard: Use this command to transfer your text selection to Windows’ clipboard.
From there you can paste it into your word processor or any other application that allows the
pasting of text from the clipboard, for example the Windows notepad or D'TP programs.

TRADOS Translator's Workbench - Demo - English [United Kingdom) -> German [Germany]
File Settngs View Options Tools Help

Bl what exactly is a translation memoary (TM)? @ Translation Memory
Uhersetzungsspeicher «
Translation Memaory «

®= Wyas hat man sich unter einem Translat

What precisely is a {EIEE e N (Thti?
Perfarm Concordan
llen?

Search in MuliTerm. ..
Fuzzy Search in MultiTerm...

LCopy to Clipboard

< |90z | >4z || Match 1 of 2

Figure 13-2: Opening the Text Selection Context Menu

13.2.1 Editing & Deleting Translation Units

The right mouse button is also used to edit or delete translation units from within the
Translation Memory, Concordance, and Maintenance windows. Refer to the section on “Editing

& Deleting Translation Units” in the “Translation Memory” chapter for more information.

13.3 Key Assignments

In Translator’s Workbench’s windows, the following key assignments are available to move the

cursor around (most of them are also valid for the TagEditor window):
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[Homel]

Moves the cursor to the beginning of the current line.

[End]

Moves the cursor to the end of the current line.

[Ctrl] + [Homel

Moves the cursor to the beginning of the text displayed in the currently active
window.

[Ctrl] + [End]

Moves the cursor to the end of the text displayed in the currently active window.

[=>1] Moves the cursor one character to the right.
[€] Moves the cursor one character to the left.
[ Moves the cursor one line up.

V1 Moves the cursor one line down.

[Page M Moves the cursor up one screen page.
[Page V] Moves the cursor down one screen page.

[Ctrl] + [2]

Moves the cursor one word to the right.

[Ctrl] + [€]

Moves the cursor one word to the left.

If one or more known terms and/or placeable elements have been found for the current source
sentence, the following additional shortcuts can be used in the Source window of Translator’s
Workbench to move from one element to the next and vice versa:

[Alt] + [=] Moves the focus (bold red bracket) to the next known term. This function is only
available in the Source window.
[Alt] + [€] Moves the focus to the previous known term. This function is only available in

the Source window.

[Alt] + [Ctrl] + [>]

Moves the focus (bold blue bracket) to the next placeable element. This
function is only available in the Source window.

[Alt] + [Ctrl] + [€]

Moves the focus to the previous placeable element. This function is only
available in the Source window.

To select text, the following key assignments are available:

[Shift] + [>]

Moves the selection one character to the right.

[Shift] + [€]

Moves the selection one character to the left.

[Shift] + [Home]

Selects text from the current cursor position up to the beginning of the current
line.

[Shift] + [End]

Selects text from the current cursor position up to the end of the current line.

[Shift] + [1M]

Moves the selection up one line.

[Shift] + [V]

Moves the selection down one line.

[Shift] + [Page ]

Moves the selection one screen page up.

[Shift] + [Page V1]

Moves the selection one screen page down.

[Shift] + [Ctrl] +
[Homel]

Selects text from the current cursor position up to the beginning of the text
displayed in the currently active window.

[Shift] + [Ctrl] +
[End]

Selects text from the current cursor position up to the end of the text displayed
in the currently active window.
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13-4 Translator’s Workbench’s Windows—Mouse Functions and Key Assignments

13.3.1 Special Key Functions and Shortcuts

The shortcut [Ctrl] + [C] or [Ctrl] + [Ins] copies selected text to the Windows clipboard. From
there you can paste it into your word processor or any other application that allows the pasting of
text from the clipboard, for example the Windows notepad or D'TP programs.

The [Enter] key has several functions:

* If you have selected text in any window, pressing [Enter] starts a new Concordance search,
based on your selection.

e If the mouse pointer is located on a flag and you have chosen the translation unit
information to be Hidden (see “Setting Concordance Options” in the “Working With
Bilingual Concordances” chapter), the [Enter] key will toggle between visualising and hiding
the corresponding information (system fields, attributes and text fields). The same applies if
the mouse pointer is located on the database icon in the Translation Memory window.

e If the mouse pointer is located on the dictionary icon in the Terminology window, the
[Enter] key displays/undisplays the translation of the current term.

After selecting text with keys as described above, pressing the shortcut [Shift] + [F10] in any
window opens a context menu at the current selection cursor position. This menu is described
above under “Right Mouse Button.”

13.3.2 Editing & Deleting Translation Units

You can also use the [Shift] + [F10] shortcut to edit or delete translation units from within the
Translation Memory, Concordance, and Maintenance windows. Refer to the section on “Editing
& Deleting Translation Units” in the “Translation Memory” chapter for more information.
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Appendix A : Error Messages &
Troubleshooting

This appendix lists error messages that Translator’s Workbench might display during your work
with the program. It also gives some hints as to how to troubleshoot them. The following types
of errors are covered:

* segmentation error messages lranslator’s Workbench might display during interactive
translation work (from within your word processor) or batch mode (Translate, Analyse, and
Clean Up tools). Note that such errors cannot happen when working with TagEditor since it
always protects all delimiting marks;

e database errors;
*  matrix errors;

* miscellaneous other error messages.

Segmentation Error Messages

Error messages appearing during interactive or batch translation work all have to do with how
Translator’s Workbench segments your texts (see the “Before Starting: Some Background
Information and Useful Settings” section in the “Interface With Your Word Processor and
TagEditor” chapter). The graphic below sums up the segmentation terminology:

Translation unit
start mark —= (0>

‘Source subsegment start mark ‘

SR ¥ ‘Source subsegment end mark

delimiting mark | —— <yo(>T

Translation unit
end mark — <01 Target subsegment Target subsegment
start mark end mark

Troubleshooting

The following section provides all error messages involving segmentation errors and gives hints
as to how correct and avoid them in the future. As a general rule, set your word processor to
display hidden text to view the special marks that Translator’s Workbench inserts into your text
during translation. To find problematic spots in batch-processed files, see “Troubleshooting
Batch-Processed Files” in the “Document Analysis, Translation, and Cleanup” chapter.

The mark for starting a translation unit is missing or damaged

Explanation: One or more characters of the (o> string at the beginning of the translation unit
have been accidentally deleted.
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Solution: Check the beginning of the T'U. Every TU must have the delimiting mark (o> at its
beginning. Otherwise Translator’s Workbench is unable to process it.

Examples

These are examples of translation units for which Translator’s Workbench will display the above
error message:

T ‘The “0” is missing.

[ ‘The “{" and the “>" are missing.

of
This is a sample sentence (open TU).q
<}0{>1

Dies ist ein Beispielsatz (geoffnete TU).q

<O}
The mark for ending a translation unit is missing or damaged
"This error is very similar to the previous one.

Explanation: One or more characters of the - string at the end of the TU have been
accidentally deleted.

Solution: Check the end of the TU. It must have the delimiting mark -y at its end. Otherwise
Translator’s Workbench is unable to process it.

Examples

These are examples of TUs for which Translator’s Workbench will display the above error
message:

The “0” is missing.

-/

{0>1
This is a sample sentence (open TU).q
<}0{>1

Dies ist ein Beispielsatz (geoffnete TU).q

oM

\— ‘The “<” is missing.

The mark for delimiting source and target is missing or damaged

Explanation: One or more characters of the o> string between the source and target segment
of the T'U have been accidentally deleted.
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Segmentation Error Messages A-3

The “<” and the “{" are
missing.

Solution: Check the string between the source and target segment of the TU. It must have the
delimiting mark 4 o(> exactly as shown. Otherwise Translator’s Workbench is unable to process
it.

Examples

These are examples of TUs for which Translator’s Workbench will display the above error
message:

The “0” is missing. ‘

{0>1

This is a sample sentence (open TU).q
TS o

Dies ist ein Beispielsatz (geoffnete TU).q

<0y

The mark for starting a subsegment is missing or damaged
Explanation: One or more characters of the > string (# being any number between 1 and 9) at

the beginning of a subsegment (index entries, footnotes, etc.) have been accidentally deleted.

Solution: Check the beginning of the TU’s subsegment(s). Every subsegment must have the
delimiting mark > at its beginning. Otherwise Translator’s Workbench is unable to process the
corresponding T'U.

Example

This is an example of a TU for which Translator’s Workbench will display the above error
message:

T |The “1” is missing. |

The mark for ending a subsegment is missing or damaged

Explanation: One or more characters of the -, string (# being any number between 1 and 9) at
the end of a subsegment (index entries, footnotes, etc.) have been accidentally deleted.

Solution: Check the end of the TU’s subsegment(s) you want to save or re-open. Every
subsegment must have the delimiting mark < at its end. Otherwise Translator’s Workbench is
unable to process the corresponding T'U.
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Example

This is an example of a TU for which Translator’s Workbench will display the above error
message:

|The “<" before the “1” is missing.

Subsegment Has Already Been Placed

Explanation: You press [Alt] + [n] to place a subsegment inside the target field (# being the
number of the subsegment you would like to place), but fail to achieve this. Instead Translator’s
Workbench displays the above error message. The reason is that you have already placed a
subsegment with that number inside the target field. It cannot be placed twice.

Solution: Make sure your word processor is set to display hidden text. You will find that you
have already placed a subsegment with the number you just pressed along with the [Alt] key.
Delete that subsegment and place it in a different location, or change it as convenient.

Subsegment Not Found

Explanation: You press [Alt] + [n] to place a subsegment inside the target field (7 being the
number of the subsegment you would like to place), but fail to achieve this. Instead Translator’s
Workbench displays the above error message. The reason is that the source segment of the
current T'U does not contain any subsegment with the number you just pressed along with the
[Alt] key. It can therefore not be placed.

Solution: It is not possible to place a subsegment that does not exist in the source segment of a
TU. If you want to insert, say, an extra index entry inside the target field—that is, an index entry
that does not exist in the source field—do this with your word processor’s conventional methods.

Database Errors

There is one major database error message in Translator’'s Workbench (version 2): Not a
TW4Win v2 file. This error occurs in two situations:

*  You try to open a TM database created with version 1.x of Translator’s Workbench.
Translator’s Workbench version 2.x cannot directly open a TM of the previous version. See
the “Upgrading from Version 1.x to Translator’s Workbench 2.0” in the “Installing
Translator’s Workbench 2.0” chapter.

*  You try to open a file that has not been created using Translator’s Workbench. For instance,
if you create a file in your word processor and assign a filename with the extension *. t MW to
it, this file will of course not open in Translator’s Workbench although it has the “correct”
extension. Instead, you will get the above error message.

Other database error messages you may get are “Invalid record reference” and “Key not found.”
If such an error occurs, it’s generally necessary to reorganise the Translation Memory database. If
the error still persists, you may need to export the Translation Memory into a text file, create a
new database with the same setup, and re-import the text file into the new Translation Memory.
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Matrix Errors

Matrix Errors

Matrix errors are errors that the neural network reports. They all indicate problems with the
fuzzy searching capabilities of Translator’s Workbench and/or MultiTerm. The error message
Translator’s Workbench displays always gives you the name of the file in which the error
occurred.

If a matrix error occurs, it’s generally necessary to reorganise the Translation Memory database.
If the error still persists, you may need to export the Translation Memory into a text file, create a
new database with the same setup, and re-import the text file into the new Translation Memory.

Miscellaneous Other Messages

The following section lists messages that may come up in various situations, e.g. when opening a
Translation Memory or during the initialisation of the program, but also during the interactive
work in your word processor.

The system cannot find the file specified. [Drive:Path\Filename.iix]

This error message can occur when opening a Translation Memory. It indicates that you have
moved or copied the Translation Memory to a new location without moving or copying all
Translation Memory files. See “Translation Memory Files” in the “Translation Memory”
chapter for further information.

Couldn’t obtain database lock. Couldn’t open [Filename.tmw]. Probably already open exclusively.

This error indicates that you are trying to open a Translation Memory that has already been
opened in exclusive mode by another user, probably your Translator’'s Workbench system
administrator. Exclusive mode is necessary for doing a Reorganize or other critical TM operation.
You will have to wait until your system administrator makes the Translation Memory available
again to everyone.

Don't use ; as list separator in style name.

This message comes up when Translator’s Workbench detects a semicolon (;) in a style name of
the document that you are translating interactively or in batch mode. A semicolon in a style
name is invalid, and Word as well as Translator’s Workbench will run into trouble handling style
names with this character when converting from and to RTF. This problem often occurs with
documents that have been formatted with NAE styles and that are translated in Europe.

To fix this problem, you have to change a Windows setting that is independent of Workbench or
Word. Follow these steps:

1. Click the Start button.

2. From the Settings menu, choose Control Panel. The Control Panel opens.

3. Double-click the Regional Settings icon. The Regional Settings dialog opens.

4. Click the Number tab.
5

In the List Separator text box, change the semicolon to a character of your choice,
preferably a comma.

6. Click OK to confirm these settings to dismiss the Regional Settings dialog. The above
message will no longer come up.
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A-6 Error Messages & Troubleshooting

Invalid RTF format

"This error can come up before or during the Analyse, Translate, or Clean Up utility. It indicates
that you are trying to batch process one or more RTF files not coming from Word 2.0 or higher.
Open the file(s) in question in Word 6.0 or higher, save them again as RTF, and try again.

It is also possible that you have added DOC files to the list but forgotten to open Word and
activate the Workbench template TWAW n. dot (Word 6.0/7.0) or TWAW n97. dot (Word 97)
before starting the batch utility. Translator’s Workbench can only accept Word DOC files if this
template is loaded, since it converts the files to and from RTF during the batch process.

Too many open files

This error comes up mostly before or during the Analyse, Translate, or Clean Up utility. It
indicates that too many files have been opened on your system simultaneously.

To fix the problem, check the FI LES line in your CONFI G. SYS start-up file. Increase the value
if possible and necessary (a recommended setting would be FI LES = 70 or higher).

If you’re working in a Novell NetWare environment, it might also be useful to check the
NET. CFGfile that contains parameters controlling your network access. It sometimes contains a
FI LE HANDLES line. Increase the value indicated in this line if possible and necessary (a
recommended setting would be FI LE HANDLES 50 or higher).

Outdated document template (TW4Win.dot). Please use current version.

This error often happens after installing a new maintenance release of Translator’s Workbench.
It indicates that you forgot to copy the TWAW n. dot (Word 6.0/7.0) or TWAW n97. dot
(Word 97) template file shipping with the new version to the Tenpl at e or St art up directory
of Word. See “Preparing Your Word Processor for Interaction with Translator’s Workbench” in
the installation chapter for further information.

Solving “Out of Memory” Problems

When you get “Out of Memory” messages in Translator’s Workbench, this is often due to a very
large font table in the current translation memory (TM). By exporting the memory into a text
file, removing fonts from the RTF Preamble and re-importing the text file into a new memory,
you can solve these problems in most cases. Follow these steps:

1. Open the TM which gives you the “Out of Memory” messages in exclusive access mode.

2. From the File menu, choose Export. This opens the Export dialog.

3. Since you want to export the whole contents of the TM, click OK. This opens the Create
Export File dialog.

4. Provide a file name, and start the export by clicking Save. Translator’s Workbench now
exports the entire TM into the text file you specified.

5. Once completed, open the text file in a text editor that can handle large text files. You can
also use Word for this in most cases.

6. After you have opened the text file, you will notice that the <Font Tabl e> section is very
big. Often it contains more than 1000 fonts. Under rare circumstances, this can then lead to
the “Out of Memory” messages.

7. Experience has shown that it is generally possible to delete all fonts starting from number
100. So, if the font table has 1000 fonts, you can safely delete fonts number 101-1000.
IMPORTANT: Be careful with the last font name in the table. It has two closing curly

Translator’s Workbench, © 1994-99 by " TRADOS GmbH
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braces. It is very important that these curly braces remain there. So it is recommended not to
delete the very last font name; otherwise the text file will become invalid.

8. After deleting the font names from the table, save the file again in text only format (. TXT).

9. In Translator’'s Workbench, create a new TM. Do not copy the setup of the old TM, since
these would also copy the font table of your old TM, and the problem would remain.
Instead, re-configure the TM manually in the same way as your old one.

10. You can now import the text file saved in step 8 into the new TM. Run a few tests to see if
the new TM is complete and if the “Out of memory” problem has gone away. If it has, you
can delete the old TM or archive it for future reference.

No previous search! Could not save translation unit. Use “Close” without saving.

This message comes up after you have carried out the following steps:

1. You have closed the current Translation Memory or exited Translator’s Workbench before
closing the currently open translation unit in your word processor with the ) button.

2. You have re-opened a Translation Memory or re-started Translator’s Workbench after
realizing this.

3. Now the program displays the above message when you try to save the still open translation
unit.

To fix the problem and still be able to save the translation unit in TM, perform these steps:

1. Close the translation unit, using the " button.

2. Place the cursor somewhere inside the translation unit you have just closed, and click the &
button to re-open it.

3. Click the * to save the TU in Translation Memory. If you want to immediately go on to the
next unit, click the & button.

Different target in TM. Use “Get” to update document or “Set” to update TM.

This message comes up when Translator’s Workbench finds out that the target segment of the
currently open translation unit (T'U) is not the same as its counterpart in Translation Memory
(TM). In this case you can decide if you want to use the target segment from TM, if you want to
update TM based on the changes in the current TU, or if you want to cancel without making any
changes to your document or TM:

e Toupdate the document based on the target segment from Translation Memory, click #.
*  To update the TM based on the target segment in the current TU, click the '#! or & button.

»  To neither change the document nor the TM, click the "7 button. This will allow you to
keep the target text in your document without changing the T'U in Translation Memory.

New Translation Unit! Use “Set” to add it to the TM.

This message comes up when Translator’s Workbench finds out that the current translation unit
(TU) does not have any counterpart in Translation Memory (TM). This happens, for instance,
after pre-segmenting a document using the Translate function and then opening a new T'U in
the pre-processed file from within your word processor. Make the desired changes, if any, to the
target segment of the TU in your word processor and click the &) or ) button to save the TU in
the document as well as in T'ranslation Memory.
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Dongle Problems

The following messages indicate that Translator’s Workbench does not correctly recognise the
dongle connected to the parallel port of your computer:

e “While no dongle is connected to the parallel port, program only runs in demo mode”

e “Translation memory too big for demo mode. Connect dongle to parallel port!”

If you get these messages even if you have properly connected the dongle, try fixing the
problem by using the Configure Dongle Drivers program from the Trados fine translation tools
program group. The dongle driver utility also contains a Help file with more information on how
to set up the drivers.
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Appendix B : Application Programming
Interface Reference

Please note that this appendix is no longer available as an integral part of the Translator’s
Workbench manual. However, you can find it as a PDF document on our Web site. At the time
of writing, the exact download address was http://ww.trados. comtexts/
t wb2api . zi p. The API documentation is regularly updated, so you may want to check back
every now and then for the latest version. It is only available in English.
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—

# footnote (in Help files), 7-2

—$—

$ footnote (in Help files), 7-2

+ footnote (in Help files), 7-2

—Key Assignments—

[Alt]
+ [*] on the numeric keypad, 6-2
+ [+] on the numeric keypad, 6-2
+[1], 6-17
+ [7] on the numeric keypad, 6-2
+ [Ctrl] + cursor keys, 3-11, 13-3
+ [Del], 6-2
+ [End], 6-2
+ [F4], 3-9, 5-3, 6-15
+ [Home], 3-5, 3-17, 6-2
+ [Ins], 6-2
+ [Page] keys, 6-3
+ [x] on the numeric keypad, 6-2
+ cursor keys, 13-3
+ cursor keys, 3-9, 3-10, 6-3
[Cerl]
+ [Alt] + [Page] keys, 6-3
+ [Alt] + cursor keys, 6-3, 6-4
+ [Alt] + cursor keys, 6-3
+[C], 13-4
+ [End], 13-3
+ [Home], 13-3
+ [Ins], 13-4
+ cursor keys, 13-3
[End], 13-3
[Enter], 13-4
[F3], 5-1
[Home], 13-3
[Page] keys, 13-3
[Shift]
+ [Cerl] + [End], 13-3
+ [Ctrl] + [Home], 13-3
+ [End], 13-3
+ [Home], 13-3
+ [Page] keys, 13-3
+ cursor keys, 13-3

—A—

abbreviations, 4-22
and language formatting in your word processor, 6—-6
access rights, 12-2
Access Rights tab (Setup dialog), 4-26, 12-3
acronyms
how to handle, 3-11, 4-14
active terminology recognition. See terminology recognition
alignment, 4-5
penalty, 4-43
Alignment Penalty (Translation Memory option), 4-43
Analyse function, 9-1
Analysis Results (group box in the Analyse Files dialog), 9—
3
ANSI, 1-5,11-1, 11-6
API documentation on the Web, B-1
Apply Placeable Penalty also when Source Tags differ, 4-43
ASCII, 1-5, 11-1, 11-6
Asian languages, 4-12
segmentation, 4-19
attribute fields
changing ~ at a later date, 4-8
defining, 4-8
attributes
Penalty, 4-30
setting translation project ~, 4-28
translatable, 3-16
using ~ as filters, 4-30
automatic translation, 6-12

—B—

Background Read-Only TM for Concordance searches, 5-4
backing up a Translation Memory, 11-12
backup, 2-6, 2-7, 4-4
batch processing, 9-1

analysis, 9-1

cleanup, 9-9

pre-translation, 9-6

troubleshooting, 9-13
BIF (bilingual file format in TagEditor), 3-19
Big Windows, 13-1
bilingual concordances, 1-1
bilingual file format, 3-19

Translator’s Workbench, © 1994-99 by " TRADOS GmbH



C-2

Index

blanks

extra ~ added by the Get Placeable function in tag

support, 8-15
boundary value for fuzzy matching, 4-32, 5-4
Browser
defining a ~ via the DTD Settings Wizard, 8-9
button bar description, 6-2

—C—

Change Date, 4-3
Change User, 3-8, 4-3
changed translation units, 4-37
changing
project settings globally, 4-66
text globally in translation units, 4-68
character sets, 4-12
Check Matching Sub-Languages (Import option), 11-5
Chinese, 4-12
segmentation, 4-19
Cleanup function, 9-9
Clipboard, 3-9, 6-15, 13-2
closing a translation unit from your word processor, 6-2
closing tags, 3—-16
colours
for identifying differences, 6-13
concordance, 1-1
definition, 5-1
searching, 5-1
Concordance options, 5-3
Background Read-Only TM, 5-4
Display Translation Unit Information, 5-4
Maximum Number of Hits, 5-4
Minimum Match Value, 5-4
constraints
defining ~ for exporting, 11-9
defining ~ for TM maintenance, 4-57
Copy Source on No Match, 4-33
tip for using, 8-15
Copy to Clipboard (context menu function), 6-15, 13-2
copying or moving Translation Memory files, 4-4
corrections, 6—15
Couldn’t obtain database lock (error message), A-5
country codes in the export file, 11-2
Create Project TM (Analysis Results option), 9—4
creating a Translation Memory, 4-2
Creation Date, 4-3
Creation User, 4-3
CSV log format, 9-3, 9-9
custom footnotes in Help files, 7-1

defining
attribute fields, 4-8
automatic substitutions, 4—14
font options in TM setup, 4-12
font translations, 4-12
general Translation Memory options, 4-6
new DTD settings, 8-3
non-translatable text options, 4-26
text fields, 4-8
deleting & editing translation units, 4-51
description of buttons, 6-2
description of toolbar, 6-2
dialog language
switching, 3-13
Different target in TM (error message), A-7
display
a MultiTerm entry, 10-3
translation unit information, 5-4, 13-1
Display Time, 4-33
document analysis, 9-1
document cleanup, 9-9
document pre-translation, 9-6
document type definition. Sec DTD
dongle
driver installation, 2-2
problems with, 2-3
troubleshooting problems, A-8
Don’t use semicolon as list separator in style name (error
message), A-5
DTD
defined, 8-2
editing settings, 8-3
DTD Settings Wizard, 8-2
Default Formatting, 8-6
Document Type Definition, 8—4
Element Properties, 8-6
entity conversion management, 8—8
preview mode settings, 8-9

DTP, 13-2, 13-4

—D—

database errors, A—4
dates
defining substitution settings for, 4—45
how to handle, 3-11, 4-14, 4-44
default End Rules, 4-23

—E—

East European languages, 4-12
editing & deleting translation units, 4-51
Element Properties (D'TD Settings Wizard), 8-6
End Rules, 4-17
entities
managing conversion (D'T'D Settings Wizard), 8-8
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C-3

error messages, A-1
Couldn’t obtain database lock, A-5
Different target in TM, A-7
Don’t use semicolon as list separator in style name, A-5
Invalid record reference, A—4
Invalid RTF format, A6
Key not found, A—4
matrix errors, A-5
New Translation Unit, A-7
No previous search, A-7
Not a valid TW4Win v2 file, A—4
Outdated document template, A—6
subsegment has already been placed, A—4
subsegment not found, A—4
the mark for delimiting source and target is missing or
damaged, A-2
the mark for ending a translation unit is missing or
damaged, A-2
the mark for starting a subsegment is missing or
damaged, A-3
the mark for starting a translation unit is missing or
damaged, A-1
The system cannot find the file specified. [Drive
Path\Filename.iix], A-5
Too many open files, A-6
exclusive access, 11-1
existing translation units during import, 11-3
Expand Segment (Trados menu function), 6-3
expanding segments, 6-22
Export
creating a backup of a Translation Memory, 11-12
Frequent Segments (Analysis Results option), 9-4
from a Translation Memory, 11-8
Unknown Segments (Analysis Results option), 9-5
external tags, 3-16, 8-13

footnotes, 6-16
in Help files, 7-1
Formatting
Defaule (D'TD Settings Wizard), 8-6
element (DTD Settings Wizard), 8-6
mapping tags to ~, 87
Formatting Differences Penalty (Translation Memory
option), 4—41
formatting in TagEditor, 3-18
FrameMaker
translating ~ files with Translator’s Workbench, 8-1
Freelance Edition of Translator’s Workbench
introduction, 1-3
Full Stop End Rule, 4-24
fuzzy index, 3-1, 10-6, 10-7
fuzzy match, 4-39, 6-13
Translate to Fuzzy (toolbar function), 6-12
fuzzy matching, 1-6
definition, 4-2
Fuzzy Search in MultiTerm (context menu function), 104,

13-2

—F—

Far East languages
segmentation, 4-19
fields, 6-15
how to handle, 3-10
Fields tab (Setup dialog), 4-7
filter
using a ~ in MultiTerm, 10-4
filter attributes
defining, 4-30
Penalty, 4-30, 4-42
find and replace, 4-59
Fix Document ('Trados menu function), 6-4, 6-22
flagman, 64
Followed By Lowercase option, 4-20
Followed By Tab option, 4-20
Font Table, 4-52, 4-54
Font Translations, 4-12
fonts
changing the default font for source and target languages,
4-12
in the RTF Preamble, 11-2
Fonts tab (Setup dialog), 4-12
footnote handling
in Word 6.0 and 7.0, 6-18
in Word 97, 6-18

—G—

General tab (Setup dialog), 4-6
Get Translation, 3-8, 6-2
global changes
defining for TM maintenance, 4-59
example of global changes in project settings, 4-66
example of global text changes, 4-68
graphics, 6-15
how to handle, 3-10
Greek, 4-12
Guessed Abbreviation, 4-20

—H—

Help files
characteristics, 7-1
custom footnotes in ~, 7-1
example of a Help page, 7-2
exceptions and special issues, 7-8
non-standard ~, 7-8
translating with Translator’s Workbench, 7-1
troubleshooting jumps and popups, 7-9
turning graphic references into placeable elements, 7-4
turning graphic references into placeable elements, 7-9
Help, online, 3-23
hidden text, 6-4, 6-16
HTML
editing settings, 8-3
preparing TagEditor for handling ~, 8-2
previewing, 3—-19
HTML files
translating ~ with Translator’s Workbench, 8-1
HTML Help files, 7-1
hyperlinks, how to handle, 6-16
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import
import mode, 11-3
importing TW II or TAlign ASCII text files into a TM of
the Windows Workbench, 11-6
importing WinAlign alignment results into a translation
memory, 11-6
into a Translation Memory, 11-1
large import file, 11-3
small import file, 11-3
index entries, 6-16
Insert Blank After Tag, 4-33
Insert Blank After Tag (Translation Memory Option), 8-15
installation
dongle drivers, 2-3
MultiTerm, 2-1
Translator’s Workbench, 2-1
interface
MultiTerm ~, 10-1
TagEditor ~, 6-1
Word ~, 6-1
Interleaf
translating ~ files with Translator’s Workbench, 8-1
internal tags, 3-16, 8-13
and blanks, 8-15
tip for translating documents with many ~, 8-15
interrupting automatic translation, 6-13
Invalid record reference (error message), A—4
Invalid RTF format (error message), A-6
inverting a Translation Memory, 11-13
ISO 3166 country codes in the export file, 11-2

large import file, 11-3
Leading Characters, 4-18
Leading Words, 4-18
left mouse button, 13-1
linguistic fuzzy matching, 1-6, 4-2
List Abbreviation, 4-20
log file, 9-12
selecting, 9-3, 9-9
LOGOS (Machine Translation system), 9-5

—J—

Japanese, 4-12
segmentation, 4-19
jump links (in Help files), 7-2

— K—

K footnote (in Help files), 7-2
Keep Backup, 4-50
key assignments, 13-2
Key not found (error message), A—4
Korean, 4-12

segmentation, 4-19

—M—

Machine Translation
integration of ~, 9-5
Machine Translation Penalty (Translation Memory option),
4-44
maintaining a Translation Memory, 4-55
Maintenance/Reorg password
defining, 12-3
explained, 12-2
mapping tags to formatting (DTD Settings Wizard), 8-7
matrix errors, A-5
Maximum Number of Hits (Translation Memory option),
4-32
measurements
defining substitution settings for, 4—48
how to handle, 4-14, 4-44
Minimum Match Value (terminology recognition option),
10-2
Minimum Match Value (Translation Memory option, 4-32
mouse functions
left mouse button, 13-1
right mouse button, 13-2
Multi-Segment Footnotes, 4-50
multi-segment footnotes in Word 97, 6-18
MultiTerm
active terminology recognition, 1-6
additional documentation, 1-7
context menu functions for accessing ~, 10-3
displaying a MultiTerm entry, 10-3
fuzzy search in MultiTerm, 10-4, 13-2
getting started, 3-1
installation, 2—1
interface, 10-1
search in MultiTerm, 10-3, 13-2
terminology recognition, 1-1
troubleshooting, 10-6
using a filter, 10-4

—l—

language
available source ~s, 4-3
available target ~s, 4-3
switching the dialog language in Translator’s Workbench,
3-13
language direction
inverting the ~ of a TM, 11-13
language formatting, in your word processor, 6—6

—N—

names
how to handle, 4-14, 4-44

network
installing T'ranslator’s Workbench on a 7, 2-5
operation, 12-1

New DTD Settings dialog, 8-3

New Translation Unit (error message), A-7

no match, 4-32, 6-14

No previous search (error message), A-7

Non Xlatable Text tab (Setup dialog), 4-26

nonprinting characters, 64

Translator’s Workbench, © 1994-99 by " TRADOS GmbH



Index

Non-Translatable Paragraphs (Settings menu item), 6-6
Non-Xlatable Text tab (Setup dialog), 6-8
Not a valid TW4Win v2 file (error message), A—4
Not Matching Attributes Penalty (Translation Memory
option), 4-41
Number of Dots value, 4-21
Number Stop option, 4-19
numbers
defining substitution settings for, 4—47
how to handle, 3-11, 4-14, 4-44

Project passwords
defining, 12-4
explained, 12-2
project settings
defining, 4-26
properties
element (DTD Settings Wizard), 8-6
protected tags, 3—16
protection of tags, 3—16

—O0—

online Help, 3-23
on-line Help files. See Help files
open translation unit from your word processor, 6-2
opening tags, 3—16
options
Concordance options, 5-3
setting view options in Word, 3-7, 6-5
terminology recognition, 10-2
T'ranslation Memory options, 4-31
ordinal followers, 4-21, 4-23
Out of memory, A-6
Outdated document template (error message), A—6

_Q_

QuarkXPress
translating ~ files with Translator’s Workbench, 8-1

—p—

PageMaker
translating ~ files with Translator’s Workbench, 8-1
password
Maintenance/Reorg, 12-2
Project, 12-2
Read-Only, 12-2
Read-Write, 12-2
SuperUser, 12-2
penalties
Alignment Penalty, 4-43
Formatting Differences Penalty, 4-41
Machine Translation Penalty, 4-44
Not Matching Attributes Penalty, 4-41
setting, 4—40
Perform Concordance search (context menu function), 4—
51,5-2
placeable elements, 6-15
Placeable Penalty
also apply ~ when Source Tags differ, 4-43
placing a subsegment, 6-17
popup links (in Help files), 7-2
Preceded By Guessed Abbreviation option, 4-20
Preceded By List Abbreviation option, 4-20
preview mode settings (DTD Settings Wizard), 8-9
previewing documents in TagEditor, 3-19
problems
in documents, 6-22
project
starting a new, 3-22
project attributes
Not Matching Attributes Penalty, 4-42
setting ~, 4-28
using ~ as filters, 4-30

—R—

RC files
translating ~ with Translator’s Workbench, 8-1
Read-Only passwords
defining, 12-4
explained, 12-2
Read-Write password
defining, 12-3
explained, 12-2
reducing segments, 6-22
Repetitions, 9-1
Resource files
translating ~ with Translator’s Workbench, 8-1
right mouse button, 13-2
RTF, 4-53, 4-54
RTF Help files. See Help files
RTF Preamble, 11-1
removing unused fonts from, A-6
Russian, 4-12

—S—

Search Depth (terminology recognition option), 10-2
Search in MultiTerm (context menu function), 10-3, 13-2
Search Resized Segment (Trados menu function), 6-3
searching

T'Us according to project settngs, 4-65

T'Us changed after a certain date, 4-63

T'Us changed after a certain date AND by a certain user,

4-604

Segment Unknown Sentences (option in the Translate

Files dialog), 9-8
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segmentation rules
default End Rules, 4-23
End Rules, 4-17
Followed By Lowercase option, 4-20
Followed By Tab option, 4-20
Full Stop End Rule, 4-24
handling abbreviations, 4-22
handling ordinal followers, 4-23
Leading Characters value, 4-18
Leading Words value, 4-18
Number of Dots value, 4-21
Number Stop option, 4-19
Ordinal Follower option, 4-21
Preceded By Guessed Abbreviation option, 4-20
Preceded By List Abbreviation option, 4-20
Single Letter Dot option, 4-21
Skip Rules, 4-18
Stop Character is Dot, 4-20
Stop Character list, 4-18
Trailing Whitespaces value, 4-19
Segmentation Rules tab (Setup dialog), 4-17
segments
expanding, 6-22
reducing, 6-22
semi-WYSIWYG view in TagEditor, 3-16
settings
dialog language, 3-13
setup
changing the Translation Memory ~ at a later date, 4-8
copying the ~ from existing Translation Memories, 4—4
dongle drivers, 2-3
MultiTerm, 2-1
Translator’s Workbench, 2-1
SGML
editing settings, 8-3
preparing TagEditor for handling ~, 8-2
SGML files
translating ~ with Translator’s Workbench, 8-1
shortcuts, 13-2
Show Project Settings, 4-33
Shrink Segment (Trados menu function), 6-3
Single Letter Dot option, 4-21
Skip Rules, 4-18
small import file, 11-3
source field, 3-6, 3-8
source language, 3-2, 3-15, 4-3
define the default font, 4-12
special character sets, 4-12
S-Tagger
display full STF tags in TagEditor, 3-18
standalone tags, 3-16
starting a new project, 3-22
STF
display full STF tags in TagEditor, 3-18

tip for translating STF or other Workbench RTF files in

TagEditor, 8-15

Stop Character is Dot, 4-20
Stop Characters, 4-18
Strip TW4Win Styles, 4-50
Strip Unused Fonts, 4-50
Strip Unused Styles, 4-50
Style Sheet, 4-52

used character styles, 4-52
styles

character, 6-8

character styles in the RTF Preamble, 11-2

paragraph, 6-6

sub-languages
check matching (Import option), 11-5
subsegment
handling multiple, 6-17
placing, 6-17
subsegment has already been placed (error message), A—4
Subsegment not found (error message), A—4

Substitution Localization tab (Translation Memory

Options), 4-44
substitutions

dates, 4-45

measurements, 4—48

numbers, 447

time, 4-47
Substitutions tab (Setup dialog), 4-14
SuperUser password

defining, 12-2

explained, 12-2
supported file types, 4-1
supported formats, 4-1
Switches

Insert Blank After Tag, 8-15
system fields, 4-3

Change Date, 4-3

Change User, 3-8, 4-3

Creation Date, 4-3

Creation User, 4-3

Usage Counter, 3-8, 4-3

Used Date, 4-3
system requirements, 1-9
SYSTRAN (Machine Translation system), 9-5

—T—

table of contents entries, 6—16
tag support, 8—1

preventing Workbench from inserting an extra blank

after internal tags, 8-15
tag tip, 8-15
TagEditor
button description, 6-2
interface, 6-1
introduction, 1-2
supported formats, 1-2
tag protection and verification, 1-2
the Translator’s Workbench toolbar in, 6-2
the Workbench menu in, 6-2
toolbar description, 6-2

translating tagged files using Translator’s Workbench and

TagEditor, 8-1
tagged files
defined, 3-14
definition, 8—1
tags, 6-15
closing, 3-16
defined, 3-14
definition, 8—1
external, 3—-16
internal, 3-16
opening, 3-16
protection of, 3-16
standalone, 3-16
transferring from source to target segment, 3—18
veritying, 3-19
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TAlign, 4-5, 11-1, 11-6
penalty, 4-43
target field, 3-6, 3-8, 3-9, 3-10
target language, 1-5, 3-2, 3-15, 4-3, 10-1
define the default font, 4-12
terminology recognition, 1-1, 1-6, 3-2, 3-6, 3-8, 3-15, 3-
17,10-1
options, 10-2
Minimum Match Value, 10-2
Search Depth, 10-2
troubleshooting, 10-6
text fields
changing ~ at a later date, 4-8
defining, 4-8
text format specification, 11-1
Thai, 4-12
The mark for
delimiting source and target is missing or damaged, A-2
ending a subsegment is missing or damaged, A-3
ending a translation unit is missing or damaged, A-2
starting a subsegment is missing or damaged, A-3
starting a translation unit is missing or damaged (error
message), A1
The system cannot find the file specified. [Drive
Path\Filename.iix] (error message), A-5
time
defining substitution settings for, 4—47
time specifications
how to handle, 3-11, 4-14, 4-44
tips & tricks
for Word, 6-22
tips and tricks
for translating STF or other Workbench RTF files in
TagEditor, 8-15
translating documents with many internal tags, 8-15
TM mode
buttons in ~, 6-2
leaving ~, 3-8
starting ~, 3-5, 3-17
TMX, 11-1
exporting into, 11-8
importing, 11-7
TOC entries, 6-16
Too many open files (error message), A—6
toolbar description, 6-2
Tools
Analyze, 9-1
Cleanup, 9-9
Translate, 9-6
Trados menu, 6-2
Expand Segment function, 6-3
Fix Document function, 6-4
Search Resized Segment function, 6-3
Shrink Segment function, 6-3
TRADOS TagEditor. See TagEditor
Trailing Whitespaces value, 4-19
translatable attributes, 3—16
Translate function, 9-6
Translate Terms (option in the Translate Files dialog), 9-8
Translate to Fuzzy
interrupting, 6-13
Translate to Fuzzy (toolbar function), 6-12
translation
automatic, 6-12, 9-6

Translation Memory, 4-1
~ files, 44
assigning a file name to a new ~, 4—4
backing up a ~, 11-12
configuring a ~, 4-5
copying or moving ~ files, 4-4
copying setups from existing ~, 4—4
creating a ~, 4-2
definition, 1-5
editing & deleting translation units, 4-51
exporting from a ~, 11-8
how ~ is updated, 4-33
how ~ works, 4-1
importing into a ~, 11-1
inverting a ~, 11-13
maintenance, 4-55
examples, 4-63
options, 4-31
protecting, 12-2
using WinAlign to create a ~, 4-5
working with, 4-26
Translation Memory Exchange format, 11-7
Translation Memory mode. See TM mode
translation unit
~ in Translator’s Workbench’s text format, 11-2
attribute and text fields of changed ~s, 4-37
attribute and text fields of used ~s, 4-34
classifying translation units, 4-7
closing a ~, 3-8
definition, 1-5
display ~ information, 54
editing & deleting ~s, 4-51
example of a typical ~, 4-1
existing ~s during import, 11-3
in TagEditor, 3-19
opening a ~ from TagEditor, 3-17
opening a ~ from your word processor, 3—-5
storing a ~ in Translation Memory, 3-8
system fields, 4-3
Translator’s Workbench
installation, 2—1
Translator’s Workbench
What’s New
in release 2.2, 1-2
in Translator’s Workbench 2 compared to version 1, 1-
4
Translator’s Workbench Freelance Edition
installation, 2—1
introduction, 1-3
Translator’s Workbench II for DOS. See TW 11
troubleshooting, A-1
batch-processed files, 9-13
documents, 6-22
MultiTerm, 10-6
TWIIL, 1-5, 11-1, 11-6, 11-8
T-Window for PowerPoint
introduction, 1-3

Translator’s Workbench, © 1994-98 by " TRADOS GmbH



Index

—U—

Unicode™, 1-4, 4-3

Update Changed Translations (option in the Cleanup Files
dialog), 9-11

Update Changed Translations (option in the Translate
Files dialog), 9-9

updating Translation Memory, 4-33

upgrading
from version 1.x to Translator’s Workbench 2.x, 2-6

Usage Counter, 3-8, 4-3

Use Previously Created TM (Analysis Results option), 9-6

used character styles, 4-52

Used Date, 4-3

used fonts, 4-54

used translation units, 4-34

Userid
entering a ~, 3-3

—\V—

variable elements
and the Concordance feature, 4-16
variable lists
how to handle, 4-14
Ventura
translating ~ files with Translator’s Workbench, 8-1
versions
upgrading from version 1.x to Translator’'s Workbench
2.x, 2-6
View Log File (Analysis Results option), 9-4
view options in Word, 3-7, 6-5

—\W—

What’s New
in release 2.2, 1-2
in Translator’s Workbench 2 compared to version 1, 1-4

WinAlign, 1-5, 11-1, 11-6
penalty, 4-43
Windows Clipboard, 3-9, 6-15, 13-2
Windows Resource files
translating ~ with Translator’s Workbench, 8-1
WinWord. See Word
Word
button description, 6-2
interface, 6-1
source field, 3-6, 3-8
target field, 3-6, 3-8
the Trados menu in, 6-2
the Translator’s Workbench toolbar in, 6-2
tips and tricks, 6-22
toolbar description, 6-2
Word 6.0/7.0
copying the document template, 2-9
preparing, 2-9
Word 97
copying the document template, 2-8
preparing, 2-8
Word for Windows. See Word
word processor
interface, 6-1
the Trados menu in your ~, 6-2
the Translator’s Workbench toolbar in, 6-2
WordPerfect
support for discontinued, 2-10
Workbench menu in TagEditor, 6-2
Workbench RTF
defined, 8-1
tip for translating STF or other Workbench RTF files in
TagEditor, 8-15
WYSIWYG
mapping tags to formatting to achieve semi-~, 8-7
semi-WYSIWYG view in TagEditor, 3-16

— X—

XE entries, 6-16
XML, 11-1
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